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Manual Contents
This manual describes specifications and applications of MEMOSOFT for DOS.

Please read this manual carefully and be sure you understand the information provided before attempting to
operate any associated electronic devices or machinery.

Visual Aids

The following aids are used to indicate certain types of information for easier reference.

Indicates references for additional information.

IMPORTANT | Indicates important information that should be memorized.

<EXAMPLEp |ndicates application examples.

Y

Indicates supplemental information.
» SUMMARY Indicates a summary of the important points of explanations.

Note Indicates inputs, operations, and other information required for correct operation
but that will not cause damage to the device.

Indicates definitions of terms used in the manual.

NOTICE

The following conventions are used to indicate precautions in this manual. Failure to heed precautions
provided in this manual can result in injury to people or damage to the products.

&WARNING Indicates precautions that, if not heeded, could possibly result in loss of life or
serious injury.

A Caution  Indicates precautions that, if not heeded, could result in relatively serious or minor
injury, damage to the product, or faulty operation.

©Yaskawa, 1999

Allrights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, or
by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission of
Yaskawa. No patent liability is assumed with respect to the use of the information contained herein. Moreover, because
Yaskawa is constantly striving to improve its high-quality products, the information contained in this manual is subject to
change without notice. Every precaution has been taken in the preparation of this manual. Nevertheless, Yaskawa assumes
no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the
information contained in this publication.
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Introduction and Precautions

This chapter introduces this manual and provides precautions for the
use of this manual and the product. You must read this chapter be-
fore attempting to read the rest of the manual or using the prod-

uct.

1.1 Overview of Manual ......... -

1.2 Precautions ...... Ceeveecaene

1.2.1  Applications Precautions .........
1,22 Wiring Precautions . .............
1.23  Safety Precautions ..............
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Introduction and Precautions

1.1 Overview of Manual

» This manual describes how to operate MEMOSOFT Programming Software. Read this
manual carefully in order to use MEMOSOFT properly. Also, keep this manual in a safe
place so that it can be used whenever necessary. -

» Refer to the following manuals for related peripheral devices and modules.

Manual Manual number Contents
CPU Module | MEMOCON GL.120, GL130 SIEZ-CB825-20.1 Describes the foliowing for the GL120 and
Hardware User's Manual GL130:

1) System configuration

2) System components

3) Functions and specifications

4) Installation and wiring

5) F;’anel layout and hole dimensions

6) Extemal dimensions

MEMOCON GL120 : SIEZ-C825-20.1-1 Describes the functions, specifications, and
CPU10 Module User's Manual ’ usage of the CPU10 Module.

MEMOCON GL130 SIEZ-C825-20.1-3 Describes the functions, specifications, and
CPU35 Module User's Manual usage of the CPU35 Module.

MEMOCON GL120, GL130 SIEZ-C825-20.11 Describes the following for the GL120 and
Software User's Manual GL130:

Volume 1 :

1) Operating principles

2) IfO allocation

3) Overview of instructions

4} Instruction processing times

—_12 —




1.1 Overview of Manual

m

Manual Manual number Contents
CPU Module | MEMOCON GL120, GL130 SIEZ-C825-20.12 Describes the programming instructions
Software User's Manual used to create ladder programs for the
Volume 2 GL120 and GL130.

The following instructions are described in
other manuals.

1) Expansion Math instructions:
Software User's Manual (Vol. 3)

2) Process Control Instructions:
Software User’s Manual (Vol. 4)

3) Communications Instructions
COM: COM Instructions User's Manual
FBUS: PC Link Module User’s Manual
MSTR: MEMOBUS PLUS User's Manual

4) Motion Control Instructions
(ladder motion instructions}
Motion Module MC20 Software User's
Manuai

5) Motion Language
Motion Module MC20 Software User’s

Manual

MEMOCON GL120, GL130 SIEZ-C825-20.13 Describes expansion math instructions
Software User's Manual (floating point math instructions, etc.) used
Volume 3 for the GL120 and GL130.
MEMOCON GL120, GL130 SIEZ-C825-20.14 Describes process control instructions used
Software User's Manual for the GL120 and GL130.
Volume 4

IO Modules MEMOCON GL120, GL130 SIEZ-C825-20.22 Describes the functions, specifications, and
120-Series /0 Modules usage of the 120-Series Digital /0 Modules.

User's Manual _
Special-pur- MEMOCON GL120, GL130 SIEZ-C825-20.24 Describes the functions, specifications, and

pose Modules | 120-Series High-speed usage of the 120-Series High-speed Counter
Counter Module User's Manual Module,
MEMOCON GL120, GL130 SIEZ-C825-20.26 Describes the functions, specifications, and
Uniwire Interface Module usage of the 120-Series Uniwire Interface
User’s Manual Module.
MEMOCON GL120, GL130 SIEZ-C825-20.28 Describes the functions, specifications, and
Pulse Catch and Counter usage of the Pulse Catch and Counter
Moduie Module.

User's Manual
MEMOCON GL120, GL.130 SIEZ-C825-20.29 Describes the functions, specifications, and

Distributed I/O Driver Module usage of the MECHATROLINK Distributed
User's Manual 11O Driver Module .

Motion Module | MEMOCON GL120, GL130 SIEZ-C825-20.41 Describes the functions, specifications, and
Motion Module MC10 usage of the One-axis Motion Module MC10,

User’s Manual

MEMOCON GL120, GL130 SIEZ-C825-20.51 Describes the functions, specifications, and
Motion Module MC20 usage of the Four-axis Motion Module
Hardware User's Manual MC20.

MEMOCON GL120, GL130 SIEZ-C825-20.52 Describes motion control instructions {ladder
Motion Module MC20 : motion instructions} and motion program
Software User’s Manual language used for the Four-axis Motion
Module MC20.

—1-3—




Introduction and Precautions

Manual

Manual number

Contents

Communica-
tions Modules

MEMOCON GL120, GL130

PC Link Module User’s Manual

SIEZ-C825-70.4

Describes the functions, specifications, and
usage of the PC Link Module for the GL120
and GL130.

MEMOCON GL120, GL130
MEMOBUS PLUS
User's Manual

SIEZ-C825-70.5

Describes the functions, specifications, and
usage of the MEMOBUS PLUS.

MEMOCON GL120, GL130
Coaxial Remote I/O System
User's Manual

SIEZ-C825-70.8

Describes the functions, specifications, and
usage of the Coaxial Remote I/O System for
the GL120 and GL130. .

MEMOCON GL120, GL130 SIEZ-C825-70.9 Describes the functions, specifications, and
1000/2000-series Coaxial usage of the 1000/2000 I/0 Coaxial Remote
Remote I/O System /O System for the GL120 and GL130.
User’s Manuai

MEMOCON GL120, GL130 SIEZ-C825-70.12 Describes the functions, specifications, and
M-NET Module usage of the M—NET Module.

User's Manual

MEMOCON GL120, GL130 SIEZ-C825-70.13 Describes the functions, specifications, and

MEMOBUS User's Manual

usage of the MEMOBUS.

MEMOCON GL120, GL130
COM Instructions
User’s Manual

SIEZ-C825-70.14

Describes the functions, specifications, and
usage of the COM instructions. It also
describes the specifications and usage of the
MEMOBUS Module.

MEMOCON GL120, GL130
YENET1600-D Module
User's Manual

SIEZ-C825-70.20

Describes the functions, specifications, and
usage of the YENET 1600-D Module
{supporting 63 nodes).

Traceback User's Manual

MEMOCON GL120, GL130 | SIEZ-C825-70.21 Describes the functions, specifications,

Ethemet Interface Module parameters settings, wiring, and special

User's Manual instructions for Ethemet Interface Module.
Other MEMOCON GL120, GL130 SIEZ-C825-60.10-4 | Describes the specifications and applications

of Traceback.

« Check thoroughly the conditions on the product such as the specifications and restrictions
of the product before using it.
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1.2 Precautions

A T

1.2 Precautions

This section outlines general precautions that apply to using this manual and the
product. You must read this section first before reading the remainder of the manual.

1.2.1  Applications Precautions .............cviiiiiiiiiiiiiii i, 1-5
1.22 Wirng Precautions ... 1-5
1.2.3 SafetyPrecautions .......... ... i i e 1-6

1.2.1 Applications Precautions

&Caution Abide by the following precautions when applying the MEMOSOFT to control the PLC.

= Operations such as RUN, STOP, forced output, and program change during operation must
be carried out with care. Operational errors may damage the machine or cause accidents.

» When using a modem, turn the power supply OFF or ON carefully.

I the power supply of a slave machine is turned ON or OFF while the modem power sup-
ply is ON, the modem will cutput unnecessary signals to the twisted-pair cable for several
tens of milliseconds. If any messages are being transmitted at this time, a transmission
error will occur. To avoid problems, turn ON the power supply of a slave machine before
turning ON the power supply of the modem and turn OFF the power supply of the modem
before turning OFF the power supply of the slave machine. Alternatively, turn ON and
OFF the power supplies of a slave machine and a modem simultaneously.

» Be sure not to use the single sweep function while the machine is operating.

Do not use the single sweep for testing purposes, once machinery, processes, or convey-
or equipment has begun operating. On completion of decoding, the MEMOCON will stop
after output has been sent. Subsequent decoding will not be executed, so all furtherinput
signals will be ignored resulting in the likelihood of severe damage to any machine con-
nected to the MEMOCON.

1.2.2 Wiring Precautions

» Insert the interface cables properly.

Insert the connectors of the various interface cables that are to be ¢onnected to the ME-
MOCON into the communication ports and attach them properly. Improper insertion of
interface cables may cause operational errors in the MEMOCON,

—15—
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1.2.3 Safety Precautions

1.2.3 Safety Precautions

* MEMOCON was not designed or manufactured for use in devices or systems that concern
human lives. Users who intend to use the product described in this manual for special pur-
poses such as devices or systems relating to transportation, medical space aviation, atomic
power control, or underwater use must contact Yaskawa Electric Corporation beforehand.

1

» This product has been manufactured under strict quality control guidelines. However, if this
product is to be installed in any location in which a failure of MEMOCON involves a life and
death situation or in a facility where failure may cause a serious accident, safety devices
MUST be installed to minimize the likelihood of any accident.

+ Any illustrations, photographs, or examples used in this manual are provided as examples
only and may not apply to all product to which this manual is applicable.

» The products and specifications described in this manual or the content and presentation of
the manual may be changed without notice to improve the product and/or the manual. A
new version of the manuai will be re-released under a revised document number when any
changes are made.

» Contact your Yaskawa representative or a Yaskawa office listed on the back of this manual
to order a new manual whenever this manual is damaged or lost. Please provide the docu-
ment number listed on the front cover of this manual when ordering.

» Contact your Yaskawa representative or a Yaskawa office listed on the back of this manual
to order new nameplates whenever a nameplate becomes worn or damaged.

» Yaskawa cannot make any quality guarantee for producté which have been modified. Yas-
kawa assumes no responsibility for any injury or damage caused by a modified product.

— 16—
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m

1.3 Using this Manual

» The structure of this manual is as follows:
Chapter 1: Read this chapter before starting MEMOSOFT.

Chapters 2 and 3: When using MEMOSOFT for the first time, operate MEMOSOFT ac-
cording to the examples given. These chapters show the basic op-
erations of MEMOSOFT.

Chapter 4 and subsequent chapters: Read these chapters thoroughly once, and then
review the necessary sections as required.

« Meaning of Basic Terms

in this manual, the following terms indicate the meanings as described below, unless
otherwise specified.

» PLC = Programmable (Logic) Controller
* MC = Mgotion Module

*» GL120 and GL130 = MEMOCON GL120 and/or MEMOCON GL130 Programming
Controller

» Description of Technical Terms

The bold technical terms in this manual are briefly explained in the Glossary provided at
the bottom of the page. An example is shown below.

* Key Operation

The operation examples that are introduced in this manual are designed so that as much
as possible they can be entered as described.

Glossary

The following types of terms are described.

» Specific sequence control terms required for explanation of functions.

« Terms that are specific to programmable controllers and electronic devices. -
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s Floppy Disk

The floppy disk containing this software must be stored properly.
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m

1.4 Software Copyright

» Copying the software for purposes other than backup is prohibited.

+ Reverse compilation and reverse assembly (reverse engineering) of the software is prohib-
ited.

* Itis prohibited to allow third parties to use any part or all of the software without prior consent
from the manufacturer. This prohibition applies to transfer, exchange, or lending.

» Use the software on one computer only. A separate copy of the software must be purchased
separately to use it on a different computer.
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Preparations

This chapter describes the preparations required for using MEMO-
SOFT, including the installation procedure.

2.1 Preparations Required for Using MEMOSOFT 2-2

211 Whatis MEMOSOFT? ....................0.uu. 2-2
212 ItemsRequired ............................ ... 2-2
213  SystemSoftware ..................... ... 0..... 2-2

2.2 Installation of MEMOSOFT ........coc00.. 2-3

221  Preparations Required Before Installation ... ........ 2-3
2.2.2  Activating the Installation Program ................ 2-3
223  Setting the Computer Environment ................ 2-4
224  Activating MEMOSOFT ........................ 2-5

225 Installation/Activation from Windows95 ............ 2-6

2.3 ConnectionwithPLC .........covivvvnee.. 2-13
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Preparations
- 2.L1 What is MEMOSOFT?

2.1 Preparations Required for Using MEMOSOFT

1

Q This section describes the preparations required before installing MEMOSOFT.

211 Whatis MEMOSOFT? ... i et 22
212 ltemsRequired ........................ R e 2-2
2.1.3 System Software ......... e R TR LT R T T T O Pppp 2-2

2.1.1 What is MEMOSOFT?

MEMOSOFT is a programming system that fully supports the MEMOCON GL120, and
GL130 Programmable Controllers.

The model is FMSGL-AT3.

The MEMOSOFT consists of a programmer that creates ladder programs and motion pro-
grams, and utilities that execute operations such as managing files.

The MEMOSOFT software operates onan IBM or PC/AT—compatlble computer running MS-
DOS.

Note MS-DOS is a registered trademark of Microsoft Corpbration.

2.1.2 Items Required i

The following items are required to instali MEMOSOFT.

+ Personal computer:  iIBM or PC/AT-compatible
CPU: 80386 (25 MHz) or better
Main memory: 640 Kbytes
Extended memory: 3 Mbytes or more
Floppy disk drive: One 3.5-inch ‘
Hard disk: Free area of 10 Mbytes or more.

» MS-DOS version 5.0 or later

2.1.3 System Software

The system software of MEMOSOFT is stored on 3.5-inch floppy disks. This system software
is activated from the hard disk after being instalied. The system software cannot be run from
the floppy disks.

—_22
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2.2 Installation of MEMOSOFT

This section describes the procedure for installing MEMOSOFT on a hard disk, and the

MEMOSOFT startup procedure.

2.2.1 Preparations Required Before Installation
2.2.2 Activating the Installation Program ...
2.2.3 Setting the Computer Environment ...
2.2.4 Activating MEMOSOFT .............

2.2.5 Installation/Activation from Windowsg5

..............................

2.2.1 Preparations Required Before Installation

2-3
2-3

2-5
2-6

MEMOSOFT is installed automatically by the installation program provided on the system
disk. Before starting installation, check whether MS-DOS is installed on the hard disk of the
personal computer. If not, install MS-DOS (version 5.0 or later). Refer to the personal comput-

er manual for installation of MS-DOS.

Before installing MEMOSOFT, create a backup copy of the system disks. Use the disk copy
function of MS-DOS or some other tool for creating a backup disk. Refer to the manuals for
each tool and MS-DOS for details on basic procedures,

2.2.2 Activating the Installation Program

The following procedure assumes that the personal computer is equipped with two drives,
one hard disk drive and one floppy disk drive. In this example, MEMOSOFT is instalied from

drive A: (floppy disk) to drive C: (hard disk).

1) Turn ON the power supply of the personal computer.

2) When MS-DOS is activated, insert the installation disk in drive A.

3) When the prompt C> is displayed on the screen, enter A: and press the Enter Key. The

current drive will be changed to A.

C>A:

4} Enter INSTALL and press the Enter Key.

C>A:
A>TINSTALL
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2.2.3 Setting the Computer Environment

5) Aninstallation program will be activated. Specify the drive in which the installation disk is
inserted. :

Since drive A is the default setting, simply press the Enter Key.
Enter source drive name: Al
6) Specify the drive of the installation location. Enter C and press the Enter Key.

Enter source drive name: A

Enter destination drive name: C
7} A confirmation message will be displayed. Press the Enter Key at the end.

Enter source drive name: A
Enter destination drive name: C.

Start installation MEMOSQFT (GL120/130) from A to C.
Is it OK? (Y/N)Y

Installation will be executed.

Installation is controlled by the messages which: appear and the answers given to the
questions.

OIREID 1) Whenthe default drive can be used, simply press the Enter Key. Specify a drive and press
the Enter Key only when changing the drive. |

2) When an incorrect drive has been specified, enter N for the confirmation message. The
drive can be reset from the stan.

3) When MEMOSOFT has already been installed because of the version upgrading, the fol-
lowing message will be displayed: The files already exists. Do you want to install? (Y/N).

4) According to the version of MEMOSOFT being used, the messages displayed may differ
slightly, however the interactive installation can be performed similar to the above exam-

ples.

2.2.3 Setting the Computer Environment

« Directory Structure after Installation

The following directories will have been created as a result of installation.

- FMSGL RUNTIME |
EE PROGRAMS
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m

By default, the programs created by MEMOSOFT are stored in the directory
\FMSGL\PROGRAMS,

« CONFIG.SYS

To activate MEMOSOFT, the environment file (CONFIG.SYS) must be changed fromthe
nocrmal settings as shown below.

a) Include HIMEM.SYS.
b) Includg EMM386.EXE.

¢) Change the number of files to 30 or more (50 files are recommended).

d) Include ANSI.SYS.

Exampie of Modifications

DEVICE=C:\DCOS\HIMEM, SYS
DEVICE=C:\DOS\EMM386 .EXE RAM
FILES=50
DOS=HIGH, UMB
DEVICE=C:\DOS\ANSI.SYS
Specify the directory containing ANSL.SYS.

* Memory Allocation

To start MEMOSOFT, a usable memory space (conventional memory) of 530 Kbytes or
more must be allocated on the personal computer. The currently usable memory space
can be displayed on the screen by executing the MS-DOS command CHKDSK (check
disk). If MEMOSOFT is started with insufficient usable memory, abnormal functioning
may resulit.

If executing CHKDSK shows that there is not sufficient memory available, remove unnec-
essary device drivers. Then, after increasing the usable memory, activate MEMOSOFT.
Refer to the manual for MS-DOS for further details.

» Cache Usage Restriction

Using SMARTDRYV (smart driver) or other caches could result in a malfunction, so be
sure not fo use a cache.

2.2.4 Activating MEMOSOFT

MEMOSOFT is activated by executing the following after changing the current drive to the
drive in which the MEMOSOFT has been instalied (C drive in this example):

1} Enter MEMOMENV and press the Enter Key.

C>MEMOMENU
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2.2.5 Installation/Activation from Windows95

2) A menu displaying the MEMOSOFT operations will appear. Select the desired operation
using the Up or Down Cursor Key fo start.

MEMOSOFT~Henu

Please select an operation from the following wenu with arrow
keys and hit “return™ key.

GL128-138 FROGRAMER (PROCRAM MODE)
GL12@-138 FROGRAMER (MONITOR NODE>
PRINI LADDER

APPLICATION BaCKUP <TI0 FD>
AFPLICATION RESTORE <FROM FD)

[ 1 ESE LT YT
Ca v e e n s

[

Note (1) MEMOSOFT will not operate propery when there is insufficient memory available.
Make sure to use MEMOSOFT with sufficient memory available as described in sec-
tion 2.2.3 Sefting the Computer Environment. :

(2) Be sure to exit MEMOSOFT by selecting the “Quit” from the initial screen (see 3.5.2
Exiting Procedure). It MEMOSOFT is interrupted during operation by resetting the
computer, for example, the hard disk files may be’ damaged.

(3) Activate MEMOSOFT from MS-DOS. If MS-DOS prompts are used from Windows to
start MEMOSOFT, a malfunction could result.

2.2.5 Installation/Activation from Windows95

1. Outline

The procedures for using MEMOSOFT from Windows95 are described bellow.
1} Installation of MEMOSOFT
2) Setting MEMOSOFT properties using Widowsg5s

2. Installing MEMOSOFT

Install MEMOSOFT software to the personal computers using the following procedures.
MEMOSOFT is installed by entering commands with keys from MS-DOS prompt.

A. Activating MS-DOS Prompt

1) Turn ON the power supply of the personal computer.
2) Click the Start button.

e 26 e



2.2 Installation of MEMOSOFT

3) Select Program-MS-DOS Prompt from the menu.
MS-DOS prompt will be displayed.

B. Installing MEMOSOFT

The following procedure assumes that the personal computer is equipped with two
drives, one hard disk drive and one floppy disk drive. In this example, MEMOSOFT is
installed from drive A: (floppy disk) to drive C: (hard disk).

1) Insert the installation disk 1/2 in the floppy disk drive of the computer.

2) When the prompt C> is displayed on the screen, enter A: and press the Enter Key. The
current drive will be changed to A.

C>a:

3) Enter INSTALL and press the Enter Key.

C>A:
A>INSTALL

An installation program will be activated. Installation is controlled by the messages which
appear and the answers given to the questions.

OII!HI) For details of Installation of MEMOSOFT, refer to 2.2.71t0 2.2.3.

C. Setting the Environment of Windows95

For setting the environment of Windows35 to use MEMOSOFT, activate the MEMO-
SOFT to display the properties setting window.

(i) Activating MEMOSOFT

The operating procedure for activating MEMOSOFT is described below. MEMOSOFT
has been installed on the C drive in this procedure.

1} Click the Start button.
2) Click Run from the menu.

3) Enter C: \ MEMOMENU and press the Enter Key.

; R

& c.\memoments




Preparations
S RS i
2.2.5 Installation/Activation from Windows93 cont.

4) MEMOSOFT Menu Screen will appear.

ifthe window is displayed in full screen mode, préss the Alt + Enter Keys to switch to win-
dow display mode.

"= memomenu - EMEMMENY

MEMOSOFT ~tMenu

Pleasc uelcct an upclatlun from the follouving nenu with arrow
keys and hit “return" key,

GL120-138 PROGRAMER {PROGRAM MODE>
CL12BA13Y PROGRAMER <MONIIQR MODE>
PRINT LADDER

APPLIGCATION BACKUP <TO FD»
APPLICATION RESTORE (FROM FD)

(i} Setting MEMOSOFT Properties

1) Right-click the titie bar of the MEMOSOFT Menu Screen.

3) Set the properties as follows.
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* Program

"/ Enter drive name and : \
e.g..c:\

. Click the checkbox and a
check mark will be displayed
to mark the selection.

|~ Set530 kB or more.

- Set to 1024.
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2.2.5 Installation/Activation from Windows95 cont.

» Others

Click the checkbox to clear
an option. (If a check mark is
already displayed, clicking
the check box will erase the
mark.)

. mm

R T e

LD A G A e R PR ATE L T

4} When all iterns has been set, click OK.

5) The confirmation window will appear. Click OK.

memomenu )
ALY ;§g§. £33
ot

Wﬁ =

Select the lowest.

MEMOSOFT-Henu
keys and hit “return” key.

GL128-138 PROGCRAMER (PROGRAH HODE)
CL12¥-134 PROGHANER (MONITOR MODEX
PRINT LADDER

APPLICRIION BACKUE {10 FD»
APPLICATION RESTORE (FROM FD>

@ AIT B LB

9.
ECR  END

Flease select an operation fron the follouing menu uith arrow
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2.2 Installation of MEMOSOFT

The setting operation of MEMOSOFT properties is now completed. For activation and
operation of MEMOSOFT, see item (i) on page 2-7.

For more details of the terms used for setting items such as start button or properties, referto
the manuals for Windows95.

D. Windows95 Operating Modes

{i) Operating Modes
MEMOSOFT operates in the following three modes of Windows95.
* MS-DOS prompt displayed in window display mode
¢ MS-DOS prompt displayed in full screen mode
» MS-DOS function mode {command prompt only)

1) For activating the MEMOSOFT in window display mode or full screen mode, follow the
procedures described in item (i) on page 2-7, By pressing the Alt + Enter Keys, the mode
can be switched between window display mode and full screen mode.

2) For activating the MEMOSOFT from the MS-DOS function mode, follow the procedures
below. '

a) Turn ON the power supply of the personal computer.

b} While Windows95 is starting up, “Starting Windows95" will be displayed in the upper
left corner of the screen. In this state, press the F8 Key.

¢) Windows85 Start up Menu will be displayed. Select Command Prompt Only.

d) MS-DOS prompt will be displayed, and MS-DOS function command ¢can be entered.
Activate MEMOSOFT from MS-DOS. For the procedures of activating MEMOSOFT
from MS-DOS, refer to 2.2.4 Activating MEMOSOFT.

(ii) Selecting Operating Modes

When the low-speed computer is used to communicate with PLCs, MEMOSOFT display
is intermittently interrupted. This status may be caused by multi-tasking of Windows
which performs various applications. Having the communications become unstable on
Windows is a common problem and not unique to MEMOSOFT.

Perform the following procedures for countermeasures.
(1) Keep the number of simultaneously running applications to a minimum.
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2.2.5 Installation/Activation from Windows95 cont. . .

This procedure is effective when MS-DOS prompt is displayed in window screen
mode. [f the applications such as for word processors, spread-sheet are activated,
exit them to activate MEMOSOFT only.

i

(2) Display MS-DOS prompt in full screen mode.

This procedure is effective when communications with PLCs are intermittently inter-
rupted even after performing step (1). Changing between window display mode and
full screen mode can be performed by pressing Alt + Enter Keys.

(3) Operate MEMOSOFT in MS-DOS function mode.

This procedure is effective when communications with PLCs are intermittently inter-
rupted even after performing step (1). and (2) For operating procedures, refer to the
information on the previous page.

OIIHEP Select the operatmg mode according to the CPU capacnty Standards for operating modes
are described below. :

» For Pentium il, 200 MHz : perform the step (1).

» For 80486, 66 MHz : perform the step (3).

E. Shortcuts

Setting the environment of Windows95 to use MEMOSOFT can be performed with the
following procedures. Recommended for those who familiar with Windows95 operation.

1} Create a shortcut icon for the “MEMOMENU.BAT" , which is stored in folder C: / of the
drive installed MEMOSOFT on the Windows desktop.

i

2) Right-click the Shortcut's to MEMOMENU on desktop and select the Properties from
the menu.,

3) Perform the settings as described in (i) Setting MEMOSOFT Properties on page 2-8.

MEMOSOFT Menu Screen will be displayed with double-click on this shortcuticon on the
desktop.

Note (1) Do not use a compressed drive when using MEMOSOFT from Windows95.

(2) Activate MEMOSOFT from MS-DOS or MS-DOS prompt from Windows95. If MS-DOS
prompts are used from Windows3.1 to start MEMOSOQFT, a malfunction could resulit.

[ rr—

$ineo > For details on procedures such as operating Explorer and creating shoricuts, refer to Win-
dows95 manuals.
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2.3 Connection with PLC

This section describes the procedure for connecting the personal computer to the PLC,
and the types of cables that are used.

The personal computer must be connected to the PLC for online operations.

Two types of communications protocol, MEMOBUS and MEMOBUS PLUS, can be used for
the connection,

1) MEMOBUS Protocol

The RS-232C Port of the personat computer is connected to the RS-232C Port of the
PLC, such as the GL120, using a special cable. In a system using GL120 and GL130
PLCs, itis possible to connect to the RS-232C ports of various Modules, such as MEMO-
BUS Modules, as well as the RS-232C port of the CPU Module.

2) MEMOBUS PLUS Protocol

The MEMOBUS PLUS Port on a MEMOBUS PLUS Network Adapter (Model
JAMSC-120NOM21110), which is mounted to the expansion siot of the personal comput-
er, is connected to the MEMOBUS PLUS Port of the PLC, such as the GL120, with a spe-
cial cable. For further details, refer to the MEMOCON GL 120, GL130 MEMOBUS PLUS
User’s Manual introduced at the chapter 1 of this manual.

Following table lists the cables which are available for each communications protocol.

Table 2.1 MEMOBUS Protocol Cables

Cable Length Mode!
25m JZMSZ-120W0202-03
15.0 m JZMSZ-120W0202-15

Table 2.2 MEMOBUS PLUS Protocol Cables

Cable Length Model
25m JZMSZ-120W0800-03
16.0 m JZMSZ-120W0800-15

Note (1) Be sure to turn OFF the power to the PLC and personal computer before connecting
the cables,

(2) After inserting the cable, be sure to tighten the screws to secure the connector.
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From Start to Exit: Offline

This chapter describes the procedures for creating a system configura-
tion and ladder programs using MEMOSOFT offline, i.e., without be-
ing connected to a PLC.

3.1 Overview of Operating Procedures .......... 3-2
311 CreatingaNewProgram .............coovemnn... 3-2
3.1.2  EditinganExistingFile ......................... 3.2

32 CreatingFiles ............ccciiivviveee.. 34

3.21 Activating MEMOSOFT ........................ 3-4
322 CreatingFiles ............. . i, 3-5
3.3 PLC Configuration .............. -
331 Configuringthe System ..............ccoivvnnn.. 37
332  Settingthe JOMap ..................oivon... 3.7

3.4 Creating Ladder Programs ................ 3-11

341 Creating Segments .................... e 3-11
342  Inputting Relaysand Coils ....................... 3-12
343 Inputting Timersand Counters . ................... 3-18

3.5 Exiting MEMOSOFT ............c00vvvee. 325
3.51  Retuming to the Initial Screen .................... 3-25

352  ExitingProcedure................iiiiiiiin.., 3.26
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From Start to Exit: Offline
3.11 Creating a New Program

3.1 Overview of Operating Procedures

I This section describes the procedures for creating ladder programs with MEMOSOFT.

3.1.1 Creating a New Program VTR s 3-2
3.1.2 Editingan ExistingFile .................. Ce e et 32

3.1.1 Creating a New Program

To operate the PLGC, the required programs and parameters for operation must be created
with MEMOSOFT and written to the PLC. This chapter describes the procedures to be fol-
lowed in creating those programs and parameters on.a personal computer without connect-
ingto a PLC. It is also possible to connect to a PLC and write the programs and parameters
directly using the procedures described in this chapter, but online operation will not be cov-
ered here.

H
The procedure is given below for creating a new program. In particular, make sure the com-
munications parameters are set correctly, as they are used when writing data to the PLC.
1) Turn ON the pow?er supply to the computer.

2) Activate MEMOSOFT.

3} Create the new files. Select the directory in which the programs are to be stored, and set
the communications parameters.

4) Configuye the system such as the model of PLC _being used.
5) Set I/O allocation (/0 mapping) for the system bging used.
6) Edit the ladder and motion programs.

7) Exit MEMOSOFT.

Examples of creating files with these procedures are given from section 3.2 Creating Files
onwards.

3.1.2 Editing an Existing File

Use the following procedures to edit an existing file. See chapter 17 File Operations for in-
formation on filing operations, such as saving to other files.
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3.1 Overview of Operating Procedures

1} Activate MEMOSOFT.

2) Select the program using the Select Program command.
3) Edit the ladder program, motiqn program, etc.

4) To save to another file, use the Save as... command.

5) Exit MEMOSOFT.

MEMOSOFT records the name of the file last edited. Therefore, there is no need to execute
Select Program to edit the same file that has just been modified. The name of the currently
selected file is displayed as shown below.

hde Ladder Il:tinn Comment Ref Data Il:ll Quit
I I E I I u 5 u I <R>

Prosram Kame: gliZ8 3 -
PLC add.r'::: ﬁB: 1 *
PLC Type:

Tab  moves betwssn the Menu Bar and the Editing Screen.
ALT H provides help on the menu item zelected by the cursor.
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. 3.2.1 Activating MEMOSOFT i

3.2 Creating Files

g This section describes the procedures for activating MEMOSOFT and creating new files.

3.21  Activating MEMOSOFT ................. P R R 3-4
322 CreatingFiles..................c.c..cut. e e 35

3.2.1 Activating MEMOSOFT

The operating procedure for turning ON the PLC and activating MEMOSOFT is described
below. This will prepare the MEMOSOFT for creating programs and parameters. MEMO-
SOFT is installed on the C drive in this procedure.

1) Tum ON the power supply to the personal computer.

2) Enter MEMOMENU and press the Enter Key.
C>MEMOMENU

3) The menu displaying the MEMOSOFT operations will appear. Select GL120/130 PRO-
GRAMER (PROGRAM MODE) using the Cursor Keys and press the Enter Key.

NEROSOFT-fenu

Please select an operation From the Following menu with arrow
keys and hit "return® ksy.

- GL!.ZB/!38 PROGRAMER CPROGRAM MO
GL128,138 PROGRAMER {MONITOR HODE)
PRINT LADD]

ER
APPLICATION BACKUP <TI0 FD>
APPLICATION RESTORE (FROM FD>

D‘OG\IDGAUN
OO

e

4) The program startup screen will be displayed. Press the Enter Key to display the initial
screen as shown below, :

E;d. W Ladder Hotiun collurlt le Dltl ‘Iools Quit

MEMOSOFT.

gran Name: mson‘
Pl.c Addresz:  MB:
PLC Type:

ALT H providez help on the menu item selected by the cursor.

Tab moves between the Menu Bar and the Editing Screen. ”
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3.2.2 Creating Files

The following procedure describes how to create new programs.

1) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

poae

conflg Ladder Motion Comment Rsf Data
—F2—F3 4 —F6

mosof
Program Hame: MEMOSOFT
PLC Addrexzs: MB: 1
FIC Type:

moves betwssn the Menu Bar and the Editing Scresn.
nI.‘l H provides help on the monu item selectsd by the cursor.

2) Select New Program from the submenu usmg the Down Cursor Key and press the Enter

Key.
fode do Gonfiy Ludder Metion Comment Bef Data o CECHNN Quit
[F1 I'_"' o0 lg——q—
Salact mﬁ;“.
ave © es
Save All Pile
Save az.
Change PLé Address
l.ncatinn of Prograr NHame
le¢ Operation
h ft
Program Name: MEMOSOFT
PLC Address: MB: 1
PILC Type:
Tab  woves batwsen the Menu Bar and the Editing Screen.
ALT H provides help on the menu item selected by the cursor.

3) The window for entering the file name will be displayed. Enter the file name (GL120_1 in
this example) and press the Enter Key.

Iﬂodn c.ufig Ladder Motion Comment Ref Data l'u-la Quit
——Fh
LI H Fchnane 29 I‘NU | F I
" ft
Program Name: MEMOSOFT
PLC Addrezs: HB: 1
PLC Type:
movey hotwean the Menu Bar and the Editing Screen.
FILI H provides help on the monu item selected by the cursor.

4) The communications parameters setting window will be displayed. Press the Enter Key
after specifying each parameter. Specify the PLC address to 1; select the MEMOBUS
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3.2.2 Creating Files cont. ;
protocol; specufy RTU Mode; set the data bits to 8, parity to even, the stop bits to 1, the
baud rate to 9,600 bps; and select the COM1 port.
de 00nf1g I.ndder Hnt:.on con-ent Ref Data Touls Quit
I I E I I n 5 u R>
Program Name: _IIB_IJSOP'It
PLC Address: T |
COMMUNICRTIONS PARANETERS
Addrass Protocol Mode Data Bitz Parity Stup Bitz Baud Device
i MEMOBUS RTU [ EUEN 9600  COMi
_ m Dip Switches 38%/48% |E | | 8k 7EN IM.I
78 45678
The PLC system configuration will be displayed.
;l,:in o2 gusewieu _ Settings e :'?-m-;zn-‘j]fi}—%it
P Imﬁmlisuntinn _
- Link Mep
PLC = ASCII Map Special Reg =
PLC type 6L120 Y198256 Bat coil 828192
ExecPack 20 KC coil-2  ¥2@206
User Lowic 16 X MG cnteoill QLOERE C sweep 489998 -
Stacte RRM 3z x HC cntcoil2 Q28168 409399
Scgment No 1 WC relay~1 Ri18256 Hapeed szcan 489997
Motian 2 MNModule NG relay-2 %28256 Timer Reg 489996
Link 2 HModule MC cntrly-1 P18256 Step Relay -wzlm -
NC cntrly—2 P2B256
70 = Rcode rly-1 M1BESE Calondar 489988 =
170 module 34 Ncods rly-2 M20@96 489995
CH1 Stacion 15
CH2 Station 15 Link Coil 1 D11@24 MC linkRegl 489842 -
Link Coil 2 D21824 489914
Referencs : Link Reg 1 R1i1824 MC IinkRag2 409915 -
Coil oae192 Link Reg 2 Rz16824 ; 409987
Input Relay 181824
!n t Rog 308512
Rey 489999
Cnnnt Reg 704095
OIIHED Newly-created programs will, by default, communicate with the PLC using the communica-

tions parameters set here. :
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m

3.3 PLC Configuration

ﬂ This section describes the procedures for selecting the PLC and setting the 1O map.

3.3.1  Configuringthe System .......... ...t 37
332 Settingthe VOMap ........c.viiiiii e e 3-7

3.3.1 Configuring the System

MEMOSOFT is a programming tool that supports a number of PLCs, including the MEMO-
CON GL120 and GL130, so select the PLC first.

1) Select PLC Type from the Overview Menu using the Cursor Keys and press the Enter

Key.
in B Map Settings Tools Quit
E‘T F2 twuv— ——F 66— F7- P -3 — 79
nfiguration
hnses
B System Registers cial Re
PLC type G llyunta Y18256 t eni]. muz
ExecFack 2 ¥28256
User Logic 1 Ilnt:l.nn 1 Q10168 C sweep 429998 -
State RAN 3| PC Link 12 Q20160 109779
Segment Mo 1| Reset Default 1 X18256 Hipeed scan 489997
HMotion 2 2 X28256 Timer Reg 4099%6
Link 2 Module MG ontrly-1 P1B256 Step Relay 482001 -
HC cntrly-2 P2B256 482832
120 Hoode rly-1 MIBBYE Calendar 489988 - |
170 module 34 Mcode rly-2 M20896 409995
CH1 Station 15
CH2 Station 15 Link Coil 1 Di11824 MC linkRegl 489842 -
Link Coil 2 D21824 489914
Rafsrence = Link Reg 1 R11824 MC linkReg2 499915 -
Coil 288192 Link Reg 2 R21824 489987
Input hhy 181024
Tlt 390512
409999
Const lky 704895

2) The PLC type selection window will be displayed. With the default selection of GL120
displayed, press the Enter Key.

in Ouerwiew Map Settings Tools Guit
b Bi—

F2————F3———F4——— P —— PP [WUN P~
PLC System Configuration

PLC Ss:eial Rey :

FLC type t coil 8g192

ExecPack 28

User Legic 16 X C swesp 489998 —

State RAR 32X 40999y
Segmant No 1 Hspoed xcan 499997
Motion 2 Meduls MC nhi—z #28256 Iimer Reg 489996

Link 2 HNodule MC entely-1 PLO2S6 Step Relay 482881 —

MC cntrly-2 P28256 482832

I/0 = Mcode rly-1 M1BB96 Calenday 499988 -

L/0 module 34 Meode rly-2 M28896 489995

CH1 Station 15

CHZ Station 15 Link Coil 1 D11824 HC linkRegl 409842 —

Link Coil 2 D21824 914

Beference Link Reg 1 Ri1B24 NC linkReg2 429915 -

Coil 828192 Link Reg 2 R21824 489987

Input Re 1010824

lnr‘lt le;‘y 308512
Reg . 498999%

Const Reg 7040% -

3.3.2 Setting the /O Map

Whenthe PLC type is selected in the System Configuration screen, default settings for the 1/O
map are made automatically. Next, modify these default settings. To modify the I/O map, se-
lect VO map from the Map Menu on the System Configuration screen and the I/0 Map Screen
is displayed.
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3.3.2 Setting the 1/0 Map cont.

1) Select VO Map from the Map Menu using the Cursor Keys and press the Enter Key.

in Qvervicw DTN Sectings Touls Quit
[F1 ———F2 3 RTM-F8 -S i3 —F9
i igusation
ink Map
PILC = ASCII Map Specul z
PLC type GL128 18256 Bat coll 008192
ExecFack 20 MG coil-2  ¥28256
User Logic 16 X NG entcoill Q181cB C sweep 489998 -
State RaN a2z K HC cntcoil2 Q20168 999
Segment Noe 1 relay-l X18256 Hzpeed scan m???
Mation 2 Module MG rslay-2 X28256 Timer Reg 409996
Link 2 Mo MC cntrly-1 P1B25& Step Relay 402881 -
NG entrly-2 P20256 492932
1 Mcede rly-1 M1BE96 Cahndu 499988 -
1/0 module 34 Hcode rly-2 NM2B876 487995
CH1 Station 15
€H2 Station @ 1% Link Coil 1 D11@24 NC 1linkRegl 409842 -
Link Coil 2 D21B24 489914
Reference : Link Reg 1 R11824 MC linkReg2 489915 -
Coil 208192 . Link Reg 2 R21B24 . 499987
Input Relay 191824
Inmt Reog 300512
Hold Rey 40799
Const Rey 784096

2) The YO Map Screen will be displayed. Move the cursorto the slot to be selected using the
Down Cursor Key.

i

Tools Quit
- F8 Sl —F9

Select Zoom Service =0 typ‘
——F7

1,0 TRAFFIC COP
RACK: 1~ 4

Out Relay
QUTPUT

STRATION: 1
SERU. :
Input Rayg.

INPUT

l/Otype @120!/0
Input Relay: @

SLOT HODULE TYFE
181

182
143

] s @ Out Reg.

DETAIL

186

3) Press the ? Key and a list of the the Modules for which mapping can be performed will be

displayed. Move the cursor to the Module for which to perform mapping using the Cursor
Keys, and press the Enter Key to make the selection.

k:in_m %hct Zoom Servics m%—m L I
1,0 TRAFFIC COP :
CHANNEL: S$IA GL1281-0
1/0type: GLiZﬂl/O 1jai 128CRD21118 12PRDO34416 | 126DD036418
Input Relay: @ |83+ 126MMB1684P8 12BRED] 34418 128pD033218 H
128MMB1 G190 12@DA15430d 12680DO25410 WEN S
SLOT MODULE IYPE L 124aCI820MA 1| 120001 ?4308 | 126DRAS3EOQ
161 12HAV] H2088 12800124300 1240A083200
182 128NC0A1 YA FITTIEICT 0| 128DD0313208
183 120AV001 080 124DD1J6aHY 12800035428
184 126EHC21110 | 1280D125408 | 128DD03322B
ies I 12ANMH31BBA | 12BGDRNB43A0 | 126DD02542@
186 12004102180 '| 128DA084398 128DD033000
187 . 12HAUVOYL 160 128DD0343218
188 126nU0¥1200 || 12600035418
189 >
118
111 :
112 !
113
114 H
115
t16
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4) Next, enter the starting reference number. In this example, a Digital Input Module has
been selected, so an input relay reference number (100001 in this example) needs to be
entered. Enter 100001, and press the Enter Key.

Salect gonn Service #lA0 typ 'l'oo]:s

Main
F——— 2 ————P}————— P45 —————F ————F 7 -G-8
1,0 TRAFFIC COP
CHANNEL: @ SIATION: 1 RACK: 1/ 4
I/0type: GL120I0 SEWV. : ———
Input Relay: @ Input Reg. : @ Out Relay : @ Out Reg.
- g
gabg‘[ MODULE TYPE INPUT DUTPUT DETAIL
1082
e
ig 1Z4DD1 35480 DC12-24Y 32In 2.5-5mA Con
187

5) Move the cursor to the final reference number. The default setting will be the number cal-
culated by adding the number of /O points 1o the starting reference number. If default
allocation is okay, press the Enter Key.

3

Select Zoom Service wmlA0 typ Tools
—F

in
k;—-—-—vz—ra 4————F5 Iﬂi—w
10 tmr'nc ooP
CHANNEL: STATION: 1
1/0type: t;uzm/o SERY, ; ————
Input Relay: 32 Input Reg. : B Out Relay : @ Qut Reg.
ig’r HODULE TYFE  INPUT CUTPUT . BETAIL
182
i
185 12@DDI35408 16eea)-TIIEY DCi2-24U 32In 2.5-5mA Con

The setting will be input and the cursor will move to the next slot.

hin Select Zoom Service wal/0 typ 'loal: Quit
—FP2: P
1,0 ITRAFFIC COP
- CHARNEL: 8 STATION: 1 RACK: 1/ 4
I/0type: GL1201-0 SERU. :
Input Relsy: 32 Input Reg. : 8 Out Relay : @ Out Reg.
§&gr MODULE TYPE INPUT oUTPUT DETAIL
182
104
:E 128DDI354088 108881188832 DC12-24U 32In 2.5-5wA Con
]
1@8?
109
189
114
11l
112
113
114
115
116
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3.3.2 Setting the I/0 Map cont. ‘

6) The rest of the 1/O maps can be execuied using the same procedure.

in Select Zoon Service 0l0 typ, Tools Quit
—_— P P4 P —— P—— 7V PO -0 9
1/0 TRAFFIC COP
CHRNNEL: 8 STRTION: 1 RACK: 1/ 4
1/0type: GL128I-0 SEW. ;: ————=
Input Relay: 48 Input Reg. = 8 Qut Relay : 48 Out Reg. : 8
gabf[ MODULE IYPE INPUT CUTPUT ) DETAIL
P
182 *
e
185 12@])1351“ 1809e1-180832 DC12-24U 32In 2.5-5mA Copn
186 8abDO3541 200881 -p88a32 DC12-24U 328inkOut 6.39 Con
18? 1251!])1313“ 109033100048 DC12-240 16In 4-8mA T
13 120DD0O343: 98B831-080848  DC12-24V 16SinkOut B. Sﬂ Ter
118 .
111
112 i
113
114
11§
116
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3.4 Creating Ladder Programs

ﬂ This section describes procedures such as creating segments and ladder programs.

341 CreatingSegments ..... ...t e 31
34.2 InputtingRelaysandCoils .............c i it 3-12
3.4.3 Inputting Timers and Counters ...........cviiinrrirnnennennnnannnns. 318

3.4.1 Creating Segments

Use the following procedures to create segments.
1) Switch to the menu cursor using the Tab Key.

2) Select Ladder from the Main Menu using the Cursor Keys and press the Enter Key.

Select Zoom Service AL/0 typ Tools Quit
F3————P4 — L) —d—F?
170 TRAFFIC COP

STATION: 1 RACK: 1/ 4

SERU, :

Input Rag. : @ Out Relay : 44 Out Res. H ]

INFUT OUTPUT DETAIL
185 120:01)[35130 100881-188832 DC12-24Y 32In 2.5-5mA Con
186 128DD03541@ 3488018908832 DC12-24V 325inkOut B BR Con
187 120PDI343P8 1980331-102948 PC12-24V 16In 4-8%mA T
1% 12000034310 280033888849 PC12-24% 16SinkOut @. SR Ter

|
110
111
112
113
114
115
116
1

3) The Segment Status Display will appear. Select the segment (LO1 in this example) using
the Cursor Keys and press the Enter Key.

Commands Edit Tools Quit
—rz——-—n-—n 4§ ———F6 = =]
sed ¢
SEGMENT STATUS DISPLAY Pres : 16379
Segment Network Segment  Network Segment  Network
H NOT P

ROGRAMMED
?ﬂ NOT PROGRANMED
MOT PROGRAMMED

Pross {ENTER} to view the solectsd zegment
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3.4.2 Inputting Relays and Coils

4) A confirmation message will be displayed. Enter Y and press the Enter Key.

in Commands Edit Tools Quit
k; P2 F3 P4 113 F6 7 —m—lﬁ
sed =
SEGMENT STATUS DISPLAY Free = 16379

Segment Network Segment Hetwork Ssgment Network

B HNOT PROGRAMMED
i NOT PROGRAMMED
NOT PROGRAMMED -

Hetvork<{z> «ill be created in thc: chosen segment; Cantanue? (Y/ND 5.4

Press <ENIER? to view the selected segment

The segment will be created, and network number 1 will be displayed for segment LO1.

i

Note Three kinds of segments are displayed on the Segment Status Display: H (high speed), LXX
(normal} and S (subroutine}. See section 9.7 Ladder; Program Edit Screen for details.

3.4.2 Inputting Relays and Coils ;

The procedures for inputting relays and coils are described here. The following example is
used to describe creating a ladder program.

Example

in Elements Edit
D F3—F4——
Seg.LO1 #1 ; 1 N
188981 |1 mE e

1) Move the cursorto the position to be input using the Cursor Keys, and switch to the menu
cursor using the Tab Key.

Hain Elements Edit GosSrch Network Ref Tools Quit
e P2 e P F 'S, '~ —F 7P PR - T — P9

[
!ei.wi /1

3

‘Reference Data

Format :Decimal File Data Range 1 1
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2) Select Relays from the Elements Menu using the Cursor Keys and press the Enter Key.

Main GosBrch Hetwork Ref Tools  Quit
I S F6 Fo MNP -IE——F9
Seg LO1L ¥1 /1

Reference Data

Forwat :Decimal File Data Range : 1

3) A submenu will be displayed. Select an N.O. contact and press the Enter Key.

hli!l W Edit GosSrch Hetwork Ref Tools Quit
[F1 F2 £lamants—— Fo——F7- TP -5 —F?
[Seg.res %1 |
: ) unter
i 1
i Othors
s
Ref ¢ Data
L Format :Decimal Fils Data  Range : 1

4) An N.O. contact will be input at the cursor position. Next, enter the reference number
(100001 in this example) and press the Enter Key.

[l‘hin Elements Edit Go/Brth Hetwork Ref Tools Quit
——F g P ———F 66— F7- W Fe - —F?

3

Ox ¥ix ¥2x Qlx ¢2x Dix D2x 1x Xix K2x Pix P2x Mix M2x
Reforence Data

- Format :Decimal Pile Daca Range : 1 |

The N.O. contact will be input.
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L
3.4.2 Inputting Relays and Coils cont.

5) In the same way, input an N.O. contact (000001 in this example).

Iﬂnin Elements Edit Go/Srch Metwork - Ref Tools Quit
F1 F2 3 P4 5 F6 P78 -Ul-—F?
18:9.181 m-1

..__
188881

- Format :Decimal Fils DPata Range = 1

6) Next, a vertical short circuit will be input. Move the cursor to the position to be input using
the Cursor Keys. ;

7) Switch to the menu cursor using the Tab Key.

i

8) Select Relays from the Elements Menu using thé Cursor Keys and press the Enter Key.

in Edit GosSrch Matwork Ref Tools Quit
F2 HT:-M:: F§——Ff ——F 7T -0 —F9
Se .[-81_81 s 1

Fiimer Counter
th
Othors

'Ho Symbol/Descriptor availahl

Re £ ze Data:

- Format =Decimal File Data Range : 1

9) A submenu will be displayed. Select the vertical short circuit using the Down Cursor Key
and press the Enter Key.

k};m WEIYOOR Edit  Go/Srch Metwork Rof ools  Guit
—r g " lements—— —Re la, F6—————P7 - PO —F9
eg . Fd

‘No Swmbol/Descriptor availabl

Reference Data

- Parmat :Decimal Fils Data Range : 1
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The vertical short circuit will be input.

Elsments Edit Go/Srch Metwork Ref Tools Quit
44— Ps———F6 F7-R-Fe-THE—-F9

'Ho Symbol/Descriptor availabl

Reference Data

- Format :Decimal File Data Range : 1

10) An N.C. contact will be input next. Move the cursor to the position to be input using the
Cursor Keys.

11) Switch to the menu cursor using the Tab Key‘

3

12) Select Relays from the Elements Menu using the Cursor Keys and press the Enter Key.

Pain Edit  CosSrch Network Ref Tools  Quit
i ontE P e - PO TR

r/Countar
1l Hlath
Others

~ Format :Decimal Pile Data Rangs = 1

13) A submenu will be displayed. Select the N.C. contact using the Down Cursor Key and
press the Enter Key.

[Mai Go/Srch Metwork Ref Tools Quit

g 3 1 P& ———F7—EX-FR T —FY
e S |

) unter

mma:zl- Path

— Others

BaEBAL —=

Reference Data .
Format :zDecimal File Data Range ¢ 1
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3.4.2 Inputting Relays and Coils cont.

14) An N.C. contact will be input at the cursor position. Next, enter the reference number
(100002 in this example) and press the Enter Key.

in . Elsments Edit GosSrch Network Rof Tools: Quit
Bx Yix ¥2x Qlx @2x Dix D2x 1ix K!..x'RZx Pix P2x Mix M2x
Referonce Data T
Format zDecimal File Data Range = 1
The N.C. contact will be input.
Quit

Elements Edit
F3——F

in
—p2
FE:._IW 8,1
U4
1m|18880!;-

Go/Srch MNetwork Ref Tools
————Ff————F7 -

‘ Format :Decimal

File Data

Ref, ra B
heterente Data

Range - 1

15) Use the same procedure to input an N.O. contact (000101 in this example.)

in

Tools Quit

Ma
[F1 P 2 e 3
1 om

1

oo

Elements Edit
P4

GosSrch Network Ref
PS5 F6 7

~ Format :Decimal

File Data

Reference Data

Range = 1 ]

16) Next, a coil will be input. Move the cursortothe position to be input using the CursorKeys.

17) Switch to the menu cursor using the Tab Key.

H
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3.4 Creating Ladder Programs

18) Select Relays from the Elements Menu using the Cursor Keys and press the Enter Key.

Go/Srch Metwork Ref Tools Quit
6 7P -0il—F9

Refersncs Data

Format :Decimal File Data Range : 1

19) A submenu will be displayed. Select the coil using the Down Cursor Key.

in Edic GosSech MNetwork Ref Tools Quit
h ments—— lays — F6~———F7—-IR-Fo -NTT—F9
Seg.LB1l M1 /1
4 Fianer. unter I
1 1 08 |rath P
Others N
|
Ref Data
Format :Decimal File Data Rangs z 1

20) A coilwill be input at the cursor position. Next, enter the reference number (000001 in this
example) and press the Enter Key.

Main Elements Edit GorsSrch HNetwork BRef Tools Quit
it 2 FA———F5———F6——F7-EXR-Fo -9
Seyg.LBL M1 /1
/
ol rodids ool b TR

‘Ho Symbol-/Descriptor availabl

Reforence Data

* Farmat :Decimal File Data Rangs : 1

The coil will be input, completing the ladder program editing.
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3.4.3 Inputting Timers and Counters

3.4.3 Inputting Timers and Counters

The procedures for Insert After Network and inputting counters and timers are described
here. The following example is used to create a clock ladder program.

1

Example
in Elements Edit Go/Srch
F2 F3 P4 F5
Seg.lB1 B2 /2 <>
W i;;uaié 888811 N
/[——I H. —
888011 408881 282068 EBBP12
{/—{UCTR|-
BB09A12 4BRBH2 .

1) A ladder program will be created in network 2. The Insert After Network procedure is

used. Switch to the menu cursor using the Tab Key.

Elements Edic

GosSrch MNetwork Ref
F5 6 F7-

e

Tools

Quit

‘No Symbol/Descriptor availabl

Reference Data

Format :Decimal File Data

2) Select Insert After Network from the Network Menu.

Eloments Edit CasSreh Ref Tools
——F: —_— t

Quit

1——~F2 Je
|Seg.lot 21 -~ 1 Inzert Before Hetwork
s

1 1

L 00|

y Networ
Delete Hetwork
Pazte Network

Subroutine Segment

‘Mo Symbol/Descriptor availabl —

File Data

- Pormat :Decimal Range : 1

The screen will move to network 2.

3) A horizontal short circuit will be inserted next. Move the cursor to the position to be in-

serted using the Cursor Keys.

4) Switch to the menu cursor using the Tab Key.
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5} Select Relays from the Elements Menu using the Cursor Keys and press the Enter Key.

GosSrch Metwork Ref Inols Quit
Ps—Fb—F7- K-8

"

Format :Decimal Pile Data Range = 1

6) A submenu will be displayed. Select the horizontal short circuit using the Down Cursor
Key and press the Enter Key.

bain

I

F2
en.101 32 / 2

/S¥ch MNatwork Ref Tools Quit
lays F6———F 77— PO~ —F

»1imer Counter
MHiath
Others

Reference Data

- Foraat tDecimal File Data Range : 1 -

The horizontal short circuit will be input.

lﬂn:in Elements Edit Go/Srch Network Ref Tools Quit
1 ——F2 H—-—--P!————FS—PS—P‘)—W—FB—W—P?——‘
Soy.LOL #2 ~/ 2
Reference Data
Format :Decimal File Data Range = 1

7) Foliowing the same procedure, input an N.C. contact (000011 in this example.)
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3.4.3 Inputting Timers and Counters ¢cont.

8) Next, a0.1-SECOND TIMER is input. Move the cursorto the position to be input using the

Cursor Keys.
Elements Edit GosSrch Metwork -Ref Tools Quit
————F3——F: P F7 -] -
Seg.lB1 B2 2

R f 5 e I
Rneference Data

Format :Decimal File Data Bange = 1

9) Switch to the menu cursor using the Tab Key.

10} Select Timer/Counter from the Elements Menu using the Cursor Keys and press the En-

ter Key.

in DIETYTYES Edic GosSrch Metwork Ref Tools Quit

1. g2 tx P P B

Seg.lEl %2 - 2 thnﬁ
rlath
Others

Reference Data
Pormat :Decimal File Data Range = 1 1

11) A submenu will be displayed. Select T0.1 (i.e., the 0.1-SECOND TIMER) using the Down

Cursor Key and press the Enter Key.

ST Eaie

4.0 laE r]
At
Othe

re I.

GorSrch Metwork R“;f

Tools Quit

Eeferance Data

"~ Format :Decimal File Data Range :© 1
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12) The symbol for the 0.1-SECOND TIMER will be displayed. Enter the top element {10 in
this exampie) and press the Enter Key.

bhin Elements Edit Go/Srch  Hetwork Ref Tools Quir
l"l-—m“z—ﬂ———l‘ﬂ-——l’s———l’s F7- - P8 -d—F9
Seg. s

s
1

3x 4x 7?x Rix R2x #x

Reference Data

- Format :Decimal File Data Range © t

13) Next, enter the bottomn element (400001 in this example) and press the Enter Key.

Main Elements Edit GosSrch Metwork Ref Tools Quit
[FL-——F2——— 33—, ———— P————F7 =]

Seg.LB1L X2 ~ 2

poma
/

odal 2R

“x Rix R2x
Reference Data

- Format :Decimal Pile Data Range : 1

The 0.1-SECOND TIMER will be input.

in Elements Edit GosSrch Metwork Ref Tools Quit
F1————F2 ———— P ————f P P, —————F 7 -V 8 -,
Seg.lei 82 ~ 2
[y} —{Tat
7 -
fegell 400081

Reference Data

“ Format :Decimal File Data Range = 1

14) Following the same procedure, input a horizontal short circuit, a vertical short circuit, a
coil for 000011, and an N.C. contact for 000012,
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3.4.3 Inputting Timers and Counters cont.

15) Next, an UP COUNTER is entered,
Cursor Keys.

Move the cursor to the position to be input using the

Eleaonu Edit

GosSrch MNetwork Raf
PS Fo—i

Tools Guit
n—

nce Data

" Format :Decimal File Data

Ref
Refers

Range :

16) Switch to the menu cursor using t

he Tab Key.

17) Select Timer/Counter fromthe Elements Menu using the Cursor Keys and press the En-

ter Key.

Ediv
ments
+Rola:

Othors

=y

Tools GQuic

Go/Srch Hetwork Ref
PP Pl

hel

Format :Decimal File DPata

Reference Data

Range :

18) A submenu will be displayed. Select UCTR (i.e., the UP COUNTER) using the Down Cur-
sor Key and press the Enter Key.

TR

Seg.LO1 ¥2 - 2

xeeat
=4/ }—18.1 -
Bo0e11 460€81 |

Quit

GosSrch Notwork Ref Tools
F5———F§———F7-i =

L Pormat :Decimal File Data

“-'—hfuﬂncn Data

Range 3
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3.4 Creating Ladder Programs

19) The symbol for the UP COUNTER will be displayed. Input the top element (60 in this ex-
ample) and press the Enter Key.

GorsErch MNetwork Ref Tools Quit
e Py P =] -JF—F9

Hain Elements Edit
—F

“Ix 4x 7x Kix R2x #x

Refaronce Data

Format :Decimal File Data Range =

20) Next input the bottom element (400002 in this example) and press the Enter Key.

GosSrch Matwork Ref Tools Quit
o - Fe - II—P?

Elements Edit

—_—r— P ————F4
IS.:Q.I.B:I. %2 /2 <>
80810 Aeea11
/—i109.1
1 488881 20006
Vi T |
penrary V510 |
“ix Rix R2x
Refsrence Data “
* Pormat :Decimal File Data Range = 1

The UP COUNTER will be input.

Elemeants Edit Go/Brch Metwork Raf Taols Quit
—_— 3 4 F5 P6 -F7— F8-03—F?
Seq.lO1 82 / 2 <>
T L —
sapm d Beee1 1
7 {T7@.1
aau m'_

2PB6
s UCIR |-
200812

X

Reference Data

=1

* Pormat :Decimal File Data Range
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From Start to Exit: Offline

3.4.3 Inputting Timers and Counters coni.

21} Following the same procedure, input a coil for 000012,

ain
P2
rog.LB1 #2 ~ 2 5
T T L=
) 99811
s—T18.1 L—r—( —
P Arp iy, 408960 0B12

Elements Edit GosSrch Metwork Ref
——F4———F5——— P ———F 7

Format :zDecimal File Data Range :

The clock ladder program is now complete.
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3.5 Exiting MEMOSOFT
3.5 Exiting MEMOSOFT

B This section describes the procedures for exiting MEMOSOFT.

'3.5.1  Retuming to the INitial SCreen ... .......eeeeeeenae e, 3-25
3.5.2 Exiting Procedure

3.5.1 Returning to the Initial Screen

1) Switch to the menu cursor using the Tab Key.

2) Select Quit using the Right Cursor Key and press the Enter Key

hlin Element: Edit CosSrch Metwork Ref Tools
4———FS————F6———— 7R

|Seg.LO1 %2 /2 <>

: Ba0e1 1

/ 18.1 |- —
880012
4 UCTR
980e1 2
Refovence Data
Format :Decimal File Data Range z 1

3} Use the same procedures to exit the next display.

© [Main Commands Edit Tools Quit
[Pl ———P2 e P e PG P -, pvs
3E =
SEGHENT STATUS DPISPLAY Free : 16351
Segment Network Segmant Network Segment Metwork

H no‘rrnomzmm
gm NOT FROGRAMMED

FPress <ENTER)> to viow the selected scgment
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From Start to Exit: Offline :

3.5.2 Exiting Procedure

The iniﬁal screen will be displayed.

Illoée Gonﬁ‘;g Ladder Motion Comment Ref Data Tools

]I‘-'IEI‘-'IUEI]F

Nn-e GLlZBJ

Program
rl.ca
FIC Type

Tab  moves betwesn the Menu Bar and the Ed:.t:.ng Screen.
ALT W provides help on the menu item selected hy the cursor.

3.5.2 Exiting Procedure

This procedure is used to exit the program.

1) Select Quit using the Right Cursor Key and press the Enter Key.

(h Canfig Ladd-:- l‘lnthn Cn-nt Rtf Dan' ‘Ionl:

I"'IEI"'IUEEIF

Name GLi28.1
ddress:  HB: 1
ype:

Program
mﬁ
PLC T

Tab  moves bhetusen the Menu Bar and the Editing; ‘Screen.
ALT H provides help on the menu item zelected by'the cursor.

2} A confirmation message will be displayed. Enter Y and press the Enter Key.

1

de Canfig Laddgr Motien Comment Ref Bata Tools

MEMOSOET

Hemosof t
1
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3.5 Exiting MEMOSOFT

3) A window will appear asking whether to save the changes. Select Save Changed Files
and press the Enter Key.

Llode Confiy Ladder Motion Commant Ref Data Tools
[Fl ———F2——— P —F 4 F5 ———— P ————F 7 F8 -,

GL128_1 Chanyes have heen nade to... <R>

LARDDPER LOGIC

moves betuesn the Menu Bar and the Editing $creen.
RI-T H provides help on the menu item selected by the cursor.

4} The program will be exited and the MEMOSOFT Menu will appear. Select END using the
Down Cursor Key and press the Enter Key.

MEMOSOFT—tenu

Fleaze select an opsration from the following menu with arrow
keys and hit “return™ koy.

1. GL320-130 PROGRAMER C(FROGRAM MO
2. mzwga PROGRAMER (MONITOR mDE)

PRINT
4. APPLICRTION BRCKUP <TG FD>
5. APPLICAIION RESIORE (FROW FD>

N DD

MEMOSOFT will be exited.
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From Start to Exit: Online

This chapter describes the operation procedure for connecting a per-
sonal computer to a PLC, taking a ladder program that has been
created offline and writing it to the PLC, and then running the program

from the PLC.

4.1 Overview of Operating Procedures ..... ceees 42
4.1.1 Operating Procedures .. ......................... 4-2
4.1.2  ComnectingtothePLC .......................... 4-3

4.2 Loading the Program onto the PLC ......... 4-4

421 Activating MEMOSOFT ........................ 4-4
422  Loading the Programontothe PLC . ............... 4-5
4.3 Going Online ...... tesesenens verrees veeer 4-8
4.3.1 Switching between Online and Offline ............. 4-8
4.3.2  Displaying the Ladder Program ................... 4.9

4.4 Displaying Reference Data ................. 4-11

44.1 Displaying Reference Data ...................... 4-11
442 Disabling Procedure ... .............coeneeinn. .. 4-12
4-5 Exiting MEMOSOFT Ce b v ereaae E RN R 4-15
45.1  Retumning to the Initial Screen .. .................. 4-15
4352 ExitingProcedure................. . ......iiin.. 4-16
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From Start to Exit: Online

4.1.1 Operating Procedures

4.1 Overview of Operating Procedures

1

l This section describes the procedures for connecting the personal computer to a PLC.

41.1 Operating Procedures ......... e .......................... 4-2
4.1.2 Connectingtothe PLC .................. e 4-3

4.1.1 Operating Procedures

This chapter describes the procedure used to take a program that has been created on a per-
sonal computer, write it to a PLC, and actually run the PL.C. There are three phases to this
operation. ‘

» Writing the program to the PLC
 Switching to Online Mode
» Monitoring the data
The basic Qperational procedure is outlined below.
1) Connect the personal computer to the PLC with a special cable.
2) Turmn ON the power supply to the personal comp;uter.
3) Activate MEMOSOFT.
4) Write the program created in offline to the PLC.
5) Switch to Online Mode.
©6) Display the ladder program and the reference data.

7) Exit MEMOSOFT,
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4.1 Overview of Operating Procedures

4.1.2 Connecting to the PLC

A special cable is required to connect the personal computer to the PLC. Make sure to have
one of the following cables.

Table 4.1 MEMOBUS Protocol Cables

Cable Length Model
25m JZMSZ-120W0202-03
15.0m JZMSZ-120W0202-15

Table 4.2 MEMOBUS PLUS Protocol Cables

Cable Length Model
25m JZMSZ-120W0800-03
15.0 m JZMSZ-120W0B00-15

i S



From Start to Exit: Online
4.2.1 Activating MEMOSOFT

4.2 Loading the Program onto the PLC

This section describes the procedures for activating MEMOSOFT and writing the
program to the PLC. .

4.21  Activating MEMOSOFT ................. e 4-4
422 Loadingthe Programontothe PLC ...... ... . ooiiiiiiiiiiia. .. 4-5

4.2.1 Activating MEMOSOFT

As in Chapter 3, operations begin with turning ON the power to the personal computer.
1) Turn ON the power supply to the personal compﬁter.
2) Enter MEMOMENU and press the Enter Key.

C>MEMCOMENU

3) The MEMOSGOFT Menu, will be displayed. Select GL120/130 PROGRAMER (PRO-
GRAM MODE) using the Cursor Keys and press the Enter Key.

MEMOSOFY -Nenu

FPloase seloct an -pn-atiun Erom the !‘ulloui.ng menu with arrow
hys and hit “return”™ key.

1

GL128-138 PROGRAMER (PROGRAM MODE>
%20/1301’“%"58 <MONITOR MODE>
APPLICATION mcmr <10 FI»
APPLICATION RESTORE (FROM D>

.Q:O‘Odﬂ\mhw

"

4) The Program Startup Screen will be dispiayed. Press the Enter Key to dispiay the initial
screen as shown below.

r Hut ion Cu—wnt Ref Data Toc ls Quit

Ha
[F1
Program Name: GI.I.ZB_J.
l’l-c Address: MB:
PLC Type:
Tab mover hetween the Menu Bar and the Editing Screen.
ALY R providex help on the menu item zelected by the cursor.
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4.2 Loading the Program onio the PLC

4.2.2 Loading the Program onto the PLC

Use the following procedure to load the program from the personal computer onto the PLC.

1) Select Loader from the Tools Menu using the Cursor Keys and press the Enter Key.

h:de c.nfu Lauldn- Ilotinn cann:nt lief Data

MEMOSOF

1
Program Name: GL12B_1
P‘I.C Address:
PLC Type:

Tah  moves botween the Menu Bar and the Editing Screen.
ALT B provides help on the menu item sslected by the cursor.

2) A submenu will be displayed. Select File to PLC using the Down Cursor Key and press
the Enter Key.

d. Cunl'ig Ladder Ihtion ca-unt Raf Dltl

HEHEIEI]Ifm

moves between the Menu Bar and the Editing Screen.
ﬁl.'l' H provides help on the menu item zelected by the cursor.

3} A screen will be displayed for selecting the file to be loaded onto the PLC. Select
GL.120_1 using the Down Cursor Key and press the Enter Key.

Mode Config Ladder Motion Comment Ref Data Tools Quit

FEMOSOFT

ft

Progranm Hame: (ﬂdzﬂ_,t
l'u: Rddress: MB:
FLC Type:

Tah  moves between the Menu Bar and the Editing Screen.
ALT H provides belp on the menu item sslected by the curstor.
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From Start to Exit: Online
4.2.2 Loading the Program onto the PLC cont.

F

4) Ifthe PLCis in RUN State, a confirmation message will appear asking whether to stop the
contrcller. Enter Y and press the Enter Key.

Mode Conf ig Ladder Motion Comment Ref Data . Tools Quit

MEMOSOFT

5) A confirmation message will then appear asking whether to clear the programs in the
PLC. Enter Y and press the Enter Key.

Il‘l-dn Config Ladder Motion Comment Rcf Data ~ Tools Quit
J—F9

HEHI]EI]FT

Tab 0 .
ALT W prevides help en the aenu item sslacted by the cursaor.

.

6} The program will be loaded onto the PLC. When the lcad process has been completed, a
confirmation message will appear asking whetherto startthe PLC. Enter Y and press the
Enter Key.

kd’ Conhg l-addu- lbtun tbmnt Ref Data 'l'oul: Quit

MEMOSOFT.

Progran Name: GI.!Z&J.
Plac fddress: MB:
PLC Type:

LTRHT CONTHULLEH" (YN b ]
Tab moves hetwsen Reseemesemenss -1 3]
ALT H provides help on the wmenu iteu selected by the cmor.
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4.2 Loading the Program onto the PLC

Controller status information simitar to the following example will be displayed.

CONTROLLER STATUS INFORMATION

PC 3 SYSTEM REGISTER : INFO =
PC ADDRESS [ BTRY COIL 988192 EXEC ID B3F® REU A180
PC TYFE GL128 STRTUS Running
MEMORY 40.9 CONST SWEEP 409999 - LOCIN o
USARBLE MEMORY 16351 999 SIOP CODE 2988
NO OF SEGMENT 1 RS SCANTIME 489997 HEMORY PROTECT H
MOTION 2 MODULE TIMER REG 489996 CONST SWEEP N
LINK 2 HMODULE STEP RELAY 40%2%3; BATTERY 0K 4
REF RANGE = CALENPER 409988 —
oos192 499995

INPUT RELAY i@id24 I :

REG 30a512 NO OF I/0 MODULE 34
HOLDING REG 489999 REMOIE -
COMST REG NO OF 1 REM STIAT 15
L COIL -1 rie24 NO OF 2 REM SIAT 15

Prest {PGDN> for I/D Status; <Enter> pr <ESC> to exit

The loading operation from the personal computer onto the PLC is now complete.
If the loading operation onto the PLC fails, follow the check procedure given below.

1} Check the personal computer's communications parameters. See section 17.2.6
Changing the PLC Address.

2) Check the cable connections.

3) Checkthe PLC’s communications parameters. Use the DIP switch to returnto the default
settings for the communications parameters.
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From Start to Exit: Online

4.3.1 Switching between Online and Offline

4.3 Going Online

I This section describes the procedures for changlng to online operation and displaying

ladder programs.
4.3.1  Switching between Oniine and Offline ... .. RS 4-8
4.3.2 Displaying the Ladder Program .......... e, 4-9

4.3.1 Switching between Online and Offline

The procedure for switching to online operation is descnbed here. Begin the operation from
the Initial Screen.

1) Select Online from the Mode Menu using the CUrsor Keys and press the Enter Key.

]—Cnnfis l.nl.dur llntion Cnment He!‘ Data 'I'nnls Qui.l:
Wffl:mc

|'|EI"1EIEEIFT

1% ft
Program Name: GL128_1
PLC Address:: "e: 1
FLG Type:

moves h-tuoon the Menu Bar and the Editing Screen.
ﬂl.'l' N provide: help on the menu item selected by the cursor.

'

2) A submenu will be displayed. Select Direct to PC using the Down Cursor Key and press
the Enter Key. If there reference comments are input, use Select Program, and com-
ments and other information will be displayed.

1

m_conflg Luddex- llutun Coancnt Bef Data 'l'nn Quit
uornin- T

FEMOSOFT

£t

FProgran Ihm GI.123_1
Pl.c Address
ype:

FIC T

Tab movez betwecn the Menu Bar and the Editing Screen.
RLT H provides help on the menu itew selected by the cursor.

3) The communications parameters setting window will be displayed. Press the Enter Key
after specifying each parameter. Set the PLC address to 1; select the MEMOBUS proto-
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4.3 Going Online

coland RTU Mode; set the data bits to 8; select even parity; and set the stop bits to 1 and
the baud rate to 9,600 bps. if the settings for the PLC communications parameters are
different, see chapter 17 File Operations.

dc Cnnfig l.uh‘hu» I'lot:l.on comm: Ref Data 'ln-ls Quit

HEHEIEI]F'T

I Wame: GL1%@ i

PLC Rddress: MB:
COMMUNICATIONS PARARMETERS
Address Protecel Mode Data Bits Parity Stop Bits Baud Device

]ﬁl Dip Switche:r I8X/48X m 68%/78% | |
78

4) The MEMOSOFT should be online with the PLC. Check that the programming mode dis-
played in the upper right corner of the screen indicates Online Mode.

Config Ladder Motion wComment Kef Data Icels Quit

FEMOSOF T

Program Hame:
Pl.c Addrest: MB: 1
PLC Typa: GL120

moves betussn the Menu Bar and the Editing Screen.
nl.'l' H provides halp on the menu itsm selected by the cursor.

4.3.2 Displaying the Ladder Program

1) Select Ladder using the Cursor Keys and press the Enter Key.

I!inde (‘Jnfiu Hotinn ﬁ:nnllunt Rcf Data Tools

F7-EXR-P8-30—F9
e 4 | fr

Program Name:

PLC Address: MB: 1

PLC Type: cL128
Tabh moves between the Menu Bar and the Editing Screen.
RLI H provides help on the wenu item selected by the cursor.

|
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From Start to Exit: Online .
D ... "
4.3.2 Displaying the Ladder Program cont.
2) The Segment Status Display will appear. Select the segment where the program is stored
using the Cursor Keys (L01 in this example,) and then press the Enter Key.

[!hin PLC Ope Commands Edit Tools Quit
—2———FP3 P4 PS5 P& ¥ — =
' Uzed ¢ 29
SEGMENT STATUS DISPLAY . Prewe = 16351
Segmont Hetwork Sesment Network Segment Hetwork

H HOT PROGRAMHMED
F -
ROT PROGRAMHED

Presz {ENTER> to view the selected zegment

Note Three kinds of segments are displayed in the Segment Status Display: H (high
speed), LXX (normal} and S (subroutine). See section 9.7 Ladder Program Edit
Screen for further details.

The ladder program created in Chapter 3 will be displayed. The status of the reference at
the cursor position wilt be shown in the upper right corner of the screen.

PLC 9pe Elements Edit GoSrch MNetwork Ref Tools Quit
_P3_F1—!'S-—----¥G-—-—-1—F7—¢ —S—>Y

Symbol-Descriptor availabl

Reference Data

]Pomt sDecimal PLC Data ge = 1

3) Additions can be made to the ladder program uéing the same procedures as in Offline
Mode.
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4.4 Displaying Reference Data
“

4.4 Displaying Reference Data

This section describes the operating procedures for displaying reference data and the
disabling procedure.

4.41 Displaying Reference Data
4.4.2 Disabling Procedure

4.4.1 Displaying Reference Data

Use the following procedure to display reference data.

1) Move to the clock ladder program in network 2 on the next screen using the Page Down
Key.

2) Move the cursor into the reference data area by pressing the Down Cursor Key several

times.

Il‘lain FLC Ope Format Settings Window Transfer Diszable Tools Quit
P ——— P2~ ——— P3P PSP -

Seqg. LBl B2 - 2 5

138816 -k
[ 181 r—
@1 4890001 -_ma_mz
I
I o I ElUC L
Reference Data-

| —

Format :Decimal PLC Data Range : 1

3) Enter the reference number for the 0.1-SECOND TIMER (400001 in this example) and

press the Enter Key.

Main PLC Ope Format Settings Window Transfer Disable Tools Quit
P} —-— P2 §3— P ———Ff o =
Seq.LB1 82 /2 s

i -_ma_ lm: 5

i —
T 200060 000912
lz -] -
| Bone12
|
Roference Data

I

Format :Decimal FLC Data ge t 1
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From Start to Exit: Online

4.4.2 Disabling Procedure

4) The current values and formats for the reference data will be displayed. Confirm that the
numerical values for the reference data change repeatedly from 0 through to 10 as the

ladder program is solved.

in PLC Ope Format

—ases TP ——————FF TS
Seg.L81 #2 / 2 R
BO818 8A611
- —]Tn.1 >—
1409081 ._m )_800a12
v
[ e T

'S‘Etti.nys !—imlnu jrans!:r.hi:ahle Taols

s _wbol./bcscriptor availabl

! ol Quit

7]

Reference Data

R
408081

Pormat :Decimal

PLC Data

5) Next, enter the reference number for the UP COUNTER (400002 in this example) and

press the Enter Key.

+

m.c Opo Format

Setrings Window
§—F%
s. _LBt 42 / 2

Transfar Dizabla Teols
——F 2

)—

Quit
~I———F?—il—

Reference Data

HHM W

Pomt Deci.nl PLC Data Bange = 1

6) The current values and formats for the reference data will be displayed. Confirm that the
numerical values for the reference data change repeatedly from 0 through to 60 as the

ladder program is solved.

Lhin PLC Ope PFormat Settings Window Transfer Dizable Tools Quit
1 ———F2 ———F3 14— PT, —F7 = -
Seqg.LB1 842 /2 5
__easid 200011 R !
e T )

Symbol/Dezcriptor availahbl

Reference Data

4Ba881 3 Dec
48882

Format :Decimal

i PLC Data Range *

4.4.2 Disabling Procedure

Use the following procedure for disabling.
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4.4 Displaying Reference Data

1) Fieturh to the Network immediately preceding using the Page Up Key.

2} Display network 1 of the ladder program. Move the cursor to the reference data area us-
ing the Cursor Keys and enter the reference number (100001 in this example.) Then,
press the Enter Key.

i.n nc Opo Format  Settings Window Tranzfer Dizable Toels Quit
Fi———F2 Fa— 1 —————F3————F4—————F5———F6. T F8—i——F 9+
oy .

s

Reference Data
Format :Decimal FLC Data ge 1

The current value of the reference data will be displayed.

km PLC Ope Format Settings Window Irancfer Disable Tools Quit
$ L1 s-1 &
14 H

&Jmm&—‘ o

Symbol/Descripter availakl
Reference Data
rm p——" A

Porsat :Decimal PLC Data Range : 1

3) Move the cursor to the Enable/Disable (E/D) display area using the Right Cursor Key.
Enter D to switch to Disable and press the Enter Key. ‘

l!hin PLC Ops Format Ssttings Window Iransfer Disable Tools Quit
F%—Lm—ﬁTn—-—!M—-ﬂi’Sw—Ps—i‘? - -
.y,

4.4 rapes W e My

Symbol/Descriptor availabl
l hfifﬁcncc Data

18ee81 -]

Format :Decimal PLC Data hge = 1
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From Start to Exit: Online

4.4.2 Disabling Procedure cont.

4} The cursorwill move automatically to the location bf the reference data. It will be currently
set to 0 (OFF). Enter 1 (ON) and press the Enter Key.

in PLC Ope Format Settings Window Transfer Disable Tools Quit

I;; F2 F3 4 e F6 ¥7— -8 ~—F9 i
Seg.LB1l 31 ~ 1 :

/P —t )—

88081 180082 PBB101 BODEBL

s L/Bescriptor availabl
ymbo P -Reference Data
198881 T N ¢ 1

L Pormat :Decimal " PLC Data qe : 1

5) Confirm that, on the ladder program, the N.O. contact for 100001 is ON.

in PLC Ope Format Settings Window Tranzfer i’isnhle Tools Quit
74 ¥ s i it

b x

———— P2 73
Seg.LBL 81 / 1

1 — »— .
80621|[1800E BAA101 POPEEL .

Symbal/Descriptor availabl
Refersnce Data
llm " D

Format :Decimal PLC Data ge = 1
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4.5 Exiting MEMOSOFT
4.5 Exiting MEMOSOFT

§ This section describes the procedure for exiting MEMOSOFT,

4.5.1 Retumingtothe InitialScreen ............ .. ... ... ..., 4-15
452 EXtingProcedure ..........c.ooiiiiiiiii e s 416

4.5.1 Returning to the Initial Screen

1) Move the cursor to the ladder program area using the Up Cursor Key.

Main PLC Opa Elementsz Edit GosSrch Network Ref Tonls Quit
1 P2 P4 ¥6 F7-EXOR-Pa-30——F9

r4 S

Rofeprence Data
]

“ Format :Decimal PLC Data ge 1

2) Switch to the menu cursor using the Tab Key.

3) Select Quit using the Right Cursor Key and press the Enter Key.

h;i.n PLC Ops Elements Edit GosSrch MNetwork Ref Tools K}
—0n-—7—3——Pt—5 ¥ —— 7 - P8

I Reference Data
1896881 1 ]

Format :Decimal PLC Data ge = 1
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From Start to Exit: Online

4.5.2 Exiting Procedure

4) Exit the Segment Status Display following the same procedure.

k:‘.ﬂ PLC Ope Commands Edit ; Tools  Quit
S MLARIE — el 7 A - po— ~E P
SEGMENT STAIUS DISPLAY F::B ; 16351

Segment Network Segment Network Segment Network
] NOT Pmlﬂﬂz) ’
NOT PROGRAMMED

Press <ENTER> to view the zelected segment

The initial screen will be displayed.

Mode ConfF iy Ladder Motion tComment Ref Data Tools

MEMOSOFT

e ft
Program Name:
PI-C Address: MB: 1
PLC Type: GL128

moves betwesn the Menu Bar and the Editing Screen.
nu H providez help on the menu item selected by the cursor.

4.5.2 Exiting Procedure

Exit MEMOSOFT using the following procedure.

1) Select Quit using the Right Cursor Key and press the Enter Key.

hde Conrxg l.ndder Ilutnn K:nan-nt Rl!' Data "1‘ Ioo 3
flemosoft
Progran Name:
PLC Address: MB: 1
PLC Type: GL120

Tabk  movss betuesn the Menu Bar and the Editing Screen.
ALT H provides holp on tho menu item telected by the cursos.
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4.5 Exiting MEMOSOFT

2) A confirmation message will be displayed. Enter Y and press the Enter Key.

MEMOSOFT

8) The program wili end and the MEMOSOFT Menu wili be displayed. Select END usingthe
Down Cursor Key and press the Enter Key.

MEMOSOET —Menu

Pleasze select an opont:icn from the following menu with arrow
keys and hit “return™ key

1. GLI20-130 FROGRAMER <PROGRAM MODE)
2. GL128-130 PROGRAMER <MONMITOR MODE>
3. PFRINT LADDER
4. APPLICATION BACXUP <TO PD}
E. APPLICATION RESTORE <FROH FD)
?.
8.
¥,
BD

MEMOSOFT will be exited.
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Basic Operations

This chapter describes the basic procedures for using MEMOSOFT,
including the screen configuration and menu operations.

5.1 Screen Configuration ............. - 7.
5-2 Mel’luoperations LI I I R R R O A R R S R 5‘3
321 UsingtheCursor ........cvviiiieranreiirannnns 5-3
522  UsingFunctionKeys ........................... 5-6
523  UsingQuickKeys ........ccoiiiiiiiminninanin. 5-8
524  Summary of Key Operations ..................... 5-11
5.3 Programming Modes ...... Cererevenasens .o 512
531 ProgrammingModes .........................., 5-12
532  Switching Programming Modes . .................. 5-13
5.4 Environmental Settings .................. . 317
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Basic Operation

5.1 Screen Configuration

I This section describes the screen configuration of MEMOSOFT.

The screen configuration is shown below. )

...........................................

Mode_ _ _STYSTEE Lodder _ Mation . Comment Ref Data . ___ _ Tgols_ . = 1)
F1———f2——— F3— P

MEHDEDH :z

4)

Program Hame: GL:I.28_1
PLC fddress:
PLC Type:

Tab moves between the Menu Bar and the Editing Screen.
ALT H provides help on the menu item selected by the curtor.

1) Menu Bar

This line displays the menu items that can be selected for the currently displayed screen.
See section 5.2 Menu Operation for menu selection operation.

2) PLC Status and PLC Address

When the programming mode is Online or Debug, the PLC RUN/STOP State and the
PLC address are displayed - Rxxx: RUN State; Sxxx: STOP State (xxxindicates the PLC
address (1 to 247)).

3) Proegramming Mode

The current programming mode is displayed - ON: Online Mode; OFF: Offline Mode;
DEB: Debug Mode; See section 5.3 Programming Modes for details on programming
modes.

4) User Level

The current user level is displayed. Normally, the user level is set to 7. In Monitor Mode,
however, the level is 0.

Monitor Mode only allows data to be read, and not saved. fMonitor Mode is used, it will notbe
possible to return to the normal mode until MEMOSOFT is exited. To use Monitor Mode, se-
lect GL120/130 PROGRAMER (MONITOR MODE) from the MEMOSOFT Menu,
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5.2 Menu Operations

I This section describes the three types of menu operation that can be used in

MEMOSOFT.
521 Usingthe CUIsSor ...........oovvvunuunnnnnnn... I 53
522 UsingFunction Keys ... .. ..ot 56
523 Using QUickKeYs ...t it et trraai i eeaarens 58
5.24 Summaryof KeyOperations ........ ..ottt inneanen, 5-11

5.2.1 Using the Cursor

In the following cases, a menu item can be selected using the Up, Down, Left, and Right Cur-
sor Keys.

» When the Cursor is not Used on an Editing Screen

The cursor is not used on the editing screens, and other screens first displayed when the
MEMOSOFT is activated. The menu cursor is used on these screens.

» Switching with the Tab Key

When the Tab Key is pressed during editing in the Ladder Editor Screen, the normal cur-
sor is disabled and the menu cursor is enabled. When the Tab Key is pressed again, the
normal cursor is enabled.

Whenamenuitem s selected using the Cursor Keys, the item at the current cursor position is
highlighted. When the menus are further expanded, other menus are displayed vertically.
This is called pull-down menus. Operation examples using the Cursor Keys are shown below.

1} Initial Screen

When MEMOSOFT is activated and the Enter Key is pressed once, the following screen
will be displayed.

Ladder Hol:ion Gonncnt laf Data To-ls Quit
el FM Ldder B

MEMOSOFT

Hamozoft
gram Nameo: GL120_1
ru: Addresss: MB: 1
FLC Type:

Tab  moves betwesn the Menu Bar and the Editing Screen.
RLI B provides halp on the menu item selscted by the cursor.
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5.2.1 Using the Cursor cont.

O[[!Ei]b Depending on the programming mode being used, some items on the menu cannot be se-
lected, and will be displayed as follows:

« Color display: The menu items will be displayed in red.
s Monochrome display: A mark will be displayéd on the left side of the menu item.
See section 5.3 Programming Modes.for more details on programming modes.

When the Right Cursor Key is pressed, the menu cursor will move to the right. No puli-
down menus are displayed for the Config and Ladder Menus because there are no me-
nus available.

Iﬂnde Confls lht jion Comment Ref Data Tools Quit
£5 F6 PTG Fe-Ai—Fe

>

Progran
ma
PLC Type

Tab wovez betwesn the Menu Bar and the Editing Screen.
ALT # provides help on the menu item relected by the curser.

] ft
Iha-: GL12@_31 R
MB: 1 .
|

When the Down Cursor Key is pressed atthe Motion Menu, the menu cursor will move in
the pull-down menus.

Fde Cunfig cwunent Ref Data - ‘l‘aols Guit

MENGSOFT)

Progran Name: GI.128_1 |
1

FLC Address: MB:
FLC Type:

moves between the Menu Bar and the Editing Screen.
lﬂ.‘l‘ H provide: help on the menu item selected hy the cursor.

The cursor will move to the right again when the:Right Cursor Key is pressed.
After moving the cursor to the item to be selected, press the Enter Key. The operation
corresponding to the menu item will be executed.

2) When an ltem has a Submenu

When an item has a submenu, the item is prefixed by “p". When the Enter Key is
pressed, the submenu will be displayed. !
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1) Select Files from the Tools Menu using the Cursor Keys.

de Conf Ladder Motion Comment Ref Data
F——n-—-i’-—m F4 F5 F6 .

Tab  moves betweon the Henu Bar and the Editing Screen.
ALT N provides help on the menu item selected by the cursor.

2) Press the Enter Key, and another submenu will be displayed.

de cnnfi’ huﬂ- Hot:un cmuunt Ref Data Quit
T r ) 1

Files

%.. Egru

Save changes

Save All Fils

Save as...

Changs FIC Address
Iaea:!on of Program Kame
File Oparation

Pro Nanes : 61420_1
m';:.dnnz HB:
PLC Type:

#oves betwesn the Monu Bar and the Editing Screen.
IILT H provides elp en the menu item selacted by the cursor.

3) When the Cursor is Switched by the Tab Key

Examples on a ladder editing screen are shown below. in this state, the cursor on the
ladder program is enabled. The cursor will move by pressing the Cursor Keys.

Illain Eloments Ed:.t GosSrch Network Ref Tools Quit
h— n!'-/' 1 ¥3 5 F6 TN ¥8 -0 —FY

Foference Data
i

L Format :Decimal File Data Range = 1
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5.2.2 Using Function Keys

When the Tab Key is pressed, the menu cursor is disabled and a pull-down menu is dis-
played. When the Cursor Keys are pressed subsequently, the menu cursor moves in the
submenu.

in [ Ediv GosSrch Hetwork Ref Tools Quit
E_H—W-mnts Poame PG nw = - FB - —F?
Seg.loL 81 - 1 i
- rT imer/Counter
rlath

Reference Data - "

Pormat :Decimal File Data Range : 1 — |

» SUMMARY

L

=)

Move the normal cursor and menu cursor,

Ly
(«]
(¥)

Switches the mode from the normal cursor to the menu

TAB cursor (pull-down menu).

Selects a menu item and displays a submenu.

Cancels the last entry. When a submenu is displayed,
control is retumed to the item one level higher.

!@@

AL @ Displays the explanation screen for the current menu item.

5.2.2 Using Function Keys

All the items displayed on the menu bar of the screen correspond to the Function Keys indi-
cated on the second line. By pressing the corresponding Function Key, an item can be se-
lected. When a submenu is available, the items on the top line are substituted by the items on

the submenu.
An example of selecting the Tools Menu in section 5.2.1 using Function Keys is shown below.

1) Display the initial screen.

— 56—
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2) Since Tools is assigned to Function Key F8 (check the combination of the item on the first
line and FX on the second ling), press the F8 Key.

d. I.uld.or llotinn Connent Ref Data ‘l'onls mit

HEHI]EI]FT

gram Hams: GLIZB_:.
PI-C Address:  MB:
PLC Type:

moves betwean the Menu Bar and the Editing Screen.
nL‘I H provides help on the menu item selected by the cursor.

3) The menu bar will switch to the Tools Submenu. Select Files from the submenu. Since
Files is assigned to the F2 Key, press the F2 Key.

nfo laulm- Print fSatting

Files

DOS

sﬂe hln
el ]
an Kl

Save All

Save as.

Changs FLC Address

lﬂcat:l.on of Frogram Name
le Operation

moves betwsen the Menu Bar and the Editing Screen.
ALY H provides Melp en the menu item zalected by the cursor.

The menu bar will switch to the Files Submenu.

Smo Saue All Sawve ns Address Lecation F:l.le

I"'IEI"'IEIEEIFT

gran Hame: 61-123_1
PLC ARddrezs: HB: 1
PLC Type:

Tab  woves hetween the Menu Bar and the Editing Screen.
ALT H provides help on the menu item sewlected by the cursor.
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5.2.3 Using Quick Keys

$ SUMMARY

' Select a menu. If there is a submenu, the menu
@ to display is switched. S

[ SHIFT :] + r fo1 J to[ f«9 ] Display the :explan'ation screen of the menu.

@ Returns control to the previous menu.

5.2.3 Using Quick Keys

In MEMOSOFT, special keys are assighed to a frequently used menu items. The assignment
of quick keys varies according to the editing screen currently being displayed. A list of quick
keys that can be used on the current editing screen can be displayed on the screen using Key
Help at Info in Tools.

In the following example, entry of an N.C. contact in a ladder program is executed by cursor
operation, Function Key operation, and Quick Key operation.

1. Cursor Key Operation

1) Switch to the menu cursor using the Tab Key.

1

2) Select Relays from the Elements Menu using the Cursor Keys, and then press the Enter

Key.
in Edit GosSrch Metwork Ref Tools Quit
—m" w lewsints 5P ————F7- - Fe -3 —F9
.. I
l_ | |[T—
Hiath
F . Others
Reference Pata
Porsat :Decimal File Data Rangs : 1

- 5-8 —
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3) Asubmenu will be displayed. SelectanN.C. contact using the Cursor Keys and press the
Enter Key.

in

Edic Go/Srch HNetwork Ref Tools Quit
18 H# /1 Fe -
a3

enents— 1a PB-EE—F9

imer/vounter
Math

Others -

Referance Data

Format :Decimal File Data Range : 1

2. Function Key Operation

1) Since the F3 Key is assigned to Element, press the F3 Key.

.2) The menu will switch to a submenu. Since the F1 Key is assigned to Relay, press the F1
Key.

IRI Lays Timex Math Others
———— P} — P Fs —F6——— PO ¥ - —F9——y

Reference Data

Format :Decimal File Data Range : 1

3) The Relay Menu will switch to the submenu. Since the F2 Key is assigned to an N.C. con-
tact, press the F2 Key.

— —L Y —
@!“Lu;;*:—*‘uﬁiﬁlt;siﬁ__n" I P8 -T— P9 ——
L I

¥
M

Reference Data

I-Pomt sDecimal File Data Range = 1
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5.2.3 Using Quick Keys cont,

3. Quick Key Opération

An N.C. contact can be entered by the / Key or\ Key. In this example, press the / Key.

Main Elements Edit CoSrch MNetwork Ref Tools_  Quit
]% H 81 1 ’F'?"' -
i ”

Reference Data-

- Format :Decimal Pile Data Range = 1

‘$ SUMMARY Features of these three operation methods are described below.
s Cursor Key Operation

Since menus are displayed in a tree structure, there is no confusion in terms of operation
even if the menu structure is not remembered clearly. However, more key entries are re-
quired. This methed is useful for the users who are not familiar with MEMOSOFT.

» Function Key Operation

Less key entries are required than Cursor Key oberation. However, since menu display
changes, there may be some confusion in operation unless the menu structure is clearly
understood. This method is suitable for users who are familiar with MEMOSOFT.

» Quick Key Operation

The least key entries are required compared to the other two methods. Although it is not
necessary to memorize all the Quick Keys, it is convenient to memorize frequently used
Quick Keys, such as relay, coil entries, and copy operation.
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5.2.4 Summary of Key Operations

Basic key operations are summarized below.

[

Move the cursor.

(4)
[«]
(]

TAB Switches the editing screen cursor to the menu cursor.

@ Activates the selected menu jtem,

[ f1 Jto[ 9 ] Select a menu item.

[ SHIFTj + [ ol ] Display an item explanation screen.

Ends the current editing screen. This function is equivalent
to selection of End from the menu.

ALT ] + B Displays an explanation screen of the menu item or symbol
to which the cursor is currently set.

H

ESC Basically used to cancel a state as described below,

» Cancelling Entries
If the Esc Key is pressed during entry of the data to which
the cursor is set, the entry operation can be cancelled. As
a result, the data is reset to that of the start of the entry.

5

* Deleting System Messages
If the Esc Key is pressed when a message such as an
entry error is displayed, the message is deleted.

® Deleting a Help Screen
The Esc Key ends the help screen currently being
displayed and returns control to the original editing
screen.

* Changing a Menu )
I the Esc Key is pressed while a submenu is displayed,
the submenu display is cleared and a menu one level
higher is displayed.

¢ Ending a Screen
If the Esc Key is pressed without any operation, the
screen currently being displayed is exited.

Switches the Insert/Overwrite Mode in comment editing, etc.

:
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5.3.1 Programming Modes

5.3 Programming Modes

I This section describes the three programming modes used by MEMOSOFT.

5.3.1 ProgrammingModes ................... et eeeaee et e naaa 5-12
5.32 Switching Programming Modes .......... e 5-13

5.3.1 Programming Modes

The following three programming modes are available in MEMOSOFT.
. Oﬁline Mode
« Online Mode
» Debug Mode
The functions éf each mode are as described beloﬁ
1) Offline Mode

This mode is used for programmirig ona persona;l computer only. Programs to be edited
are stored on the hard disk or floppy disks of the computer. The MEMOSOFT editing op-
erations can be fully utilized, but PLC operations and monitor functions cannot be used.

2) Online Mode

This mode is used to directly edit programs that are stored in the PLC by connecting the
personal computer to the PLC. PLC operations and monitor functions can be used, how-
ever some of the program editing operations cannot be used. This mode is classified into
the following two submodes depending on whether symbols and comments are dis-
played.

» PLC Internal Program Selection

Data is displayed from PLC internal programs only. Therefore, symbols and comments
are not displayed.

= Program Selection

Data is displayed from PLC intemal programs and symbol/comment data stored in the
personal computer. Since the symbols are displayed, programs can be monitored more
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easily than the PLC internal program selection submode. Symbols and comments can
also be edited. Programs cannot be loaded in Online Mode.

3) Debug Mode

This mode is used to directly edit the programs that are stored in the PLC by connecting
the personal computer with the PLC. However, program data that is stored in the person-
al computer can be changed concurrently with PLC intemnal programs.

When editing is started in this mode, the corespondence between the PLC intemal pro-
grams and programs in the personal computer is checked. When a ladder program is
edited subsequently, the data in the personal computer is also changed when the PLC
internal data is changed. Therefore, when a change is made, data in the personal com-
puter can be changed concurrently without having to load data from PLC to the personal
computer.

Itis possible to select whether the change is to be saved in a personal computer file at the
end of debugging.

Note Changestoladder programs and other operations that change the CPU status cannot be per-
formed while memory protection is ON. To perform these operations, first release memory
protection by switching the CPU Module key switch position from P.ON to P.OFF.

5.3.2 Switching Programming Modes

1. Switching from Offline to Online

1) Select Online from the Mode Menu using the Cursor Keys and press the Enter Key.

Conf:m l-uldcr Matisn Go—unt Ref Data Tools Quit
fl [

FIEMOSOFT.

gram Mancs GLlZB_l
P’LC Address: MB: 1
PLC Type:

moves betwesn ths Menu Bar and the Editing Screen.
aLT H provides help on the menu item gelectad by the cursor.
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R
5.3.2 Switching Programming Modes cont.

2) Asubmenu w11| be displayed. Select Direct to PLC using the Cursor Keys and press the

Enter Key.

Config r Mot ien Comment Ref Data

I $elect

|'||:|'1IZIE|IIIF'IHl

JTools

Progran Nams: GL:I.ZB_J.
Pl.c Addrezs:  MB:
PLC Type:

Tab mouss between the Menu Bar and the Edil:i.ng Screen.
ALT H provides help on the menu item selected by the cursor.

3) A communications parameters setting window will be displayed. When the Enter Key is
pressed as indicated by the display, communications parameters are set as foliows:
{PLC) Address 1; MEMOBUS Protocol; RTU Mode; 8 Data Bits; even Parity; 1 Stop Bit;
and a baud rate of 9,600. If different PLC cormmunication parameters are to be set, select
them within the selection window using the Cursor Keys. See chapter 17.2 File Opera-

tions for details.

Ilnt:.nn co-unt Rtf Data -

bde G

[F1

Confi 19 l-nd.dlr

'l'uuls Qui:

MEMOSOFT.

gran Hame: GLIZB_I
PI.C Address:  MB:

l

conlnucnr: ONS PARAMETERS

Address Pretocal
] BUS ltl'll

IE_‘I Dip Switches 3I8X/48X |§ I
78 12345678

Data Bits Puity Stnp Bits
EVEN

Baud Device
9680 CoMt

- )
3

4) The mode will switch to Online Mode. Verify that the programming mode in the top-right

comer of the screen indicates Online Mode.

Conf 13 I.uld-r Mot inn

e

Dabug

—-—-----—-—-—-——Hemsol't

gram Mame:
PI.C Address: HB:
PLC Type: cmza

d:o-nnt Rnf Data

FMEMOSOFT.

Inuls Qult

Tab movezs betwnen the Menu Bar and the Editing Scresn.
ALT R provides help on the menu item selected by the cursor.
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2. Switching from Online to Offline

1} Switch to the menu cursor using the Tab Key.

2) Select Mode from the Main Menu using the Cursor Keys and press the Enter Key.

IO PLC Elements Edit GosErch Metwork Ref Tools Quit
D il A -—9
nfiguration >—
tladder 200011
rotion e
Tt |, Tl ol
ta
4000872
Reforence Data

Format :Decimal PLC Data Range : 1

3) A submenu will be displayed. Select Offline using the Cursor Keys and press the Enter
Key.

M .El.c-cnts Edie GosSrch MNetwork Ref Tools Quit
lbmr- joe—— 5 ————F6
Conf igurat ion |#0n ko
#ladder lllhu 11
Hiotion

I

ﬂit Cn-ent BE8R12

=|l

- Format :Decimal PLC Data

-Ifl-—-i 1—

Referance Data

ge = 1

4) The initial screen will be displayed and a confirmation message will appear. Enter Y and
press the Enter Key.

|Hode Confiyg Ladder Hotion Comment Ref Data Ioels Quit
F1 ———F2+eroe——f P ——u P ————P%

MEMOSOFT.

ft

Tak moves be
ALT H provides he

0 CUrsor.
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5.3.2 Switching Programming Modes cont,

5) Select the name of the file to be edited in Offline Mode using the Cursor Keys and press
the Enter Key.

Ede Config Ladder Motion Camment Ref Data l'cols Quit
—2—F3 P4

”DEDFT

Program Name: cLize 1 '
PLC Address: NB: 1 s
PLC Type:

Tab movaz between the Menu Bar and the Edi.t:l.ng Screen.
ALT B provides help on the menu item zelected by the cursor.

The mode will switch to Offline Mode.
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5.4 Environmental Settings

This section describes the environmental settmgs when editing ladder programs in
MEMOSOFT.

Setting Reference Display

Set whether reference numbers are displayed in numeric digits or alphabetic characters. This
setting relates to display only and reference numbers of ladder programs can be entered in
either numeric digits or alphabetic characters. The correspondence of these references is

shown below.
\ Numeric Display Alphabetic Display
Coil OX XXX X Ox X XXX
Input relay 1x X X X% IXX XXX
Input register IX X XXX IX XXX X
Holding register 4X X XXX WX X X X X
Constant register T XXX X KX X X XX

By default, the display is set to Numeric. By memorizing the first character of alphabetic dis-
play, the following abbreviated input can be performed. This can be done regardless of the
display.

+ Entering a Reference Number of Input Relay

Normal input: Enter 100010
Abbreviated input: Enter 110

* Entering a Reference Number of a Holding Register

Normal input: Enter 400001
Abbreviated input: Enter W1

Switching operation is shown below.

1) Select Setting from the Tools Menu using the Cursor Keys and press the Enter Kay.

in Overview Ihp Eutti.nsn Quit
[Fl—————P2—~——F3 77N —Tools—
FLC Systea conflgmtmn Finfo
FFiles
PLC : Special Reg|rLoader
PIC twpe GL12B NG coil-1l  Y18256 Bat coil Print
ExecPack 28 MG coil-2_  Y2@256
User Logic 16 X MG cntcoill Q1B1g8 C awesp
State RAM 32 K NG coteoil2 Q291608
Segment N0 1 II: nlay—l X108256 Hspeod scan 189997
Motion 2 Module X20256 Timer Reg 29996
Link 2 Moduls W eatrlvct PIB3S5¢  SeesTReLly dmanes -
MC cotrly-2 P2B256 482832
10 : Mecode »ly-1 HIBG96 Calenday 489768 -
1/0 moduls 34 Mcode rly-2 M2@E96 489995
CH1 Starion 15
CHZ Station 15 Link Coil 1 D11024 MC linkRegl 409842 -
Link Ceil 2 D21824 914
Refersnce : Link Reg 1 R11@24 MC linkReg2 489915 -
Coil 288192 Link Reg 2 R21824 409987
Input Relay 1@1824
Input Reg 308512
Hoid Reg 409999
Const Reg 6
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2} A submenu will be displayed. Select Reference and press the Enter Key.

Main Overview Map Settings Quit
[P ——F2————F3———F Leyv Vgl
PLC System Configuration
PLC Special Reg|rloadar
PLC type GL12@ WC coil-1 10256 Bat coil
ExscPack 28 MC coil-2  %20256
Uzer Logic 16 X MC cntcolll QlB16 C swaep
State RaN 32K MC enteoil? Q20168
Segment Mo 1 nC relay-1 X18256 Hzpesad zcan 489997
Motion 2 Moduls nC relay-2 X28256 Timer Reg 489996
Link 2 HNodule MC centrly-1 P18256 Step Relay 402001 -
nC entrly-2 P2B256 492032
10 Hcods rly-1 M1BE96 Calendar 499988 —
1/0 module 34 Meode rly—2 M20096 489995
CH1 Statien 15 - :
CH2 Statien 15 Link Coil 1 Dii1g24 MC linkRegl 409842 -
Link Coil 2 D21@24 409914
Reference & Link Reg 1 Ri1924 MC linkReg2 409915 - .
Coil 288192 Link Reg 2 R21@24 . 429987
Input Relay 1@1824
Input Reg 380512 f
Heo Reg 489999
Const Rey - 6

+

3) A selection menu will be displayed. Select Alphabet.

in Overvieu Map Settings m Quit
h;—!'z P Too
PIC System Configuration HnFn
: Sg:chl Rey Plam‘l,er
PLC type GL128 WC coil-1 ¥1@256 coil ference
ExccPack - 20 NC coil-2  v2e25 [
User Logic 16 K MC cntcoill Q1B160 C zweep | Alphabet | }nlmn
State RAM 32 NC cntcoilZ Q28166
Segment No 1 II! rehy-l X1@256 Hzpeed scan 489997
Motion 2 Module X28256 Timer Reg 489995
ink 2 Moduls N entr{y-i P10256 Step Relay 402081 -
nC entrly-2 P28256 . 482832
I = Fcode rly-1 MLBB96 C-alenlhr mesi -
I70 module 34 Hcode rly-2 N290956 995
CH1 Station 15
CH2 Station 15 Link Coil 1 biim24 NC lLinkRegl ﬂ?sﬁ =
Link Coil 2 D21624 48991
ﬂeference H Link Rey 1 Ri1G24 MC linkReg2 489915 -
Cail 228192 Link Reg 2 R21624 409987
Joput Relay 121824
lnr‘:ll: Reg 388512
Ha Reg 499999
Const lle' 784896

The reference number display on the system cohfiguration screen or a ladder program
screen will be switched to alphabetic display.
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PL.C Operations

This chapter describes PLC operations such as starting and stopping
~ the PLC, and sweep setting operations.

6.1 Overview of PLC Operations ............. . 62
6.2 PLC Start/Stop ..... Ceesenesenataataennn . 65
621  PLOSHM .....oootttiiieeii i, 6-5
622  PLCSIOP ..oviiiiii ittt 6-6

6.3 SweepOperation ..........o0vvvvvennenn.. 6-8

631 SingleSweep ... .. 6-8
6.3.2  High-speed SingleSweep ....................... 6-10
633 ConstantSweep .............ceiiiiiiiiaa.... 6-12

6.4 State Display Change ..................... 6-14
64.1  State DisplayMode ........................ ... 6-14
642  Changing to State Flow ........ e 6-15

6.5 ProgramClear ..............cvvvvvvenne. 617

6-6 SettingCIOCk-............--............. 6'19
6.6.1  Setting the Personal Computer Hardware Clock . . .. .. 6-19

6.6.2  Setting the PLC Hardware Clock .................. 6-20
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6.1 Overview of PLC Operations

This section describes the PLC Operation Menu. See section 6.2 PLC Start/Stop and
subsequent sections for each operation procedure.

H

The PLC Operation Menu is used to start and stop PLC operation and to set operating param-
eters forthe PLC, such as the sweep operation. The following items are available. This menu
cannot be displayed in Offline Mode. .

1

1) Start

Start is used to start the PLC. Ifthe PLC is a!ready in RUN State, this item cannot be se-
lected. :

2) Stop
Stop is usedto stopthe PLC. lithe PLC is already} stopped, this item cannot be selected.
3) Sweep

Sweep enables the sweep operations. The folloWing three sweep operations are avail-
able. Only Constant Sweep can be selected while the PLC is stopped.

» Single Sweep: PLC is operated for one scian only.
« HS Single Sweep: A high-speed scan is opergted for one scan only.
¢ Constant Swéep: The scan time is fixed to the specified period.
4) Staté Display
The ladder program state display method can be set.
* Power ﬂovy
« State flow
* No flow
5) PRG Ciear

PRG Clear is used to clear the ladder programs that are stored in PLC. This item cannot
be selected when the PLC is in RUN State.
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6) Set Clock

The data of the calendar in the personal computer is written to the calendar of PLC. This
item cannot be selected when the PLC is stopped.

The PLC Operation Menu can be selected when any of the following screens are displayed.
However, the items that are displayed varies according to the display screen.

» System Configuration Display
» Start
* Stop
» Set Clock
* Segment List/Segment State Displa.y
e Stant
» Stop
» Sweep
» State Display
* PRG Clear
. » Set Clock
* Ladder Program Display
o Start
* Stop
* Sweep
» State Display
» Reference Data Display
s Start
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s Stop

» Sweep

« State Display
The folléwing items cannot be selected when the PL:C is in any of the specified states.
+ PLC in STOP State ’

» Stop

* Sweep methods other than a Constant Sweep!

» Set Clock
* PLC in RUN State

s Start

* PRG Clear
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m

6.2 PLC Start/Stop

ﬂ This section describes how to start and stop the PLC from MEMOSOFT.

B.21  PLO Star ... 6-5
6.22 PLC Stop

6.2.1 PLC Start

Use the following procedure to start the PLC from MEMOSOFT. In the following example, the
GL120 is used.,

1) Switch to the menu cursor using the Tab Key.

2) Select Start from the PLC Operation Menu using the Cursor Keys and press the Enter

Key.
k;in [P Commands Edit Tools Quit
—_— rat isn~— f4—P —— Pl e 3 - pvs
t1d 3

Etop SEGMENT STATUS DISPLAY Pree : 16351
rSweep

==|ritate Pizplay

$¢| PRG Cle Scgment Network Segmant HNetwork

-;— vEet Cloc

Press <ENIER> to view the celacted segment

3} A confirmation message will be displayed. Enter Y and press the Enter Key.

ftain  PLC Ope Commands Edit Tools  Quir
[F1. —PLC ration— F4————P5 ———ff ————F 7= -Emzl’?
sed =
top SEGMENT STATUS DISFLAY Fres = 16351
rEweep

== {rState Dizplay

Se{ FRG Clear Segment MNetwork Scgment MNetwork

—i#Set Clock

[ B

$TART CONIROLLER? (¥~/M> ¥

Prosa <ENTER> to viow the sclccted segnent
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PLC Operation

6.2.2 PLC Stop

4} The following control status information will be displayed. Verify that the status inthe top-
right hand corner is displayed as Running. Press the Esc Key or the Enter Key to go back
to the original screen. '

CONTROLLFR STATUS INFORMATION.
SYSTEM REGISTER :

PC ADDRESS BTRY COIL 888192 EXEC ID 88F@ REV nie®
FC TYPE G128 TRIUS Running
RY 48, CONST SWEEP 409998 - IN CRY

USABLE MEMORY 16351 409999 SIOP CODE

WO OF SEGHMENT 1 HS SCANTIME 489997 MEMORY FPROYIECT ]
MOTION 2 MODULE TIMER REG 4B9996 CONST SWEEP N
LINK 2 MODULE STEP RELAY %935 BATTERY OX ¥y
RANGE = CALENDER 499988 —

COIL 192 499995

INPUT RELAY 101824 /0 =

INPUT REG 308512 NO OF [0 MODULE 34
HOLDING REG 489999 REMOTE =

CONST REG 784896 NO OF 1 REM SIRT 1S
L COIL -1 Diigz4 NO OF 2 REM SIATI 15
L COIL -2 D2ig24

G -1 16024
L REG -2 R21824
Pregs (PODH> for 1.0 Status; <Enter> o» <{ESC> teo exit

6.2.2 PLC Stop
The PLC can be stopped from MEMOSOFT by the following operations:

1) Switch to the menu cursor using the Tab Key.

2} Select Stop from the PLC Operation Menu using the Cursor Keys and press the Enter

Key.
h;in Commands Edit : Tonls  Quit
ration— PQ—PS—PG—P'?-W—PB—EB—H—i
wStart [T H 29
) SEGMENT STATUS DISPLAY . Free : 16351
weep
=={rState Display
Se |{6PRG Clear Segment MNetwork Segment  HNetwork
——] Set Clock

9 por rrocrANES

Prexs (ENTER)> to view the selected segment

3) A confirmation message will be displayed. Enter Y and press the Enter Key.

Main PLC Ops Commands Edit Toals Quit
[F1———r—PLC Operation— F4——F5——F6———F7- B0 PO -—F9-]
wStart Used = 29
SEGMENT STATUS DISPLAY Pres : 16351
riuaap
=—=|PrState Display
$8 |9FRG Clear Segment Network Segment MNetwork
Set Clock

m
T o1 PRocRAMIES

STOP CONTROLLER? (Y~/MD ]

Pross <ENTER” to view the selected segment
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: 6.2 PLC Start/Stop
e ——————— T .

The PLC will stop.

}hin PLC Ope Commands Edit Tools Quit
’1—~—F2—F3—-——-F1—F5—-—F6'—F?-im—l_’a—m—zl?9-§[-—

Used
SEGNENT STRTUS DISPLAY Free = 16351

Scymant HNetwork Segment  Network Segment Hetwork
H MNOT PROGRAMMED
Eﬂ] 1 -2

NOT PROGRAMMED

Press {ENTER> to visw the selected cegment
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PLC Operation
6.3.1 Single Sweep

6.3 Sweep Operation

I This section describes PLC sweep operations such as Single Sweep and Constant

Sweep.
B.3.1 Single SWeep ... ... i e e 6-8
6.3.2 High-speed Single Sweep ............... e 6-10

6.3.3 Constant Sweep

6.3.1 Single Sweep
Use the Single Sweep operation for debugging ofdinary segments. If Single Sweep is
executed while the PLC is in RUN State, normal segments will be executed for each scan. ¥O

services and ladder program solving are executed for one scan. This operation ¢an be se-
lected only when the PLC is in RUN State. '

1) Switch to the menu cursor using the Tab Key.

2) Select Sweep from the PLC Operation Menu usiﬁg the Cursor Keys and press the Enter

Key.

Pain Elemants Edit  GoSrch Network Ref Tools  Quit
it ration—) Paom-——F5———P6——F7-EMA-Fe-L—F7-
Seg.l01 [tStart

? S - .

- ritat —
ﬁi- = “’_” 50_800812
T

l Reference Pata

Format :Decimal PLC Data ge : 1

3) A submenu will be displayed. Select Single Sweep using the Cursor Keys and press the
Enter Key.

in AV Elements Edit GosSrch Metwork Ref Tools Quit
= —PL{ Operation— P4———F5—————FP6———F7- TN} P&~ I—F -
Seg. LBl |#Ecart
r Stos ——Suee
s |rState Ditplay Single Sweep
@1 Constant Sweep
=l

m—

l Raference Data r
Format :Decimal PLC Data Lg' =1
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6.3 Sweep Operation

4) The minimum scan time setting screen will be displayed. Enter a minimum scan time (100
in this example} within the specified range.

k;in PLC Ope Elsments Edit Go/Srch MNetwork Ref Tools Quit
LC Openthn—ll"l—?s-—-—-?s——l’? -

lﬂe:.m wEtart

Sto ———=Swee
E— rState Eisp!y HS Single Sweep
1' { Constant Swesp

Refarance Data:

Farmat :Decimal PLC Data Range = 1

5) The PLC wili stop and a single sweep can be executed. Press the F9 Key while holding
down the Ctrl Key to execute normal segments for one scan.

in PLC Ope Element: Fdit GosSrch Network BRef Tools Quit
——p2 F3———F 7 NG
|$.:g.l-8'.l. 2s2 MWETWORK SKIFPED
29081

weep Mo. @ Presz <Ctrl P¥> for next Swesp. {Ctrl F18> to end Sweeps

eI erence &

Format :Decimal PLC Data ge = 1

+

CTRL +

Runs PL.C for one scan only.

Ends the Single Sweep Mode.

Minimum Scan Time

The minimum scan time is the period that is temporarily set as the execution period for one
scan. When timers are used in a ladder program, execution is performed as if timer counts

up consecutively for this setting. Set a value close to the actual scan time. The value canbe
set in 10 ms units only,

—_—69 —



PLC Operation
6.3.2 High-speed Single Sweep

6.3.2 High-speed Single Sweep

Use the High-speed Single Sweep function for debugging high-speed segment. By executing
high-speed single sweeps while the PLC is in RUN State, high-speed segment can be
executed for each scan. /O services and ladder program solving are executed for one scan.
Normal segments are not solved. This operation can be selected only when the PLC is in
RUN State. ;

1) Switch to the menu cursor using the Tab Key.

2) Select Sweep from the PL.C Operaticn Menu usirig the Cursor Keys and press the Enter
Key.

in Elements Edit Go-Srch Network Ref Tools Quit
Operation— P4——p5— — po——P7- WO PE-——F9—]
Se:.LBl pEtart
r Sto ;;’
s jrState Dic —
B L m 3_oodel?
]

Reference Data:

IFDPI.t :Decimal PLC Data ge - 1

3} A submenu will be displayed. Select HS Single Siveep using the Cursor Keys and press
the Enter Key.

Elements llgdit GosSrch Metwork Ref Tools Quit

T
LC Operation
Seg. .18l |aStart _l
Sto e e
T S inqle Suce
pag |FEcace Display W
1 nstant Sweep
=]
_ 2

—

Reference Pata

Pormat :Decimal PLC Data Range : 1
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6.3 Sweep Operation

4) The minimum scan time setting screen will be displayed. Enter a minimum scan time {10
in this example) within the specified range and press the Enter Key.

lll-:in Element: Edit Go/Srch Hetwork Ref Tonls Quit
ntion—ll'i——l?s-'—-—l’s——l’?—m—?ﬂ-m}—?‘)

—&ue
Binﬁle S\maE
nstant Sweep

Paf, ~a Dat:
roterence Pata

ll‘orﬂat :Decimal FLC Data ge : 1

5) The PLC will stop and single sweeps can be executed. Press the Ctrl + F9 Keys to
execute ordinary segments for one scan.

in ?1C Ops Element: Edit GosSrch MNetwork Ref Ioels Quit
—p———F3———P———P5———F% —
Seg.Lit 82 / 2 s NETVO! SKI

T . =

280019 90081 1
—1/ 18.1 - y—
888211 180864 BBeA12

/ —JUCTR |-

p No. B Press <Ctrl F?> for next Swcep. <Ctrl F1@> to end Suecps
Reforence Data

Format :Decimal FIC Data Range = 1

Runs PLC for one scan only.

.

Ends the High-speed Single Sweep Mode.

’ Minimum Scan Time

The minimum scan time is the period that is temporarily set as the execution period for one
scan. When timers are used in a ladder program, execution is performed as if timer counts
up time consecutively for this setting. Set a value close to the actual scan time. The value
can be set in 10 ms units only.
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6.3.3 Constant Sweep

6.3.3 Constant Sweep

The Constant Sweep function enables operation with a constant scan time by setting a target
value for the scan period. The target value must be greater than the actual scan time within
the range from 10 to 200 ms in 10 ms units. Constant sweep operation uses the following two
registers.

409998: Target value that was set
409999: Time required for actual scan processing
{Unit: ms, however, the value changes every 10 ms)

The registers to be used can be changed using the system configuration screen. See chap-
ter 7 Setting Systern Configuration for detalils.

1) Switch to the menu cursor using the Tab Key.

2) Select Sweep from the PLC Operation Menu using the Cursor Keys and press the Enter

Key.
in Elements Edit Go/Srch MNetwork Ref Tools . Quit
Operatiesn— F4———F5 ————F6——F 7 IM-F3 -3 —FY
$eog. L1 ‘sgzﬂ —
I M 11
Ema|Fitate Display —
|z 0. 000812

[ ——UCTR
2 400002

Reference Data

lFm--m: :Decimal PLC Data Range = 1

3) A submenu will be displayed. Select Constant Sweep using the Cursor Keys and press
the Enter Key.

h:il’l g Element: Edit GosSrch Hetwork Ref Tools Quit
Operat ion-—-] F&———F5————F6————F7- - Fe -0 ——F9
S-:.LBI ﬂég:rt .
o YR
E1= FStats Dicplay| HS ginﬁlo S:-ai

;——ﬁm

Reference Data: q

IFomt :Decimal PLC Data ge = 1
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6.3 Sweep Operation

4) Enter a scan time (50 in this example) set value and press the Enter Key.

fMain  FLC Ops Elements Edit Co/Srch Metwork Rof Tool:  Quit
i — P pg———P7 = ;

F% L1 ‘tlrgwngmn F4
B .
M ingle Swep
- tate Dizplayf NS :I.I'lile Sueei

Baf .
HOLSrENCE Datd

Iant :Decinal PLC Data g : 1

5) The constant sweep status will be displayed. Press the Enter Key.

k;i.n PLC Ope Elsments Edit Ga/Srch Hetwork Ref Tools Quit
P4——— P ———F———P7-{EW}-F5 - -

Sog Lol [ebrareys 1"

Y ..

h Sto woep————

— TR

Ei= FState Display| HS i.nﬁh Sm.i
—

[ A 2106082

F

—Hef s Data

- Format :Decimal PLC Bata lmn 1

Olmiilb 1) If the target value that was set is less than the actual scan time, the target value will be
ignored.

2) To cancel Constant Sweep operation, select Constant Sweep again. Constant sweeps
can also be set or canceled on the segment scheduler screen of the system configura-
tion. See chapter 7 Setting System Configuration for details.

3) When both the Constant Sweep and Single Sweep operations are selected at the same
time, Single Sweep operation is performed. When Single Sweep operation ends, Cons-
tant Sweep operation is performed.
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6.4.1 State Display Mode

6.4 State Display Change

This section describes changing the operations of state display modes, such as Power
Flow and State Flow Modes.

641 StateDisplayMode ...... ...t it et
6.4.2 Changing to State Flow

6.4.1 State Display Mode

The following three types of state display are avallable for monitoring ladder programs on
MEMOSOFT. ~

* Power Flow Display

This mode is set at PLC initialization. The section up to the point at which power is con-
ducted from the power rails is highlighted on the display.

s State Flow Display

All the contacts in the ON state are highlighted on the display regardiess of power flow
from the power rails. This display is useful for testing operation.

» No Flow Display
ON/OFF displays for contacts are not periormeci.

The dlfferences between Power Flow and State Flow are shown below. The coil statuses are
as follows;

Reference Status Reference Status
000128 OFF 000130 OFF
000129 ON 000131 ON
* Power Flow
] || /
| 1 { —
poolze 000131 000132

ooo129

I_

00013¢C
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6.4 State Display Change

m

« State Flow

)'_

000128 000131 Q00132

000129 000130

The Power Flow Display is very useful for debugging. The scan time, however, will increase
slightly in comparison 1o that of the State Flow Display or No Flow Display. Select State Flow
Display to keep the scan time from fluctuating excessively.

6.4.2 Changing to State Flow

Atinitialization, the state display is set to the Power Flow Display. This section shows how to
change to the State Flow Display using an example.

1) Switch to the menu cursor using the Tab Key.

2) Select State Display from the PLC Operation Menu using the Cursor Keys and press the

Enter Key.
in THTT Elementz Edit GosSrch  Natwark Ref Tools Quit
1< Oporat ion— F4—— o —F§ 2
SQI.LBI. Mtart
Stop y—
= PSU&GE 11 3
L I-mni- 2
- -
OBOOLT 400067
Ref ze Data
Fermat :Decimal FLC Data Range = 1

3) A submenu will be displayed. Select State Flow using the Cursor Keys and press the
Enter Key.

Go/Sxrch MNetwork Ref Tools Quit
m——pg—————17 -

-—IF I kE-F8: I~
-

tate Ditpla

oPovar Flew

No Fgcu

Format :Decimal PLC Data ge = 1

—6-15 —



PLC Operation
6.4.2 Changing to State Flow cont.

The ladder program state display will be changéd to State Flow.

in FIC Spon Floments Eate GosErch MNetwork Ref Igols  Quit

3 PP P8 -3 ———F9
ISc Lol %2 /2 ’ “
i 300918 |m11
Iu.1 —] >—

@ B00a1 —00060 000012

Baf, ~a B
refarence Pata

Format :Deciaal PLC Data ge : 1

OII!EID When display is changed to State Flow, “State” will be displayed between F2 and F3 on the
second line from the top of the screen.
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6.5 Program Clear
e

6.5 Program Clear

I This section describes the Program Clear operation for ladder programs.

Use this operation to clear the contents of ladder programs and various registers that are
stored in the internal memory of the PLC. This operation cannot be selected unless the PLC is

stopped. Utmost care is necessary in this operation since the operation clears data from the
PLC.

1) Switch to the menu cursor using the Tab Key.

2) Select PRG Clear (Program clear) from the PLC Operation Menu using the Cursor Keys
and press the Enter Key.

IH.I:I,n Commands Edit Tools Quit
[F1 Fat jon e P4———— G 5, - =3
Start T H 29
wgtop SEGHENT SIATUS DISPLAY Free = 16351
FSweep
==|rEtate Dizpla:
Se m#l Segment Network Sagment Network
———|oSst Cloc
& 12

- NOT PROGRAMMED

Pross <{ENTER> to vicw tho selected sogment

3) A confirmation message will be displayed. Enter Y and press the Enter Key.

hnin PLC Ope Commands Edit Tools Quit
F1————F2———FI————— P4 P5——¢ I - =
e H
SEGNENT STATUS DISPLAY Free = 16351
Segment Network Seg N k Seg Network
NOT PROGRAMMED
1 -2
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The ladder programs and register data will be cleared.

b;in PLC Ope Commands Edit - Tools Quit
2 F3 F4 —FS 6 P’.'—Cu —m—l”1
sed =
SEGMENY SIARTUS DISPLAY Pree = 16379
Segment  Network

Segmont Network Segment HNetwork

NOT FROGRAHMED
NOT FROGMMIED
s NOT PROGRAMMED

Fress <ENTER> to viev the :-hctéd segment

WLanFo >

This function can be selected from the Segment Status Display or Segment List Display
Screen.
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6.6 Setting Clock
m

6.6 Setting Clock

This section describes the procedure for setting the calendar built into the PLC from the
calendar data of a personal computer.

6.6.1  Setting the Personal Computer Hardware CIOcK .........vvueeeennn.. 6-19
6.6.2 Setting the PLC Hardware Clock

6.6.1 Setting the Personal Computer Hardware Clock

This operation enables the calendar data in the personal computer to be stored in the hard-
ware clock of the PLC. Therefore, it is necessary to set the clock in the personal computer

accurately using the following procedure. If the clock has been accurately set beforehand, itis
not necessary to set it again.

1) To set the date, enter DATE and press the Enter Key.

C:>DATE

2) The date which is currently set will be displayed. In the following example the new date is
1 April, 1997. To enter the new date, enter 04-01-97 and press the Enter Key.

C:>DATE
Current date is Mon 03-31-1997
Enter new date (mm-dd-vyv):04-01-97

The date setting is now complete.

3) Next, set the time. Enter TIME and press the Enter Key.

C:>TIME

4) The time which is currently set will be displayed. In the following example the new time is
1:20 pm. To enter the new time, enter 13:20:00 and press the Enter Key.

C:>TIME
Current time is 8:38:30.95p
Enter new time:13:20:00

The time setting is now complete.
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6.6.2 Setting the PLC Hardware Clock

6.6.2 Setting the PLC Hardware Clock

The PLC hardware clock is setwhen the PLC is in RUN State. If the PLC is stopped, start the
PLC.

1) Switch to the menu cursor using the Tab Key.

2) Select Set Clock from the PLC Operation Menu using the Cursor Keys and press the

Enter Key.
h;i.n [P Commands Edit . Tools Quit
ration—P4———P5———FPc————— -1V} P8 -]

sStart y Used = 29
Stop SEGMENT STATUS DISPLAY Fres : 16351
rSussp N

——|»Stats Display

Se |aFRG Clae. Segment MNetwork Ssgment HNetwork

AT
H

2 w1 rRocRwIES

Press (ENTER> to view the :aln::ta{d segment

3) The Set PLC Clock Screen will be displayed. Venfy the calendar data of the personal
computer and press the Enter Key.

FLC Commands Edit Tools  Quit
]&—HLH—FQ—SH PLC CLOCKS——F7- RN} P8 -30—-F9

PLC

TEME: 19:17:37
DATE: 9A-A1-19

| Urite PANEL :lnr;k data to PLC? (¥Y/MN) K| i

OIKED Directly Inputting the PLC Hardware Clock Settings

When the Write PANEL clock data to PLC? (Y/N) message appears, select N to directly
input the PLC time and date settings from the keyboard.
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6.6 Setting Clock

------II-l-I-III--III-I.------.III-l--lI.l--II-l-------------.---.----III--I

4) The calendar data of the personal computer will be stored in the PLC. Press the Esc Key
or the Enter Key to reset to normal operation.

fHain
[F1

PLC Commands Edit Yool Quit
0 fmends B2 SH PLC cLoCKs— - he

PANEL

Ting: TETEIT
DATE: e st

PANEL clocck data has been written tg PLC ’
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Setting System Configuration

This chapter describes setting the system configuration and settings,
and how to set constant sweep operation.

7.1 Setting the System Overview Table .......... 7-2

711 Settingthe PLCType ....oovvevvie e, 7-2
7.1.2  Seiting Reference Ranges ....................... 7-3
7.1.3  Setting System Registers ........................ 7-5
714  Setting Segments ..............00iiint .., 7-6
715 Settingl/OModules ............................ 7-7
7.16  Setting MotionModules ,....................... 7-8
7.1.7  Setting PCLink Modules . ....................... 7-9
7.1.8  Table Initialization ............................. 7-10

72 TTOMaps vovviiiiiiiinrnnnrennnnnnnness T-11

721 BasicMaps............ . i 7-11
722  Switching FOMap Screens ...................... 7-16
723 ModuleZoom.............. .. i, 7-18
7.24  1/O Service Setting Operation .......... e 7-22

703 Other Mappillg Opel'ations L N T ) 7-23
730 PCLIBKMap .....ooovneneeenenee oo 7-23
732 ASCHMEp . ... .oueeeensnnresn e 73

7.4 Other Setting Operations .................. 7-32

74.1  Setting Communications Parameters . .............. 7-32
742  SettingConstant Sweep ................ovvnn. .. 7-34
743  SettingSegments .. ................ 0. a.... 7-36
744  Setting MC10 Parameters ....................... 7-43
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Setting System Configuration
L
7.1.1 Setting the PLC Type

7.1 Setting the System Overview Table

This section describes how to set the system overview table to select the type of PL.C
and other seftings.

711 Seftingthe PLCType ......ooiviii i 72
7.1.2 SeftingReference Ranges ..............iiiiiiiiiiiireirainennn 7-3
7.1.3 SettingSystemBegisters ............. ... 7-5
7.1.4 SettingSegments......................; ......................... 7-6
715 Settingl/OModules ... . ..oiiiiiiiii i i i it it 7-7
716 SettingMotionModules ... ... ... i i, 7-8
7.1.7 SettingPCLinkModules ............ovviivinnnnn e 79
7.1.8 Table Initialization ....... ... ... i i i 7-10

7.1.1 Setting the PLC Type

MEMOSOFT is a programming tool that supports a number of PLCs, such as the MEMOCON
GL120 and GL130. Therefore, when a new program is developed, the PLC must be set. The
GL120 is set by default. An example of setting to the GL130 is shown below.

1) Select PLC Type from the Overview Menu in the PLC System Configuration Screen us-
ing the Cursor Keys and press the Enter Key.

in Map Settings . Tools Quit
F2 omhv o 7P - —FY
: nfiguration
ges
PLC = System Registers Special Reg
PLC type G| Se nts Yie256 t coil msuz
ExwcPack ‘2] I ¥28256
User Logic 1] MHotiom 11 Q18168 c TWesp 499998 -
State RRM 3] PC Link 12 Q28168 . 429999
Segment No 1] Reset Default 1 X1B256 Hipeed scan 42399397
Motion 2 2  R28256 Timer Reg 489996
Link 2 HModule MC cntrly-1 PF10256 Step Relay 422081 -
MC cntrly-2 P28256 482832
I : Hcode »ly-1 MLBB96 Calendar 429988 -
10 module 34 NMcode rly-2 M20996 489995
CH1 Station 15 .
CHZ Statiom 15 Link Coil 1 Di1B824 #MC linkRegi 489842 -
Link Coil 2 D21824 487914
Reference = Link Reg 1 R11824 MC linkReg2 489915 -~
Coil 38192 Link Reg 2 R21624 429997
ln:r,lﬂ: thy 101824
ﬁt Reg 98512
489999
(hnst Reg 794996

2) The PLC type selection window will be displayed. Setect GL130 using the Cursor Keys
and press the Enter Key.

g;in Dvarvisw Map Ssttings Tools Quit
P2—F3 74 PS5 3 F7- T FR- U —FY
PLC System Configuration B
PIP‘?.C : gm s%:cnlil aaa192
cype t o |
ExscPack ] :
User Logic 16 X P10 C swesp 489998 -
Stats RAM 32K Mc cntcni.‘lz qQZR169 499999
Segmant No 1 MG relay-1l X18256 Hapeed zcan 489997
Marion 2 Module MG relay-2 X28256 TIimer Reg 40899%6
Link 2 Moduls MG cntriv-1 PIB2SE  Step Rolay 46288] —
MG cntrly-2 P28256 402032
0 = Ncode riy-1 M1PA96 Calendar - 409988 -
170 module 34 Ncode rly-2 M28896 4189995
CHE Station 15
CH2 Statien pL3 Link Coil 1 D11824 HC lmldlegl 489842 —
Link Coil 2 D21B24 409914
Reference = Link Reg 1 Rii@24 MC linkReg2 489915 -
Coil 208192 Link Reg 2 R21024 493987
Input l\chy jgiez4
Tlt 3008512
409999
Cnnst Heg 724296
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7.1 Setting the System Overview Table

The PLC type will be set to the GL130.

7.1.2 Setting Reference Ranges

The range of usable reference numbers is initialized according to the type of PLC. These
numbers can be set freely from MEMOSOFT within the memory range of the PLC used. For
instance, to develop a program that requires a large number of holding registers, extra regis-
ters can be moved from constant registers. Usually, the default reference ranges are suffi-

cient for developing programs. Therefore, change the ranges only when registers are insuffi-
cient.

The following examples show the operations used to move holding resisters from the:
constant registers.

1) Select Ranges from the Overview Menu using the Cursor Keys and press the Enter Key.

an

mng.mi Settings Tools Quit

E af iguration
FIC : ystca Registers SEchl H
PLC type G /S-n 3 ¥18256 t coil 888192
ExecFack 3 ¥20256
User Logic 3| Wotion 11 Q16 C zueep 499998 -
State RN 3| PC Link 12 Q208160 489
Sls—nt No 1| Pesct Default 1 X18256 Hizpeced_acan 489997
Motion 2 X28256 Timer Ray 18’”5
Link 2 HNedule MC entrly-1 P18256 Step Relay -
NC cntrly-2 P20256 402!32
s Mcode rly—1 NLOBYE Calendar 409988 -
1/0 wodule 34 Hcode rly-2 M20896 409995
CH1 Station 15
CH2 Station 15 Link Coil 1 DLim24 HC linkReg: 409842 ~
Link Coil 2 D21W24 14
Refercnce = Link Rog 1 Ri1924 MC linkReg2 489915 -
Coil oBg1Y2 Link Reg 2 R21824 429987
Input Relay 181924
Inﬁt Rey JoRsiz
Hold Rey 489992
Const Reg 70429

2) The cursor will move to the reference range position. Move the cursor to the Hold Reg
(Holding Register) position using the Cursor Keys.

in Overviow Map Settings Tools Quit
k: 2 F3 P4 PS F6 —i——¥y
PLC System Configupation
PLC : sBehl H
PLC type GL138 HC coil-1 ¥10256 t cuil 2eyiy2
ExwecPack 38 NC coil-2  Y2B256
User Logic 32 X BC cntcoill Q1B168 C sweop 409798 -
State RAM 2K NG cntcoll2 Q20168 409929
Segment Mo 1 NC relay—-1 X18256 Hspaed zcan 489997
Motilon 2 Module HC relay—2 X20256 Timer Rey 489996
Link 2 Module MC catrly-1 P10O256 Step Relay 482081 -
MC entrly-2 P202%6 4182932
10 : Mcode »ly—1 M183%6 Calsndar 489988 -
170 module 34 Hcode »ly-2 M20896 489995
CH1 Station 15
CHZ Station 15 Link Coil 1 D11924 MC 1inkRegl 409842 -
Link Coil 2 D21024 914
Reference 3 Link Reg 1 Ri11824 MC linkReg2 489915 -
Coil 208192 Link Reg 2 R21824 489987
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Setting System Configuration

7.1.2 Setting Reference Ranges cont.

3) Setthe number of holding registers. The foIIowiﬁg example will increase the number by

+

11 registers to 10010. Enter 10010 and press the Enter Key.

Too Quit
IE—¥F7?

h‘.in Overview Map Settings
1 —F2——F3 —P4 5 F6
PLC System Configuration
PLC type GL138 MC ceil-1  ¥1B256
ExecPack 28 MG ceil-2  Y2@256
User Logic 32 K MC cntcoill Q1816
State RAM 32 K MC cntcoilZ 028160
Segment Mo 1 MC relay-1  X18256
Fotion 2 Hodule HC relay-2  X20256
Link 2 Module MC cntrly-1 P18256
MG cntrly—2 P2E256
7 = Mcode rly—1 8896
_ [/0 module - 34 Mcode rly-2 M280%6
CH1 Station 15
CHZ Station 1% Link Coil 1 Mig24
Link Coil 2 D21824
Reference : Link Reg 1 R11824
il 288172 Link Reg 2 R21824
Input Relay 181824
lnf‘t Rey Inesi2
Hold Rey
Const Reg [3
1 - 19854

7~ F9-

Special Reg =
g:t coil 2888192
489998 -
4839299
Bspesd scan 489997
Timer Reg 409996
Step Relay 402081 -
- 492032
Calendar 499988 -
: 499995
H -
MG linkRegl 409842 -

407914
MC 1inkReg2 409915 -
409947

c swesp

+

¢

4) The cursor will move to the constant registers after the holding registers have been in-
creased. This example is showing the movement of constant registers, so the number of
constantregisters is reduced by 11 registers from 4096 to 4085. Enter 4085 and press the

Enter Key.
hin Oveyuicw Hap Settings 7 Tools Quit
—t2 —F e P e 7T} PR T —
PLC Syztoem Configuration

PLC = Special Reg :
PLC type GL139 W coil-1 ¥Y10256 t coil ou8192
ExswcPack e e coil-2  Y28256
User logic 32 X MG catceill Qi@EE C sweep 409998 -
State RAM 32K MC catceil2 Q28168 . 409999
Segment Mo 1 HC relay-i  X10256 Hspeed zcan 489997
Motion 2 Hodule MG relay-2 X28256 Timer Rey 409995
Link 2 HModule NG cntrlp-1 P18256 Step Relay 482881 -

AC cntrly-2 P28255 492832
10 = Mcode rly-1 M188%6 Calendar 489938 -
170 module 34 Mcode rly—2 M2BB96 489995
CHL Statien 15
CH2 Station 15 Link Coil 1 DP11824 MC linkRegi 489342 -
Link Coil 2 D21624 14
Reference = Link Reg 1 R11824 MG linkReg2 489915 -
Coil 28192 Link Rey 2 R21@24 . 403987
Input Relay 1P1924 +
lnﬁt Reg Jeas12
iler xmd
nst
1 — 409

The reference ranges will be changed. If the data that was entered exceeds the setting
range, the value will be reset to original value.

The reference ranges that can be set vary according to the PLC type and model, See the re-
lated PLC user’s manual for details.
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7.1 Setting the System Overview Table

7.1.3 Setting System Registers

System coils and system registers, such as the battery coil and calendar, are assignedtospe-
cific reference numbers by default. To change these reference numbers, use the following
procedure.

1) Select System Registers from the Overview Menu using the Cursor Keys and press the

Enter Key.
in Map Settings Tools Quit
——p— ory ie: —Fe——F7-{I0IE-Fe -} —9
PLC type afiguration
Ranges
FLC : Sﬁchl Reg =
PLC type ] :Suents 18256 t coil 888192
ExscPack 3 I Y28256
Usey Logic 3| MWation 11 @168 C sweep 489998 -
State ] 3| PC Link 12 Q2@ieR 489999
Segment Mo 1| Reset Default 1 %18256 Hispesd_scan 487997
Motion 2 2 X2@256 Timer Reg 489996
Link 2 Module MC catrly-1 PLE2SE Step Relay 482081 -
MC entrly-2 P28256 482932
10 : Meode rly—1 M18896 Calendar 407988 -
170 module 34 Mcode rly-2 N20896 489995

CH1 Station 15
GHZ Station 15 Link Coil 1 Di1P24

MC linkRegl 409842 -
Link Goil 2 D21P24 489914

Refecrence Link Reg 1 Riip24 MG linkReg2 489915 -
Coil 208192 Link Reg 2 R21024 489987
Input Relay 101@24
Inﬁt Rey 308512
Hold Reg 4106219
Const Rex 704085

2) Change the reference number of the battery coil. In this example, enter 8190 and press
the Enter Key. If no change is necessary, move the cursor to the next position using the
Enter Key or the Cursor Keys.

in Overview Map Sattings Tools Quit
[Fl———F2 '3 P4 PS 6 7P -HNy-—F?
PLC Syztem Configuration
P : Special Rey =
PLC type GL138 MC coil-1 Y18256 B:l: coil B
ExacPack EL NG coil-2  Y2@25
User Logic 32 X WC entcoill Q18160 C sweep 4189978 -
State RAM 32 K NG entcoil2 Q20168 489999
Segment No 1 HC relay-1  X18256 Hapeed_scan 489997
Motion 2 Module MC relay-2 X26256 Timer Regy  4099%
Link 2 PModulas HC cntrly-1 P18256 Step Rolay 418288 -
MC entrly-2 P28256 482032
10 Hcode rly-1 Mi08%6 Calendar 4109788 —
1/0 module 34 Hcode rly-—2 H20896 489995
CH1 Btation 15
CH2 Station 15 Link Coil 1 D11B24 NC linkRegl 4089842 -
Link Coil 2 D21824 489914
Refarence Link Reg 1 R11824 MC linkReg2 499915 -
il 208192 Link Reg 2 R21B24 499987
Input Relay 1081824
Inﬂe Reg 300512
Ho Rey 419818
Const Rey 704085

3) Change other registers, such as the timer register, using the same procedure.
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7.1.4 Setting Segments

7.1.4 Setting Segments

IMPORTANT

Use this function to set the number of segments excluding the high-speed segment and sub-
routine segment. Set the number of normal segments within a range from 1 to 30.

4
1

1) Select Segments from the Overview Menu using the Cursor Keys and press the Enter
Key. '

in Ma; Settings Tao Quit
F: 2 T e L w-m-mmm—m—-——ll
g typo nfiguration
x ;

PLC = S g:n Registers Special Reg =
FLC type c;ﬁn_ v1E256 Bat coil - @28199
ExecPack 31 10 Y28256
Uzer Logic 3§ Motion 11 Q1Pi6| C tweap 499998 ~
State RAM 3} PC Link 12 [ + 489999
Segment Mo 1] Besot Default 1 X18256 Hspeed scan 487997
Hotion 2 2 ¥2@256 Timer Reg 489796
Link 2 Module NC cntrly-1 P18256 Step Relay 482081 -

NC cntrly-2 P2B256 * 482832

Hoode vly-1 MIBO%C
Mcode rly-2 M28896

Link Coil 1 D11P24
Link Coil 2 D21824
Link Reg 1 R11824

120 = Calendar 489988 -
1,0 module 34 493995
CH1 Station 15 ¢
CH2 Statien 15 MC linkRegl 489842 —
- 489714
MG linkReg? 489915 —

487987

L 888192 Link Reg 2 R21824
Input Relay 1061824
lng:t Rey 300512
Hold Rey 419919
Const Rey 704085 '

2) The cursor will move to the normal segment settiﬁg. In this example, enter 5 as the num-
ber of normal segments and press the Enter Key.

k;i.n uerviow Map Sottings : Too Quit
e ame ¥ PO L Pumm— | v AU e 3
PLC System Configuration
PIC : Spacial Reg @
PLC type Gla3a MC cofl-1 18256 Bat coil ess198
ExecPack e MC coil-2  Y¥28256
User Logic 32 K nC cnteoild Q1846 C sweep 409998 —
State RAM 32 K MC entenil? Q208168 - 489999
Scgment Ne ? MC relay-1l X18256 Hspeed zcan 489997
Motion Hodule MC relay-2 X20256 Timer Reg 409996
Link 2 Module MC cntrly-1 P1B256 Step Relay 402081 —
MG entrly-2 P20256 402832
170 : Mcode rly-1 M16G96 Calendar 489988 -
I/0 module 34 Mcode rly-2 M20836 402995
CH1 Station 15
CH2 Station 15 Link Coil 1 Dil1@24 HC linkRegl 409842 -
Link Coil 2 D21824 489914
Reference = Link Reg 1 1824 MC linkReg2 48991% -
Coil 88192 Link Reg 2 R21824 499287
Input Relay 1081824
Input Reg e8512 {
Hold Reg 410018
Const Reg 784885

If the number of normal segments is changed when a network is stored in the segments, the
network positions will shift. Therefore, this operation must not be performed after network
have been stored. :
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7.1 Setting the System Overview Table

7.1.5 Setting /O Modules

Setthe number of I/O Modules to be used. When using remote stations, also set the num-
ber of stations for each channel.

1) Select /O from the Overview Menu using the Cursor Keys and press the Enter Key.

Llli.n overy 1 culls™ Settings Tools Quit
i 2 Overvise 5 F7—{IEI-FB - DHE—
m type nf iguration .
ges
PLC System Registers Special Reg :
PLC type G| _Segments 718256 t coil 889198
ExecPack 3 ¥28256
User Logic 3§ Metion 11 Q19168 C sweep 487998 -
Stata RAM 3| PC Link 12 Qo168 487799
Segment No S| Rezat Default 1 X18256 Hspeed scan 429997
Hotion z X28256 Timer Reg 487776
Link 2 Module MG cntrly-1 PIO256 Step Relay 482881 -
MG cntrly-2 P20256 832
1,0 = Hcode rly-1 NiBBY6 Calendar 109988 -
1.0 module 34 ficode rly-2 M288%96 189995
CH1 $tatien 15
CH2 Statien 15 Link Coil 31 Di1824 HC linkReygl 409842 —
Link Coil 2 D21824
Refepence = Link Reg 1 Ri1824 nC linkReg2 409915 -
Coil oB8192 Link Reg 2 R21824 4897987
Input Relay . 181824
[nﬁt Rey 300512
Hold Reg 418018
Conzt Reg 4085

2) The cursor will move to the position for the number of /O Modules. Set the number of /O
Modules (50 in this example) using the Cursor Keys and press the Enter Key.

in Overview Map Settings Tools Quit
k!; P2———F3————F4———P ———F6—————F 7 Fo - D —F9
PLC System Configuration
PLC : Sg:cinl Reg ¢
FLC type GL139 MC coil-t  Y1B256 t coil egsi9e
ExecPack 38 MC coil-2 ¥20256
User Logic 32 X MC cntcoill Q1P168 C tweep 489998 -
State RAM 32k MC cntooil2 Q2B160 489999
Segment No 5 HC welay-1 XiB256 Hspeed scan 489997
Motion 2 Module HC relay-2 X20256 Timer Reg 48999
Link 2 Module HC catrly-1l P1R256 Step Relay 492881 -
MG cntrly-2 P2U256 482832
Ir0 = Ncode »ly-1 M1G896 Calendar 489988 -
[/0 module ? Heode »rly-2 M288B96 497995
CH1 Station 1
CH2 Station 15 Link Coil 1 D11824 MC linkRegl 409842 -
Link Coil 2 D21@24 409914
Reference : Link Reg 1 R11824 HC linkReg2 489915 -
Cail BO81Y2 Link Reg 2 R21824 409987
Input Relay 101824
lnﬁt Reg 388512
Hold Reg 4118218
Conzt Rey 704085

3) Set the number of channels for each station. When no changes are required, simply
press the Enter Key.

4

Ol]'!]ﬁ]) The setting of the number of I/0 Modules is not an absolute limit, i.e., the actual number of /O
Modules that can be allocated wilt be somewhat higher than the set value. The number of I/O
Modules can be changed only in Offine Mode. To change the program stored in the PLC,
save the program on the personal computer first, change the setting of the number of /O
Modules, and then reload the program from the personal computer to the PLC.

Allocations may become impossible in Online Mode if the set number of I/O Modules is too
small. If the set number of I/O Modules is too large, extra time will be required when loading
and saving programs. To prevent such problems, always set an appropriate number of /O
Modules.
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7.1.6 Setting Motion Modules !

7.1.6 Setting Motion Modules

Set the number of Motion Modules. The number is set to 2 by default.

1) Select Motion from the Overview Menu using the Cursor Keys and press the Enter Key.

[Main Ha Seteings oo Quic
Py —————p2———— ere inu——— ———P6————F7- TR PE-31T5—P2?
l;:'(.: type nfiguration I
Ranges .
PLC Syctea Registers Special Reg :
PLC type G| Segments 718256 t coil aas190
ExecPack 3§ 1 ¥28256 .
Uzer Logic 3 11 Q1816 C sweep 429998 -
State RAM 3 1, 12 Q29168 489999
Segment Mo 5| Rezet Default 1 X1@256 Hspeed scan 489997
Kotien 2 2 X2@m256 Timer Reg 489996
Link 2 HModule NC entrly-1 P18256 Step Relay 482001 -
MC catrly-2 P2U256 4@2832
1,0 Mcode rly—1 MLI9B76 Calendar 489988 -
L0 module 58 Mcode rly-2 M28896 489995
CH1L Station 15 -
CH2 Statien 15 Link Coil 1 Dlie24 MC linkRegl 489842 -
Link Coil 2 D21924 489714
Reference : Link Reg 1 El11824 MC linkReg2 489915 —
Coil . P8192 Link Reg 2 R21824 489987
Input Relay 181824 i
Input Reg 3512
Im?dl Reg 410818
Conzt Reg S

2} Select the number of Motion Modules to be use:d (1 in this example) using the Cursor
Keys, and press the Enter Key.

hi.n Ouervieu Hap Settings R Tools Quit
B e 7 — L b e i3 ~—ry
FLC System Confisuration
PLC : Special Reg :
PLC typs GL138 Bat coil sgs19e
ExecPack 30
Usey Logic 32 K C sweep 429998 -
State M 2K 489999
Ssgment No s Hspeed scan 489997
Motion F% Timer Rag 4089996
Link Mo Step Relay %ﬂ;
I/0 : Mcode »1ly—1 M1BEYG Calendar 429988 -
170 module 50 Mcede rly-2 M20096 429995
CH1 Statjen 15
CH2 Station 15 Link Coil 1 D11@24 MC linkRegl 4@9842 —
Link Coil 2 D21024 429914
Referenca @ Link RBeg 1 R11924 MC linkRes2 489915 -
Coil 288192 Link Reg 2 R21924 404987

The number of Motion Mcdules will be changed 1o 1. The reference number for Motion
Module 2 will be displayed as ----.
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7.1.7 Setting PC Link Modules

Set the number of PC Link Modules. The number is set to 2 by defautt.

1) Select PC Link from the Overview Menu using the Cursor Keys and press the Enter Key.

in Map Settings Toels Quit
g;-——rz——m- ——Overvic ————P6————F7 - P83 F?
P‘Ih-g typs nfiguration
] qes
: vetem Registers Special RAeg =
PLC type G} Se nts Y18256 t coil #881%
ExecPack 3 ¥2—ro
User Logic 3| Motien 11 gil@ise C sweap 489998 -
State RAN 3 12 g2— 489999
Segment No 5 set ault i Ki@256 Hspeod zcan 409997
Motion 1 2 X2-— Tiwer Reg 499996
Link 2 Medule MC cntrly-1 P18256 Step Relay 49283%35

MC cately-2 PF2-———r

I,0 = Mcods rly—-1 MLOGTE Calendar 499988 -

L1/0 madule 58 Meode rly-2 M2—— 429995

CH1 Statien 15

CH2 Station 15 Link Coil 1 D11@24 MC linkRegl 489842 —
Link Coil 2 D21824 489714

Refarence = Link Reg 1 Ri1B24 MC linkReg2 4-—0 -

Golil paR192 Link Reg 2 R21824 4

Input Relay 181824
lnfut Reg 388512
Hol# Reg

Canst Reg 741085

2) Select the number of PC Link Modules to be used (1 in this example) using the Cursor
Keys, and press the Enter Key.

in Overview Map Settings Tools Quit
B ¥z o i Al LA P78 T
PLC System Configuration

Special Rey ¢
t coil 089190

€ sweep 499998 -
489

Pﬁc : GL138

3

Exncl’m 39

Usar hﬂh 32 X
N

State 32 X 99
Segment No 5 Hepeed_scan 409997
Motion 1 Module Timer Reg 489996
Link [ Hodule] Step Relay %103;
120 ¢ Hoade rly-1 M10896 Calendar 489988 -
170 wodule 58 Meode rly-2 M2--—— 489975
CH1 Station 15
CHZ Station 15 Link Coil 1 Dii@24 MC linkRegi 4099842 -
Link Coil 2 D21824 409714
Refsrence : Link Reg 1 R11824 #C linkReg2 4——- -
Coil o0s1y2 Link Reg 2 R21824 44—

The number of PC L.ink Modules will be changed to 1. The reference number only for Link
Module 1 will be displayed.
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L
7.1.8 Table Initialization

7.1.8 Table Initialization
initialize the settings of the system configuration. The GL1 20is setasthe PLC type by default.

To use a PLC other than the GL120, perform all the setting operations from and including the
PLC type.

1) Select Reset Default from the Overview Menu using the Cursor Keys and press the En-

ter Key.
in . Map Settings Tools Quit
k:—irz—‘——-—o“wi‘- F6 77T I —PY
ﬁ type nFiguration
ges
PILC : System Registers Sgcill Reg =
PLC type G| Se nts Y14256 t coil saR19a
ExecPack 3 L 2—-— N
User Logic 3| Motion 11 q1e16ee C sweep 489998 -
State RAM 3| PC Link 12 Q2=——m 487999
Segment Ho 5 1 X18256 Hspeed scan 489797
Hotion 1 2 X2=—— Timer Reg 489996
Link I PModule e cntrly-1 PlE256 Step Relay 402881 -
"C cntrly-2 P2==—- 482832
124 = Meode »ly—1 MIOOTE Calendar 499988 -
170 module 50 Hcode rly=-2 H2-— 489995
CH1 §tatjion 15 .
CH2 Station 15 Link Coil 1 D11824 MC linkRegl 409842 —
Link Coil 2 D2—— . 409914
Reference : Link Reg 1 R11824 MC linkReg2 4———— -
Coil 288192 Link Rey 2 R2—— G
Input Relay 181824
Input Rey Jes12
Hold Reg 410810
Const Reg 5

2) A confirmation message will be displayed. Enter. Y and press the Enter Key.

Iﬂai.n Overview Map Settings . oo Quit
[F1: F2: 73 4 PS 76 F7-n-Fe - —FY:
ML System Confisuration 3 ‘
PLC = Special Rey =
PLC type GL138 MC ceil-1  Y18256 t coil 228198
ExecPack 38 nC coil-2 Y2—— :
User Logic 32 X MC cntcoill Q12160 C sweep 489998 -
State Ref 32X HC ontcoil2 Q2———— 489999
Segment Mo _ § MG relay-1 X18256 Hspaed _scan 489997
Mot lon 1 Module MC relay-2 X2— Time» Reg 489996
Link 1 HModule MC entrly-1 P18256 Step Relay 402801 -
nC entely-2 P2— 482832
1,0 : Mcode rly-1 M1B896 Calendar 409988 -
1/0 module 50 Mceds »rly-2 M2— 489995
CHi Station 15
CH2 Station 15 . Link Coil f D110024 NG linkRegli 409842 —
Link Coil 2 D2-—- 489914
Refsrsnce : Link Reg 1 RiiQ24 MC linkRsg -

The system overview will be initialized.

—7-10 —



7.2 IfO Maps
e ————

7.2 /O Maps

| This section describes /O mapping.

7.2 BasiCMapPs . ..o 7-11
7.22 Switching l/OMap SCreens ...........cvvviiiir i, 7-16
7.23  Module ZoOm . ... e 7-18
7.24 O Service Setting Operation ....... ..ottt 7-22

7.2.1 Basic Maps

* The I/O Map Screen can be displayed by selecting 1/0 Map from the Map Menu. Editing op-
erations are not possible when the PLC is in RUN state.

1) Select /O Map from the Map Menu using the Cursor Keys and press the Enter Key.

in Ouerview Settings Tools Quit
——f—F3 i —L P -} -FO - )F—F9
1 P qﬁr igurat ian
-
PIC = ASCII Map Spocial Reg :
PLC type GL128 ¥18256 B:t coil 8881592
ExscPack 28 HC ceil-2  Y20256
Uzer logic 16 X MC cntcoill 010160 C sweep 409998 —
State RAN 32 X NG cntcoil2 Q28160 489999
Segment No 1 HC relay-1 K18256 Hazpesed scan 489997
Motion 2 Module MG relay-2 K28256 Timey Reg  4099%
Link 2 RNodule NC cntrly-1 P182%6 Step Relay 402881 -
MC cntrly-2 P2B256 482832
20 = Mcode rly—1 M188%6 Calendar 499938 -
170 module 34 Mcode »1y-2 M2899¢ 489995
CH1 $tation 15
CH2 Station 15 Link Coil 1 D11824 MC linkRegt 489842 -
Link Coil 2 D210824 4
Raference : Link Reg 1 R11824 MC linkReg2 489915 -
Goil 888192 Link Reg 2 R21824 499987
lnput: nahy 191824
{ue Reg 308512
489999
const lbs

2) The I/0 Map Screen will be displayed. Move the cursor to the position of the slot to be
mapped using the Cursor Keys.

in Select Zaowm Service wI/0 typ Tools Quit
P ———F2 F3———P4 —-———rs—rs—n—cm—m-m—m—ll

1,0 TRAFFIC COP
CHANNEL: 8 STRTION: 1 RACK: 1/ 4
1/0type: GL120]/0 SERV. :
Input Relay: B Input Reg. : 8 Out Relay : 8 Out Reg. H

ELOI HODULE TYPE INPUT ouTPuT DETAIL
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7.2.1 Basic Maps cont.

3) When the ? Key is pressed, a list of Module types‘that can be allocated will be displayed.
To select the Module to be mapped, move the cursor fo the position of the Module and
press the Enter Key. ‘

in Select Zoom

——t2—F3

Tools Quit
e-Fe S —F9

Service W0 typ
——
1,0 TRAFFIC COP

CHANNEL: @ SIA| L1ZWI 0

[/0type: GL1Z2GI70 SE|ESWavREL 12BRD0O31418 120bD036418

Input Relay: @ b0 | 12emnBipdeal [ 128RDI34418 | 128DD033210

124MMEB1 0189, 2 12@DD025410

S$10T WMODULE TYPE 126ACTHZbAY( 126DRN81POG
181 120AUTO20008¢ | 124DDI343AR | 126DN0832608
18z - 129ACOR1HM8 128DDI135489 1280003413260
183 128AVG0B19BY| | 120DD136488 | 12MDD0I5420
184 120EHC211:18| | 128DD125480 § 128DD0332208
105 NN 12@NMN318B2| | 12@8DRAB4380 | 120800025428
186 129AUIE2108, | 128DA0OR4380 128DD033806
187 128AV0B1 1BY 124DD034318
188 . 120AU0H:I 208 126DD035418
189 . -
118
1131
112
113
114
115
116

4) Enter the starting reference number. In this example,the reference number of the input
relay is 100001 since a Digital Input Module was selected.

b;in Select  Zoom Serwice ml/D typ Taals Quit
10 TRAFFIC COP i
CHANMNEL: @ STRTI’WE 1 RACK: 1/ 4

I-0typer GL12BI-0 SERU. = .
Input Relay: B Input Reg. : @ Out Relay : @ Out Reg. : 8

ig‘l MODULE TYPE INPUT OUTPUT DETAIL

185 120DD] 35490 DC12-24U 32In 2.5-5m Con

5} The cursor will move to the position of the last reference number. The number deter-
mined by adding the number of |/O points to the starting reference number will be set as
the default. If the number is correct, simply press the Enter Key.

hin - Selsct Zoom Service ulA0 typ - Tools Quit
—F—F ——F7- -7 - —F?

—F2
1,0 TRAFFIC COP
CHANMEL: 8 STATION: 1 RACK: 1/ 4
I-0type: CL120170 SER. :
Input Relay: 32 Enput Reg. : @ Out Relay : 9@ Out Reg. : B

iml‘ MODULE TYPE INPUT OUTPUT DETAIL

105 12000135400 190801 —IIKA . DPC12-24V 32In 2.5-5mA Con
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m

The setting will be stored and the cursor will move to the next slot.

in ’ Salact Zoom Service @0 typ Tools Quit
i * 176 TRAFFLC COP ~ET-T -0
CHANNEL: @ STATION: 1 RACK: 1/ 4
I-0type: GL128IA SERV. :
Input Relay: 32 Input Reg. : 8@ Out Relay := B Out Rag. : @
iabfl' MODULE TYPE INPUT QUTPUT DEIRIL
182
i
iﬁ 12@DD! 35408 1A00@1-108032 DC12-24V 32In 2.5-5mfl Con
[ ]
107
188
189

6) Map other /O using the same procedure,

h;in Select Zoom Service uIA0 typ Iools Quit
—2 F}——P4——P5 P ———— 7 COW-F -3 F9
170 TRRFFIC GOP
CHANNEL: @ STATION: 1 RACK: 1/ 4
l/0type: GL120I,0 SERU., :
Input Belay: 48 Input Reg. : @ Out Ralay : 43 Qut Reg. ]
gw MODULE TYPE INPUT oUTMIT DETAIL
182 .
104
1085 1285DI35408 190021100032 DC12-24V 32In 2.5-5mA Con
106 128DD035418 -8e8a32 DC12-240 328inkOut 8.3 Con
i 187 120DDI34340 190833100848 DC12-240 16In 4-8mR Ter
13 128DDO34319 BBB8833-988R1E DC12-24Y 16SinkOut 0.5R Ter
118
111
nz
113
114
115
116
OIIUEID 1} Only YO Modules, Special Purpose Modules, and Motion Modules require I/O mapping.

Mapping is not required for Power Supply Modules, CPU Modules, Communications
Modules, and Expander Modules.

2) The MC20 Motion Module uses two slots, and mapping is executed for the slot with the
higher number. When two MC20 Motion Modules are being used, execute the Module
Zoom operation, and set the module numbers. See section 7.2.3 Module Zoom for de-
tails on the Module Zoom operation.

3) When specifyingan /O relay as the reference, specify a value of 16n+1(n=0, 1,2, ...)as
the starting reference number.

4) If the reference number that was entered has already been assigned, a waming mes-
sage will be displayed. if the existing reference number can be used, simply press the
Enter Key.

5) To change the tast reference number set by default, enter a different reference number in
the position of the last reference number. When specifying an I/O relay as the reference,
specify 8n (n=1, 2, 3, ...) as the number of IO points.

» Changing a Reference Number

Use the foliowing procedure to change a reference number that has been allocated.
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7.2.1 Basic Maps cont.

1) Move the cursor to the position of the reference number to be changed using the Cursor

Keys.

Select  Zoom Sarvice

in
lﬁ—m—n
CHAMKNEL: @ STATION: 1
[/0type: GL1201/0 SERY. :
Input Relay: 48 Input Rey. - @

ol 0 typ .

170 TRAFFIC COP
RACK: 1/ 4

Out Relay : 48

Tools Quit

Out Reg. B )

SLOT MODULE TYPE INPUT OUTPUT

128DDI 354830 1000631 -1 8BA32
120PD035418

128!!9131338 180833100048
128DD03431

008851288232
IIITEG-eas848

DETAIL

t
DC12-24U0 32In 2.5-5mA Con
DC12-24U 32Sink0ut 8.3A Con
DC12-24V 16In 4-8mA Ter
DC12-24U 16SinkOut B.57 Ter |

2) Enter the starting reference number (65 in this example) and press the Enter Key.

Select Zoom Service

in
i
CHAMNEL =

I-0type: GLlZBIIO
Input Relay: 48

STRTIM. 1
SERU.
Input lhg- : 8

810 typ -

1/0 TRAFFIC 00?
RACK: 1- 4

Out Ralay

Tools Quit

: 49 Out Rey. B ]

im‘l’ MWODULE IYPE INFUT oUTPUT

12@DDI 35468 100091 -100032
128DD0O35410
128DDIJ4360 128833100048
128DDb034318

000901 ~800932
ENNT-06i043

DETAIL

DC12-24U 32In 2.5-5mA Con

DC12-24Y 32SinkOut G 30 Cen
DC12-24¢ 161n 4-8mA T

DC12-24U 1568 inkOut B. Sﬂ Ter

3) The cursor will move to the position of the last reference number. The number deter-
mined by adding the number of I/O points of the Module to the starting reference number
will be set by default. In this example, assign 8 points of a possible 16 points. Enter the
last reference number (72 in this example) and press the Enter Key.

Ilki.n Select Zoom Service OI/0 typ . Toolx Quit
[F1 ——F2 ! ]
i rmw:c Cop
CHAMNNEL: @ STATION: 1 RACK: 1- 4
170type: GL128IA0 SERU. :
Input Relay: 48  Input Reg. : @ Qut Relay : 48  Out Reg. : @
fg‘r MODULE YYPE INFUT QUTPUT DETAIL
182
104 '
185 120DDI354BG 180001 -1 09632 DCL2-240 321n 2.5-5mA Con
186 128DPDO3541 BOBEa1-8B3832 DC12-24U 32SinkOut B.3A Con
187 128DDI134398 180833-100043 DC12-24Y 16In 4-9mA Ter
ig 128PD034318 008855 ¢F DC12-24V 16SinkOut 8. SR Ter
118
111
112
113
114
115
116
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m

The reference number will be changed.

in Select Zoom Service ©I/0 typ Tools Quit
i ¥ * 10 TRRFFIC COP ~ERE- T
CHANNEL STATION: 1 RACK: 1/ 4
lloumo GLIZOI/O SERU. :
lnput Relay: 48 Input Reg. : B Out Relay : 40 Out Reg. 8
gl-O'l' MODULE TYPE INPUT OUTPUT DETAIL
iez
104
ies 12@!)135” 180001188832 DC12-240 32In 2.5-5#2 Con
ies 128DD0O35418 2p08a1 389832 DC12-24¢ 32SinkOut @.30 Con
13 {%W%gﬁﬂ * 3 BBEB65-280072 ggg:%ﬁ igg'i‘.nk()u?ﬂrSﬁ Ter
139 SeSm—
111
112
113
114
115
116
Omﬁﬂb Itis also possible to change the last reference number onty. Move the cursor to the position of

the current last reference number and enter a new last reference number,
« Composite Module Mapping

Relays and registers can also be mapped using a 2-line mapping area on the /O Map Screen.,
The following example shows the operation.

1) A Counter Module is mapped as an example. Move the cursor to the slot where the
Counter Module is to be mapped. Select a Counter Module, and a 2-line mapping area
will be displayed and the cursor will move to the relay position. Enter the starting refer-
ence number of the input relay (100065 in this example) and press the Enter Key.

2) The cursor will move to the position of the last reference number. Press the Enter Key if
the last reference does not need to be changed.

in Solect Zoom Service wl0 typ Toels Quit
h P2 F3 P4 5 P F7-WG-F8 - —F7
1/0 TRAFFIC COP
CHARMEL: B STATION: 1 RACK: 1/ 4
[/0type: GL120]0 SERU, :
Input Relay: 64 Input Reg. : B Out Relay : 48 Out Reg. : 8

ggt MODULE TYPE IMPUT OUTPUT DETAIL

1¢z

i

185 12@DDI35409 108861-188832 DC12-240 32In 2.5-5mA Con

186 12@bDO3S418 DE2821-300832  DC12-24U 32SinkOdut @.38 Con

187 120DDI34300 108033100048 DC12-240 160in 4-8mA Ter

i 120800034316 200833-000048 DC12-24V 16SinkOut .58 Ter

119 128EHC2111@ 180065-IEIR Preset Counter{Interrupt)ich

111

112

113

114

i15

|
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T

7.2.2 Switching I/0 Map Screens

The settings will be stored, and the cursor will move to the position of the starting refer-
ence of the output coil.

hi.n Select Zoom  Eervice 6140 typ Tools Quit
r— P2 = F § P e {5 P —————F 7 M- PR - —F9
10 TRAFPIC COP
CHANNEL: @ STAETION: 1 RACK: 1/ 4
I/0type: GL12BI0 SERU, :
Input Relay: 64 Input Reg. = 8 Out Rolay : 48 Out Reg. : 8
ig]‘ MODULE TYPE INPUT SUTPUT : DETAIL
i@z
= -
185 129DDI35488 10808a1-100032 DC12-249 32In 2.5-5mA Con
186 128DDO35418 000091 -888832 DC12-240 328inkOut B-3RA Con
187 1200DI3436008 180833-100048 DC12~-24) 161n 4-8mh Ter
ig 1280034318 P00833-800048 DC12-24¢ 16SinkOut 8. 59 Ter
118 128FEHC21110 100065-100850 Y Preset Counteri{interruptiich
111
112
113
114
115

1

- 3) Map the output coil, input register, and output regrster foliowing the same procedure giv-
en above.

7.2.2 Switching /O Map Screens

The I/O Map Screen is displayed for each rack. Therefore, to assign /O for a different rack,
the map screen must be switched. The channel number, station number, and rack number
currently being edited are displayed on the 4th line from the top of the screen. An example of
switching a channel or a station is shown below.

1) Switch to the menu cursor using the Tab Key.

2) Select Station from the Select Menu using the Cursor Keys and press the Enter Key.

in 3 Zoom Service 0l 0 typ Taols Quit

Ig; 2 Frntion ] 1/0 TRAFFIC GOF - -
Statian

CHANNEL: B 1 RRCK: 1/ 4

I/0type: GL12010 SERV. :

Input Relay: 48 Input Reg. : 8 Out Relay : 48 Out Reg. ]

i&?‘f MOBULE TYPE Inrut OUTPUT DETRIL

182

183

184

185 128DDI35468 168081 -188832 DC12-24¢ 32In 2.5-5e Con

186 120DDO35418 R38Nl -3z DC12-24¢ 325ink0ut 8.3 Con

18?7 128DDI34318A 1BOX)3-1089048 DC12-244 161n mA Ter

ig 120DD034318 P98a33-08P848  DC12-24V ISS:kaut e. sn Ter

]

118

111

112

113

114

115

116

716 —



7.2 170 Maps

Ill-.I--IllllllIIIIIIIIIll-IlI.llllIII----lllllIII---l-.IIIl----I-IIIIlIIIllll-IlllIllIIIIIIIIIIIIII.III.IIIIIIIIIIII-II-

3} Awindow forentering achannel number and a station number will be displayed. Enterthe
channel number (2 in this example) and press the Enter Key. Enter the station number (1
in this example) and press the Enter Key.

in Select Zoom Sarvice B1/0 typ Tools Quit
b;-—n—--—m-—m F?~-RTE-Fe-0g—Pe
1,0 TRAFFIC COP
CHANNEL: @ STRTION: 1 RACK: 1/ 4
I1-0type: GL128I0 SEM. :
Input Relay: 48 Input Reg. = @ Out Relay = 48 Qut Reg. : 0
Eﬁ‘f MODULE TYPE INPUT OUTPUT DETRIL
182
i
i85 12@DI35m 109001108932 DC12-24V 32In 2.5-5mh Con
186 128DDO3541 9Q8291-289932 DC12-248 32%8inkOut B.3A Con
187 125])1)1313% 180033109048 DC12-248 16In 4-8mf Ter
i 128DD034310 GUBU33-006@48 DC12-24U 16SinkOut @.5A Ter
“
118
111 inpnt aunher
112 Channe} Mo LB-21 2
113 Starion Mo [1-15) 1
114
115
116

The /O Map Screen for channel number 2 and station number 1 will be displayed.

in Select Zoom Service 10 ¢t Teols Quit
i 10 TRAFFIC cop”. -3k
CHANNEL: STATION: 1 RACK: 1/ 4
1/0type: GM.ZGI/O SERY. : raal
Input Relay: 49 Input Reg. : 8 Out Relay : 48 Out Rey. =8

SLOT MODULE TYFE  INPUT OUTPUT DETAIL
R

Control can be transferred between racks by the following key operations.

The I/O Map Screen of the rack one number lower is
displayed. When Rack 1 is displayed, the screen is
switched to that of Rack 4.

The I/O Map Screen of the rack one number higher is
displayed. When Rack 4 is displayed, the screen is

switched to that of Rack 1.

Channels and stations can be switched from the menu only.
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7.2.3 Module Zoom

7.2.3 Module Zoom

This operation displays a screen for setting parameters for /O Modules. Settings are made
for the input data types and scan I/O processing. Always check the settings whenever a
Module is assigned. The contents to be set vary according to the Module.

1. Bit Order

I/0 processing can be performed by reorganizing data in ascending bit order or descending
bit order. Two types of bit order specification are available to do this: MSB and LSB. In MSB,
the starting reference number is allocated to the lowest /O number of the Module. In LSB, the
starting reference number is allocated to the highest I/0 number of the Module. By default,
MSB is set when coils/input relay are used for alfocation and LSB is set when registers are
used.

Allocating 16 Points from 100001

e MSB ® LSB
100001 « Input1 100001 « Input 16
100002 « Input 2 100002 « input 15
100016 « Input 16 100016 « Input 1

2. Output Data Type

When a register is specified as the reference numbef, data /O can be set as BIN (binary) or
BCD. By default, BIN is set.

3. Service Scan

For a Module in the local station, the I/0 servicing can be set for each Module. When a high-
speed scan is set, /O servicing is performed synchronized with the high-speed scan. By de-
fault, the normal servicing is set. This function is invalid for Modules in remote stations even if
it is set.

4. Time-out Output

When the state of a CPU Module is changed from the RUN State to the STOP State, output
data can be selected. Either the data immediately before the Module was stopped or the data
that was preset can be output.

5. Time-out Output Data

When output of set values is selectedin for the time-out cutput, set the data to be cutput when
the CPU Module is stopped. The data here is the image of the PLC reference data. The data is
converted, based on the bit order that was set, and is output.
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7.2 1/0 Maps

An example of setting the bit order and time-out output data is shown below.

1) Move the cursor to the Module to be set using the Cursor Keys and press the Enter Key.

Main Select  Zoom Service B0 t Tools  Quit
FL P2 3 4 ] P67 YR Fo - T PY
1/0 TRAFFIC COP
CHANNEL: B STRTION: 1 RACK: 1/ 4
I/Otype: GL1201,0 SEW. :
Input Relay: 48 Input Reg. : @ Out Relay := 48 Out Regy. : 8
i&r MODULE IYPE  INPUT QUTPUT DETAIL
182
164
185 12@DDI35408 109601-100032 DC12-24U 32In 2.5-SmA Con
186 128DD0O35410 888861888832 DC12-24U 32SinkOut B.3A Con
107 128DDI34368 100033100548 DC12-24V 15In 4-8mA Ter
:g [ 2ADD0343 1] 988833-p00B48  DC12-24V 16SinkOut B.50 Ter
p51: )
111
112
113
12 |
116 II

2) Switch to the menu cursor using the Tab Key.

3) Select Zoom using the Right Cursor Key and press the Enter Key.

]?11" - Select Service wul/0 typ - Tools Quit
——-FB-—-—;E—I’S—I’G——— - W -F8 - I5—FY
1,0 TRAFFIC COP
CHANKEL: @ TATION: 1 RACK: 17 4
I 0type: GL12B1.40 sm :
Input Relay: 48 Input Reg. = @ Out Relay :@ 48 Out Reg. 1 8
iﬁ? MODULE TYPE INFUT OUTPUT DETAIL
182
i
185 12@DDI35400 109991-1B8R32 DC12-24¢ 32In 2.5-5mh Con
166 1268DD0O35418 @Be981-88RR32  DC12-24U 32SinkOut B.34 Con
187 128DDI134399 18PE331-182848 DC12-240 16ln 4-8mA Ter
ig FTETREERT 2998313800848  DC12-24U 16SinkOut B.58 Ter
118
111
112
113
114
115
116

4) A Module Zoom Screen will be displayed. Move the cursor to the bit order position and
press the Enter Key.

g:x geiul Binary  Mov Quit

¥ l/D Hodule Editor——F?—ETF-F8- mﬁ;—m
129DD031 18: DC12-240 1600T age 1 7/ 1

Head: @ Drop: 1 Slot: 8

OUTPUT DATA IYPE: BIN
BIT ORDER:

SERVICE SCAN:
TIMEOGT OUT: SET URALUE

TINEOUT OUTPUT DATA
" Ne. DEFRULT SET UALUE
[ 0200 e DEC

End of PD034310 Zoom
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7.2.3 Module Zoom cont.

2 —
#

5) A setting selection window will be displayed. Move the cursor to the LSB position and

press the Enter Key.

|l||x Decimal Binary FMovs

r{——F2—-—F3———F
1280D034318: DC12-240 160UT

Head: 8 Drop: 1 Slot: &

TINEOUT OUTPUT DATA

End of DDO34310 Zoom

Ne. DEFAULT 3 SET USLUE
a1 2808 -

1,0 Map Module Editor——F7-TXN-F8-3F3—F9
Page 1 - 1
BIT ORDER ‘
MEOUT oU E -

Quit

The bit order will be set to LSB.

6) Move the cursor to the set value position.

&x "Decimal Binary Move
F 1,0 Map Module Edito
128DD03431@: DC12-24U 160UT

Hoadz @ Drep: 1 Slot: 8

QUIPUT DRlA I?g BIN
BERVICE BCHAN:

TIMEOUT OUTPUT DATA

End of DD0O34318 Zoom

Ti S$ET VALUE

. : = age 1 7 1
BIT ORDI 3B
NORMAL
NEQUT OUY:
Ho. DEPRULT . BET UIILI.IE
61" @000

7) Switch to the menu cursor using the Tab Key.

8) Toinputthe set value in hexadecimal format, select Hex using the Cursor Keys and press

the Enter Key.

E_ Decimal Binary Move
] —p2 1,0 Hap Module Editnr——-!’?-mﬂ

128DD034318: DC12-24V 160UT

|llond= @ Drop: 1 Slot: &
OUTPUT DATA IY¥PE: BIN
SERVICE SCAN: NORMA

TINEQUT OUTPUT DRTA

End of DD034318 Zooa

TIKEQUT OUT: SET UHLUE

———F3 ————F
l’lg- i1
BIT ORDER: LSB
No. DEFRULT SET URLE!E
O
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M

9) The input and display of the set value will change to hexadecimal format. Enter a set val-
ue in hexadecimal digits (in this example, 8012) and press the Enter Key.

|l|ux Decimal Binary Hove Quit
F1———F2———F3-——F 1/0 Map Module Editor——F7—EFNA-F8-TE3—F9
128DDO3421@: DC12-244 160UT Page 1 » 1
Head: DProp: 1 Slet: B
OUTPUT DATA TYPE: BIN
BIT ORDER: LSB
SERVICE SCAM: NORMAL
TIMEOUT OUT: SET VALUE
TIMEGUT OUTPUT DATA

Mo.  DEFAULY SET_UALUE
" [

End of DD034318 Zoom

10} The time-out output is now set. To return control to the I/0 Map Screen, select Quit from
the menu bar or press the Esc Key.

1) When Last Data is set for the time-out output, no time-out output data needs to be set.

2) When time-out output data is set in decimal format, the numeric format does not need to
be changed as described above.

3) For 32-point Output Modules, two words of time-out output data must be set.

4) If 1/O mapping for a Module by using the Copy operation, copy source data will also be
copied. This data must be check using the Zoom operation.

5) When atlocation of a reference number is changed from coils to registers or registers to
coils, the bit order will not be changed. The Zoom operation must be used to change the
bit order.
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7.2.4 I/O Service Setting Operation

7.2.4 /O Service Setting Operation

+

An /O service cycle can be set for each remote station. By default, a normal cycle is set. For
the local station, I/O servicing can be set for each Module. Therefore, servicing for the local
station is indicated by a dash (—----) and cannot be selected.

1) Switch to the menu cursor using the Tab Key.

2) Select Service using the Cursor Keys and press the Enter Key.

[Main Sslect Zoom 1/0 typs Tools Quit
J’IH—JZMHQ#—MS_W*M—W—P?
1,0 TRAFFIC COP .

CHAMMEL: 2 STATION: 1 RACK: 1- 4

I-0type: GL1281,0 SERU. : Normal

Input Relay: 48 Input Reg. : 8@ Out Relay : 48 Out Reg. =8

351' MODULE TYPE INPUT OUTPUY DETAIL

1 ]

ie2

ie3

184

ies

1@

187

168

189

3) A selection window will be displayed. Select ngh Speed using the Cursor Keys and
press the Enter Key.

1-0 TRAFFIC COP
CHAMMEL: 2 STATION: 1 RACK: 1/ 4
1/0type: GL1281,0 SERV. : Normal
Input Relay: 48 Input Reg. : @ Out Relay :- 48 Qut Reg. : B8

imr MODULE TYPE  INPUT OUTPUT DETAIL
L

in Select Zoom Service 1.0 type Tools Quit
—_—— 33— P ————F ———F7?- P - —F?

111

112 Marnali
113 | Hiigh Speed]
114 g

The /O servicing of station 1 of channel 2 will be set to High Speed.
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m

7.3 Other Mapping Operations

This section describes map operations for PC Link Modules and ASCIl Modules that are
used by the MEMOCON GL120, GL130 PLCs.

731 PCLINKMap ..o 7-23
732 ASCIIMEaD ... 7-31

7.3.1 PC Link Map

PC Link Modules can be used to reference data from other PLCs connected to the PC Link. To
reference this data, a Link Map is required. The link mapping procedure is described below.

1. Displaying the Link Map Screen

Select Link Map from the Map Menu using the Cursor Keys and press the Enter Key.

E;i.n Overview Settings Toolse Quit
—— 2 —p3 Py =P — P I-F8 S —F9
P| 170 Ha iguration
FILC : EEEH &p Sgtull g =
FLC type GL126 ¥18256 t coil 988192
ExecPack 2@ MC coil-2  ¥2B256
User Logic 16 K MC cnteoill Q19168 C sweep 409998 -
State RAN 32X HC cntcoil2 Q20168 489999
Segment Mo 1 HC relay-1 X18256 Hspeed scan 489997
Motion 2 feduls ne nlni-z 20256 Timer Reg 409996
Link 2 Medulo MC catrly-1 P1ERSE Step Relay 482881 -
MC entely—2 P28256 4829832
0 = Hcode rly-1 M1B296 Calendar 489908 -
170 module 34 Mcode rly—2 M20@96 499995
CHl Statian 15
CH2Z Station 15 Link Coil 1 Dii@24 MC linkRegl 409842 -
Link Coil 2 D2i@24 489914
Referencs @ Link Reg 1 Rii@24 NG linkReg2 489915 -
Cail ane192 Link Rsy 2 R21824 409987
Input Relay 1011024
! Input Reg Jeas12
o Reg 489997
Conzt Reg (]

The Link Map Screen will be dispiayed.

Pain Edit Textl'ilu DataSaot Toolx Quit
[Ft————p2———— P3. T F6 7P - F9
cH ” STATION:
GHOUP DRESS = TOXKEN HOLD 'llllE nL TOKEN CHX TIME: nT
STRTION SRCH : me FBUS TIMEOUT ns FBUS RETRY :
g}ﬂ L-COIL POINT L-REGISTER S1ZE i;l L-COIL  POINT L-REGISTER SIZE
az 18
- E] 19
B84 28
s 21
[ 22
az 23
[} 24
a9 25
1@ 26
11 27
12 28
13 29
14 38
15 k3
16 32

2. Setting PC Link Parameters

Setthe channel number, station number, and communications parameters of PC Link Module
using the following procedure.
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7.3.1 PC Link Map cont.

1) Enter the channel number that is set on the DIP switch of the PC Link Module and press

the Enter Key.
Main Edit TextFile DataSave Tools Quit
i ¥ LINK MAP - U
CH = STATION:
GROUF ADDRESS : TGKEN HOLD TIME: nE TOKEN CHK TIME: »E
STATION SRCH : ns  FBUS TIMEOUT = ms  PBUS RETRY :
ST8 L-COIL  POINT L-REGISTER SIZE $I¢ L—COIL ; POINT L-REGISTER SIZE
ez 18
a3 19
B4 8
a5 21
B6 22
a7 23
a8 24
a9 25
18 26
11 27
12 28
13 29
14 3a
15 31
16 32

2) Enter the staticn number that is set on the rotary §witch of the PC Link Module and press
the Enter Key. In Online Mode, the number wili be displayed automatically.

Main Edit TextFile BataSave Toa Quit
i LINK MRP -
: 1 STATION: .
GROUF ADDRESS : TOXEN HOLD TIME: ms "TONEMN CHK YTIME: "z
STATION SRCH : wnz  PRUS TIMEOUT = wms, FBUS REIRY -
gl L-COIL POINT L-REGISTER SIZE i;l L-COIL  POINT L-REGISTER SIZE
a2 18 !
a3 19
a4 28
s 21
96 22
a7 23
es 24
[ 4 25
18 . 26
11 27
12 . 28
13 29
14 38
15 .on
16 . 32

3) The communications parameters of the PC Link Moduie will be displayed. In Offline
Mode, default values will be displayed. As an example, change the FBUS time-out time.
Move the cursor to FBUS time-out time using the Cursor Keys.

Main Edit TextPFils DataSave Tao Quit
[Pt —————F2 e fy e ) VPR - TR ——F 9
LINK MAP
CH -1 STATION: @5
GROUP RDDRESS: 169 TOKEN HOLD TIME: 21@ mc .TONEN CHX TIME: 2588 ns
STATION SRCH : @1888 ws FBUS TIMEOUY : IIIEED ms FBUS RETRY :- @
g{l L—COIL POINT L~REGISTER SIZE s;l L-COIL POINI L-REGISTER SIZE
i
a2 iB
2] 19
a4 28
[ 21
26 22
a? 23
[ 24
29 25
1] 26
11 27
12 28
13 29
14 38
15 n
16 32
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4) Set the FBUS time-out time to 300 ms by entering 300 and pressing the Enter Key.

Main Edit TextFile Datafave Tools Quit
[Pt ———F2————F3 P4 Lﬁ;ﬂ o F6 F7-ING-F8 -l-——F9
CR =1 SIATION: @5
GROUP ADDRESS: 168 TOKEN HOLD TIME: P10 ms TOXEN CHX TIME: @582 ms
STATION £RCH : B1908 ma FBUS TIMEOUT mx FBUS REIRY : @
gﬂ L-C01), POINT L-REGISIER $IZE i;s L-COIL PMOINT L-RECISTER BIZE
a2 18
a3 17
[ ] 28
(-3 21
[ 22
a7 23
B8 24
29 25
1e 26
it 27
12 i 28
13 29
14 38
15 31
16 32

5) Set the other communications parameters using the same procedure.

OITIEID To change a channel, move the cursor to the channel position and enter a channel number
and a station number.

3. Link Reference Map Operation

The following procedure provides an example of link coil and link register map operations.
1) Move the cursor to the map area using the Home Key.

2) Aliocate the position of station number 1. Enter the lower-place four digits of the link coil
number to be allocated. The high-order 0 can be omitted. In this example, enter 1 and
press the Enter Key.

lHlin Edit TextPile DataSave Tools Quit
T LINK MAF Toai-re-ia
CH :1 STATION: B85
GROUP APDRESS: 16@ TOKEN HOLD TIME: 81® ms TOXEN CHK TIME: US89 ms
STATION SRCH : 91908 ms FBUS TIMEOUT : B2388 m:x FBUS RETRY : @
St
ST% L-COIL POINI L-REGISTER SIZE SI8 L-COIL POINT L-REGISTER SIZE
[ | 1?
az 13 ’
ay 19
B4 28
[ 21
-3 22
a7 23
e 24
[ 25
il 26
11 27
12 28
13 22
14 3o
15 3
16 az
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. .

7.3.1 PC Link Map cont.
3) Specify the number of points. The number of points can be specified in 16-point units. In
this example, enter 128 and press the Enter Key. .
| . Edit TextFile DataSave : Tools Quit
3 LINK map e -

CH =1 STRATION: 8BS
GROUF ADDRESS: 168 TOKEN HOLD TIME: 819 ms . TONEN CHK 1IME: 8588 mx
STARTION SRCH : #1008 mc FERUS TIHEOUT : BB3IBE ms FBUS RETRY : @

ST# L-COIL POINT L-REGISTER SIZE ST# L-COIL ° POINT L-REGISTER SIZE
B8l Diesal 1128 17 P

az 18

a3 1?

a4 28

s 21

L3 22

a7 23

] 24

[ 4 25

18 26

11 27

12 28

13 29

14 30

15 31

16 32

4) Set link registers using the same procedure.
i[inFo 1> 1) By pressing the Home Key, the cursor can be moved between the communications pa-

rameter area and the link reference map area.

2) Onily the lower-place four digits can be entered for a reference number of a fink coil or a
link register. Leading zeroes can be omitted. For instance, to set D10017 for the link coil,
enter 17.

3) Foralink coil reference number, specify 16n+1{n=0,1, 2, ...). For the number of points,
specify 16n (n = 1, 2, ...). No restrictions are imposed on link registers.

4. Moving Allocations

1) Move the cursor to the allocation position to be moved using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.-

3) Select Delete from the Edit Menu using the Cursor Keys and press the Enter Key.

Iﬂli.n TextFile DataSave Too Quit
[Fl————p2 It —er— G ——————f ———F 7 - T -3 —FY
Igm LINK MAP
cH 1 pyY TATION: @5
GROUF ADDRESS: | Paste OKEN HOLD TIME: D10 w: .TOKEN CHK TIME: @508 ms
STATION SRCH : FBUS TIMEOUT : B8380 ms+ FBUS RETRY : O
ST# L-COIL POINT L—REGISTER SIZE SI® L-COIL  POINT L-REGISTER SIZE
81 Digeégt @128 Ri8001 a6 1?
82 Digi12y 8964 Ri@e1? a6 i8 .
a3 W 8964 19
a4 aa32 Ri0&33 e16 28
25  D1928% 2064 Ri024% 816 21
86 22
a7 23
[ 24
e 25
18 26
11 27
12 28
i3 29
14 39
15 3
16 a2
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m

4) The allocation at the cursor position will be deleted. Move the cursorto the position of the
target station number using the Cursor Keys.

in Edic TextPile DataSave Tools Quit
P ————F2———F3 F4 Lﬁl‘ “AF F6 F7-TR-F8-S33—Fy

CH =1 STATION: 85

GROUP ADDRESS: 168 TOKEN HOLD TIIIE- 818 mc  TOKEN CHK TIME: 250@ mc

SIRTION SRCH : 91008 mng FPBUS T : BE3PA ms FBUS RETRY : @

§I% L-COIL POINT L-REGISTER SIZE ST#® L-COIL POINT L-REGISTER SIZE

8l DioGdr @128 Rieeal 816 1?7

g MP127 2964 o7 13 :g

B4 D1G2S?  e|32 R10833 216 28

g D18289 @e64 R1004? 16 %%

o7 23

[ 24

(4 25

18 26

11 2?

12 28

13 29

14 38

15 a

16 32

5) Switch to the menu cursor using the Tab Key.

6} Select Paste from the Edit Menu using the Cursor Keys and press the Enter Key. A

ilhi.n TextFile DltlSlv- Toale Quit
[Pl——F2 Py fm— F6 78 -Ta—FY
CH : 1 TATION: @S .
GROUP ADDRESS: OKEN HOLD TINE: 818 wc  TOKEN CHX TINE: 0508 ms
STATION SRCH : FBUS TIMEOUT : 8939@ ms PBUS RETRY : @
$I8 L-COIL POINT L-REGISTER SIZE SY® L-COIL POINT L-REGISTER $IZE
@ DidGi Bi28  Rie8ei 816 17
g Di@i29 9Ms4  Rie\1? 016 g
B4 DiB257 @932 R18G33 P16 2@
h g PiE289 8964 R10949 BL6 %
a7 — 23
es 24
"y 25
18 26
1 27
12 28
13 29
14 30
15 i
16 ”

The reference data allocated to the station that has been deleted will be pasted at the

cursor position.
&I‘in Erlit }"zxtl'ih[‘%)__;n::l 6 }_’_m;ggle Quit
i1 STATION: @5
P ADDRESS:= 160 TOKEN HOLD TIME: 810 ms TOKEN CHX TIME: 9500 ms
srn‘rlou SRCH : 818008 ms FBUS TINEOUT : 88300 m¢ FBUS RETRY : @

SI® L-COIL POINT L-REGISIER SIZE §T# L-COIL POINT L-REGISTER SIZE
8128 R1p8e1 216 1?

8t  D186a1
g big12? 9064 R16917 @16 ig
Il 84 Di@25? a3z RE@3I3 @16 28
65 I#289 0@64 RiOG4? @16 21
es DUTEE] 0ac4 22
@7 23
ez 24
a9 25
18 26
11 27
12 29
13 29
14 3@
15 31
16 32

5. Text File

The following two text file operations are available.
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7.3.1 PC Link Map cont.

¢ Importing

An ASCII file that has been created according to the MEMOSOFT format is read. The
data that is read overwrites the link communications parameters and map data tables.

+ Exporting

The link communication parameters and map déta that have been edited are stored as
an ASCll file. The file that has been written can be edited using a commercially available
editor. After being edited, the data can be read by MEMOSOFT again.

By writing a map table as a Text File and reading the file using another file, the map table
can be utilized. The Text File format is shown below.

aAra, BBB, CCCC, DDDDD, EEEEE,
1, GGGG, HHHH, IIII, JJJ
2, GGGG, HHHH, IIII, JJJ
3, GGGG, HHHH, IIII, JJJ

32, GGGG, HHHH, IIII, JJJ

AAA:  Group address F:
BBB: Token holding time GGGG:
CCCC: Token monitoring time  HHHH:
DDDDD: Station search time :
EEEEE: FBUS time-out time  JJJ:

An example of a text file is shown below.

160, 010, 0050, 00010, 00003,
1, 0001, 0002, 0001, 064
2, 0017, 0004, 0033, 032
3, 0048, 0002, 0049, 064

32, 0993, 0004, 1060, 024

FI

FBUS retry count

Lower-order four digits of a link coil
Number of points (8-bit units)
Lower-order 4 digits of the link register
Size (8-bit units)

0

When 16 link coils are allocated, the number of points is 2, When one link register is allo-
cated, the size is 2.

» Exporting operation

1) Switch to the menu cursor using the Tab Key.
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2) Select Export from the Text File Menu using the Cursor Keys and press the Enter Key.

I;jain Edit DataSave Tools Quit
1————F2—F3 oxt File——F6 -F?- I -Fe-ThE——F9
F_— I lnErt | MAP
GROUP RDDRESS: 168 TIME: B18 mx TOXEN CHK TIME: 95908 ms
STATION SRCH : 91800 m: FBUS TINEOUT : BO3080 ms FBUS RETRY : @

STR L-COIL POINT L-REGISTER SIZE ST L-COIL POINT L-REGISTER SIZE
D1998L 8 R18281 016 1?
DiB12%  BP64 R18017 e 18

D18257  @a32 R1O233 ais 20
R1084% 816 21

22IRREBAR
4
]
2

Di@353 @\i2e Riegss 264 22
Dio4s1  B12% R10129 a32 %i

25

%g % 8864 R101i61 a3z gg
12 28
13 29
14 e
15 E) ]
16 32

3} Afile setting window will be displayed. Specify the export destination by entering the file
name and press the Enter Key.

in Edit TextFile DataSave Tocls Quit
LINK MAP T-F9 -0
STATION: BS
ADDRESS: 160 TOKEN HOLD TINE: 916 ms  TOXEN CHK TINE: €500 ms

STATION SR : B1000 we  FBOS FTHEOVETC: Baoan'ms TOFoNCHK LirE: o
STH L-COIL POINT L-REGISTER SI1ZE ST® L-COIL  POINI L-REGISTER S12%
81 DieBM @28 mGeel el 17

DiR125 @064  RiBOI? @46 1p
a3 D1819%3 9964 19
@4 DieS? OEIZ  ROE33 @6 28
¥ DIB2EY B4 Reed? Bl 21
B DIAIS) BIZ8  RiGMes  Be4 22
97 DIBH1 mizé  Kieiz9 832 53
- ] 24
% 1969 [ 1] =113 g3z gz

6/ 1

11 - 27
12 24
13
14 Filenane:
15 o iLTbuc gae R
16 e e —

Link data will be written to the specified file.
« Importing operation
1} Switch to the menu cursor using the Tab Key.

2) Select Import from the Text File Menu using the Cursor Keys and press the Enter Key.

[Main : Edic {?ﬂnﬂ DataSave Tools Quit
[FL———P2——F3 axt File —Fs———r}-'m—m-m—-n
rt
GROUP nnms 160 TIME: D18 mse TOKEN CNX TIME: 9500 mo
STATION SRCH : 91009 mc FBUS TINEOUT : @0380 ms FBUS RETRY : 9
g‘ﬁ L-COIL POINT L-REGISTER SIZE f;l L~-COIL POINT L-REGISTER SIZE
82 18
83 19
a4 28
a5 21
26 22
o7 23
28 24
] 25
18 26
11 2?
12 28
13 29
14 38
15 31
16 32
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3) A file setting window will be displayed. Specify the import source by entering a file name
and press the Enter Key. .

1

in Edit TextPile DataSave Tools Quit
T Fe LINK HRP i ! - i

CH =1 BEATION: @5 '

GROUF ADDRESE: 168 TOKEN HOLD TIME: 818 ms TOXEN CHX TIME: 8589 ms
STATION SRCH : B100@ ws FBUS TINEOWT : 82389 m» FBUS RETRY : @

SI% L-COIL POINT L-REGISTER $IZE SI® L-COIL POINMI L-REGISTER SIZE
[ 1?7 :

t

18
a3 19
™ 20
as 21
-3 22
a? 23
82 24
a9 25
18 26
11 27
12 28
13

14 Filenane : |

15 LINK.dat -

The specified file will be read as link data.

6. Data Save Operation

The Data Save operation writes the current map data to the PLC in Online or Debug Mode. In
Offline Mode, the data is written to a file.

Normally, write processing is performed when the link map screen is terminated. Therefore, if
this operation is performed, link maps can be written in any state. That is, data can be written
to the PLC while a link map screen is being displayed. This operation is usefut for debugging.

1) Swiich to the menu cursor using the Tab Key.

2) Select Data Save using the Cursor Keys and press the Enter Key.

k:in Edit TextFile Toals Quit
—_—_— e Py . P LINKT“__W_M—M
11 STATION: @5
GROUP ADDRESS: 168 TOXEN HOLD FIME: 918 mx TOXEN CHK TIME: 8584 ms
STRTION SRCH : 21090 ms FBUS TIMEQUT : BB368 ms FBUS RETRY : @

ST® L-COIL POINT L-REGISTER SIZE EI® L-GOIL POINT L~REGISTER S£IZE
pigeal  \i128 Ri0081 B16 1?7

a1
82 D129 BB64 RIMAI? @16 18
83- Digi93  PO64 19
64 DIe2S? @832 2 RBA33 @6 28
05 DIBZSY @964 RIBAMY @16 21
86 012§  RIBAES @64 22
@7 D1P481 B128 Rie129 @32 23
% 24
a9 25
1 % BG4  RiB161 €32 26
12 28
13 29
14 38
15 3
1% 32

The link map data will be written to the PLC.

OII!EE,D When the drive and directory are not specified, files are read from or saved to \FMSGL.
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7.3.2 -ASCll Map

When using an ASCII Module, it is necessary to specify whether the Module is connected to
remote channel 1 or 2, The module number is set on the rotary switch of the ASCII Module.

The following procedure provides an example of the setting operation.

1) Select ASCIl Map from the Map Menu using the Cursor Keys and press the Enter Key.

in Overview XM Settings Toels Quit
g;——'"'!’z - — - P -V —PY
P| 140 Hap iguration
Link Ma
PIC @ Special Reg
PLC type Gli28 - Y10256 Bat coil 208192
ExeocPack 28 #C coil-2 ¥28256
User Logic 16 X MG cotcoill Q18168 C zweep 489998 -
State RAM 2K MC cntcoil2 Q28160 489999
Segment No 1 nC relay-1 X18256 Hepeed scan 4897997
Motion 2 Module HC relay-2 K20256 Timer Rag 489996
ink 2 Moduls MC cntrly-1 P18256 Step Relay 482881 -
MC cntrly-2 P28256 4082832
I : Mcode rly-1 M1B896 Calendar 4897988 -
120 module 34 Mcode »ly-2 M2B896 489995
CH1 Statijom i5
CHZ Station 15 Link Coil 1 D11824 HC linkRegl 489842 —
Link Coil 2 D21824 14
Reference : Link Reg 1 Ri1824 HC linkReg2 489915 -
Coil 008192 Link Reg 2 R21i6824 487987
Input Relay i81@24
!nﬂt Reyg 390512
Hold Rey 489999
Const Regy 704096

2) The ASCII Map Screen will be displayed. Setthe channel of Module number 1 by entering
1, and press the Enter Key.

E‘};iﬁ . T on:ls Quit
Moduls No. Channel
1 a
2
3
L]
5
6
?
3
J

3) Set the subsequent Modules using the same procedure.
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7.4 Other Setting Operations

This section describes setting operations for communications parameters, constant
sweeps, segments, and MC10 parameters.

7.4.1 Setting Communications Parameters ....................c.oal. 7-32
7.4.2 Setting Constant Sweep ................ e 7-34
743 SeftingSegments ...................... ittt iaaaanaa e 7-36

7.4.4 Setting MC10 Parameters ............... e eiireereiaaaaaas 7-43

7.4.1 Setting Communications Parameters

1. Changing Communications Parameters

The following procedure can be used to setthe communications pori parameters forthe PLC.
The parameters that are set here are transferred to the PLC by the Load operation, and are
actually changed when power is tumed ON or the PLC is started. An example forthe GL120 is
shown below.

1} Select Ports from the Settings Menu using the Cursor Keys and press the Enter Key.

in Overvisw Map Tools Quit
F2 F3 “tti £y 7P -0a—F?
PLC Syeten lm_
S-slunt:
FLC = NCi@ Parametsr |cial Re
PLC type GL128 NG coi coﬂ 888192
ExecPack 20 W coil-2 Y2
User Logic 16 X ne cnteoill QG160 C sweep 489998 -
State 2K MC cnteoil2 ll2 21608 409999
Segment Mo 1 NC relay—1 Hspeed scan 489997
Mot ion 2 HModule ne relay-2 2232 Timer Reg 489996
Link 2 Module MC cntrly—1 PLE256 Step Relay 482001 -
MC cntrly=-2 P28256 482032
irn0 s Hcode rly-i M10@96 Calendar 409988 —
1/0 module 34 Hcode rly-2 M280%96 409975
CH1 Station 15
CH2 Station 15 Link Coil 1 Dii824 HC linkRegl 40%942 -
Link Colil 2 D21924 914
Reference = Link Reg 1 R11024 MC linkRog2 489915 -
Coil 088192 Link Reg 2 R21824 489987
Input Relay 181824
Input Reg 398512
Hnﬁ Res 493239
Const Reg 784876

2) The Port Parameter Setting Screen will be displayed. Select the itemto be changed using
the Cursor Keys.

I;lr:in Default - m_%guMit
P2 F3 P4 FS- 6 F2-1 -
PORT PARAMETER SETTING
PORT M0  MODE DATR BIT PARITY STOPF BIT BAUD RATE ADDRESS DELAY
CPUport RTU 8 EVEN 1 2600 1 Bms
COM P 3 EVEN 1 2688 1 Bt
com2 u s EVEN 1 9688 1 Bns
Comm3 RIU 8 EVEN i 9688 1 Bns
COMM4 RIU 2 EVEN 1 2600 1 Bnt
RIQR1G1 RTU | ) EUEN 1 9688 1 Bms
R182 RIU g EVEN i 9688 1 Bms
RICRIA3 RIU 1 EUEN 1 9688 1 Oms
RiB4 RIU 8 EUEN 1 9688 1 Bz
RICRiGS RIU ) EVEN 1 2600 1 Bns
RIOR1@G RIU 8 EUEN 1 9688 1 Bns
RICR187 RTL 9 EVEN 1 2688 1 Bmz
RIORiB8 RTU 8 EVEN i 9688 . 1 Bz
RIOR1@G9 RTU 8 FUEN 1 9600 1 Ons
RIORL18 RIV ] EUEN 1 7688 1 Bz
RICR111 RTU 2 EVEN 1 2600 1 B
RIOR112 RIV ] EUEN 1 2600 1 Bnz
RIOR113 RIV 8 EVEN 1 9680 - 1 Bz




7.4 Other Setting Operations

3) After moving the cursor to the position of the item to be changed, press the Enter Key.
Data that can be selected will be displayed. After selecting data using the Cursor Keys,
press the Enter Key again.

Default " " };gtl: Quic
P g5 ————P————F7- TR PR - —FY
PORT PARAMETER SEITING

DaTh EIT PARITY STOP BIT BAUD RATE ADDRESS DELAY
[ EUEN 1 9600 1 [ i

[] EUEN 1 2688 1 B

[ EUEN 1 96P0 1 Bny

£ EUEN i 2600 1 Baz

8 EUEN 1 9608 1 Bns

4 EUEM 1 2600 1 Bns

3 EVEN i 2690 1 [ ]

3 EYEN i 9600 1 i

] EUEN i 2608 1 Bax

] EVEN 1 600 1 [

] EVEN 1 9688 i Bms

| 4 EUVEN 1 7608 i Bmz

] EVEN 1 9688 1 Bmx

] EUEN 1 9688 1 [

[ EUEN 1 7688 1 Bmx

L] EVEN 1 96688 i Bmz

] EVEN 1 2600 i Bnz
RIOR113 RIU L} EVEN 1 9600 1 Bmz

The communications parameters will be changed.

in Default Tools Quit
a2 —r—F3 4 F5 £6 F -E—FY
PORT PARAMETER SETTING
PORT NO  1ODE PATA BIT PRRITY STOP BIT BAUD RATE RADDRESS DELAY
mmﬂ RTU ] EVEN 1 608 1 Bus
? EVEN 1 7608 1 Bax
com2 (1] 2 EVEN i 9608 1 Gmz
CONnM3 Ry | ] EUEN 1 9609 1 Baz
RIU ] EVEN 1 9688 i Bas
RIORiAL RV | ] EVEN 3 9589 1 Oms
RIORIG2 RYU | ] EVEN 1 9688 1 Bms
RIOR1B3 RTU ] EVEN 1 9680 1 Bz
RIOR184 RIU -] EVEN 1 9600 1 Bag
RIORL@S RIU [} EVEN 1 2688 1 Bms
RIORLB6 RTU ] EVEN 1 7600 1 Bnz
o7 KIy 8 EMEN 1 2600 1 Bnz
RIORLIES RTU 8 EUEN 1 688 1 Bna
RIOR18% RTY ] EVEN 1 2688 1 Bz
RIORL1® RTU ] EVEN 1 9688 1 [ g
RIOR111 RTU 8 EUEN 1 9688 i Bns
RIOR112 RTD 4 EVEN 1 9688 1 Bmz
RIOR113 RTV [ EVEX 1 9688 1 Bt

4) For other parameters, move the cursor to the position of the parameter to be changed
and press the Enter Key. A selection window will be displayed. Select the data to be set
and press the Enter Key again,

2. Initializing Communications Parameters

Use this operation to initialize the settings of communications parameters.

1) Switch to the menu cursor using the Tab Key.

—7-33 —



Setting System Configuration
L _

7.4.2 Setting Constant Sweep !

2) Select Default using the Cursor Keys and press the Enter Key.

in Deault | Tools Quit
r2 B3 P4 75 P PP -Fo- 03—
E; PORT PRRANETER SETTING

PORT MO MODE  IMTA BIT PARITY ST0P BIT BAUD BATE ADDRESS DELGY
CPUport RIU 8 EUEN 1 2508 i Bma
comri  ASCII ? EVEN 1 9608 t ns
comtz  RID s EVEN i 9600 1 Bas
COMM3 RIU 8 EUEN 1 9689 | i B
com Ry 8 EVEN 1 9698 1 Bns
RIORIBY  KIU 8 EVEN 1 9680 | 1 Bns
RIOR1B2 RIU -4 EVEN i 2680 i [ it
RiOR{E3 KU 8 EVEN i 9688 1 ns
RIORiB4 IV g BN 1 9698 i Bes
RIOR1BS RIU 8 EVEN 1 690 1 Bns
RIOR1O6 FRIU 8 EVEN i 7608 . i Bz
RIORLB? KIU g EVEN | 9600 i tas
RIORIBE RIU 8 EVEN 1 9600 ° 1 i aid

Ri69 R0 3 EVEN 1 9608 . 1 o
RIOR{18 RTU : EVEN 1 9600 | i ons
RIORI11 RIU ' EVEN 1 7688 1 ene
RIOR112 BRIV 8 EVEN 1 2688 . 1 Bnz
RIOK113 BTV ] EVEN 1 2688 1 Bms

The communications parameters will be initialized. .

7.4.2 Setting Constant Sweep

Setthe constant sweep as described below. This operation is also possible fromthe PLC Op-
eration Menu in Online or Debug Mode.

1) Select Segments from the Settings Menu using the Cursor Keys and press the Enter

Key.
bhin Ouerview Ha biecz aingr g Toals Quit
FI’!.*—F!—-—-—-% !";p Settings - Fe-T—FY
PLC System| FPorts ‘
PLC = Ei Paramoter |cial Reg =
PLC type GL12@ MC coi t coil 288192
ExecPack 20 MG coil-2  Y20256
Uzer Logic 16 X MC cntcoill Q18168 C sweep 429998 -
Stats RAN 32 X MC ecntcoil2 Q20168 429999
Segment Mo 1 MG relay-1 X18256 Hspeed scan 489997
Motion 2 Hodule MC relay-2  ¥X28256 Timer Reg 489996
Link 2 HModule HC cntriy-1 P18256 Step Relay 402001 -
G entriy-2 P2E256 2
170 = ficode rly-1 M18896 Calendar 489988 -
170 wodule 34 Mcode rly-2 M208%6 4089995
CH1 Station 15
CH2 Station 15 Link Coil i Di11B24 nC linkRegl 489842 -
Link Coil 2 D21824 4
Reference : Link Reg 1 Ril1B24 MC linkRey2 489915 —
Coil 008192 Link Reg 2 R21024 429987
Input Relay 181824
!ngut Reg 3808512
Hold Resy 499999
Conzt Reg 704096

2) The Constant Sweep Screen will be displayed. Switch to the menu cursor using the Tab
Key.
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M

3} Select C Sweep using the Cursor Keys and press the Enter Key.

Iﬂain Inzert Delete W HE Scan Default Tuh
[Fl —————F2———F3 P4 m——-ﬂ
SEGMENT SCHEDULER & COMSTANI SWEEP
CONSTANI SVEEP :0FF lllll SCAN TIME: n3 REFP :
WATCHDOC TIMER : 248
HIGH SPEED ESCAN :QFF SCAN TIME: L)
SCHEDULE REF L SPEED S$EG
NO TYPE WO ° SENSE
1 CONT INUOUS !1
2 EOL

The cursor will move to the position of the constant sweep.

4) When the Enter Key is pressed on the constant sweep position, an ON/OFF Selection
window will be displayed. Select ON using the Down Cursor Key and press the Enter Key.

—— Insert Delete C Swsep I|S Scan Default Tools Quit
3 -4

I%L;% P ] P4 PS5 F7 - -Fo - ——F9
SEGMENT SCHEDULER & CONSTANT SVEEP
CONSTANT SVEEP =% MIN_SCRN TIME: [ REF :
WATCHDOG TIMER [
HIGH SPEED SCAN :0FF SCAN TINE: n3
SCHEMWLE REF L SPEED SEG
NO TYYE NG SENSE Lixx
1 Boml. TNUOUS a

5) The cursor will move to the minimum scan time position. Set a minimum scan time {20in
this example) and press the Enter Key.

Main Insart Delete € Sweep HS Scan Defale Tole o
PP PG g

[F]———P2 —F?
SEGMENT SCHEDULER & COMSTANT SWEEP

COMSTANT SWVEEP :OM  MIN.SCAN TIME: Il =s REF = 489995489779
WATCHDOG TIMER : 240 ms
HIGH SPEED SCAN :0FF SCAN TIME: ad
SCHEDULE REF L SPEED SEG

NO TYPE MO SENSE

i CONTINUQUS Bi

2 EoL

6) To change the constant sweep holding register, move the cursor to the Reference posi-
tion and enter a reference number.
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7.4.3 Setting Segments

For normal segments, the conditions and order of solving can be set for each segment. These
parameters can be set on the Segment Scheduler Screen. An example of setting the seg-
ment scheduler is shown below with the normal segment number 5.

1. Displaying the Segmeht Scheduler Séreen

Select Segments from the Settings Menu using the Cursor Keys and press the Enter Key.

Piatn

—p2—

CHL Station
CH2 Station

Refavence :
?ilt Rela
n
Inwt Reg v
u.ﬂ Bey
Const Reg

Too

Quervisw Hap
3 P4 Settings
PLC Syatem| Popts
Eﬂ Imt:r cial Reg
GL128 MC coi t coil
20 MC coil-2_ Y2@256
16 X MG enteoill Q10160 C susep
32 X MC catcoil? Q2016
5 MG relay—1 X1B8256 Hepeed scan
2 Module MC relay-2  X20256 Timer Reg
2 PNoduls e entrly-1 H1O256 Step Relay
MC entrly-2 P26256
Meode rly-1 N18E96 Calendar
g; Heode rly-2 H2BE96
15 Link Coil 1 D11B24 MC LlinkRegl
Link Coil 2 D21@24 :
- Link Reg 1 Ri11024 NG linkReg?
228192 Link Reg 2 R21824
181924 .
JeBes12
429999

008192

409998 —
489999

489997

! Quit
TP -G

“

The Segment Scheduler Screen will be displayed.

E;in Inzert Delate C Swsep HS Scan Default Tools Quit
P2 ————F3 ————F—————F - F - —F9

SEGMENT SCHEDULER & CONSTANT SWEEP

CONSTANT SUEEP :OFF MIN.SCAN TIME: ne REF : -
WATCHDOG TIMER : 248 ms
HIGH SPEED SCAN :0FF SCRN TIME: ns
SCHEDULE REF L SPEED SEG
Ilg IYPE NO SENSE Lﬁ
2 CONT I NUO: a2
3 CONT INUOUS a3
4 CONT INUGUS a4
5 CONT INUOUS as
6 EOL

2. Setting High-speed Scan

By setting the high-speed scan, the ladder program stored in a high-speed segment is
executed for each scan. When high-speed segment are used, this setting is required.

1) Switch to the menu cursor using the Tab Key.
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2) Select HS Scan using the Cursor Keys and press the Enter Key.

in Insert Delete C Sweep Defanlt Taols Quit
k;——-——l?z—-——l’:—ﬁ————-—l's——-—mw-m——ﬁ
SEGMENT SCHEDULER & CONSTANY SWEEP
TANT BUEEP -OPP ﬂlll SCAN TIME: REP : -
Hﬂlcll TIMER
HIGH SPEED SCAN :OFF scmt TINE: n3
SCHEDULE REF L SPEED SEG
NO TYPE NO SENSE Locx
1 CONT INUOUS a1
2 CONT INUOUS -]
3 CONT INUOUS ]
4 CONT INUOUS a4
s CONTI &
e EOL

3) The cursor will move to the high-speed scan position. When the Enter Key is pressed, a
selection window will be displayed. Select ON and press the Enter Key.

Inszert Delete C Sweep HS Scan Default Taols Quit
———F4————P————P% ~Tg—FY

OFF i
SEGMENT SCMEDULER & CONSTANI SWEEP
CONSTANT SVEEP :OFF lllN SCAN TINE: »3 REF : -
NRTCHDOG TIMER : 2
RIGH SPEED SCaN :Ij SWN TIME: i
SCHEDULE REF L SPEED SEG
NO TYPE NO SENSE Lxx
1 CONT INUOUS el
2 CONTINUOUS ez
3 CONT INUOUS a2
4 CONT INDOUS B4
5 CONT INUOUS s
L EOL

4) The cursor will move to the scan time position. Set a time interval for executing high-
speed scan (10 in this example).and press the Enter Key.

Insert Delete G Sweop llS Scan Default Tools Quit
[F1 F2 3 T4 FS 6 P2 Fe-THE—-F9

SECMENT SCHEDULER & COMSTANI SWEEP

GONSIRNI SHEEP :OFF IIIN SCAN TIRE: L] REF : -
HATCH. TIMER 240
HIGH SPED SCAN .(II SORN TINE:[ZH ns
SCHEDULE REP L SPEED SEG
NO TYPE NO SENSE Loox
1 CONT INUOUS []
2 CONT INUOUS -7
3 CONT INUOUS e3
4 CONT INUOUS a4
5 CONTINUOUS -
6 EOL
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3. Changing Ladder Program Processing Order

The order of solving the program can be set freely for normal segments. Solving can be
executed twice in one scan for normal segments depending on the setting. The following ex-
ample shows how to rearrange the solving order for normal segments 2 and 3.

1} Move the cursor to the segment number position of schedule number 2 using the Cursor

Keys.
Main Insert Delete C Sweep HS Scan -Default Tools Quit
[fl——F2 —F — TP -Fe -,
SEGMENT SCHEDULER & CONMSTANT SWEEP
CONSTANT SWEEP :0FF MIN.SCAN TIME: »s REF : -
WTCHDOG TIMER = ns ;
WIGH SPEED £CAMN :ON SCAN TIME:1P as
SCHEIWLE REF L SPEED SEG
NO TYPE MO SENSE Looc
CONTINUOUS 2l
2 CONTINJOUS @
3 CONT INUOUS
4 CONTINUOUS a4 |
5 CONTINUOUS es -
6 EOL

+

2) Enter the second normal segment number to be solved. In this exampie set segment
number 3 and press the Enter Key.

Main Insart Delsts C Sweap HE Scan Default Tools Quit
[Pl ————F 22— — e e 7 IO
SECMENT SCHEDULER & CONSTANT SWEEP
CONSTANY SWEEF :OFF MIN.SCRN TIWE: ns H -
WATCHDOG TIMER : 2 ns
HIGH SFEED SCAM :ON SCAN TIME:1B ns
SCHEDJLE RER L SPEED SEG
NO TYPE NO SENSE Lxx -
1 CONT INUOUS a1
2 CONMTINJOUS g
3 CONTINUOUS
4 CONT INDOQUS 84
2 CONTIMNQOUS s

- I|

]

3) Move the cursor to the segment number position of schedule number 3 using the Cursor
Keys. Change the third segment number to be solved to 2 and press the Enter Key.

o o

Insert Delste J(;.!Su-lp HS Scan Default Tools Quit
F3 $4- F6 F7— T Fo -]

™ ¥

SEGMENT SCHEDULER & CONSTANT SUEEP

COMSTANT SWEEP :OFF MIN.SCAN TIME: ne REF : -
SATCHDOG TIMER : 240 s
HIGH SPEED SCAN :ON SCAN TIME:10 =s .
SCHEDULE REF L SPEED SEG

NO TYFE NO SENSE Loox

1 CONT I NUCUS 81

2 CONT INUOUS a3

3 CONT INUOUS 7

4 CONT INUSUS

S CONT INGOUS oS

€ EOL
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M

The setting has now been changed so that segment 3 is solved second, and normal seg-
ment 2 is solved third.

4. Changing Segment Solving to Controlied Segment Solving

Itis possible to specify that solving for a normal segment can be restricted to only the scans
for which a reference is ON or OFF.

1) Move the cursor to the position of the schedule numberthat is to be changedto controlled
solving using the Cursor Keys.

Main Inzsert Delste C Sweep HS Scan Default Toals Quit
P————F2————F3———F4——— P ——— e

SEGNENT SCHEDULER &k COMSTANT SWEEP
CONSTANT SWEEP :0FF MIN.SCAN TINE: n3 REF = -

WATCHDOG TIMER : 240 ma
HIGH SPEED SCRN :0M SCAN TIME:18 ms

SCHEDULE REF L SPEED SEG
N TYPE SENSE Loor
1 CONT INUOUS a1
2 CONT INUOUS a3
3 CONT INUOUS a2
4 24
5 i es
[ EdL

2) When the Enter Key is pressed, a selection window will be displayed. Select Controlled
using the Down Cursor Key and press the Enter Key.

Insert Delete C Sweep HS Scan Default Toeols Quit
F3————Ft——— P ———— P ———F 7 - Fo- 1T —FY

SEGMENT SCHEDULER & CONSTANT SWEEP

CONSTANT SWEEP :OFF HMIN.SCAN TINE: L3 REF : -
HATCRDOG TIMER : 240 ms
HIGH SPEED SCAN :0N SCAN TINE:18 =ms

ECHEDULE REF L SPEED SEG

L] TYPE HO SENSE Lxx
i CONT INUBOUS a1
2 CONT INUOUS a3
a CONT TRUOUS 2
4 B4
S NUOY
6 EOL
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—— L
7.4.3 Setting Segments cont. )

3) The cursor will move to the reference number pos:ition. Enterthe reference number to be
referenced {20 in this example) and press the Enter Key.

in Inzsert Delete € Sweep HS Scan ‘Default Tosls Quit
[F1 —————P 2w J i P e rreererere— 6 ————F 7/~ T8 - —F9
SEGHENT SCHEDULER & CONSTANT SVEEP
CONSTANT SH'EEP zOFF MIN.SCAN TIME: ms REF : -
WUATCHDOG TINER : 248 ms
HIGH SPEED SCAN -m SCaN TIME:18 =as
SCHEDULE L SPEED SEG
NO TYPE NO SENSE Lixx
1 CONT I NIOUS )8
2 CONT I MIOUS a3
1 GONTROLLED IEIZEE  OM ’
AMHHZ Y
E %lwws as

4) The cursor will move to the sense position. If ON is correct, move the cursor to another
position. To change the setting to OFF, press the Enter Key. A selection window will be
displayed. In this example, keep the setting as ON.

'

k;in Inzsert Delete € Sweep RBS Scan Default Teols Quit
e f2 e ————F s P, —— - F -0l —F?
SEGMENT SCHEDULER & COWSTANT SWEEP
CONSTANT SWEEP :0FF MIN.SCRN TIME: e REF : -
WATCHDOG TIMER : 240 ns
HIGCH SPEED SCAN =ON SCAN TINE:10 ms
SCHEDULE REF L SPEEP SEG
NO TYPE NO SEMNSE Lxx
1 CONT I NUOUS [-}]
2 CONT LNUOUS o«
3 CONT INIOUS a2
4 CONTROLLED ©oe828 a4
E EOOONLHWOGIS s

For normal segment 4, solving and processing will not be performed only for the scans in
which reference number 20 is ON,

5. Inserting/Deleting Schedules

The following example shows how to add one schedule between schedule numbers 2 and 3.

1) Move the cursor to the line of schedule number 3 using the Cursor Keys.

Iﬂain Incert D-].ltc c Su-np HS Scan Default Toals Quit
[Fi————F2—¥3 P4 5 F7- RN F8 -0 -—FY
SEGMENT SCMEDULER & COMSTANT SWEEP
WNST‘IH‘I’ SWEEP :OFF MIN.SCAN TIME: ne REF : -
DOG TIMER : 248 ms
lﬂl SPEED SCAN :=ON SCAN TIME:10 ms
SCHREDULE REF L SPEED SEG
NO TYFE NO SENSE Lo
1 WTINIWS a1
2 a3
3 ONIINUOUo
4 CONIROLLED opeaze OR B4
5 CONTINUQUS 5
[ EOL
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2) Switch to the menu cursor using the Tab Key.

3) Select Insert using the Cursor Keys. Then, press the Enter Key.

in [EETSTHM Delete C Sweep HS Scan Default Tools Quit
E; 2 ) P4 FS— " 76 7N PO B9
SEGMENT SCHEDULER & CONSTARNT SWEEP
CONSTANT SWEEP :0FF HMIN._SCAN TiME: L] REF : -
WATCHDOG TIMER : 248 mx
HIGH SPEED SCAN :0M SCAN TIME:18 msx
SCHEDULE REF L SPEED SEG
L] TYPE NO SENSE Looe
1 CONT INUOUS a1
2 CONT I MUOUS 2]
3 CONT I NUOUS a2
4 ROLLED B86820 O o4
2 CONT INOUS a5

One schedule will be added between schedule numbers 2 and 3.

Inzert Delete C Sweep HS Scan Default Toels Quit
—F e P§ ———F————F?~- [ -F8 - [ —F9

SEGNENT S$CHEDULER & CONSTANT SWEEP

COMSTANT SWEEP :zOFF MIN.SCAN TIME: ns REF : -
WATCHDOG TIMER : 249 ms
HIGH SPEED SCAN :=0M SCAN TIME:10 ws

SCHEDULE L SPEED SEG
NO TYPE NO SENSE Toox
1 CONTINUOUS ot
2 CONT I \UouS a
3 a3
4 OUsS a2
5 CONTROLLED B99820 ON -2 )
g EDGWLIIN.IGIB -3

1) When a schedule is inserted, the normal segment number will be duplicated. Therefore,
always set a different normal segment number after inserting a schedule.

2) Bolving is not performed for normal segmenits that are not set in the segment scheduler.

3) If the number of segments set exceeds the range of the number of segments set in the 7
overview screen, an error wilt occur. See section 7. 1.4 Setting Segments when changing
the number of segments.
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7.4.3 Setting Segments cont.

6. Initializing a Scheduler

Only the segment scheduler is initialized by this operation. The settings for constant sweeps
and the high-speed scan are not initialized.

1} Switch to the menu cursor using the Tab Key.

2) Select Default using the Right Cursor Key. Then, press the Enter Key.

SEGMENT SCHEDULER & CONSTANT Sl‘EEP

CONETANT SWEEP :OFF MIN.SCAN TIME: ns REF = -
WATCHDOG TIMER : 2 n3 !
HIGH SPEED £CAN :ON SCAN TINE:10 mz

SCHEDULE REF L SPEED SEG
NO TYPE NO SENSE Lxx .
CONT INUOUS !
CONT INUOUS
CONT INUGOUS
CONT INUOUS
CONTROLLED
CONT INUOUS
EOL

rin o !_n_sn-t Delste S'Su.up HS Scan m_;gnh Quit

apeaze oN

SRR W N
REREER

3) A confirmation message will be displayed. Enter Y and press the Enter Key.

in Ingert Delete C Sweep HS Scan Default Tools Quit
——— 22— F——— PP ————F§ ———F - PP A - T —F9
SECMENT SCHEDULER & CONSTANI SWEEP
CONSTANT SWEEP :0FF MIN.SCAN TIME: ns REF : -
VATCHDOG TIMER : 248 ns .
HIGH SPEED SCAN :0N SCAN TINE:18 ma
SCHEDULE REF L SPEED SEG
NO TYPE NO SENSE Locx
1 CONT TNUOUS o
2 CONTINUOUS aa
3 CONTINUOUS [-x]
4 CONT INUOUS a2
5 ROLLED 888828 ON a4
'5.! CONIINUOUS a5

Reset Seygment Table to DEFAULT {‘,:nt\‘j.c: —- Are You Surc? <{Y/N2 T

The segment scheduler will be initialized.
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M

7.4.4 Setting MC10 Parameters

Use this operation to set the MC10 parameters. When using an MC10 Motion Module, it is
necessary to set the parameters for each Module using this operation. The MC10 parameter
operation can only be executed in Offline Mode.

1. Displaying the MC10 Parameter Edit Screen

1) Select MC10 Parameter from the Settings Menu using the Cursor Keys and press the
Enter Key.- '

Main Querview Map Tools Quit
1 P2 F3 Fi—-—-—*-—%tingc 7-N-F8 - 5—F9

PLC Syttem| Ports
Segmente
PLC cial Rey :
PLC type %120 HC cei t coil Bae192

3
ExscPack WG coil-2  ¥28256

User Logic 16 X HC cntcoill Q1iB160 C sweep 409998 -
State ] 2z x MC cntcoil2 G2@160 4187992
Seymant No 1 MC welay-1 X18256 Hspewd scan 489997
Metion 2 Module MC relay-2 X20256 Timer Reg 489996
Link 2 Module MC cntrly-1 PLB256 Step Relay 402001 -
NC cntrly-2 P20256 482832
1,0 ¢ Mcode rly-1 M1IBG96 Calendar 489988 -
1-0 module 34 Ncode »rly-2 N20@96 489995
CHL Station 15
CH2 Station 15 Link Coil 1 D11824 BC linkRegl 409842 -
Link Coil 2 D21924 489914
Reference * Link Reg 1 Rii@24 NC linkReg2 409915 —
Coil 298192 Link Reg 2 R218924 429987

2) The Module number selection window will be displayed. Select the Module number using
the Cursor Keys and press the Enter Key.

Main Select Defanlt Textfile . Ioo_h Quitc
IF1 F2 ¥3 P R B PP F8-TER—F?
. SET VALYE | UNIT RANGE
—
o iNFo It the Module has not been previously set, select New, and the Module Number Input Screen

will be displayed. Enter the desired Module number.
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7.4.4 Setting MC10 Parameters cont.

The MC Parameter Edit Screen will be displayed.

Main - Select Defamlt Textfile ' Taols Quit
[F{——— F2-FFie P 76 —————F 7O PO - — P ——
MG PARAMETER EDIT
Filename: GL128_2.M61
NG. DESCRIPTION $ET UALUE UNIT RANGE |
PBOL |DECIMAL POINI 1-3
PBE2 ] —-+99999999
P16l |POSITION LOOF GRIN 3818 1 - 208
P182 |FEED FORWARD GRIN alx 8 - 200
P1B3 |POSITIONING RANGE 18 |UNIT . 8 - 19990
P1B4 |POSITIOMING CHECK TINE 100883 | me . ]
P18S |POSN DEUIATION MARGIN 200 | La - 299
PiB6 |STEP MOUEMENT 1090 [UMIT B - 99999999
P167 -] —+99999999
P281 {mAX FEED SPEED 24989 |mamin 1 - 240908 II
Pz2e2 |FEED SPEED 24000 (masmin 1 - 240888
P283 |ACCEL TIME 188 |ms 1 - 18388
Fzb4 |DECEL TIME 1688 |ns 1 - 10908
P285 |S CURVE nCC/DEC TIME C 108 |ms 2 - 1608

3) Set the parameters for the MC10 Motion Module.

2. MC10 Parameter Edit Screen Operations

The operation procedure of the MC10 Parameter Edit Screen is basically the same as that for
other Motion Modules. See chapter 14 Editing Motion Parameters for further details.

o[ iNFo 1> 1) The MC10 parameter data is saved in files for each Module. The file name configuration
is as follows:

GL120_3. M99
l T Module number (01 to 99)
MC10 parameter file

File name selected from Programs

2) The number of the MC10 Motion Module is set using the rotary switch on the front of the
MC10 Motion Module. The Module number cannot be set from MEMOSOFT,
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Segment/Network List Operations

This chapter describes operations that can be used while a segment list
or a network list is displayed.

8.1 Segment List Operations .................. 82

8.1.1 Overview . ... 8-2
8.1.2  Command Operations .......................... 8-4
B.1.3  Edit Switching Operations ....................... 8-10

8.2 Network List Operations .................. 8-14

821 Overview ............. ... ... .. 8-14
822  Network Operations ............................ 8-15
B.23  Editing ... ... g-18
824  Reusing/Referencing Other Programs .............. 8-22
8.25 SavingandMerging ............. . . ... ... ... 8-26
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Segment/Network List Operation
8.L1I Overview

8.1 Segment List Operations

+

This section describes basic segment list operations such as switching the segment list
display, and displaying the network list.

811 OVeIVIEW . ... it ittt e 8-2
8.1.2 Command Operations ..........cc.coiiiiiiiiisiiiiiiniiniiiianass 8-4
8.1.3 Edit Switching Operations ............... e 8-10

8.1.1 Overview

A segment list can be displayed by selecting Ladder frorn the Main Menu or ending the Lad-
der Editor Screen.
The following operations can be performed while theg segment list is displayed.

» Transferring control between segments

+ Searching and substituting ladder programs

+ Clearing network data contained in a seg;nent

« Checking for duplicate coil use

+ Displaying a network list

» Switching the display type

An example of displaying a segment list is shown below.

Select Ladder from the Main Menu using the Cursor Keys and press the Enter Key.

Hain | Ouervisw Map Settings Tools Quit
in Menu 3—F ~e—e——F6 Lev 7o ROF Famy o
de . PLC System Configuration
BConf §. tion
Special Reg :
Hiotion L12@ MC coil-t Y18256 Bat coil 888192
PEdit Comment a MC coil-2  ¥28256
£ Data 6 X MC cntcoill Q1P168 C sveep 409998 -
2K nc enteoll? Q20168 s 489999
Segmont No 5 nhri X18256 Hspesd_tcan 489997
Hetion 2 HModulse HC rela X28256 Timer Reg 409996
Link 2 Toduls R Dnerlvt PiGzoe  Stey Relsy sac6e1 -
MC entrly—-2 P28256 402832
10 = ode rly-1 M188%6 Calendar 4@89988 -
170 moduls 34 Mcode »ly-2 M20896 489995
CH1 Station 15
CHZ Station 15 Link Coil 1 D1—— MC linkRegi 489842 -
Link Ceil 2 D2--— 489314
Reference Link Reg 1 Rl—— MC linkRog?2 489915 - il
Coil 008192 Link Reg 2 R2— 489987
Input Relay 181824
Input Reg 399512
Hold Reg. 489399
Const Rey 7948%6
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m

A segment list will be displayed.

b;in Commands Edit Tools Quit
— P —Ps——F4 7 - 11??9
e H
SEGMENT STATUS DISPLAY Free : 16263
Segmant  Network Segment  Hetwork Segment HNetwork

Press <ENTER> to view the selectod segment

The following two types of segment fist are available.
« Segment Status

A list of segments allocated by the segment scheduler (high-speed segments and sub-
routine segments need not be allocated) and the number of networks stored in each seg-
ment are displayed.

E:in o Commands Edit Iools Guit

5 i 2.
e H 117
SEGMENT STATUS DISFLAY Fres : 16263

tl Segwent Network Segment Metwork Ssgment  Network
5

RN
:
:
:

Prezs (ENTER)> to view the xelected segment

+ Segment List

A list of segments allocated by the segment scheduler and the title of each segment are

displayed.
hllh. Commands Eﬁit Tools Quit
SEGMENT LIST DISPLAY Usu! H 117
Free @ 16263
Sey Ticle Seg Title
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Segment/Network List Operation
8.1.2 Command Operations

See section 8.1.3 Edit Switching Operations for details on switching the display between the
two types of segment lists.

O[EE{IP 1) The amount of used and free memory space for the ladder program is displayed in the
upper right corner of the screen. The unit used is the basic memory consumption of ele-
ments.

2) When the operations listed below are performed offline, ladder programs can be input
regardless of the maximum program size of the PLC. However, always be sure that the
maximum program size of the PLC will not be exceeded when loading edited programs to
the PLC. )

» Editing ladder programs.
¢ Browsing part or all of an existing ladder program.
» Merging I-adder programs. .
3) Anerror message will be displayed when loading ; program created offlineto a PLC if the

size of the program exceeds the maximum program size for the PLC.

4) As indicated above, no restrictions have been placed on the size of ladder programs that
can be input offline. This is to allow for easier editing.

8.1.2 Command Operations

1. Search in Program

The Search operation searches for the following information in all the segments and displays
the search results on the screen.

» Reference number
» Reference symbol
» Network title

» Segment title

Search results are stored in the \FMSGL directory as a text file. The file name is
SEARCH.LOG.

An example of the Search operation for a reference number is shown below.
1) Switch to the menu cursor using the Tab Key.
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m

2) Select Search in Program from the Commands Menu using the Cursor Keys and press

the Enter Key.
| Edit Tools  Guit
21 P2—————Co! d ~pf———F? -~ F9
titute in Fram PFree = 16263
Seg Delete Sogment g Title
———————| File Chec

3) A search setting window will be displayed. Enter a search pattem (in this example, refer-
ence number 18) and press the Enter Key. '

ain Commands Edit Tools  Quit
1 £2 3 F4 75 ¥ :—f—w—fﬂ—n
SEGMENT LIST DISPLAY FTI z 117
Free = 16263
Sey Title Ssy Title
Segment 1

Se nt 2

PRED
LeS NOT PROGRAMMED
§ NOT PROGRAMMED

Search results will be displayed.

Illain Commands Edit
[F1 F2——————F3—*—-———Fl——————ﬁs—m————fi-—~———¥?1F!lﬂk¥8—ﬂﬂ!——iﬂ
SEGMENT LIST DISPLAY ze
Free
] Seg tle

Found in:Segnent:H MHetwvork:2

Qeccurrences in Progran: 2
Occurrences in Comment: @

ESC Cancel
EHNTER  Continue
4, G Continue uithout confirmation
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Segment/Network List Operation
——————

8.1.2 Command Operations cont.

Use the following keys for the operations.

@ Cancels search processing.

Continues search processing. A screen is displayed
whenever a search pattem is detected.

Continues search processing. Even if a search pattern is
@ detected, the screen is not displayed and search is
continued until the end of the program.

2. Substitute in Program

The Substitute operation searches the following data for the information that matches a par-
ticular character string, such as the specified reference number, and substitutes the charac-
ter string with the specified character string. '

» Reference number
» Network title
« Segment title
An example of substitution of a network title is showh below.
1) Switch to the menu cursor using the Tab Key.-

2) Select Substitute in Program from the Commands Menu using the Cursor Keys and
press the Enter Key.
nEdit N Too Quit

in
= S T
Search in Pre 1 SPLAY lize H 117
mmqmﬁm Pree : 16263
Sey Delete g Title

File Chock
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3) A substitution setting window will be displayed. Enter the character string to be substi-
tuted (Timer 1 in this example) and press the Enter Key.

Main Commands Edit Toals Quit
Ft-———§2 ————F3————P4————F5~———F6———P?—Y F8~) P9
SEGNENT LIST DISPLAY tzecd i1
Frae 16263
Seg Title Sey Title
gnmnt %
egmEnt
Le2 NOT

PROGRAMIED
LB3 NOT PROGRAMMED
L84 NOT PROGRAMMED
L85 NOT PROGRAMMED
£ W07 PROGRAMMED

R I e A ——

4) Enter the character string to be inserted (Clock 1 in this example) and press the Enter
Key.

k;in Commands Edit Tosls Quit
———H—-—%——-PQ—PS———PS——P?—W—PB-!E}——H
SEGHENT LIST DISPLAY sed = 117
Pree = 16263
Seoy Titls Sey Title
1 Segment 1
91 Segmant 2
La2 uorf-mm
LB3 NOT PROGRAMIED
L84 NOT PROGRAMMED
LoS PROGRAMMED

Substivute by: ACRTET A

The substitution results will be displayed.

|ﬂcin Commands Edit Tools Quit
Fl—————F2————F) P4 FS- P6 :’?-{lw—
SEGMENT LIST DISPLAY EL3 H 117
Soy Title | Seg
Seyment 1
E Snwnt 2

Found in:iSegment:H Netiork:2
Cccurrences in Progran:
Qceurrences in Connent: 1
Suhztitutes jn Progran: @
Substitutes in Connent: 1

ESC Cancel

ENTER  Continue R
y. G Continue without conf irnation
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8.1.2 Command Gperations cont.

Use the following keys for the operations. ' :

@ Cancels substitution processing.
Continues substitution processing. The screen is displayed
whenever a substitution pattem is detected.

Continues substitution processing. However, even if a
EG] substitution pattern is detected, the screen is displayed and
substitution is continued to the end of the program.

3. Delete Segment

The Delete Se_gment operation removes network data from a specified segment.

An example of deleting network data from segment i.O‘l is shown below.
1) Move the cursor to the position of the segment tp be deleted usihg the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Delete Segment from the Commands Mehu using the Cursor Keys and press the
Enter Key.

k;i..

'Edi.t . . - Tools Quit
Search in Pregram o R 0] B 117

Subivus i | pisrLay Fres : 16263
——— C

Ne rk Sey Hetwork

)

“SEENE"|§
g
:

Prezs (ENTER> to view the selected segment

4} A confirmation message will be displayed. Enter Y and press the Enter Key.

in Commands Edit . Tools Quit
!'1—?2—-—!’3—!’4—?5———-—?6-—-———!‘7-”—?8—333;;!’9
sed =
SEGMENT STATUS DISPLARY . Fres = 16263
Segment HNetwork Sey Ny k S t MNatwork
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The network data of segment LO1 will be deleted.

Main Commands Edit Tools Quit
[Fl~———F2————TF3 Fd——F5————F6 - %

1 H 1
SEGMENT STAIUS DISPLAY  Froe - 16264

Seqment MNetwork Segment MNetwork Segment  MNetwork

"HEERE"
L
:

Pres: CENTER)> to view the selected segment

4. File Check

The File Check operation checks whether the program matches the system configuration and
if duplicate coils are being used. Search results are stored in the \FMSGL directory as a text
file. The file name is MEMOSOFT.ERR.

1} Switch to the menu cursor using the Tab Key.

2) SelectFile Check from the Commands Menu using the Cursor Keys and press the Enter
Key.

h;in 2 .,'r)nn-mdf, N 6 w—w—;’::ﬁ}“——glt

Search in Progran sed 119
Substitute in Program DISPLAY Fres : 16261
Dalste Slﬁnt

Segment He rh Segment HNetwork

" :

I

B2 sor

L83 NOT PROGRANMED

LB4 NOT PROGRA

L85 NOT PROGRAMMED

H NOT PROGRAMMED

Press (ENTER)> to view the selected segment

When the same coil is used more than once, the following messages will be dispiayed.

hiﬂ . Commands Edic . Tools Quit
F2 T3 P4 ] F6 F7-TE-F s
SEGNENT STATUS DISPLAY Fres 1 16261
Seamant Network Segment Network Segment Network

ek

Seynent: 2 Object: PAYE  HNetuwonk:
Errver 1

Systen Mevuaye
itten tuice

colim 1 BUBA2 - <ESC» Cancel Check
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_
8.1.3 Edit Switching Operations
Use the following keys for the operations.
@ Cancels file check processing.
Continues file check processing. A screen is displayed
whenever an error is detected.
f[nro 1) When the file check results contains errors, the results cannot be loaded to the PLC. Cor-

rect all errors before loading the information.

2) When networks are copied or edited, duplicate coils may be present. Perform a file check
after any of these operations.

8.1.3 Edit Switching Operations

The following displays can be accessed through ths{ Segment Status Display.
» Ladder Editor Screen
» Network List Display
» Segment List Display

. éwitching to the Ladder Editor Screen

The foliowing two types of operations are available for switching to the Ladder Editor Screen.

1. Using the Enter Key

Move the cursorto the position of the segment to be displayed on the screen using the Cursor
Keys and press the Enter Key.

H,;i.n - Commands Edit o Tools Quit
F2: ¥3 4 PS5 P6 Fo-E-F e
SEGMENT SYATUS PISPLAY Free = 16263
Segment  Network Scgment HNetwork Segment MNetwaork

Press <(ENTER> to view the seclscted segment
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Network 1 of the specified segment will be displayed.

Main Elements Edit Go/Sech  Network Ref Tools Quit
[Pl ——————F2-———F3 4P ————F ————F7- - F8-0F5—F9
Seg-H %1 - 1 Start Sequance

10d00e

AAAWL {0
‘-

‘Mo Symbol/Descriptor availabl

feference Data

* Format =Decimal Files Data Range * 1

2. Using a Menu

1} Move the cursor to the position of the segment for which ladder editing is to be performed
using the Cursor Keys, and switch to the menu cursor using the Tab Key.

in Commands Edit Tools Quic
[Fl ———F2 ~er——F 3 —— P 4P ———F%. = e
zed =
SEGMENT STATUS DISPLAY Free : 16263

Segment HNetwork Segment HNetwerk Seyment HMNetwork
oo i
LB2 NOT PROGRAMMED
L83 NOT PROGRAMMED

| L84 NOT PROGRAMMED
Las PROGRAMMED
8 NOT PROGRAMMED

Prass (ENTER> to view the :alected zegment

2) Select Ladder from the Edit Menu using the Cursor Keys and press the Enter Key.

F!h i dx 1t
o in - Comman %ﬂ ‘lo: Quit

~F6———r7-[R-F8
m sed 117
Network List DISPLAY Free * 16263

Segment List

Segwment MNatwork Segmant HMHetwork Segment Network

Pross <ENTER> to view the selected segment

Network 1 of the specified segment will be displayed.
» Displaying a Network List

A list of networks contained in the selected segment can be displayed. See section 8.2
Network List Operations for details on the operations after displaying a network list.
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8.1.3 Edit Switching Operations cont.

1) Move the cursor to the segment for which network list is to be displayed using the Cursor
Keys.

2) Switch to the menu cursor using the Tab Key.
! _
3) Select Network List from the Edit Menu using thq Cursor Keys and press the Enter Key.

in Commands ZITHIN Tools Quit
h?——-—rz—-—-m—-—-—- - it —P6 ———F 7 PR
Ladder Used : 1172
DISPLAY : Free : 16263
Segment List
Segwment Network | Segwent MNetwork Segment MNetwork
58 i
182 NOT PROGRAMMED
L83  NOT PROGRAMMED
Le4 FROGRA
Lés  NOT PROGRAMMED
s NOT PROGRAMMED

Preszs {ENTER> to view the selscted segment

A network list will be displayed.

Netwerk Edit " Tools Quit

in
k:—m—-——m—n—-—-—-rs ————————Scgment:
SEGMENT z> ;iaer 3

3> Check at Start
4) Chack 1
Segment Metwork Segment 5> Check 2

Press {ENTER> teo

« Switching List Display

When MEMOSOFT is activated and Ladder is initially selected, the segment status will be
displayed. To switch to the segment list, execute the operation outlined below.

Afterthe display is switched to the Segment List Display Screen, the segment list is displayed
until Segment List is selected again. If Segment List is selected again, controf wili retum to the
Segment Status Display. '

1) Switch to the menu cursor using the Tab Key.
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8.1 Segment List Operafions

m

2) Select Segment List from the Edit Menu using the Cursor Keys and press the Enter Key.

ll‘lain Commandx Tools Quit
iF1 P F3 it -6 P2 -
Ladder Uzed 117
Hetwork List DISPLAY Pree : 16263
Soyment HNetwork Segment Network Segment HNetwork
B
182 MNOT PROGRAMMED
183 NOT PROGRAMMED
184 NOT PROGRAMMED
;@S NOT PROGRAMMED

Prezs {ENTER> to view the selscted zsgment

The display will switch to the Segment List Display Screen.

Main Commande Edit Tools Quit
[FL ~———F2———TP3 P4 PS5 P6 Fo-i -
SEGNENT LIST DISPLAY Used : 117
Free : 16263
Seg Title Seg Title
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Segment/Network List Operation

8.2.1 Overview

8.2 Network List Operations

This section describes edit operations performed on individual networks while the
network list is displayed.

821 Overview........ e e e e e 8-14
8.22 Network Operalions ..........c. ittt rreneeenny 8-15
B2.3  EQIliNG oottt ettt et e e e e 8-18
8.2.4 Reusing/Referencing Other Programs ........... ..o aa... 8-22
B.25 SavingandMerging ................... [ 8-26

8.2.1 Overview

A network list can be displayed by selecting Network :Listfrornthe Edit Menu onthe Segment
List Display Screen as described in section 8.7 Segment List Operations.

The following operations can be performed while a imetwork list is displayed.
+ Transferring controt between networks
» Inserting networks
e Copying, deleting, and pasting networks
« Executing the offset operation for networks

An example of simple transfer of control between networks is shown below.

1} Move the cursor to the position of the network to be displayed on the screen using the
Cursor Keys.

Main Network Edit Tools Quit |
F1 72 F3 P4——FS Seyg H
1> Start Sequence
SEGHENT 27 Timer 1
32 Check at Start
4> Check 1
Segment Network Segment 5> Check 2 ]

-
1

L82 NOT PROGHRHHED
LB3 NOI PROGRAMMED
L84 HOT PROGRAMMED
L85 MNOT PROGRAMMED
s HOT PROGRAMMED

Press (ENTER> to
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2) Press the Enter Key. The selected network will be displayed.

in Elements Edit Guﬁrch Hetwork Ref Jools Quit
P2 F4 F7- T8 -Ta—F7
Seg.H 45 + 5 Check 2 i

1 1

‘He Symbol/Descriptor availabl

Reforsnce Data

~ Format :Decimal Fils Data BRange : 1

8.2.2 Network Operations

1. Goto Network Operation

The cursor can be moved to the position of the specified sequenced network number or net-
work title while a network list is displayed.

1) Switch to the menu cursor using the Tab Key.

2) Select Goto Network from the Network Menu using the Cursor Keys and press the Enter

Key.
[Main JRTT Edit ‘Inols Quit
1% P2 HNetwork
| Ennrt Efou Het I gE
Cllnr.:k lt Start
4) Chech
Segment MNotwork Segment 5% Check 2
e H
1 1

La2
La3
L84 NOT PROGRAMMED
s

Prezs <ENTER> to
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Segment/Network List Operation

8.2.2 Network Operations cont.

3) A window for specifying the destination network will be displayed. Enter the destination
network number or title (Check 2 in this example} using the Down Cursor Key and press
the Enter Key. When a network title is entered, the network number will be ignored.

in Metwork Edit
[l ———F2 s———F
SEGMENT
Segment Network Segment
m o
L82 NOT PROGRAMMED
L83 MHOT PROGRAMMED
LB4 PROGRA
ls-ﬁ NOT PROGRAMMED

Network:z 1
Netvork Title:

Press <ENTER> to

ctuork

Goto N
|
Check 2§ ]

Tool: Quit

e ——— 1 -] nt:H

2 imer 1.
3> Check at Start
4} Check 1
5} Check 2.

4) The cursor will move to the position of the network title that was entered. Press the Enter

Key.

in Metwork Edic
R ] ——F
I SEGMENT
Segment HNetwork Segment
e i
1
Lez

Tools Quit I

Preszs <ENTER> to

gment :
1) Start Sequence
2> Timer 1
3) Check at Start
4> Check 1-

The network with the network number to which the cursor is currently set will be dis-
played.

in Elements Edit GosSrch Hetwork Ref Too Quit
-3 —F e —————F 7— DT -
Seg.H 85 ~ & Check 2 <>
186811
‘o Symbol-/Descriptor availabl
Reference Pata i
Format :Decimal File Data Range 1
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2. Insert Before Network Operation

This operation adds one empty network before the network in which the cursor is currently
set.

1) Move the cursorto the position in which a network is to be inserted using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Insert Before Net from the Network Menu using the Cursor Keys and press the
Enter Key.

]ﬂ};iﬂ o v'tunrk Eﬂit' - : Tools Quit
b Goto .htwuri; 1> Start Sem’mncu.
2) Timer i
4 ek 1
Ssgment MNetwork Segmant 53 Check 2
| s
La1 1
B2 NOT PROGRAMMED
LB3 NOT PFROGRAIRIED
LB4 NOT PROGRAMMED
LOS NOT PROGRAMMED
H NOT PROGRAMMED

Press {ENIER> to

An empty network will be added before the network at the current cursor position.

g;in Metwork Edit Tools Quit
—_—R—F}——P4—————F% Segmnt:l
1} Start Sequence
SEGMENT 2) Timer 1
s Network s 33 c!'l:°§ i e
sgment tWon] ognent €
i e 62 Chack 2
=
L82 HOT PROGRAMMED
La3 PROGRAMHMED
L84 NOT PROGRAMIED
L85 NOT PROGRAMMED
1 NOT PROGRAMMED

Press {ENTER> to
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8.2.3 Editing

8.2.3 Editing

1. Copy

The Copy operation stores network data from the area specified by the cursor. The data
stored by the Copy operation can be pasted to another position using Paste.

1) Move the cursor to the top or the bottom of the aﬁea to be copied using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Copy from the Edit Menu using the Cursor Keys and press the Enter Key.

in Network TITHEEE Tools Quit I
R 7 e o Bt it ] it

?ﬂ_ 1) Start Sequence

lete 2> Timer 1

Pasta 3% Chack at Start
Offeat ||

Segment N 'k ¥ ck 2

NOT ;mmm E

Press {ENTER> to

4) Specify the range using the Cursor Keys and press the Enter Key.

in Nstwork Edit Tools Quit I
[F1———F2 s Rt 5 tzl
1> Start Ssquancae
SEGMENT 22 Timer 1
3> Check at Start
47 Check 1
Ssgment Netwark Segment I S> Check 2

Prezs {ENIER> to

2. Delete

The Delete operation removes and stores the network data of the area specified by the cur-
sor. The deleted data can be pasted to another position using Paste. Therefore, this opera-
tion is useful not only for deleting networks, but also for moving networks. One network can
also be deleted by moving the cursor to the position of the network to be deleted and pressing

the Delete Key.

1) Move the cursor to the top or bottom of the area to be deleted using the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.
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8.2 Network List Operations

3) Seiect Delete from the Edit Menu using the Cursor Keys and press the Enter Key.

in Network Tools Quit
1-———P2————F3 t egment £1
Co 1> Start Sequence
'#é:. 25 Timer 1
aste m
Offset 4) Check 1
h 2

I|
Prezs <ENTER)> to

4) Specify the range (in this example, one network) and press the Enter Key.

Main Network Edit Tools Quit
Fl ——F2————F3——Fgf————F5 sgment 1
1) Start Sequence
SEGMENT 23 Timer 1
c

Segment  Metwork Sogment 5> Check 2

oo i

182 MNOT PROGRAMMED

L83 NOT PROGRAMMED

La4  NOT PROGRAMMED

L5 NOT PROGRAMMED

-3 NOE PROGRAMMED

hL Prasx <ENTER> to

The specified network will be deleted.

in Metwork Edit Tools Quit l
—_—R—F—PFf—Fs Sognent:1
1) Start Sequence
SEGMENT 2> Timer 1
4> ck
Segmant Network Segment
I 4
Lay 1
LB2 MNOT PROCRAMMED
LB3 NOT PROGRAHMED
LAa4 NOT PROCRA
L85 HMHOT PROGRAMMED
H MOT PROGRAMMED

Press <(ENTER)> to

3. Paste

The Paste operation inserts the network data that was stored by Copy or Delete at the cursor
position. In this example, the data stored by Delete described above is inserted to another
section. :

1} Move the cursor to the.position at which network data is to be inserted using the Cursor
Keys. '
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Segment/Network List Operation
8.2.3 Editing cont.

2) Switch to the menu cursor using the Tab Key.

3) Select Paste from the Edit Menu using the Cursor Keys and press the Enter Key.

knin Metwork | ) Tools Quic
] —P? e B3 it Segment 1
Gogz 1> Start Sequence
Delete 2> Timor 1
ly_ 3) Check 1 .
e ot 4> Check 2
N R

“BEERN|{
:

Prexs (ENTER> to

The stored network data will be inserted at the cursor position.

h;in Metwork Edit - Tools Quit
e P [TV -)- I— . ~ Sag a1
1) Scart Sequence
SEGMENT 2) Timer 1

Segment Hetwork Sogment 5) Check at Stant

H | 5

Le1 1

Le2 PROGRAMMED

L83 NOT PROGRAMMED

L84 NOT PROGRAMMED

Les PROGRA!

S NOT PROGRAMIED

Prezs {ENTER> to

4, Offset

The Offset operation replaces the reference numbers of the specified range with the refer-
ence numbers determined by adding a specified offset value. This operation is useful for
changing a reference number after copying a ladder program using the Copy operation.

While the Offset operation in the Edit Menu of a ladder program enables substitution within
one network only, this Offset operation allows substitution in multiple networks.

1) Move the cursor to the top or bottom of the network area to be substituted using the Cur-
sor Keys.

2) Switch to the menu cursor using the Tab Key.

1
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8.2 Network List Operations

m

3) Select Offset from the Edit Menu using the Cursor Keys and press the Enter Key.

Tools Quit
£ 13

it H
GCo; 1> Start Sequence
Do late 2> Yimer 1
Paste 3> Che ck at Start

t N k ck 2

k;in Metwork
—F3

Presz <ENTER? to

4) An offset setting window will be displayed. Enter the starting and last reference numbers
and the offset value (in this example, 100010, 100015, and 10 respectively.) Press the
Enter Key after entering each value.

in Network Edit Toals Quit
— P —F4—Fs £ H
1> s:m Sequence
SEGMENT 22 Time
32 Check at EBtart

Segment MNetwork Segment EE EcE g

5) The cursorwill be displayed in reverse video. Specify the area in which to substitute using
the Cursor Keys and press the Enter Key.

Main Network Edit Tools Quit
[fl—T———F 33— ——F5 ol tz1l
1> Start Sequence
SEGHENT 2) Timer 1
3> Check at Start
Seyment  HNetwork Segnent
mo
LAz NOT PROGRAMMED
L PROGRRMTED
LB4 WOI PROGRAMMED
Las PROGRAMNED
g WOT PROGRAMHED

Pros: {ENIER> to
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Segment/Network List Operation
8.2.4 Reusing/Referencing Other Programs

Substitution will now be executed, and the number of reference numbers that were sub-
stituted will be displayed.

E;in Metwork Edit ) Tools Quit
2 " P . P

1) Start chulncc
SEGMENT 2> Timsr 1
: 3 Chcck at Start
4) Check 1:
Ssgment Network Segment S Chack 2

oy i

Laz2
Laz
L84 NOT PROGRAMMED
%ﬁ

' Olm'i'ilb 1} This operation cannot be used to substitute for only part of a network. For substitution
within a network, select Offset from the Edit Menl of the Ladder Editor Screen. See sec-
tion 9.3 Editing.

2) Either a positive value or a negative value can Qe specified for the offset value.

3} When the number determined by édding an offset number to the specified starting or last
reference number exceeds the reference range set in the system configuration, an error
will occur. '

4) If two or more different reference ranges (for instance, 300001 for the starting reference
number and 401000 for the last reference number} are set, substitution will not be
executed.

8.2.4 Reusing/Referencing Other Programs

Using the editing operations described in section 8.2.3 Editing, part or all of a ladder program
that has been previously created can be reused or programs can be merged.

An example of how to go to a previously created ladder program is described below.

1) Select Files from the Tools Menu. Choose Select Program and specify the program
name from the submenu using the Cursor Keys. Then, press the Enter Key.

Ea. Confiy lLaddor Movion Comment Ref Data . ... Toods — Quit
—F2———F3 F7- T —leols————|

Sf-cht Pannan ‘

Swo chan

Save All ﬂlu

Save asz.

ey -
cation o gran Hume

File Operation

moves betwesn the Menu Bar and the Editing Screen.
al.f N provides help on the menu item zelected by the cursor.
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8.2 Network List Operations

m

2) Select Ladder using the Cursor Keys and press the Enter Key. The Segment Status Dis-
play Screen will be displayed.

in Commands Edit Tools Quit
Fl——— P2 PP §———F§ e P e PP Y —
ed 3

ls 1%6
SEGMENT STATUS DISPLAY Fres : 16194

Segment  Notwork Segment HNetwork Segment MNetwork

oy :
1

Prezs {ENTER> to view the sclocted segment

3) Move the cursor to the position of the segment which is to be referred to. Select Network
List from the Edit Menu using the Cursor Keys and press the Enter Key.

Mai Commands Tools Quit
Fle gy oy it o ———F7- TN V- TR
Ladder 34 H 186
limqﬁl DISPLAY Pres :© 16194
agment t
Segment Network Segmant Metwork Segment Network
H 1
md
1

Press <ENIER> to view the aclscted segment

The network list stored in the specified segment will be displayed.

4) Move the cursor to the top or bottom of the network to be referred to using the Cursor
Keys.

5) Switch to the menu cursor using the Tab Key.

&) Select Copy from the Edit Menu using the Cursor Keys and press the Enter Key,

lllain Netuwork Tools Quit
Fli——F2 P ———— §— :1e1

i

¥ B b
Ll 37 )~ R ]

te
Paste
Of fzet

1

t Start

Segment Metwork
H

] :

Lo 1ad
RELVDERW) - el
11
i
oaon
—xx

Press (ENTER> to
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8.2.4 Reusing/Referencing Other Programs cont.

7) Specify the area to be referred to using the Cursor Keys and press the Enter Key.

[Pt ——F2

ain Notwork Edit
——F——F

5 el

1) Start
SEGMENT 2) Timer
3> Check

Segment Metwork

Segment

m

Presz {ENTER> to

Sequencs
1
at Start

The network will be stored.

8) Select Files from the Tools Menu. Choose Seleict Program and specify the program
name to be edited from the submenu using the Cursor Keys. Then, press the Enter Key.

b;:i.n Network Edit
———F

Tools Quit

SEGMENT 2) Timer

Sogment > Check

t:LBt r—Tools———
iles

L ———

Save changes

Save A1l Elﬂ J
fave az...

Change PLG Address
Location of Program Mame
Pile Operation

Prezs (ENTER> to

The Segment Status Display Screen will be displayed.

9) Move the cursor to the segment to be edited. Select Network List from the Edit Menu
using the Cursor Keys and press the Enter Key.

Commands

hain  gowwes

it —F6————F74

Ladder Use H 2

m DISPLAY Free : 32762
egment List !

Tools Quit

Segment MNetwork

Sagmont Network

_Segment MNetwork

H __ NOT PROGRANMED
Ly ] 1
€ NOT PROGRAMMED

Prese <ENTER> to view the selected togmont
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8.2 Network List Operations

M

The network data stored in the specified segment will be displayed.

10) Move the cursor to the position in which the program is to be inserted using the Cursor
Keys.

11) Switch to the menu cursor using the Tab Key.

12) Select Paste from the Edit Menu using the Cursor Keys and press the Enter Key.

in MNetwork % Toals Quit
h:——l’!_ﬂ it Sogment sLO1L

Cngy 1> Normal_1 Start

Delets

Ehct
PRRTY o

ful NOT PROG?IIIED
MOT PROGRAMMED

Press <ENTER> to

The stored network will be inserted at the cursor position.

h“ Network Edic Toole  Guit
— P t——F5 —————————Segment : 181
1) Normal $tart
SEGHMENY
4> Chtgk 3
Segment MNetuerk Segment E; &:}: g
" NOT PMG‘:MIED
NOT PROGRAMMED
Press (ENTER> ta
O[I'}]iilb 1) When the operations listed below are performed offline, ladder programs can be input

regardiess of the maximum program size of the PLC. However, always be sure that the
maximum program size of the PLC will not be exceeded when loading edited programs to
the PLC.

» Editing ladder programs.
* Browsing part or all of an existing ladder program.
+ Merging ladder programs.

2) Anerrormessage will be displayed when loading a program created offline to a PLC if the
size of the program exceeds the maximum program size for the PLC.
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S —— o — — —— —
8.2.5 Saving and Merging

1

3) Asindicated above, no restrictions have been placed onthe size of ladder programs that
can be input offline. This is to allow for easier editing.

8.2.5 Saving and Merging

The previcus section described accessing existing programs and merging programs. This
section describes how to save part or all of an existing ladder program as a file in network
units. Ladder programs, network titles, and network comments within a network are saved as
a merge file (oo .BLK). Network data saved as'a file can be merged into another pro-
gram.

1. Save

The Save operation saves the specified range of network data as a merge file.

1) Display the network list.

Main Network Edit Block Tools Quit
1 B2 -F3 F4 F5 g H
12> tt i
SEGHENT 2> starting preparation 2
3> time circuit 1
4> time circuit 2
Segment Hetwork Segment 5> time circuit 3
6) check of eguipment A
H NOT PROGHRHHEg ?> check of equipment B
I
13 NOT PROGRAMMED
Press <ENTER> to ll

2) Move the cursor to the top or the bottom of the network to be saved using the Cursor
Keys.

3) Switch to the menu cursor using the Tab Key.
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8.2 Network List Operations

4) Select Save from the Block Menu using the Cursor Keys and press the Enter Key.

Main Network Edit Tools Quit
F1 F2 F3 P4 Block —Segment:LO1
XY [=tart ing preparation 1
SEGMEN| Merge E E i 2

staptin reparation

4> time circuit 2

Segment Network Segment 5) time circuit 3
6> check of equipment A
H NOT PROGRAMMED ?> check of equipment B

5

?
s NOT PROGRAMMED

Press <ENTER> to

5) Specify the range of segments to be saved using the Cursor Keys and press the Enter
Key.

Main Hetwork Edit Block Tools Quit
Lie8 P2 F3————F4———F5 Segment :LA1
starting preparation 1
SEGHENT starting preparation 2
tine circuit 1
time circuit 2
Segment HNetwork Sogment time circuit 3
check of equipment R
H NOT PROGRRHHE_]; . of equipment B "

- NOT PROGRAMMED

Prezs {ENTER> to
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8.2.5 Saving and Merging cont.

The following window will be displayed to specify the directory in which the merge file is to
be saved. Normally, press the Enter Key with the default setting (fmsghprograms\) dis-
played.

Main Network Edit Block Tools Quit
F1l——F2 F3——F4 -FS —Seg t:LBg ?

1) starting preparation 1
SEGMENT 2) starting preparation 2
3> time circuit 1

4) time circuit 2

Segment Network Segment 2) time circuit 3

6> check’ of equipment R
H NOT PROGRHHHEg ?) check.of equipment B

I

s NOT PROGRAMMED

Location of Drive & di.-éctm-:

+

+

6) Enter a file name and press the Enter Key.

Ma in Network Edit Block Tools Quit
F1i P2 F3 P4 F5 Seg t:Le1
1) starting preparation 1 *,
SEGHENT 2) starting preparation 2
i 3> time circuit 1
S
NOT PROGRAMMED [ heck of equipment B
L61] 7
- NOT PROGRAMMED
Press (ENTER> to
2. Merge

The Merge operation inserts the network data saved as a merge file at the cursor position.

1) Move the cursor to the position at which the network data saved as a merge file is to be
inserted using the Cursor Keys.
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8.2 Network List Operations

2) Switch to the menu cursor using the Tab Key.

Main Netuork Edit Block Tools Quit
F{——F2—P3———P4—=— P —————Segment : L1
. 1) starting preparation 1 i
SEGMENT 2) starting prepavation 2

3> time cirvcuic 1
4) time circuic 2
Segment Metwork Segment 5) time circuit 3

6> check of equipnent R
H NOT PROGRAMMED > check of equipment B

]
H NOT PROGRAMMED

Press <{ENTER> to

3) Select Merge from the Block Menu using the Cursor Keys and press the Enter Key.

Main . Network Edit Tools Quit

[F1 P2 F4 glock ————-ISegment=LBIi 1
ave starting preparation
SEGMEN |]start ing preparation 2

time circuit 1
4) time circuit 2
Segment Metwork Segment 5) time circuit 3

6) check of equipment R
H NOT PROGRAMHED 7> check of equipment B

7
s NOT PROGRAMMED

Press <ENTER> to

The directory containing merge files will be displayed.

Main Hetuwark Edit Block Tools Quit
f{ ———FP2-~————P3———P4———P5 Segrment :LB1
1) starting preparation 1
SEGMENT 2) starting preparation 2

3> time circuit 1
4> time circuit 2
Segment Network Segment 5) time circuit 3

6) check of equipment A
H HOT PROGRAMMED ?) check of equipment B
Lo1] ?

8 NOT PROGRAMNED

Location of Drive & directory:
Etﬂ!jEﬁn:EEEﬂEg.......ll.li...l...............
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8.2.5 Saving and Merging cont.

4) Select a merge fite using the Cursor Keys and press the Enter Key.

bain Network Edit Block Toels Quit
1 F2 F3 F4———F5 ————Segnent: L1
1> starting preparation 1
SEGMENT 2) starting preparation 2
e rye 3) time circuit 1
MERGEQ1 4) time circuit 2
stwork Segment 5) time circuit 3
6> check of eyunipnent A |
H NOT PROGRRHHEg 7> check of equipment B
i H

8 NOT PROGRAMHED :

Press (ENTER> to

The network data saved as a merge file will be inserted at the cursor position.

Hain Network Edit Block : Tools Quit
[F1 P2 ¥3 F4——-F% Seg t:LB1
1) starting preparation 1 ‘
SEGMENT 2) starting preparation 2
3» time circuit 1
4) time circuit 2
Segment HNetwork Segment 5) time circuit 3
6 temperature controller'Ope PL-34
H NOT PROGRAMMED 7) temperature contraller Adj PL-34
Lot 11 8> temperature controller Noheating
§ NOT PROGRAMMED 9> autometic value circuit MI-9-3

10> check of equipment A}
11> check of equipment B

Press <ENTER> to

IMPORTANT Network data that can be inserted using the Merge operation is restricted to merge files that
have been saved using the Save operation in 7. Save, above.

Omﬁﬂb 1) When the operations listed below are performed offline, ladder programs can be input
regardless of the maximum program size of the PLC. However, always be sure that the
maximum program size of the PLC will not be exceeded when loading edited programs to
the PLC.

» Editing fadder programs.
. Browsing part or all of an existing ladder program.
» Merging tadder programs.

2) Anerror message will be displayed when loading a program created offlineto a PLC if the
size of the program exceeds the maximum program size for the PL.C.
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3) As indicated above, no restrictions have been placed on the size of ladder programs that
can be input offline. This is to allow for easier editing.
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Editing Ladder Programs

This chapter describes the operation used for creating and editing lad-
der programs, such as inputting elements.

9.1 Ladder Program Edit Screen............... 93
9.1.1  Edit Screen Configuration ....................... 9-3
9.1.2 BasicKeyOperations .......................... 9-5

9.2 InputtingElements ...........covvvenneen.. 96

921 InputtingRelays .............................., 9-6
922  Inputing Horizontal/Vertical Short Circuits ......... 9-8
923 InputtingTimers..............covvvireennnnnn.. 9-10
9.24  Inputting Math Instructions ...................... 9-12
925  Inputing Application Instructions ................. 9-14
926  Inputting Stepping Switches ..................... 9-16
927  Change/Delete Operations ....................... 9-18
928  SummAary ... 9-24

9.3 EditiNg «oovvvviirineiesssnnnnnnnnaannnns 926

931 CODY i 9-26
932  Delete ... e 9-27
933  Paste ... e 9-28
934 Offset ... ... e e 9-29
935 OpenRow/CloseRow ................ccvvvnnnn, 9-30
936 OpenColumn/Close Column ..................... 9-31

9.4 GO/Search .......cevvevvreeenrenannnnnn. 9.33

94.1  Moving Control Between Networks ............... 9-33
942 Search............. .. 9-34
943  Trace/Retrace ........ovviieiiniininennanninins 9-39
944  Show Trace/Search and Delete Trace/Search ........ 9-41
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952 CopyNetwork ....... ..o, 9-44
953 Delete Network . v..oceennennieinnaneerinaanns 9-44
9.54  Paste NEWOTK .. .ovevenneeenesis s 9-45
9.5.5  Moving Control to :Lhc Subroutine Segment ......... 9-46
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9.1 Ladder Program Edit Screen

9.1 Ladder Program Edit Screen

This section describes the configuration of the Ladder Editor Screen and basic key
operations.

9.1.1  Edit Screen Configuration ..........c. oot 9-3
9.1.2 Basic Key Operations

9.1.1 Edit Screen Configuration

When Ladder Editor is selected from the Edit Menu in a segment screen, the following Lad-
der Editor Screen will be displayed.

E}onnt: git %Ar«:h :I!Etuork ?-71' To:h Quit
IZTE e
12y 3
4)
8) <
10
N || Lo,
I ---------------- ReFarence Data:
9) 5) L] l 7
: } } '
Pormat :Decimal File Data Range : 1
1. Segment

The segment type and the segment number are indicated.

H: High-speed segment (executed only when the high-speed scan is enabled)

See section 7.4.3 Setting Segments for details on how to enable a high-speed
scan. :

LXX:  Normal segment and segment number

8: Subroutine segment

2. Network Number

The network number in the segment of the network currently being displayed is shown.

3. Sequence Network Number

The network number sequence from network 1 of segment H of the network currently
being displayed is shown. This information indicates the sequential position of the cur-
rently displayed network from the top.
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Editing Ladder Programs
L

9.1.1 Edit Screen Configuration cont.

4,

7.

9.

Cursor

A ladder program can be created by entering elements at the cursor position.

Input Format

The input format of reference data is displayed. See chapter 71 Manipulating Reference
Data for details.

Display Data Type

i

Whether the currently displayed reference data is PLC data or file data is displayed.

Range

The number of batched display settings of reference data is displayed. See chapter 77
Manipulating Reference Data for details.

Ladder Program Area

In the network configuration, the area consists of 7 rows x 11 columns.

Reference Data Area

Reference data can be edited by moving the cursor to this area. See chapter 17 Manipu-
lating Reference Data for details.

10.Reference Information

When the cursor is set in the ladder program area, the following reference information is
displayed.

» When a reference number is entered, a list of reference types that can be entered at the
current cursor position is displayed.

» The symbol and the comment of the reference at the current cursor position are dis-
played otherwise,
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9.1 Ladder Program Edit Screen

9.1.2 Basic Key Operations

Basic key operations are shown below.

Move the cursor. When the Cursor Keys are pressed on line
7 of the Ladder Editor Screen, the cursor moves to the
reference data area.

Moves the cursor to line 1 column 1 (top-left) of the network.

Moves the cursor to line 7 column 11 (bottom-right) of the
network.

Displays the previous network,

Displays the next network.
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Editing Ladder Programs
9.2.1 Inputting Relays

9.2 Inputting Elements

This section describes inputting elements such as relays and timers, as well as various
operation instructions.

9.2.1
9.2.2
8.2.3
9.2.4
9.2.5
9.2.6
9.2.7
8.2.8

Inputting Relays

Inputting Horizontal/Vertical Short Circuits 1
g o103 a (g T [ {31 =
Inputting Math Instructions
“Inputting Application Instructions
Inputting Stepping Switches
Changé/DeIete Operations
Summary ................ ettt

9.2.1 Inputting Relays

..................................................

........................................

......................

.......................................

...........................

9-10
9-12
9-14
9-16
9-18
9-24

The following procedure ¢an be used to input nodes that contain only a signal element, such
as relays or coils:

1} Move the cursor to the position where the elementis to be entered using the Cursor Keys.

2} Switch to the menu cursor using the Tab Key.

3) Select Relays from the Elements Menu using the Cursor Keys, and then press the Enter
Key.

Edit GosSrch Network .Ref
P5—Fb

in
—F2 ments
Seg.LB81 ¥1 /1
M imer/Counter
Hiath
Othars

Pormat :Decimal

Reference Data

File Data

Rangs :
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9.2 Inputting Elements

4) A submenu will be displayed. Selectan N.C. contact using the Cursor Keys and press the
Enter Key.

in
—2
Seg.Lo1 81 /1

Tools Quit
OF - o 3

£ n
Reforence Data

-~ Format :Decimal File Data Rangs : 1

5) AnN.C. contact will be stored at the cursor position. Enter a reference number (100001 in
this exampie) and press the Enter Key.

in Elements Edit CosSrch Metwork Raf foolt  Quit
F’. F4 F5 il F7- NP -S4 —F?

ey L81 #1 /1
.ﬁﬁ—

Bx Yix 92x Qix Q2x Dix DZx 1x Hix ¥2x Plx P2x Mix M2x

wwpa l‘

Format :Decimal Pile Data Range = 1

The N.C. contact will be input. If the Esc Key is pressed after a reference number has
been entered and before the Enter Key is pressed, the entire input will be canceled.

Special keys are assigned to frequently used elements, such as relays and coils, so that they
can be input using a single key operation. It is convenient to be familiar with these keys.

o 7] Inputs an N.O. contact
or Inputs an N.C. contact

ALT + E’] Inputs a positive transitional contact

ALT + @ Inputs a negative transitional contact
[I] or @ Inputs a coil

ALT + Inputs a latched coil
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9.2.2 Inputting Horizontal/Vertical Short Circuits

9.2.2 Inputting Horizontal/Vertical Short Circuits

" Horizontal short circuits and vertical short circuits do not require a reference number. Enter
horizontal short circuits and vertical short circuits as follows:

;

1. Inputting Horizontal Short Circuits

1) Move the cursor to the position at which the horizontal short circuit is to be entered using

the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Relays from the Elements Menu using thé Cursor Keys and press the Enter Key.

ain L Edit
—— sments
=ﬂi]/‘u e FIinar/Countsr
190981 MHiath

Others

GosSrch Metwork Raf Tools Quit
PP —— P =

“ Format :Decimal Pile Data

Reference Data

Range = 1

4) A submenu will be displayed. Select the horizontal short circuit using the Down Cursor

Key and press the Enter Key.

GosSrch MNetwork Fef Tools  Quit

hE Ff e =T F O - S —F9
rd

L]
—
—<CL)—

Main Edit
[Ff ———sene 2 e ments—
eg.LO1L #1 ~ 2
/ imer/Counter
>Hath
Others
- Format :Decimal File Data

References Data

Range = 1 |
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9.2 Inputting Elements

A horizontal short circuit will be input at the cursor position.

Elemsnts Edit Go/Srch Metwork Ref Tools Quit
P4 5 3 —X-Fe - a3

3 o 3

——F2
eg L8t B / 1

odets

Roference Data

Foraat zDecimal File Data Range - 1

2. Inputting Vertical Short Circuits

1) Move the cursor to the position at which vertical short circuit is to be input using the Cur-
sor Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Relays from the Elements Menu using the Cursor Keys and press the Enter Key,

Main i!@ Edit GosBrch  Network Ref Tools Quit
[/ F2 Elanents P8 ——r——Fg—F7- T Fo - TF—TFY
Segy.LO1 81 1
ld 1 unter
1 Miath
i Othars

Reference Data

- Format :Decimal Pile Data Range = 1

4) A submenu will be disptayed. Select the vertical short circuit using the Down Cursor Key
and press the Enter Key.

Tools Quit
-—P9

et
Reference Data

- Format :Dacimal File Data Range : 1

—9.9 __



Editing Ladder Programs
L
9.2.3 Inputting Timers

A vertical short circuit will be input at the cursor position.

Main Elements Edit Go/Srch  Metwork Ref Teols  Quit
73 P4 F6 77 - T - S —F9

S F

Reference Data

- Forsat :Decimal Fils Data Range : L

ﬂ? Special keys are assigned to frequently used elements, such as horizontal short circuits, so
that they can be input using single key operation. It is convenient to be familiar with these
keys. '

E Inputs a horizontal short circuit

@ Inputs a vertical short circuit

9.2.3 Inputting Timers

A timer or a counter requires two elements. input the elements as follows:
1) Move the cursor to the position at which the input is required using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Timer/Counter from the Elements Menu using the Cursor Keys and press the En-

ter Key.
Main HEYEN Edit Go/Srch Metwork Raf Tools Quit
[ 72 t: F§————F6—F7- - P8 -0 —F9—
Seg.L@t N1 ~ 1 »-Re La: B v
— Ao '
Yo [ pud Others
108881
Reforence Data
- Format :Decimal File Data Ranges = 1
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M

4) A submenu will be displayed. Select T0.1 (i.e., 0.1-SECOND TIMER} using the Down
Cursor Key and press the Enter Key.

GosSrch Metuork Ref Tools Quit
£l T PS el ————F7 - -F RS — P9 ————y
— 1.8
DCIR
LI
".—.‘nunic bata
-~ Pormat :Decimal File Data Range = 1

5) The symbol will be displayed. Input the top element (60 in this example) and press the
Enter Key.

Elsmenta Edit Go/Srch Metwork Ref Tools Quit
—— 73 P4 TS F6 F--F-T-—FY
. T .
Jidx 4 7x Rix R2x #x —
Format :Decimal File Data lﬂmge =1

6) Input the bottor element (400010 in this example) and press the Enter Key.

Main Elements Edit GosSrch Network Ref Tools  Quit
1 R N ol 1 ¥5 £6 F7- B Fi - NHE—
Seg.LB1 81 1
Fooeed |
7
odol A
~ix Rix R2x
Reference Data
- Pormat :Decimal File Data Range 5 1

Input of a 0.1-SECOND TIMER is now complete.

[l:? » Timers and counters can also be created by inputting the symbols. For instance, to input a
0.1-SECOND TIMER, enter T0.1, and the symbo! can be input at the cursor position.
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L - L

9.2.4 Inputting Math Instructions
« A constant is prefixed with a hash symbol (#.) For instance, for the constant 60, simply enter
60 and the prefix # will be automnatically assigned. When the constant is 10000 and higher,
enter #, otherwise the canstant will be recognized as a reference number. When entering

constants like these for efements, make sure to enter the # prefix.

9.2.4 Inputting Math Instructions

Three elements are required for math instructions. An example of inputting nodes that require
three elements is shown below. '

1} Move the cursor to the position where the elemeht is to be input using the Cursor Keys.

2} Switch to the menu cursor using the Tab Key.

3) Select Math from the Elements Menu using the Cursor Keys and press the Enter Key.

in Edit Go/Srch Hetwork Rof Tonls Quit
€ s ——— 76— 7 P

ey LA .li s 1 »Ro Lays

I imer/Counter

o R
-

ference Data:

" Format :Decimal Pile Data Range : 1

4) A submenu will be displayed. Select SUB using the Down Cursor Key and press the En-
ter Key.

Toole Quic

Reference Data “

. Foraat Decimal File Data Range = 1 - i
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9.2 Inputting Elements

5) The symbol will be displayed. Input the top element (300020 in this example)} and press
the Enter Key.

Elements Edit Go/Svrch Network BRef Tools Quit
—F P ————F——F? ~a3—F?

it
I-xix?xluxmxlx

B f Dat.
netersnca bata

- Format :Decimal Pile Data Rangs = 1

- 6) Input the middle element (100 in this example) and press the Enter Key.

Hain Elements Edit Go/Srch Metwork Ref Tools Quit
[PL————F2 P4 PS ¥6 F7-{IR-Fe-HH—F?
Seg.LB1 ¥t ~ 1

Thicty
liiag

3x 4x Px Rix R2x #x

Reference Dats

Format :Pecimal Filo Data Range : 1

7} Input the bottom element (400020 in this example) and press the Enter Key.

lll.lin Elements Edit GosErch Metwork Ref lools Quit
P 2 F3 F4-—————F5————F6 —g——F?

oy.L8L ¥1 /1

/ T@.1

kit

EIME

SUB

1NE2A
“4x Rix R2x

fisferenco Data

- Format :Decimal File Data Rangs = 1
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9.2.5 Inputting Application Instructions

Input of SUB is now complete,

Elements Edit
—

Go/Srch HNetwork Ref
—— F6———F7

Tools

Quit

Format :Decimal Fils Data Rangse - 1

EEn

symbol at the cursor position.

9.2.5 Inputting Application Instructions

For math operations, the symbols can also be entered directly. For instance, for an UN-
SIGNED SINGLE PRECISION DECIMAL ADDITION instruction, enter “ADD” to input the

Application instructions can be basically entered in the same way as for timers and math
instructions. Forexample, the instruction that requires two elements can be entered using the
same procedure as for timer input. However, difterent input procedures are required for the

following three groups of instructions.
» Extended math instructions (EMTH)

» Motion control instructions (MC)

» Message transmission instructions (FBUS)

An example of inputting an extended math instruction is shown below.

1} Move the cursorto the pésition at which the element is to be input using the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Others from the Elements Menu using the Cursor Keys and press the Enter Key.

in i Edit GosSrch Network Ref Tools Quit
P2 PS P6 P74 -
[Seg.L81 ¥1 / 2 PRelays
T M imor Counter
908068  [wMath
Wﬂ's.xa—
1 48001
Reference Data i
“ Format :Decimal File Data Range = 1
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9.2 Inputting Elements

4) A submenu will be displayed. Select EMTH using the Cursor Keys and press the Enter
Key.

bnin Elements Edit
—2 —F4

Go/Srch Metwork Ref Tools Quit
———Pf ~3—PY

- Format :Pecimal File Data Range z 1

5) An extended math instruction list window will be displayed. In this example, select
ADDFP using the Cursor Keys and press the Enter Key.

Go/Srch Metwork BRef Tools Quit
et F7-IOTE P -9
Ref Data
Format :Decimal File Data Range 2 1

6) The symbol will be displayed. Input the top element (400100 in this example) and press
the Enter Key.

Pain Elswents Edit Go/Brch Metwork Ref Tools Quit
[ F2 3 ¥4 F5 6 F7- - Fe - hi——PY
Seg.L81 ¥1 ~ 1

ot B

o

ADDFP

x{LOG, ANLOG> 4x 7x Rix R2x

Reforence Data

Format :Decimal Pile Data Range = 1
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———
9.2.6 Inputting Stepping Swilches

7) Input the middle element (400110 in this examplé) and press the Enter Key.

Matn Elsmente Edit
[F1- e b

GosSrch Netuwork Raf
—T2 -—Fe
Sey.LB1 ¥ -/ 1 1

#80868
—1/ I—I'l‘ﬂ.l&— !
168001 48861

Y

DDFP

Tools Quit
- ¥9

Rix R2x

Ference Data

-Format :Decimal File Data Rangs = 1

Input of ADDFP is now complete.

ain - E-.h-““ Eit
Seg.L@1 8L 1 o

19086
i

Go/Srch Metwork Ref
5 ————— P ————F 7

Tools Quit

Reference Data

Format :Decimal Pile Data Range = 1

« In the same way as for other instructions, application instructions can also be entered di-
rectly by inputting the symbols.

« As a method of moving the cursor on an instruction list window, the first letter of a symbol
can be entered in addition to the use of the Cursor Keys. For instance, by entering A, the
cursor can be moved among ADDFP, ANLOG, and ADDIF.

9.2.6 Inputting Stepping Switches

The following two elements can be input for stepping switches.

» A stepping switch N.O. contact { S|

« A stepping switch N.C. contact { $}

An example of inputting an N.O. contact is shown below.

1) Move the cursor to the position where the element is to be input using the Cursor Keys.
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9.2 Inputting Elements

2) Switch to the menu cursor using the Tab Key.

3) Select Timer/Counter from the Elements Menu using the Cursor Keys and press the En-
ter Key.

Edir GosSrch Motwork Ref Tools Quit
ments P ———PE— Py WT-Fe D9

th
Others

Refarence Data:

Format :Decimal File Data Range = 1

4) A submenu will be displayed. Select the stepping switch N.O. contact using the Down
Cursor Key and press the Enter Key.

Main Edie GosSrch Metwork Ref Tools Quit
[F1——————P} Hnts——jﬁ—-{’ﬁ_l"?-{m—m—m——l’!
Seg.L81 81 1 FRala }.;o:/t:ounn

) mmm: X

/ 8.1 Others 21
et gt g T

Reforence Pata

- Format :Decimal File Data Range = 1

5) An N.O. contact of a stepping switch will be stored at the cursor position. Next, enter the
reference number (201001 in this example) and press the Enter Key.

Elements Edit GosSrch MNetwork Ref Tools Quit
————P4———F5 ———— P ———P 7P~

Zyyraax (yw:iBl-32 00c:B81-899)

Reference Data

~ Format :Decimal Pile Data Rangs : i}

input of the N.O. contact for a stepping switch is now complete,
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9.2.7 Change/Delete Operations

i

I]? In the same way as for other instructions, the stepping switches can also be entered directly
by inputting the symbolis as follows:

« STPA: N.O. contact for stepping swiich

« STPB: N.C. contact for stepping switch

9.2.7 Change/Delete Operations

1. Changing Reference Numbers

A reference number can be'changed by moving the cursor to the position of the reference
number to be changed and eniering a numeric value directly.

1) Move the cursor to the position of the reference ﬁumber to be changed using the Cursor
Keys.

' 2) Enter a reference number (300040 in this example) and press the Enter Key. When one
character is entered, the remaining digits will change to question marks (?.)

Elements Edit GosSech Network Ref Tools Quit
PS5 = -A—F9

Pase ., Elemente forch Nevwork Bef L 1o

[Sey.lBl #1 - 1 N [
/ L) y: I

Todeds doesie

pnd

“3x 4x 7x Rix R2x Bx

Reforence Pata k

- Format :Decimal File Data Range = 1

The reference number will be changed.

k?i.n Elsmente Edit GosSrch MNetwork Ref 1ools Quit
1 —m-gﬂlTﬂ_w—F'!—-———ﬁ——Fﬁ—P?ﬂm-ﬂi]—??
Seg.

209060
B Jiie.t -
[
'lSUB z—

Reference Data

LFt'n-nlt :Decimal File Data Range : 1
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9.2 Inputting Elements

Press the Esc Key to cancel input of the reference number currently being executed. The
number will be reset to the original reference number.

Tochange a reference numbers to consecutive reference numbers, use the Plus (+) orMinus
(-} Key. When the + Key is used, the next reference number after the last reference number

that was input will be input. The following example shows an example for when the last refer-
ence number that was input is 300050.

1) Move the cursor to the position of the reference number to be changed using the Cursor
Keys.

2) Press the + Key. When the reference number to be changed to is displayed, press the
Enter Key.

Elemeants Edit GosSrch Network Ref Tools Quit
P4 S Fb F7- TP —FY

3

P2
ls-'.lﬂi /1

[ deoscd
Cipily

(o

* 4x Px Rix R2x 8x

h Format :Decimal

The reference number will be changed to 300051.

o
5

Elements Edit Go/Srch Network Ref Tooals Quit
Fa" P4 < F6 7T PO AN — Y

eiga
3 .!\f:!
s=El

‘:;—W

=

1.
B2

i
OT

—Reforence Data

- Pormat :Decimal File Data Range = 1

2. Deleting Elements

An element can be deleted by moving the cursor to the position of the element to be deleted
and pressing the Delete Key. For nodes that require two or more elements, deletion can be
executed regardless of whether the cursor is at the top or bottom element.

1) Move the cursor to the position of the element to be deleted using the Cursor Keys.

—9-19 —




Editing Ladder Programs
9.2.7 Change/Delete Operations cont,

2) Press the Delete Key.

[Main Elements Edit
[Fl——F2 —P
Seg. Ll %1 ~ 1

GosSrch Metwork .Ref
— P74

Tools Quit
—SE—PY

'Ho SymboL/Descriptor availabl —

¥ile Data Rangs = 1

Farmat _:Doclnl

The element at the cursor position will be deleted. In Online or Debug Mode, a confirma-

tion message will be displayed.

Llu.n Elsment: Edit GosSrch  Hetwork -Ref
—F3———P 6

Tools Quit
-H2i—F9

1!’0:--1: :DPecimal File Data Range : 1

3. Deleting Horizontal and Vertical Short Circuits

To delete a vertical short circuit only while the vertical short circuit is input with other elements,
enter the vertical short circuit again. An example of deleting a vertical short circuit only is
shown below. The same procedure can be used to delete a horizontal short circuit.

1) Move the cursor to the position of the vertical short circuit to be deleted using the Cursor

Keys.

2) Switch to the menu cursor using the Tab Key.
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9.2 Inputting Elements

3) Select Relays from the Elements Menu using the Cursor Keys and press the Enter Key.

Main i Edit GosSrch MNetwork Ref Tools Quit

[ll———F2 ——Elements F5y——Fb = - Fi - ——

Seg.LB1 81 ~, 1 v
’

Fliner Counter
Miath
Others

Format :Decimal File Data Range : 1

4) A submenu will be displayed. Select the vertical short circuit using the Cursor Keys and
press the Enter Key.

Illai.n Edit GuL:Sr:h gtmrk Ref Inu;.]sn_git
mant g — - r—

|Seg.LOL 31 /1 a v

G ET 1 unter

th

Others

Bl :
References Data
Format :=Decimal Pile Data Range : 1

Only the vertical short circuit will be deleted.

Matn Elements Edit GosSrch Network Ref Tools  Quit
[F1 P2 F3 P4—————F5————F6————F7- NP5 ——F9
Seg.L8L 81 /1
Ed
-
Refarence Data
Format :Decimal File Data Range : 1

Ex a. Changing Elements

AnN.O. contact can be changedto an N.C. contact by moving the cursor to the position of the

contact to be changed and inputting the element to which it is to be changed to. The reference
number will remain the same. Two examples are shown below.
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9.2.7 Change/Delete Operations cont.

« Changing an N.O. Contact to an N.C. Contact. |

1} Move the cursor to the position of the N.O. contact that is to be changed using the Cursor
Keys.

2) Press the / Key, which is the Quick Key for selecting an N.C. contact.

Main Elements Edit Go/Srch MNetwork Ref Toods  Quit
l% Lal ;I.: s 1 ¥ F4 b - .
' 3

T3

‘N0 Symbol/Descriptor availabl

— ]
Referencs Data

Format :Decimal File Data Range = 1

The specified N.O. contact will be changed to an N.C. contact.

in Elemsnts Edit GosSrch Hetwork :Re!’ Ioals Quit
e Py —— P 7 NI PR - S —FY

b;—pz————n——-u—-uﬁ
Seg. LBL M - 1 }

No $ymboL/Descriptor availabl — —

“ Format :Decimal File Data Range : 1

« Changing an UNSIGNED SINGLE PRECISION DECIMAL ADDITION Instruction to a
0.1-SECOND TIMER.

1) Move the cursor to the position of the instruction to be changed.

2) Switch to the menu curser using the Tab Key.
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9.2 Inputting Elements

3} Select Timer/Counter from the Elements Menu using the Cursor Keys and press the En-
ter Key.

[Main w Edit Go/Srch Metwork Ref Tools Quit
[Fl —————F 22— t F5 6 -G -IRE—rY
eg.l0l 81 /1 >Re la
3
Others

499821

1ADD &

490831

'‘Ho Symbo L/Descriptor availabl

Reforence Data:

Format :Decimal File Data Range : 1

4) A submenu will be displayed. Select the 0.1-SECOND TIMER using the Down Cursor
Key and press the Enter Key.

in Edit GosSrch Metwork Raf Tools Quit
P2 ts F5 6 -8 2
[Seg.Lo1 81 » 1 [rRela {ﬂﬁ..szcuunen—
mim: NS —
Others -
i
lap DCIR
" 40063 gg
$

'Ho Symbol/Descripter availabl

B g "
Reference Data

- Format =Decimal Fils Data Range : 1

The element will be changed to a 0.1-SECOND TIMER.

Ilhi.n Elements Edit CaSrch MHetwork Ref Tools Quit
[P1 F2—f3———P4—— P ——F————— P77 -3 —T%
1505_1.31 a1
3 i10.1
mr
Reforence Data
- Format :Decimal File Data Range : 1

1) This change operation cannot be used for coils. To change coils, delete the element and
then enter a new element.

2) Ifaninstruction that requires two elements is changed to an instruction that requires three
elements, the reference numbers before the change will be displayed for the top and
middle elements. When no changes are required, no input is required. Enter a reference
number for the bottom element only.
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9.2.8 Summary

3) lfaninstructionthat requires three elements is changed to aninstruction that requires two
elements, the top and middie reference numbers will be used for the top and hottom ele-
ments. When no changes are required, no input is required.

4) If the reference number of the previous element is unsuitable for the element to which it

number.

9.2.8 Summary |

1. Inputting Contacfs and Coils

Use the following Quick Keys for inputting contacts and coils.

‘ or [E] Inputs an N.O. contact
or Inputs an N.C. confact
+ @ Inputs a positive transitional contact
+ @] Inputs a negative transitional contact
or E] Inputs a coil
ALT + @ Inputs a latched coil
[Ej Inputs a horizontal short circuit
m Inputs a vertical short circuit

2. Entering Reference Numbers and Constants

« ltis not necessary to enter all the six digits of the reference number (00XXXX) of a coil. For
example, enter 125 for 000125,

» The prefix # does not need to be input for constants for normal elements. For the constant
60, for example, when 60 is entered, the # will be input automatically at the beginning of the
constant. The prefix # must be entered for an element that can contain either a constantora
coil so that the number will not be recognized as a reference number for a coil. Make sure to
enter the prefix # when a constant is entered for such an element.

« When entering the same or consecutive reference numbers, the following keys are useful.
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M

S The last reference number that was used is entered as it is.
A reference number determined by incrementing by 1 the
last reference number used is entered.

E] A reference number determined by decrementing by 1 the
last reference number used is entered.

3. Inputting Math Instructions

» Symbols can be directly entered for timers/counters and math instructions. Use as many
symbols as possible to reduce key operations.

» Enterthe first character of a symbol on a list display window such as for application instruc-
tions and extended math operations to eliminate searching for the instruction.

4. Qperations Available in Offline Mode

The following operations are availabie in Offline Mode.
» Omitting Reference Number Input

Afterinputting an element such as a relay, press the Enter Key without entering the refer-

useful to enter elements in advance. However, if 22?7?72 remains as the reference num-
ber of a relay element when the program is loaded to the PLC, an error will occur, An error
does notoccurwhen this operation is used for timer and math instructions, however, seta
correct value before loading the program to the PLC.

« Using Duplicate Coils

In Offline Mode, duplicate coils are not checked. Therefore, in the process of program
development, duplicate coils are allowed. However, if a duplicate coil is used in the pro-
gram, on transfer of the program to the PLC, an error will occur. Before loading a program
to the PLC, check for duplicate coils by executing File Check.
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9.3.1 Copy

- 9.3 Editing

This section describes basic operation procedures on the Edit Menu that are useful when
editing ladder programs, such as copying and deleting elements.

931 COPY vttt P 9-26

932 Delete ............iiiiii P T 9-27

933 Paste.......ciiiiiiiiiiiiiiiii i et .. 928

9.34 Offset..... ..., e 9-29

9.35 OpenRow/CloseRow .................. PO 9-30

9.3.6 OpenColumn/CloseColumn ....... ... ..o iiiiannt, 9-31
9.3.1 Copy

The Copy operation stores program data from the area specified by the cursor. The data
stored by the Copy operation can be pasted to another position using the Paste operation,

1) Move the cursor to the corner of the area to be copied using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Copy from the Edit Menu using the Cursor Keys and press the Enter Key.

Main Elsments i% GosSrch Metwork Ref Tools
[FL F2 3 it —b ———F7?-TW-F8 -
Seq.H H4 / 4 Check 1 _= [

.

- 24_hours_Timgr_output On once 24 hours at "Timer 1™
[ r———Ref s rence  Data

Formet :Decimal Fils Data Range : 1

4) The cursor will be displayed in reverse video. Move the cursor and specify the range to be
copied using the Cursor Keys.
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5) After specifying the range, press the Enter Key. The specified area will be stored.

in Elements Edit Go/Srch Hetwork Ref Tools Quit
F;———H—-P’.‘ P4 5 P6 P7-RT-Fe - ——F9
Seq.H ¥4 / 4 Check 1

- 24_hours_Timer_output On once 24 hours at "Timer 1% ﬁ
Reference Bata

Format Decimal File Data Range - 1 —'I

OIEE]P 1) To copy an instruction that requires two or three elements, all the symbols must be speci-
fied. If the instruction is only partially specified, an error will occur and the data will not be
copied.

2) The area exceeding one network cannot be copied by this operation. See section 9.5
Network Operations to copy more than one network.

9.3.2 Delete

The Delete operation deletes and stores the program data from the area specified by the cur-
sor. The data that is stored by the Delete operation can be pasted to another position by the
Paste operation. Therefore, this operation is useful for moving programs as well as deleting
programs. To delete one element, move the cursor to the position of the element to be deleted
and press the Delete Key. The element will be deleted and stored.

1) Move the cursor to the corner of the area to be deleted using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Delete from the Edit Menu using the Cursor Keys and press the Enter Key.

L!Iin Elements
1al

Co/Srch Metwork Raef Tools Quit
-~———F2 ——Pp3 = P ————F -G PO - —F9
Seg.H U4 / 4 Check 1

1 a8

- 24_hours_Timer_output On once 24 hours at “Timer 1"
FRefersnce Data

L format :Decimal File Data Range : 1
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9.3.3 Paste
4) The cursor will be displayed in reverse video. Move the cursor and specify the rangeto be
deleted using the Cursecr Keys.
v in Elements Edit GosSrch  Network .Ref Io:ls Quit
Seg.H 84 / 4 Chock 1 . ¢ —
=
__|
L HHE1A
24_hourt_Timer_output On once '2‘4‘_:22::.1& “Timer I."j
-~ Format :=Decimal Fils Data Range = 1
5) After specifying the range, press the Enter Key. The data of the specified range will be
deleted. :
Olﬂﬁﬂb 1) To delete an instruction that requires two or three elements, the entire instruction mustbe
~ specified. If only a part of the element is specified, an error will occur and the data will not
be deleted.

2) The area exceeding one network cannot be deleted by this operation. See section 9.5
Network Operations to delete more than one network.

9.3.3 Paste

The Paste operation inserts program that was stored by the Copy or Delete operation at the
cursor position data. In this example, data stored by the Delete operation described above is
inserted into another section.

1) Move the cursor to the position at which data is to be inserted using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Paste from the Edit Menu using the Cursor Keys and press the Enter Key.

Elesante § GosSrch Hetwork Rof Tools Quit
— e RT3 it -PF6———F7- AN Fo-—FY
Seg.H #4 / 4 Check 1 25;: <>
d L] ny ———
88183
Op-“;n
n Row
n column
Cloze Row
I Cloze Column
ference Data i
' Format :Decimal File Data Range : 1

—_9-28 —



9.3 Editing

The data that was stored will be inserted at the cursor position.

OI]IE'E]P 1) Ifthe data stored exceeds the range from the cursor position to the end of the network, an
error will occur.

2) Only one buffer is available to store and maintain the data specified by Copy or Delete.
Therefore, if the Paste operation is executed, the last data stored by Copy or Delete will
be inserted. This also applies to deletion with the Delete Key.

9.3.4 Offset

The Offset operation substitutes the reference numbers of the specified range for the refer-
ence numbers determined by adding the specified offset value. This operation is useful for
changing a reference number after copying a ladder program using the Copy operation. inthe
following example, reference numbers of the holding registers of the timer circuit are changed
by adding 30 tc each.

1) Move the cursor to the end of the program area to be substituted using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Offset from the Edit Menu using the Cursor Keys and press the Enter Key.

in Elenents M Go/Srch Network Raf Tools Quit
P2 3 it —Po——F7- WP -07—FY
Seg . H 82 ~ 2 Timar 1 Copy
Delste
21 1 Paste
n Row
R G0 Limn d——
Close Row eegeze
{ Claze Columwn )y—
290821
'——-—-—ﬁ/!—wcml—
1 4
" Format :Decimal Pile Data Range : 1

4) An offset setting window wiil be displayed. Enter the starting and last reference numbers,
and the offset value (400001, 400010, 30 in this example) and press the Enter Key.

Main Elemsents Edit Go/8Srch Metwork Ref Quit
H#2 /2 Timer 1
0g. r

Refsrence Data:

Starting Ref No:480081
Lact Ret No: 488818

Offuers < -

! Format :Decimal
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-
9.3.5 Open Row/Close Row

5) The cursor will be displayed in reverse video. Specify the area to be substituted using the
Cursor Keys and press the Enter Key.

km Elements Edit GosSrch Metwork Ref JTools Quit
082 2 2 Timer 1 i
Seg Fd ™

iy etz =
#HMU1 A Wmm L]
—{s—li.1}= S o e
BUYIE 4dduMl #uuuL Y
/E—|Uf‘IPi—

<D
88Pu20
—_— ) —
#8021 BoBBZ1
UCTR}
ARKMBZ1  1hygnii

st et ettt =Ry f g pENCE  Data r

* Format :Decimal Fils Data Range : 1

Substitution will now be executed, and the number of reterence numbers that were sub-
stituted will be displayed.

4

—TF2
Seg.H 82 + 2 Timer 1

| L, Beesid
— >
heems ,E}l BOGUGE #aPa19
n?uusa

in Elements Edit Go/Brch Network -Ref
———F————P4————F5———F%

>
HOUO24 OBUP21

U J
aanAz1 T ]

Reference Data .
| Parmat :Decimal L Humher of Vrr:pl«;c&nr:nts: 4 )
O[EIE’D 1) Substitution exceeding one network is not allowed for this operation. For substitution in

more than one network, select Network List from the Edit Menu. See section 8.2 Net-
work List Operations for details.

2) Either positive values or negative values can be used for offset values.
3) When the number determined by adding an offset number to the specified starting or last
reference number exceeds the reference range set in the system configuration, an error

will oceur.

4) If two or more different ranges are set (for instance, 300001 for the starting reference
number and 401000 for the last reference number), substitution will not be executed.

9.3.5 Open Row/Close Row

1. Open Row

The Open Row operation inserts one blank row in a network. Elements below the position
where a row is inserted in the network will be pushed down by one row. Therefore, inser-
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m

tion is impossible when there is not a free row below the insertion position. A row cannot
be inserted where there is an element consisting of two rows.

2. Close Row

The Close Row operation deletes one specified row from a network. Elements below the
position from which the row is deleted will be pushed up. If the row contains an element,
the row cannot be deleted.

An example of Open Row is shown below.
1) Move the cursor to the position at which a row is to be inserted using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Open Row from the Edit Menu using the Cursor Keys and press the Enter Key.

in Elsments iinm Go/Syvch Network Raf Tools
E:——-——rz 3 it —F6——F7- 0N -PS-I—FY
|Seg.H 1 / 1 Start Sequenc| Copy -
| ey 04 Delets
188081 | 100005 1 Paste
Of fzat
" co ‘
Closs Row
Close Column

IW ;

‘Ho Symbol/Descriptor availabl —

Format :Decimal File Data Range : 1

One blank row will be inserted at the cursor line.

lﬂain Elewents Edit Go/Srch MNetwork Ref Yools
f1-——F2: 3 F4- 5 F6 Fo- TGP~
[Seg.H 81 / 1 Start Sequence
P

1 198865 180086

1

1

1

Refersnce Data
Pormat :Decimal Pile Data Range : 1

9.3.6 Open Column/Close Column

1. Open Column

The Open Column operation inserts a blank column. Elements on the right side of the
position at which the column is inserted will move to the right by one column. The right-
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9.3.6 Open Column/Close Column cont.

most column of the network must be empty and it will be deleted. Therefore, if no free
column is available to the right of the insertion position, a column cannot be inserted.

2. Close Column

The Close Column operation deletes the specified column. Elements on the right side of
the position from which the column is deleted will move to the left by one column. If the
specified column contains an element, the column cannot be deleted.

An example of column insertion is shown below.
1) Move the cursorto the position atwhich a columnf is to be inserted using the CursorKeys.
2) Switch to the menu cursor using the Tab Key.

3) SelectOpen Column from the Edit Menu using th:e Cursor Keys and press the Enter Key.

in Elswments m GosSrch Metwork :Ref Tools Guit

F2 3 Edit P6 P7-TRg-Fe-Sgg—FY

Et."nlzrhri CBgz

Polate

Paste

OfFeet
n_Row

Clote Row 896820
Close Column >—

Reference Data

Format :Decimal Fils Data Range : 1

One column will be inserted in the column in which the cursor is positioned.

Bain Elements Edit  GosSreh  Metwork Ref Yool GQuit
Pl ———— P ———F 3 P F§ e P F 5 RTI}-F 8 - A —
Seq.H X2 / 2 Timer 1 <>
- /l—;m 1?— o1 >
00018 100081  o— #06a19
L #+—JUCTR y—
00719 4909082 288868 288828
~—UCTRE —
® 428623 . 400021 00se21
A il
Refeorence Data i
* Format :Decimal Pile Data Range = t

— 932 —



9.4 Go/Search

M

9.4 Go/Search

- B This section describes basic operations on the Go/Search Menu, such as moving control
between networks and searching for elements and reference numbers.

8.4.1  Moving Control Between Networks ..............cc..oouueinivnion.. 8-33
9.4.2  Search. ... ... i 9-34
9.43 Trace/Retrace .......coviiiiiiii 9-39
9.44 Show Trace/Search and Delete Trace/Search .. ......ooovvvnnnnnn. ... 9-41

9.4.1 Moving Control Between Networks

Use the following keys to move control to an adjacent network, the firstlast network in the
segment, or any other segment when the cursor is set on the Ladder Editor Screen.

Moves to the previous network.
Moves to the next network.

CTRL | +

Moves to the first network in the segment.
CTRL + Moves to the last network in the segment.
CTRL + Moves to the previous segment.

CTRL +

Moves to the next segment.

Control can be moved to a network other than adjacent networks using the Goto Network
Menu. Specify the destination using the network number or network title. An operation exam-
ple using a network title is shown below.

1} Switch to the menu cursor using the Tab Key.

2) Select Goto Network from the Go/Search Menu using the Cursor Keys and press the

Enter Key.
in Elsments Edit TSI Hetwork Ref Tools Quit
s - Madididl — o Search W-FE-Om— Y
eg.H 81 - 1 Seu-t/s-q\nncn N
S —

B aRC
1 1 1 Search Next o0ean1
Search Prev
Trace
Retrace
Show Trace Search
Dolete Trace/Search

1
1
i

Reference Data

- Format :Decimal File Data Range : 1
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L
9.4.2 Search

3) The Goto Network window will be displayed. Move the cursor to the section in which the
network title is to be entered using the Cursor Keys. Enter the network title of the network
to be moved to (Timer 1 in this example) and press the Enter Key.

h}a:l.n Elemantz Edit
g i <1 F4

!"'"—i“ a1 Stu-t/SL.qunnc-
_a'aam 188885 1
2088z

GosSrch Hetwork :Ref Tocls Quic
S 6 ¥ -—?

‘ul.u[ Netuorh

Netovoark: 1
Netvork Title: (§frar

Format :Decimal File Data Range : 1

The network corresponding to the network title that was entered will be displayed.

im Elsments Edit Go-Srch MNetwork Ref Tools Quit
— P} —— P -y~ { - Fa - —FY
150 H %2 / 2 Timer 1
1

‘ Format :Decimal File Data Range : 1

O[E{IED 1) When both a network number and a network title are entered, priority is given to the net-
work titte. Therefore, when entering a network title, the network number can be ignored
even if it does not correspond with the specified network title.

2} Enter a sequence network number for the network number. When a segment network
number is entered (excluding a high-speed segment), a correct search can not be
performed.

9.4.2 Search

The Search operation searches for specified constants, reference numbers, or element sym-
bols in ladder programs. The foliowing three search functions are available according to the
search start position and direction.

1) Search
The constant, reference number, or element symbol that was entered is searched for.
Search starts from sequence number 1 {the high-speed segment network). When match-

ing items are found, the cursor will move to that position. When no matching items are
found by the end of the program, an error message will be displayed.
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2) Search Next

The constant, referenée number, or symbolthat was entered at execution of the Searchis
searched for again in order of ascending network numbers. The search start position va-
ries according to the operation mode as described below,

e Offline Mode -

The search starts from the current cursor position.

» Online or Debug Mode

The search starts from the element position reached by the previous search.

3) Search Previous

The constant, reference number, or symbol that was entered at execution of the searchis
searched for again in order of descending network numbers. The search start positionis
the same as for Search Next.

1. Search

An operation example for an element symbol (an N.C. contact) is shown below.
1) Switch to the menu cursor using the Tab Key.

2) Select Search from the Go/Search Menu using the Cursor Keys and press the Enter Key.
The Search window will be displayed.

———p2——F3
og.H %2 / 2 Timer 1

in Elements Edit GosSrch Metwork Ref Tools Quit
4= P ——— P ———F /- FO - —F9

Search for:

Node type:

Reforence Data:

Pormat :Decimal File Data Range © 1
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9.4.2 Search cont.

3) Move the cursor to the symbol search using the Cursor Keys. The menu bar on the
screen will change to an element input menu. Use the Tab Key to display a pull-down
menu and select an N.C. contact using the Cursor Keys.

—————————————————————————Referance Data

Format :Decimal File Data Range : 1

4) Inputa symbol and press the Enter Key. A search will start from network number 1 of the
segment currently being displayed. When the search is completed, the cursor will move
to the position where the symbol is found.

ain Elements Edit CosSrch Hetwork Ref Tools
‘L - —F4—¥5——-F5—-—1P7-m-!’8-

'‘No Symbol/Dezcriptor availabl

Reference Data

Format :Decimal Filc Data Range : 1

ﬂ? When both numeric data and a symboi are entered, the item that satisfies both conditions will
be searched for. For instance, to search for the N.C. contact with reference number 5, enter
both the reference number and symbol. In this case, an N.O. contact with reference number5

will not be searched for.

To search using numeric data, press the Enter Key after entering a numeric value. The cursor
will move to the symbol input section. Press the Enter Key again.

Note When a ladder instruction uses multiple references from the specified reference number, all
the references are searched. The search range is restricted for indexed block transfers.
These are explained using the following examples.
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Example 1

I |
400100

I
400110
DADPD

400120

For the UNSIGNED DOUBLE PRECISION DECIMAL ADDITION instruction shown above,
holding registers 400100, 400101, 400110, 400111, 400120, and 400121 are searched.

Example 2

| |
0000.17

I
400010
BLEKM

# 000065

For the BLOCK MOVE instruction, coils from 000017 to 000096 and holding registers from
400010 to 400014 are searched.

Example 3

I000097|
|400100I
DIBT
#00010

Forthe DESTINATION INDEXED BLOCK TRANSFER 1 instruction shown above, coils from
000097 to 000256 and holding register 400100 are searched. The registers which are actual-
ly storing data are not searched because the reference number of the register in which data is
stored is specified by a pointer. There are references that are not searched in four instruc-
tions: DIBT, DIBR, SIBT, and SIBR. Caution is necessary when using these instructions.

2. Search Next/Search Previous

Search Next and Search Previous are useful for searching the constant, reference number,
or element symbol that was entered at Search operation once again. An example of Search
Next is shown below,

1) Switch to the menu cursor using the Tab Key.
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9.4.2 Search cont.
2) Select Search Next from the Go/Search Menu using the Cursor Keys and press the En-
ter Key.
in Elements Edit Network Ref Tools Quit
—F2—F3 /Search—
|Seg.H ¥ -~ 1 Start Se nce Goto Metwork -
Tolobi[rodols TN e
imli 100805 |
1odatz ;5.‘" v
m thﬁ:lco/Sluch
M Delste Trace Scarch
“No Syl.bol/b-:cripnr availabl
Reference Data
i
Format :Decimal File Data Range = 1
3) The search for an N.C. contact will begin from the cumrent cursor position. When the
search is completed, the cursor will move to the position of the N.C. contact that is found.
b;in Elements Edit GosBrch MNetwork . Ref Tools Quit
2 ———F3 —Pf —————F i =
[Seg.H %2 / 2 Timer 1 — :
Mo Symbol- Descripter availabl Teference Dutm
~ Format :Decimal File Data Range = 1
OIJIEEID Search must be executed before Search Next or Search Previous. If Search is not executed

first, nothing will be executed for Search Next or Search Previous.
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9.4.3 Trace/Retrace

By moving the cursor to any contact currently being displayed on the screen and executing
Trace, the coil corresponding to the contact can be searched for. By executing Retrace after
executing Trace, the trace can be displayed in the reverse sequence. By using Trace/Re-
trace, the circuits that cause state transitions of a contact can be searched sequentially as
shown below.

i Trace
—_—

1. Trace

1) Move the cursor to the contact to be traced using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Trace from the Go/Search Menu using the Cursor Keys and press the Enter Key.

'E‘i“‘

Elements Edit Metwork Ref fools  Quit
P4 G Yo T8

——F2 3 Go/Searc TT—F?
Seg.H 84 / 4 Check 1 Goto Metwork
Search —_——{ =
Search Next 2epe93
Search Preav
109810
trace
Show TracesSeawrch
Delete Trace Search

24 wurs _Timer_output On once 24 hours llt’.;"li.uer 1™
Refercnce a

“ Format :Decimal File Data Rangs = 1
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9.4.3 Trace/Retrace cont.

The cursor will move to the coil corresponding to the specified contact.

’EIﬂin Elements Edit GosSrch  Network ;Ref Tools Quit
P} ——F2—P3 4—————Fs ————F b ————F 7 -F8 -T—F?
EEiHIIS 7/ 5 Check 2
198811 '

- 24_hours_Timer cutput On once 24 hourt at “Timer 1'-
——Raference Data

- Format :Decimal File Data Range = 1

2. Retrace

The Retrace operation traces the trace execution results in the reverse sequence. Therefore,
when Retrace is executed, the cursor will move to the position of the contact specified in the
last Trace that was executed. When Trace is executed again, the cursor will move to the con-
tact of the previous Trace,

Select Retrace from the Go/Search Menu using the 'Cursor Keys and press the Enter Key.
The cursor can be set to any position.

k;in Elemsntz Edit Network Ref Tools Quit
2 Fa P4 r———~Go /Search— IE-Fi-0—FY
Seg-H 82 / 2 Timer 1 Goto Network

7 { >— Search
62818 [ i) Search Next
s —{18.1} Search Prsv
$ 188081 HO006 Trace

4 UCTR

how Trace/Ssarc
w Delete Trace/Search [ >—
i Ba21
s —UCTR |-
1 4889004

~ Format :Decimal File Data Range : 1

\Onro_ I When Retrace is executed, the trace listis deleted. See section 9.4.4 Show Trace/Searchand
Delete Trace/Search for more details on the trace list.
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The cursor will move to the position of the contact specified in the last trace.

Elements Edit Go/Srch Network Ref Tools Quit
————F2 4Py —————F§ ———F7- T F8-—FY
Ssg.H 34 / 4 Check 1

180010

- 24 hours_Timer_output On once 24 hour: at “Timer 1°
Reference Data

Fayaat :Decimal File Data Range : 1

9.4.4 Show Trace/Search and Delete Trace/Search

1. Show Trace/Search

The search result obtained by Search or Trace is referred to as a trace list. Up to 20 traced
itens are stored and can be displayed using the Show Trace/Search operation. The following
types of trace lists are displayed.

- » Reference number to which the cursor is set when Search/Trace is executed.

» Network number that was displayed when Search/Trace was executed.

1) Switch to the menu cursor using the Tab Key.

2) Select Show Trace/Search from the Go/Search Menu using the Cursor Keys and press

the Enter Key.
in Elsments Edit m! Hetwork Ref Tools Quit
F2 3 P4 {0 /Search: -E—F9
oy.H 82 / 2 Timer 1 Goto Network
T T { >— Search
00016 200918 Search Next
ml—ﬂ‘ﬂ-il— Search Prev
8 499081 . lm 'I‘::ce
— race
v Jeoons SR EETT—
- Vi = ete Trace/Searc € >—
a 8821
’ UCTR |-
1 420894
Reforence Data
- Format :Decimal File Data Range = 1
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9.4.4 Show Trace/Search and Delete Trace/Search cont.

The Trace List will be displayed on the right side of the screen.

in Elsments Edit Go-Srch WNetwork Ref Tools
P2 ¥3 ¥4 F5 6 X hrlFF
[Scg.H ¥2 7 2 Timer 1 Trace List
[ y T BPAVEL  Notuork:
so0aLe ABANE  MNetuorks
BEEH18  Metuvork:

196885 Hetuork:

[SLELEIS

* Pormat :Decimal Fils Data

3) Press any Key to clear the Trace List display.

2. Delete Trace/Search

1

To delete the trace list before starting a new search or trace, use the Delete Trace/Search
operation. The previous trace list will be deleted.

1) Switch to the menu cursor using the Tab Key.

2) Select Delete Trace/Search from the Go/Search Menu using the Cursor Keys and press
the Enter Key.

in Elements Edit Metwork Ref Tools Quit
——py——— T3 I /Searc| E-Fe-i—F
Seg.H %2 / 2 Timer 1 Gote Metwork
r { o Sparc!
#88810 209018 Search Hext
m}—ita.ﬂ— Search Prev :
8 488081 P0G Trace
1 ZFH—{UCIR|- Retrace
BO3E1LY 40002 Show Trace/Seaprch
- Pdsd| Deletr TeacesSearch | E4Pad
enaze 821
- /F—UCIR-
888821 420084
Heference Data
- Format :Decimal File Data Range = 1

3) Aconfirmation message will be displayed. Enter Y and press the Enter Key. The previous
trace list will be deleted.
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9.5 Network Operations

This section describes network editing operations, such as insertion, copying, and
deletion of networks.,

9.5.1 Insert Before Network/Insert After Network

.......................... 9-43
852 Copy Network ........oiiiiiiiiii i 9-44
9.5.3 Delete Network .......oouininiiiiii i e e 9-44
9.54 Paste NetWwork ..........coiiiiiiii i e g-45
9.5.5 Moving Control to the Subroutine Segment ...............o.oo ... .. 9-46

9.5.1 Insert Before Network/Insert After Network

1. Insert Before Network

An empty network is inserted before the network currently being displayed. The network
numbers from the currently displayed network are incremented by one.

2. Insert After Network

An empty network is inserted following the network currently being displayed. The net-

work numbers of the networks following the currently dispiayed network are incremented
by one.

An example of Insert Before Network is shown below.
1} Switch to the menu cursor using the Tab Key.

2) Select Insert Before Network from the Network Menu using the Cursor Keys and press
the Enter Key.

Ptain Elements Edit  Go/Srch JUSETTM Rof Tools  Quit
Fi—— 2 ekl > P PR (0t o T
Seg.H 82 - 2 Timar 1

nsert ter T
CoH Notwork
Delete Network
Paste Network
Subroutine Ssgment

Reference Data 1

- Format :Pecimal File Data Range 1 1

'An empty network will be inserted in network number 2. The timer circuit in the previous

network number 2 will be changed to network number 3, and subsequent network num-
bers will be incremented by one.
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9.5.2 Copy Network

9.5.2 Copy Network

The Copy Network operation stores program data and comment data of the network currently
being displayed. The network data stored by the Copy Network operation can be inserted at
another position using the Paste Network operation.

Only one network can be stored by the Copy Network operation on the Network Menu. To
copy a number of consecutive networks, select Network List from the Edit Menu on the Seg-
ment Status Screen and execute the Network List operation. See section 8.2 Network List
Operations for details.

1) Switch to the menu cursor using the Tab Key.

2) Select Copy Network from the Network Menu usiing the Cursor Keys and press the Enter
Key.

nin Elements Edit Go/Brch Ref Tools Quit
h L ] N h ¥y

—F i B s e T
Seg.H %2 / 2 Timer 1 Insert Before Network
m;;— Insert After Net
/ T@.1 - d— EE!. Network
200818 408861 20006 28da19 Paste Metwork
4 E—I, UCTR Subroutins Ssgment

Vs ucrnar- bp——y—— >
'a_leswa #0034 POBB2L

/|1—|uctnt-—

- PFormat :Decimal File Data Range : 1 |

Program data, network title, and comment of the timer circuit will be stored.

9.5.3 Delete Network

The Delete Network operation deletes and also stores program data and comment data of the
network currently being displayed. The data that is stored by the Delete Network operation
can be inserted at another position using the Paste Network operation. Therefore, this opera-
tion is useful not only for deletion of a network, but also for moving a network.

Only one network can be deleted or stored by the Delete Network operation on the Network
Menu, To delete or store a number of consecutive networks, select Network List from the
Edit Menu on the Segment Status Screen and use the Network List operation. See section
8.2 Network List Operations for details,

1) Switch to the menu cursor using the Tab Key.
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2) Select Delete Network from the Network Menu using the Cursor Keys and press the En-

ter Key.
Elements Edit GasSrch Ref Tools Quit
—F2 ——Pg—————P5 ————HNetwar) -Fy
{Sen.H 84 / 4 Check 1 Inzert Before Network
Insert Rftor Net — Y

Copy Network POBRA3
g&ﬂ:t HetuurE

Subroutine Scgment

-~ 24_hours_Timer_sutput On once E‘l.hom at ‘Timer 1"

nETBrenCe L

Format :Decimal File Data Rangs = 1

A confirmation message will be displayed. When Yis entered, the network of Checkt will
be deleted and the program data and comment data will be stored.

9.5.4 Paste Network

The Paste Network operation inserts data of one network stored by the Copy Network opera-
tion or the Delete Network operation into the network position currently being displayed. Pro-
gram numbers of the programs of the subsequent networks are incremented by one.

1) Switch to the menu cursor using the Tab Key,

2) Select Paste Network from the Network Menu using the Cursor Keys and press the En-

ter Key.
kh:'.n Elements Edit Go Srch Ref Tools Quit
i ———e P2 13 F4———Pf e —————— e twor] -F?
eg.H 85 / S Check 2 Insert Befors Network
Inzert After Net —_—
Copy Network BBasa4
" 1 Degetu Natwork
utine Segment

'‘No Symbol/Descriptor availabl

Reference Data

Format :Decimal Fils Data Range = 1

The last network data that was stored will be inserted at the position of network number 5.
Network numbers of the networks from Check 2 will be incremented by one.

O[HE]D 1) Only one buffer is available to store and maintain the data specified by Copy Network or
Delete Network. Therefore, when the Paste Network operation is performed, the data
specified in the last Copy Network or Delete Network operation will be inserted.
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S
9.5.5 Moving Control to the Subroutine Segment

2) The buffer for storing data by the Copy or Delete operation on the Edit Menu is different
fromthe location for storing data by the Copy Network or Delete Network operation on the
Network Menu. Therefore, the data inserted by the Paste operation on the Edit Menu and
the data inserted by the Paste Network operation on the Network Menu are different.

9.5.5 Moving Control to the Subroutine Segment

The Subroutine Segment operation moves control from normal segment editing to subrou-
tine segment editing. This operation is useful for edmng the subroutine programs used by the
ladder program while editing a ladder program.

1) Switch to the menu cursor using the Tab Key.

2) Select Subroutine Segment from the Network Menu using the Cursor Keys and press
the Enter Key.

k:m Elenents Edic GosSrch INUNUM Ref Teols Quic

F2 Hetwork:
Seg.H W2 / 2 Timer 1 Insert Befors Network
ot Inzert. After Net

o

Reference Data i

ll’m-uqt iDecimal File Data Range : 1

Subroutine segment (segment: S} wili be displayed.

Hain Elements Edit Go-Srch Network Ref Iools Quit
———F ————Po— - P8 - —F9

4881
'No Symbol/Descriptor availabl

ference Jata .

~ Format :Decimal File Data Range : 1

Program editing of the subroutine segment can also be used in the same way as for other
© segment editing operations.
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9.6 Reference Operations

This section describes operation procedures on the Reference Menu, such as the
Reterence Zoom operation and the Used Reference display. :

9.6.1 Changing Screen Size ..........ccviiiniiiiiir i 9-47
9.6.2 Reference ZoOm .........coouiiiiiie e 9-49

9.6.1 Changing Screen Size

This operation changes the simultaneous display of a ladder program and reference data to a
single display of ladder program or reference data on the Ladder Editor Screen. When this
operation is executed while the cursoris setto a ladder program, the screen will changetothe
single display of the ladder program. In this state, reference symbols are also displayed in
addition to the program. When this operation is executed again, the screen will change to
display the ladder program and reference data simultaneously.

1) Switch to the menu cursor using the Tab Key.

2) Select Screen Size fromthe Reference Menu using the Cursor Keys and press the Enter

Key.
Main Elements Edit Gos/Srch Hetwork _Iunls Quit
2 —— e ———— P —___pg erence e
Seg.H 82 ~ 2 Timer &

T { >— erence Zoom
seoa1t 26PBE1

’ TG.1 |~
488081

Y

l Reforence Data:

Format :Decimal File Data Rangs - 1

The display will change to the single display of the ladder program.

Elsments Edit Go/Srch Matwork Ref Tgols Quit
——F2——F3 4——F5 ———Pp———F 778,
Seg.H #2 / 2 Timer 1 . [ ?
#0018 308961
L — 1.1 1_sec_Ti->
/ . < )
298881 400081 180869 808802
1_szec_Ti-> 0.1 _sec_-> 1_min_Ti->
|} UCTR
000902 480002 *28856
1_min_ Ti-> 1_sec_pre->
]/ GCTR
4088083
1_howr_T-> {_minute-
1}
24 _hourz->
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L

9.6.1 Changing Screen Size cont.

=N

When displaying only the ladder program, a reference number can be entered using the pre-
defined symbol. For example, when the symbol of reference number 100100 is Work 1, enter

the reference number as shown below.

Inputan N.C. contact. Enter f and Work 1 as the reference number and press the Enter Key.

Elemsnts Edit GosSrch MNetwork Ref Tools Quit
[P ———nmP2 ————F3 P ——msiss 1 P - R F 6 -,
slcs.ll 82 /2 Timer 1 6 ?

< ) .
108918 28981
1_sec_Ti->
4 T8.1 < )
408081 IBVLH ’ + | OD8na2
1_zec_Ti-> B.1_sec_-> © {Hmin_Ti->

/% UCIR
489862
Pl UC'I
[ ]
Il,Jnur_I 4 1_amutn-)

480082
1_min Ti~> 1_sec_re—)>

l,}
21_)nm

By Yix ¥2x Qlx Q2x Ix X1lx X2x Plx P2x Mix M2x

100100 will be entered as the reference number.

in Elasnt: Edit
— —— s P e P,
lhg.ll 2 7 2 Tiswr 1 :
00010 Bo0aa1 ‘
. 9.1 L ll_se:_l’i—)
[seetal saa8a1 12880
1_tec _Ti-> B.l_sec_—> 1_min_ ‘Ii—)
I UCIR
Lo rd L1 g
| |1_nin_]'i-) 1_sec_re— e Iu
SBa0as
1 _hour_T-> l_ninute-)
—]
Worh_1

GoasSrch lbtuork Ref Too]s
P, —F 7 - -F8

By entering a reference number and a symbol in that sequence, a symbol table can be edited
simuitaneously.

1) Enter / and the reference number (100200 in this example) and press the Enter Key.

in Elsments Edit GosSrch Metwork Ref Tools Quit
{ ———F2 ——-P. ~———F6 —F 7 - P - T 9
Seg.H #2 # 2 Timer 1 L. ] ?
829010 889881
, _— |1_:oc_l':l-> .
pem4, 429001 ey 000032
1_sec_Ti-> B.1_sec_—> UCTR 1_min_Ti->
1
leauéaz' 2066E2 30062 l
1_min_Ti-> 1_sec_re->
1/} UCIR
428883
|1_}|nur_r-> minute=->
s
24 _hours->

Pix ¥2x Qix Q2x Ix Xix X2x Plx P2x Mix M2x
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M

2) Enter the symbol {in this example, Ext_SW_1 (=extefnal switch 1)) and press the Enter

Key.
in Elemants Edit GosSrch MNetwork Ref Tools Quit
[ F2——F3 P4 3] 6 F7-- e -Fa-gg—F9
eg.H 82 7/ 2 Timer 1 [
— )
° 1 _Ti>
sec_Ti~
——/—10.1 < >
BO0Ba1L 480001 100068 2Rsae2
1_sec_Ti-> 0.1 _sec_~> 1_min Ti->
24 UCTR
4108082 288060
1min Ti-» 1_sec_re—>
' UCTR

4188003
Il_hnu.r_]’-) 1_minute->

{/F

E _ s

B Yix ¥2x Qix Q2x Ix Xix ¥2x Pix P2x Mix MZx

The symbol that was entered will be registered in the symbol table.

9.6.2 Reference Zoom

The Reference Zoom operation displays the Reference Editor Screen and edits reference
symbols, comments, and data values.

1) Move the cursor to the position of the reference number to be edited.
2) Switch to the menu cursor using the Tab Key.

3) Select Reference Zoom from the Reference Menu using the Cursor Keys and press the

Enter Key.
in Elements Edit Go/Srch HNetwark Toolx Quit
[F1 P ————— P ——— ference 9
eg.H 82 / 2 Timer 1 cen Size
I
é L3
—./
BsapE1e

8.1_sec_register Timedunit= B.13) iy stored (Max=18)
Reference Data

“ Format :Decimal Fils Data Range : 1
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9.6.2 Reference Zoom cont.

The Reference Editor Screen will be displayed. .

g:in Elements Edit
e P 2 e B} e P e F'5

Seg.H 82 / 2 Timer 1
208814

/ Ta.1
eseais LEERN SO006!
200919

Reference : 400081
1#0Map Ref :Ho

< Peserip: Tinedu

Prezs <Esc> to

“ Format :Decimal Filea Data Range : 1

GosSrch MWetwork Ref Tools Quit
ety ——————F 7 - TIPS —FY

——
ReFerence Editor
< >unhol:B.1_cec_regicter
< Jalue:
nit= B.iz) ic stored (Max:=16>

Quit i <Crrl-Enter> accepts Descriptian

Use the following keys to edit references.

(3
3
o
L

(s )
Al

=

The following example shows how

Starts Enable and Disable editing.
Starts reference sy;‘nbol editing.
Starts reference data editing.
Starts reference comment editing.

Toggles the Insert/Overwrite Mode.

Determines input of the data. If the Enter Key is pressed
without entering any data, reference editing is exited, saving
the changed data. '

Cancels the data input. It the cursor is not displayed, editing
is exited without saving the changed data.

to edit a reference symbol.

1) Enter S to start symbol editing.
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m

2) The cursor will move to the symbol position. Move the cursor to the position at which a
character is to be inserted using the Cursor Keys.

in _ Elements Edit Go/Srch Metwork Ref
Seg.Hl #2 7 2 Timer 1 o o

L ¥

Reterence
Referencc: 4BBBO1 < 2ynbol: WYY Y I I IR
[-0OMap Ref iNo < Zalues
< Pescrip: Timckunit- B,I32 is stored (Max-108)

Precs <Esc? to Quit {Ctrl-Enter’® accepts Description

- Format :Decimal File Data

3} Press the Insert Key to switch to the Insert Mode. Input a character to be inserted and
press the Enter Key.

Elsments Edit GosSrch MNetwork Ref
P ——F3 4——r—PF———F6
eg-H 82 / 2 Timer 1

—
Reterence Editor
Reference: 408001 < >ynhol:l
170Hap Ref :No £ Sulue: B8
< Pescrip: Tinedunit= B.1cy iz stored (Max=16)

Precc <Ezc> to Quit <Ctrl-Enter> accepts Description

~ Format :Decimal Pile Data

9.6.3 Used Reference Display

In Online Mode or Debug Mode, reference utilization status can be displayed. The references

that can be displayed, however, vary according to the mode. This operation is not displayed
on the menu in Offline Mode.

s Online Mode

OXXXXX: Coil Q2XXXX: MC control coil - 2
Y1XXXX: MC coil - 1 D1XXXX: Link coil - 1
Y2XXXX: MC coil -2 D2XXXX: Link coil - 2

QIXXXX: MC control coil - 1
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9.6.3 Used Reference Display cont.

» Debug Mode
OXXXXX: Coil DIXXXX: Link coil - 1
Y1XXXX: MC coil - 1 D2XXXX: Link coil - 2
Y2XXXX: MC coil - 2 1XXXXX: Input relay
Q1XXXX: MC control-coil - 1 3XXXXX: Input register
Q2XXXX: MC control coil - 2 4XXXXX: Holding register

Usage status is displayed as follows:

LTI wWmC

Used in an /O map and ladder program {coil.)
Used in an I/O map and ladder program.
Used in an IO map only.

Used in a ladder program only (coil.)

Used in a ladder program only.

Not used

Blank Outside the reference range

An example of displaying a usage table of holding registers in Debug Mode is shown below.

1) Switch to the menu cursor using the Tab Key.

2) Select Used Reference from the Reference Menu using the Cursor Keys and press the

Enter Key.
Main PLC Elements Edit GorSrch Metwork | Tools Quict
[F1: Ove b —!'Sn = m-—lhhr::ee ’

Sey.N X2 /2 Timer 1

£

T { = .
mé_ OB N 05 Sference
y _
ErArY oo | et 206819
#—{UCTR 3—
° iy #0828
a ol #80824 m;l_
v UCIR
1

- 8.1_sec_register Time{unit= B.1z) is stored <Max=18>

-~ Format :Docimal PLC Data ge : 1

3) A submenu will be displayed. Select 4XXXX Ref using the Cursor Keys and press the

Enter Key.

in FLC Ope Elewonts Edit GosSrch Network [EYEENEE Tools Qu

P sl —R-f-ﬂncc

|Seg-H %2 /2 Timer t Scrasn Sizl

Y 3 < >— En ud nufonncc
an—!mm 5 XM - hkn Rt
$OB86! INRUN Ref
- [ 4RuXX Ref |
aoets | P

8.1_sec_regizter Time{unit= 0. 1:) is :tored Max=10>

Format :Decimal

e Data

PLC Data ge ©

—9-52 —



9.6 Reference Operations

---II-------.--------.----.-III-l.III---IIlIlIII-l.II-IIII--IIllIIl-I-.--I-I.Ill----.l

The usage status of the specified holding registers will be displayed.

PLC Ope Elements Edit Go/Srch  Network Ref
44—
eg.H %2 /2 Timer 1

£09810
ooveis TR

{ Do QTSR
020818

8.1_sec_register TimeCunic= B.1e) iz st

L O I O Y I I R B A B R B A .~}
L I e I A A B B A T

L N S A A R A

[ N N o R N I B R R AT
LI I T T IR I I A B B - -
[ N - O R B B |
L U T Y T O Y N T O I A AN |
L I I I e I I A A -
L O O Y T O Y I I BRI

1

<ESC> to qui

Format :Decimal PLC Data

Displays the usage status of the previous reference
numbers to the reference numbers cumently being
displayed.

Displays the usage status of the next reference numbers to
the reference numbers currently being displayed.

B 3

Exits the display of used references.
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This chapter describes the comment operation that enables the displaying and
editing of reference symbols and comments.

1001 Ovel'VieW LI R I N A I A I N I I N R NI R 10'2
10.1.1 Displaying Symbols and Comments ............... 10-2
10.1.2  Displaying the Edit Comment Screen .............. i0-3

10.2 Editing Reference Symbols and Comments .. 10-4

10.2.1 Overview . ... ... ... . i, 104
1022 Edit....oooii i 10-6
10,23 Search...... ... oot 10-10
10.2.4 TextFile Operations . ...........oviveerinunnnn.. 10-13

10.3 Editing Network Titles and Comments ..... 10-17

103.1  Overview ...ttt ine e 10-17
1032 EBdit......o. i i PR 10-18
1033 MovingControl ....................c L. 10-20

10.4 Editing Segment Titles and Comments...... 10-22

1041 Overview ........ ..ottt 10-22
1042 Edit......eein ittt i i 10-23
1043 MovingControl .........cccvvvviinineeneiinnn., 10-23
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10.1.1 Displaying Symbols and Comments

10.1 Overview

J This section presents an overview of the MEMOSOFT symbol and comment operations.

10.1.1 Displaying Symbols and Commenis ...... e ieeiaeriaaeeraaaas 10-2
10.1.2 Displaying the Edit Comment Screen ......... ... .. il 10-3

10.1.1 Displaying Symbols and Comments.

When symbols or comments have been entered, the Ladder Editor Screen is displayed as
shown below. No symbols or comments, however, are displayed when Directto PLC is se-
lected from the Online Submenu in the Mode Menu.

1. Reference Symbols, Reference Comr}aents, and Network Titles

in Elements Edit GosSrch MNetwork BRef Tools Quit
—_— pd————F5———F¢ - a0y
|S wg-M 82 - Displays network tlﬂes

CAnghtiy
', 1698!—39

>_
/Hucnu— >—
¥89024 030034
Dssplays reference symbols prictln

Il
D:splays reference comments
C:— 1_Jli.n_l'mr_.ut ance & lli.nut- at "Timer 175 J
--w- W Pata’
* Format :Decimal File Data Range : 1

The screen displays the symbot and comment for the reference in which the cursoris current-
ly positioned. For the network, the screen displays oniy the network title. Network comments
are displayed on the Network Comment Screen,

2. Segment Titles

!Hn.n Commands Edit Tools Quit
’1—?2—-—1'3—-———!‘1—-—-—-——!'5—?6—?7—!@—?&—
SEGMENT LIST DISPLAY Use H 117
Pr;; 1: 16263
t

Seyg Title Sag

I High-zpesd segment
LE1 Normal cegment 1
LB2 NOT MHMED

L83 NOT FROGRAMMED
L84 MOT PROGRAYMED

HOT PROGRAMMED
§  NOT PROGRAMMED

The Segment List Display Screen displays only the segment titles. Segment comments are
disptayed on the Segment Comment Screen. '
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m—

10.1.2 Displaying the Edit Comment Screen

The Comment Submenu is under the Main Menu. Therefore, the Edit Comment Screen can
be displayed immediately even when the Ladder Editor Screen, the MC Program Edit
Screen, or some other screen is currently displayed. The following example shows how to
activate the Edit Comment Screen from the Ladder Editor Screen.

1) Switch to the menu cursor using the the Tab Key.

2) Select Edit Comment from the Main Menu using the Cursor Keys and press the Enter
Key.

Elements Edit GosSrch Metwork Ref Ipols Quit
F3 P4 5 F6 PG -F8 -3 —P9

r 1

Ry s

UCIR |~
T o

)-_

Fefervence Data

- Format =Decimal File Data Range : 1

3) Select Reference Comment using the Cursor Keys and press the Enter Key.

IH Elaments Edit Gos/Srch MHatwork Ref Tools Quit
Menu: B—P—P————F— 77 Fe - T—F9

&fismin £1 >
n tion —
oLadder

Hiotion it Comment
T T | R TR TITIT, | 206622 ¢ >—
Segment Comment gmé Iaanm o
2090€3 neaag- , 000834

Tk e Dat.
Hefarence Data

Format :Decimal File Dats Range : 1

The Reference Symbol/Comment Screen will be displayed.
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18.2.1 Overview

10.2 Editing Reference Symbols and C@Jmments

l This section describes the basic procedures for editing reference symbols and

comments.
1021 Overview .........ovvevns e e aa ettty 10-4
10.2.2 Bt oo vttt ittt e e e e e e e, 10-6
10.2.3 SEaAMCh ..o vt iiieriei e i e, [ 10-10
1024 TextFile Operalions ........ociirnirniiii i iiiiiiiaaei s 1013

10.2.1 Overview

Forareference symbol, up to 32 characters can be entered. For a reference comment, up to
49 characters per line and a maximum of four lines can be entered. Therefore, up to 196 char-
acters can be entered as a reference comment.

The following example shows how to enter a symbol and a comment.

1) Enter 1 as a reference number, then press the Enter Key.

in . Edit §;;rcl| leti'i:.trd,h Tools Quit
2 3 F4% ymlso L Commen —F 7 -
REP SYMBOL DESCRIPTOR

2) The cursor will move to the symbol field. Enter 1 sec Timer output as a symbol, then
press the Enter Key.

Main Edit Search Textfile Tools Quit
[P =2 e’ 3 —————F 4S5 ymbo L/ Commant _Table——F7—EXIG-Fo-2dd—F?
REF SYMBCL DESCRIPTOR

220821 ]
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3} The comment entry window will be displayed. Enter a comment and press the Enter Key.

[Hain Edit Ssarch Textfile Tools Quit
Pl ————F2-———F3————F4S yabo L-Comment _able——F7-NIWF}-F8-355—F9
REP SYMBOL DESCRIPTOR

BBBERL 1_scc_Timer_output

Heference Sumhol Comment

Pn_once & tecond at “Timer 17N |

ff the number of comment lines entered is less than four, press the Enter Key for the re-
maining blank lines.

IMPORTANT (1) Spaces cannotbe inserted in symbols. )f a blank in the symbol is required, use the Under-
line Key “_".

(2) Do not put an asterisk mark (*} at the beginning of the reference symbol.

ﬂj: Use the following keys for Edit Comment operation.

Switches to insert mode. Because the system is normally in overwrite
mode, press this key to insert characters. Pressing this key again
retums to overwrite mode.,

E Deletes the character in which the cursor is currently positioned.

When the cursor is positioned in a blank line, automatically enters a
reference number one greater than the previous reference number.

When the cursor is positioned in a blank line, automatically enters a
reference number one smaller than the previous reference number.

When the cursor is positioned in the comment field, displays the
entire comment.

Displays the next screen (next 20 reference symbols/comments).

Displays the previous screen {previous 20 references/comments).

Moves the cursor to the beginning of the reference symbol/comment
table. :

JREE o o Fk

Moves the cursor to the end of the reference symbol/comment table.
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.
10.2.2 Edit

OIEEIF 1) MEMOSOFT allows symbols and comments 1o be attached to constants as well as to
ordinary references. To do so, enter #XXXXX (X: any number) as the reference.

2) To change an existing symbol, move the cursor to the symbol, then enter a new symbol
directly.

3) To change an existing comment, move the cursor to the comment and press the Space
Key. The entire comment will be displayed, then change the comment.

4) The list screen displays only the first 49 characters of each comment.

10.2.2 Edit

1. Insert
The Insert operation inserts one blank line at the cursor position.

1) Move the cursor to the position in which a blank line is to be inserted using the Cursor
Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Insert from the Edit Menu using the Cursor Keys and press the Enter Key.

in M Search Textfile Tools Quit
P2 it C Tnhh——-—-!’?—m-m—n
HEF SYHBOL PESCRIFIOR
REPB6E4 Coefficien te Linel’s co.ffi.chnt
BBRAA1 1 _xec_Time | Copy Comment On once a sscond at “Timer 1"
288B92 1_min_Time| Paste Cosment On once & minute at “Time» 1"
8988283 1_hour_Tim d On once an hour at “Timer 1Y
BBEAR4 24_hours_Timer_putput On once 24 hours at “Timer 1%
% 8.1_zec_register Time{unit= B.15) iz stored <Hax-18)>
1_sec_register Time{unit=ggc) iz stored (Max=6@>
490083 1_minute_regizter Time(unitewmind iz stored (Max=68)
480884 1 _hour_regitter Time(unit=hourd isx stored (max=24>
4000811 Mul_work Vork area for multiplication
480813 Div_werk Work area for division

One blank line will be inserted at the cursor position.

in Edit Search  Textfils Tools Quit
———————F2 —— s} ' 4S ymbo L Comme n t Iabh—w-m—rs EF—FY
REF SYMBOL DESCRIPT
2082864 Coefficlent_1 Linel’s cotfflcient
1_xec_Timer_output On once a second at "Timer 1"
889082 1_min_Timer_cutput On once a minute at “Timer 1"
888983 1_hour Timer_sutput On once an hour at “Timer 1"
890084 24_hours 1 imer_output On once 24 hours at "Timer 1"
460901 0.1 _sec_reyizter TimeCunit= 8. 1) iz stored (Max=18)
488082 1 _sec_register TimeCunit=sec) is ttored (Max=6E>
430003 1_minute_resgister Time{unit=nin, iz stored (Max=58)
400884 1_hour_register Time<unit=hour) isz stored (max=24)
408811 Mul_work Work area for multiplication
480813 Div_work Vork arca for division
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If insert processing is interrupted by pressing the Esc Key, the inserted line will be deleted.

The + and - Keys are useful when inserting consecutive reference comments. The following
example shows how to insert a comment in reference number 5.

Move the cursor to the line next to reference number 4 using the Cursor Keys, and then press
the + Key.

b;.in Edie S:;rch Iaxtfihtuh Tools Quit
23 ————P4S ynbo L -Conment - PR S —F9
REF SYMBOL DESCRIPIOR
Coefficient 1 Linel’s coofficient
i_tec_Timer_ output On once a sscond at "Timer 1%
1_min_Timer outpat On once a minute at "Timer 1*
1_hour_Tiser_output On once an hour at "Timer 1"
24_Jwours_Timer_output On once 24 hours at “Timer 1%

1 B.1_sec_register Time{unit= B.1x) is stored <Max=18>
1_szec_register Timp{unit=suc) is stored (Max=68>
1_minute_register Timg{unitomin) iz stored (Max=£8)
1_hour_register TimeC{unitehour) is_stored (max=24>

480811 Mal_work Work area for multiplication
488813 Div_wurk Work arsa for divi:gon

Reference number 5 will automatically be inserted at the cursor position.

ki.n Edit Szgreh I'“uhmn ITools Quit

—F P i) e P 45 ymbo L/ Commont o ——F - FO-—FY
REP . DESCRIPTCR
200064 Caefficient_1 Linel’s coefficient
000281 1_sec_Timer_output On once & second at "Timepr 1%
888882 1_min_Timer_output On once a wminute at "Timer 1"
808383 1_hour_Timer_sutput On once an hour at "Timer 1%
288824 24_hours Timer output On once 24 hours at "Timer 1"
1m B.1 _sec_register TimeC{unlt= B_13) iz stored <Max=18> '
488802 1_sec_register TimeCunit=sec) is stored (Max=50)
488983 1_minute_ragister IimeCunitsmin) iz ztored <Max=68>
488884 1 ur_register Time(unit=hour) iz ztored (max=24)
488811 Mul_werk : Work area far multiplication
488813 Div_work Work area for division

2. Delete

The Delete operation deletes existing reference numbers, symbols, and comments.

1) Move the cursor to the top {or bottom) of the range of reference numbers, symbols, and
comments to be deleted using the Cursor Keys.

2} Switch to the menu cursor using the Tab Key.
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L

10.2.2 Edit cont.

3) Select Delete from the Edit Menu using the Cursor Keys and press the Enter Key.

k::’.n Search  Textfile Tools  Quit
P2 it — -8 -9
REP SYMEOL Insert DESCRIPIOR -
BORPE4 Cocfficien IEHP Linel’s coefficient
2O2eH1 i_:cc Time| Copy Comment On once a sccond at “Timer 1
_min '[:I.ne Paste Comment On once a minute at “Timer 1%
200883 I_Mur im On once an hour at "Timer 1"

24 _hours Ti :uuer_nutyut

] 8.1_sec_register

1_sec_register

1_minute_register
1_hour_register

- Mul_werk

Div_work

On once 24 hours at ‘Timer 1%
Time{unit= B.1s) is stared (Max=-18>
Time<unit=3ec) iz stored (Max=68)
TimeCunit=min?> is stored {Max=e8)>
Time<unit=hour? is stored (max=24>
Work area For multiplication

Work area for divizien

4) Specify the range of reference numbers, symbols, and comments to be deleted.

Edis Search
—P3———P4Symbo

SYMBOL
ety E"'"ﬁ taer s

_S8C. r_output
PIB02 1_nin_Iimer_cutput
PEBA83 l_hnur_'[ i_l_ui:-;putput
t

c_register

_hour_register

o1l vor
488013 Div_work

Textfile
1/Comment Tabls
DESCRIPT

Tools Quit
——F 7P -y

Linei’'s coefficient

On once a second at “Timer 1"
On once a minute at "Timer 1"
On once an hour at "Timer i*

On once 24 llnurs at “"Timer 1%

wneduni
lne(unl tored (Max-6@>
imeduni tored (Max=68>

'me(un:t hmu) iz stored (nm- =24

Uorlt mn fo:- divitgon

The specified range of reference numbers, symbols, and comments will be deleted.

3. Copy Comment

The Copy Comment operation stores comments. When similar comments are to be entered,
you can greatly reduce input time by using the Copy Comment and Paste Comment opera-
tions.

1) Move the cursor to the comment to be copied using the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.
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3) Select Copy Comment from the Edit Menu using the Cursor Keys and press the Enter
Key.

[Main m Search Textfile Tools Quit
[F1 P2 Edit t Table F7- - Fe-JIN3—F9
REF SYMEOL Insert DROR[P‘I’OR

#88P64 Cocfficisn| Delete Linel’s coefficient

208081 1 _sec_Tine On once a secoand at “Timer 1%
882882 1_min_Time| Paste Comment On once a minute at "Timer 1V
828803 1_hour_Tim On ence an hour at "Timer 1%
BB2RA4 24 _hour: Timer_osutput On _once 24 hours at "Timer 1"
408081 9.1_ssc_register

498882 1_szec_register imec<unit=38c) iz stored CMax=e@)
480883 1_minute_rogister TimeCunit=min) is stored (Max=60>
488884 1_hour register Time{unit=hour) iz stored (max=24>
400811 Mul work Work area for multiplication
480013 Div_work Work srea for diviszien

400181

4081682

488163

482184

4) Specify the range of comments to be copied.

[ S 4 Y ko Fo i
RSN o—F7- I8
REF SYMBOL . DESCRIPT
288064 Coefficient 1 Linel’s coefficient
288881 z_aec_l’i.nr_nutput On once a tecond at "Timer 1"
1_min_Timer output On once & minute at "Timer 1™
1_houy_Timer_sutput On once an hour at "Timer 1
24_hours_Timer_sutput On once 24 ho *Ti
8.1 _sec_register i
1. soc_regiszter
1_minute_register
1_hour_register 1 |n"(||n1
Mul_werk

A
Div_sork be-k u-ea for diuhion

4. Paste Comment

The Paste Comment operation copies the comment data stored by Copy operation to the
comment corresponding to the specified reference number.

1} Move the cursor to the copy destination using the Cursor Keys.

2} Switch to the menu cursor using the Tab Key.
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10.2.3 Search

3) Then, select Paste Comment from the Edit Menu using the Cursor Keys and press the

Enter Key.
in Search Textfile Tools Quit
TR T T
REF - SYMDOL Inzert PESCRIPTOR
%00064 Cocfficien| Delste Linel’s coefficient
828081 1_secc_Time| Copy Comment On once a second at "Timer 1%
E00an? 1_min_Time m * On once a minute at ‘Timer 1%
888883 1_hour _Tim On once an hour at "Timer 1"
BB00B4 24 _hours_Timer_osutput On once 24 hours at "Timer 1"
400081 B.1_3cc_regiszter Time{unit= 8.13) i3 stored (Max=18)
4088082 1 _soc_register YimeCunit=sec) iz storsd (Max=68)
408883 I_minuts_reyister TimeCunit=mind it stored (Hax=68)>
498884 1_hour_register Time{unit=hour) ix storcd (max=24)
480811 Mul_work Work area for sultiplication
488813 Div_work Work area for division
498181
498182
498143
490194

The stored comment data will be copied to the sbeéiﬁed destination.

in B A e ble— PG POy
mment -

REF SYN3OL DESCRIPTOR

000964 Coefficient_1 Linel’s coefficient

BeARRL 1_sec_Timer_output On once a second at "Timer 1™

BBE8E2 1_win_Timer_output On once a minute at "Timer 1"

88883 1 _hour_Timer_sutput On once an hour at "Timer 1Y
24_hours_Timer_output On once 24 hours at "Timer 1*

480881 0.1 _sec_register TimeCunit=> @.13) ix stored (Max=18)>

409682 1_sec_regizter Timed{unit=sec) iz stored <(Max=40>

490083 i_minute_regizter Time{unitemin) iz stored {Max=69>
1_hour_register Time{unit=hour) iz ctored (max=24)>

408311 Mul_swerk Vork arsa for multiplication

i@ﬂiﬁl Div_work Work area for divis

n
Time{unit= B.1s? iz stored (Max=i8)
TimeCunit=3sec) iz stored (Max=6@)
488183 TimeCunit=min) is stered (Max=68>
408194 Time{unit=hour) is stored (max=24>

10.2.3 Search

1. Offset

The Offset operation increases the specified reference numbers by the specified offset value.
This operation cannot be used for constants.

1) Switch to the menu cursor using the Tab Key.
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2) Select Offset from the Search Menu using the Cursor Keys and press the Enter Key.

Main Edit Textfile Toole Quit
L R o — X earc mmant Fable——F7- WP -WFiT—F9
SYMBOL DESCRIPIOR
%88864 Coefficient 1 sarch Linei’st coefficient
8800d1 1_czoc_Timer output | Soxt On once & zacond at "Timar 1"
BOBDA2 1_min_Timer_output On once a minute at "Timer 1
890883 1_hour_Timer_sutput On once an hour at "Timer 1"
008884 24_hourt _Timer_ocutput On once 24 hours at “Timer 1"
400881 0.1 _sec_register Time{unit= B.15) is stored {(Max=18>
4900802 1_szec_reyister Time{unit=gec) itz stored {Max=-68>

L 488903 1_minute_regizter Time<unit=min) iz storsd (Max=68>
480884 1_hour_register Time{unit=hour) iy stored (max=24)
488011 Mul_work Work area for multiplicatien

488813 Div_work Work area for division

3) Anoffset window will be displayed. Enter the starting and last reference numbers and the

offset value (in this example, 400001, 400004, and 20, respectively.) Press the Enter Key
after entering each value.

b;i.n Edit Search Textfile Touls Quit
S 7 Sap— ] F435 ymbo 1./C: Table——F7-iRT;-Fo--T05—F9
REF SYMBOL DESCRIPTOR
230864 Coefficient_1 Linel's coofficient
220881 1_sec. Iimer_output On once a zecond at “Timer 1*

000882 1_min_Timer_output On once a minute at “Timer 1"
i On onece an hour at "Timer 1V
On once 24 hours at "Timer 1%
TimeCunit= P.13) is stored (Max=18>
TimeCunitesec) is stored (Max=€8>
498883 1_minute_register Time(unit=nin) is stored (Max-68)

488081 0.1_zec_register
488882 1_sec_register

1_hour_register TimeCunit=hourd iz stored Cmax=24)
488811 Mul_work Work area for sultiplication
488813 Div_werk Work arsa for divizion

Reference numbers 400001 to 400004 will be increased by 20.

Main Edit Search lextfile Tools Quit

P ——— P2 ————— 3 ————P4Symbo 1/Commant _Table-——F7-FIWEFo-,

REF SYMBOL DESCRIPTOR

ENLIE) Coefficient_1 Linel’s coefficiant

HHAOEL 1 _sec_Timer output On once a second at "Timer 1"
1_min_Timer_output On once a minuts at "Timer 1

o8983 ur_Timer_output On once an hour at 'Timer 1"

B8P0 24 hours Timer_sutput On once 24 hours at ‘Timer 1%

480811 Pul_work Work arsa for multiplication

408213 Div_work Work arca for division

408021 P.1_soc_register TimeCunit= B.13) iz stored C(Hax=18>

400822 1_sec_register TimeCunit=szac) iz stored (Max-6€@)

408823 1_minute_register Time{unit-min) is stored (Hax-68)

408824 1_hour_register Time<unit=hour? is stored (max-24>

Hunber of replacenents: 4
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10.2.3 Search cont.

2. Search

The Search operation searches the specified reference number or symbol in the Symbol/
Comment Table. The following example shows how to search a symbol in the table.

L

1) Swiich to the menu cursor using the Tab Key.

2) Select Search from the Search Menu using the Cursor Keys, and press the Enter Key.

Edit eart Textfile Taols Quit
— ] et r»l.—??-m—rs-m—n
REFP SYMBOL DESCRIPTOR
n Coefficient.1 Linel’x cctffici.nt
1_sec_Timer_sutput On once a second at "Timer 1"
[ ird 1_nin_riur_-utput On once a minute at "Timer 1°
aaasaa 1_hour_Timer_sutput On once an hour at ‘Timer 1%
B88a4 24_hours_Timer_output On once 24 hours at “Timer 1"
480881 8.1 _sec_register TimeCunit= @.12) iz stored (Max=1B)
492082 1_sec_rogitter TimeCunit=sec} is stored (Max=-68)
4BBBA3 1_minute_register Time{unit=ain> i: stored (Max=6@>
_hour_regizter Time(unit=hour? iz stored (max=24>
482811 Mul_work Work arca for multiplication
488813 Div_work Work amsa for divizion

3) The window for entering search data will be displéyed. Inthis example, enter 1 hour reg-
ister as a symbol and press the Enter Key.

Fdie Search Textfile Tools Quit
P2 3 F4Symbol/Conment Table——-F7-XIRI-F8-03—F?
SYHBOL DESCRIPFIOR
Cosfficient 1 Linel’s coefficient
1_sec_Timer_sutput On once a sscond at “Timer 1"
1_min_Timer_sutput On once a minute at "Timer 1%
1_hour_Timer_output On once an hour at "Timer 1"
24_hours_Timer_sutput On once 24 hours at "Timer 1"
0.1 _sec_reyister TimeCunite 8.13) iz stored (Max=-i8>
1_sec_register TimeCunitessec) iz stored CMax=68>
1_minute_reygister Time{unit=mind is stored (Hax=68)
1_hour _register Time Cunit=hour) is stored (max=24>
Mul_work Work area for multiplication
Div_work Work area for division

Search data: (ETTTRTYIOTT MEMMMNRENE

The cursor will move to the reference number cerresponding to the entered symbol.

Main Edic Sesarch  Toxtfile Taols Guit
[P} s P2 s Y P 4 S ymbo 1/Comment T able——7F7-F0-F0-S1—FY
REF SYMBOL DESCRIPTOR
200264 Coefficient_1 Linel’s coefficiont
820801 1_sec_limer_ocutput On once a second at 'Timer L™
208882 1_min_Timer_sutput On once a minute at "Timer 1%
289883 1_hour_Timer_sutput On once an hour at "Timer 1"
.||2e8284 24_hours _Timer_output On once 24 hours a2t "Timer 1*
480801 0.1 _sec_regliter Time{unit» B.1g> ic stored (Max=18>
488802 1_sec._register TimeCunite=zec) is stored <Max=68>
488803 1_minuts_reglster TimeC{unitenin) ic stored <{Hax=68)
1_hour_register TimeCunitshour) iz stored {(max=24)>
1 Mul_work York arsa for multiplication
4000813 Div_work Work area for division
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3. Sort

The Sort operation sorts entered reference symbols and comments in ascending order of ref-
erence number. It is automatically performed when an edit operation such as editing com-
ments is exited. Therefore, use this operation only when sorting the reference symbols and
comments during edit operation.

1) Switch to the menu cursor using the Tab Key.

2) Select Sort from the Search Menu using the Cursor Keys and press the Enter Key.

in Edit m Textfils Toels Quit

b; P2 3 c t Table——F7-[ETIGL-Fo-JI}—F9
REF SYMBOL Offsat DESCRIFTOR
W CoefFicient 1 Search Linel’s coefficient

1_zec_Timer_sutput On once & second at “Timer 1%

ABBR2 1_min_Timer P On once a minute at "Timer 1"
@BOBA3 1_Jwur_Timer_sutput On once an hour at “Timer 1"
B0D8A4 24_hours_T imer_output Oo once 24 hours at 'Timer 1"
480811 Mul work Work arsa for multiplication
488813 Div work Work area for division
408881 B.1_secc_register TimeCunit= 9.1 is stored (Max=18>
498082 1_sec_register TineCunit=sec) is stored (Max~£@)
498833 t minute_reyizter Time(unit=min) is stored <{Max-68)>
488884 1 hour register Time{unit=hour} is stored (max=24>

The reference symbols and comments are sorted in ascending order of reference num-

ber,
in . Edit Search Textfile Tools Quit
P2 F3————P4Symbo 1/Conment _Table——F?— R0 -Fe -0 —F?
REP SYMBOL DESCRIFIOR
W Coefficiont 1 Linel’'s coefficient
1_zec_Timer_output On once a socond at “Timer 1"
1_min_Timer_output On once a minute at "Timer 1"
B8B8A3 1_hour Timer_sutput On onte an hour at "Timer 1"
B8EB94 2 urs_Timer_output On once 24 hours at *Timer 1"
488891 B.1_sec_register Time{unit= P.13) ix stored (Max=18)
488802 1_sec_register TimeCunit=sec) is stored (Max=60)
488883 1_minute_register Time{unit=min) ix stored (Max=68>
488884 1_hour_register Time{unit=hour} iz stored C(max=24)>
480811 Mul verk Work area for multiplication
489013 Div_vork Work arca for division

10.2.4 Text File Operations

The Text File function is divided into the following two functions.
» Text File Importing

This operation imports text files created in MEMOSOFT format. The imported file data is
inserted into the symbol table as symbol/comment data,
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10.2.4 Text File Operations cont.

» Text File Exporting
This operation stores edited symbol tables as text files. A standard text editors can be
used to edit these text files. After editing the text flles they can be imported as symbol
tables through MEMOSOFT.

As described above, symbol tables are stored as text files, which can be then imported to
other programs. This allows different programs to process the symbol tables.

The text file format is shown below.

Row 1 8 39 42 )
X X X X X X X X 900® X X X X 00000008 5 X
XXX X X X X X ®00® X X | X X 08008088 X X } Data
X X X XX K X X 0088 X X X X 99009808 X

U ML Commentdata {up to 196 characters)
Symbol data (up to 32 characters)

Reference number (6 digits)

« Five-digit reference numbers are converted to 6-digit reference numbers in the text file.
» A blank space exists between a reference number and a symbol.

» Two blank spaces exist between a symbol and a comment.

« Comment data starts with the 42nd character.

Note (1) Spaces cannot be inserted in symbols. If a blank in the symbol is required, use the Un-
derline Key “_"

{2) Do not put an asterisk mark (*) at the beginning of the reference symbol.
1. Export
1) Switch to the menu cursor using the Tab Key.

2) Select Export from the Textfile Menu using the Cursor Keys and press the Enter Key.

Hain Edit saPC Tools Quit

PL F2 F3-————F4Sy|nbol/ l'ex!: ile F7-T- P8 -0 —F?
REF SYMBOL n ort

#88864 Coefficient_i s coc!ricunt

@88881 i_sec_Timer_output at 'Tiner i

8008882 1 _win_Timer_output Cn oncu u ainute at “Timer 1%

200882 1_hour_Timer_output On once an hour at "Timer 1"

H88884 24_hourz_Timer_output On once 24 hours at "Timer 1"
eLLEET @.1 sac_rcgistur Time<{unit= 8.1s)> is storad (Max=18>
4888082 1_sec_register Tine{unit=sec) is stored (Max=68)
4AAAB3 1_pinute_rogister Time{unit=min) is stored (Max=6@>
490884 1_hour _register Time{unit=hour) it stored <(max=24)
488811 Mul_work Work area for multiplication

468013 Piv_work Work area for division
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3) The window for entering a file name will be displayed. Specify the export destination file
name, and then press the Enter Key.

kl': Edit §;§rcll llr‘-xtfil.‘lahl Tools Quit
Sy ¥ Tepyam— i A4S yabo t —F7- G- Fe g —F9
REP SYMBOL DESCRIFTOR
290064 Coefficient_1 Linel’s coefficient
:I._:tc_'l':ulur_nutput On once a second at "Timer 1"
208882 1_min_Timer_output On once a minute at "Timer 1"
B22RE3 1_hour_Timer_output On .nce an hour at “Timar 1%
PO0PD4 24 _hours Timer_output On once 24 hours at "Timer 1%
W B.1_tec_register ‘l'inc(wnit- @.18) ix stored (Max=-18)
1_sec_register Yime{unit=sac} ix stored {Max-€@>
m I_minute_register TimeC{unit=nin) iz stored (Max-68>
Jnur_reg:hl:cr TimeCunit=hour? isr storsd (max+24)
rk Work areva for mltiﬂ.uatun
ma D:w_uu:rk Vork area for divis

Comment data will be exported to the specified file.

2. Import

1) Switch to the menu cursor using the Tab Key.

2) Select Import from the Textfile Menu using the Cursor Keys and press the Enter Key.

in Edit Search ” A 1a Tools Quit
———F 22— 3———F4S, xt! ———F7- - Fi-gd—F9

REF  S¥WDBOL yubo |-— et |non

Export

3) The window for entering a file name will be displayed. Specify the import source file name
and press the Enter Key.

Iﬂlin Edit Search _ Textfile Tools Quit
P2 ————F3———F45ymbo1/Conment Table—rF7- X -P8-dg—F?
REP SYMBOL DESCRIPTOR
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10.2.4 Text File Operations cont. .

The text fite will be inserted as symbol/commenf data.

Edit Search Textfile Too Quit
2 F3 F4Symbo L/Comment Table——F7-RXNF-PE-53—F9
SYMBOL DESCRIPICR
Goefficient_1 Linel's coefficient
1_sec_limer_output On once & second at “Timer 1%
1_min_Timer_output On once & minute at “Timer 1"
1_houyr_Timer sutput On once an hour at "Timer 1™
PO0EB4 24 _hours_Timer_ cutput On once 24 hours at "Timer 1"
1P98e1 Start _EW
109882 Change _SW
480081 8.1 _sec_register Time{unit= B.1s) iz stored CHax=-1@)>
490082 1_sec_register TimeCuniteogec) iz stored {Max=6@)>
46A0e3 1_minute_register - Time{unit=min> iz stored {Max=68>
4PE864 1_hour_regizter Time{unit*hour) iz stored C(max=24>
488811 Mul_work Work area for multiplication
488813 Div_work Uork arsa for division
O[Iﬂﬂb 1) If the imported data contains the same reference number as an existing reference num-

ber in the symbol table currently being edited, thé imported data has priority. Therefore,
the data in the symbol table will be overwritten.

2) If the imported data contains the same symbol as an existing symbol in the symbol table
currently being edited, the symbol in the symbol table has priority. Therefore, the im-
ported symbol data will be ignored.

3) if the drive and the directory are not specified, then read and write operations wilt be exe-
cuted using \FMSGL.
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10.3 Editing Network Titles and Comments

This section describes the basic procedures for editing network titles and comments.

10.3.1 Overview

Up to 32 characters can be entered for a network title. Up to 78 characters perline and up to
20 lines can be entered for a network comment.

Use the following procedure to enter a network title and comment.
1) Display the Network Comment Screen.

2) Enter Timer 1 as a network title, then press the Enter Key.

fta Edit Goto X Co Tools Quit
_FZ—IQ-'—I’Q—-—Mtwr nmen t-—yF 7"'mH"‘m_F9
Seg 1 NETWORK 2 Timer 1

:3) The cursor will move to the network comment field. Enter a network comment.

Main Edit Gote Tools Guit
[Pl ————P2———FJ————PFd—Ne twork Conment ———F7-ED0F-P8-TIT5—F%
Se! 1 MNETWORK 2 Timer 1
g 1 : On every sacond

g : On every minute

4

Ll

i
Coi ! On avery hour
Coi. 2 On every 24 hours
4888081 : 8.1 sec. counter
408802 : 1 sec. counter
488083 : 1 min. counter
4888084 : 1 hour counter
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10.3.2 Edit

4) Press the Esc Key to exit the Network Comment Screen.

When editing other network comments, select Goto from the Network Comment Screen
Menu to switch to.another Network Comment Screen.

10.3.2 Edit

1. Copy

The Copy operation stores the network comments spécified with the Cursor Keys. The stored
data can be copied to another position or another network comment by using the Paste op-
eration. '

1) Move the cursor to the corner of the area of network comments to be copied using the
Cursor Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Copy from the Edit Menu using the Cursor Keys and press the Enter Key.

Fiﬂ Goto e X Co . Tools Quit
F2 it twor nnen t ————F7- BT -FE -3} —F9
Sey 1 NEIWORK @_ er 1
Coil 1 On sver lete
Coil 2 On sver| Paste
Coil 3 : On ever
Coil 4 : On every 24 hours

480081 : 9.1 zec. counter
498882 : 1 sec. countsr
400083 : 1 min. counter
480084 : 1 hour counter

4) Specify the area of network comments to be copied using the Cursor Keys, and then
press the Enter Key.

Goto . . Tools Quit
-—B_Tg.:.—rtuork Comment —F?-TTIF-F8 -3 —F9
» ‘ |
H every second N '
: On gvery ninute '
On every houp '

: On every 24 hours i
: 8.1 sec. counter
1 sec. counter
1 min. counter
1 hour counter
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2. Delete

The Delete operation deletes the network comments specified with the Cursor Keys, and si-
multaneously stores these comments. Therefore, the stored data ¢an be moved to another
position or another network comment by using the Paste operation.

1) Move the cursor to the corner of the area of network comments to be deleted using the
Cursor Keys.

2) Switch to the menu cursor using the Tab Key.

3} Select Delete from the Edit Menu using the Cursor Keys and press the Enter Key.

in Goto Tools Quit
E—Fz it —'ﬂa! twork Comesnt———F7-{NONR-Fe-d3—FY
o

- 1 MNETWORK Co
Coil 1 : On ever w
Coil 2 : On ever| Paste

Coil 3 : On sver

Coil 4 : On svery 24 hours
400081 : @.1 sec. counter
400082 1 zsc. counter
400883 : 1 min. counter
408084 : 1 hour counter

4) Specify the range of network comments to be deleted using the Cursor Keys, and then
press the Enter Key.

Edit Goto

t
——Td—Network Comment—-——P7IYIE-FE-
Timer 1

Tools Quit
—Fr

i On cvery second
: On every ninute
On ¢very hour

On cverv 24 hours
: 9.1 3ec. counter
1 sec. counter
1 min. counter
1 hour counter

3. Paste

The Paste operation inserts the comment data stored by the Copy or Delete operation into the
cursor position. The following example shows how to insert the data stored by the Delete op-
eration explained in 2. into the network comment of network number 3.

1} Move the cursor to the position in which the stored comment data is to be inserted using
the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.
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10.3.3 Moving Control

3) Select Paste from the Edit Menu using the Cursor Keys and press the Enter Key.

Goto Tools Quit

[Fl ———P2: it —MNetwork Conment—F?—{EVIR-Fa—JINE—F%

|Seg 1 MEIWORK &gz ck at Start
te

The stored comment data wilt be inserted at the cursor position.

Edit Goto Toals Quic
—R2 e e 1 &mnt—ﬂﬂm—mﬂ—-—-—l
Sey 1 NEIWORK 3 Check at Start
Coil 1 : On svery second
Coil 2 : On cvery minute
Coil 3 : On suery hour
Coil 4 : On every 24 hours

10.3.3 Moving Control

The Moving Control operation moves to the adjacent networks, the first or last network within
the segment, or another segment. The following keys can be used when the cursor is posi-
tioned on the Network Comment Screen.

Moves to the previous network.
Moves to the next network.

Moves to the first network within the segment.

Moves to the last network within the segment.
+ Moves to the previous segment.

Moves to the next segment.
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To move to another segment or networks other than the adjacent networks, use the Goto
Menu. Specify a network number or a network titie as the destination. The following example

shows how to specify a network title as the destination.

1) Switch to the menu cursor using the Tab Key.

2) Select Goto from the Network Comment Screen Menu using the Cursor Keys and press
the Enter Key.

Main Ed;t_Pm- Tools Quit
[Pl —-——P2———F3 4—HNeotwark G F7- NP3 —P9
ch 1 NETVORX 2 Timer 1

Coil 1 : On every second

GCoil 2 := On every minute

Coil 3 : On every hour

Coil 4 : On svery 24 lours

480081 : 9.1 zec. counter

489902 : 1 sec. counter

498083 - 1 =min. counter

400084 - 1 hour counter

3) The Goto window will be displayed. Move the cursor to the network title field using the
Cursor Keys. Then, enter the network title of the destination network {Check 1 in this ex-
ample} and press the Enter Key.

Main Edit Geto Tools Quit
f ————F2——F3 '4-—HNotwork Comment———F7: -T—re
S g 1 NETWORX 2 Timer 1
11 : On every second :
il 2 : On svery minuts
i1 3 : On every heur
il 4 : On every 24 hours
400881 : 0.1 zec. counter
4Bpee2 - 1 zec. counter
428883 < 1 min. counter
402084 1 hour counter

ioto Netuopk

The Network Comment Screen corresponding to the entered network title will be dis-
played.

kiﬂ Edit &:to % Co lIools Quit
———p2——F3 ———He tuor! e n t— 7 F - - — P9
i-g 1 NETWORK 4 Check 1
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Editing Symbols and Comments
10.4.1 Overview

10.4 Editing Segment Titles and Comments

I This section describes the basic procedures for éditing segment titles and comments.

10.4.1 Overview.......................: ................................ 10-22
1042 Edit ... i et 10-23
10.4.3 Moving Control ... ... i i e e eaeaa 10-23

10.4.1 Overview

Up to 32 characters can be entered fora éegmenttitle. Up to 78 characters per line and up to
20 lines can be entered for a segment comment.

The following example shows how to enter a segment title and comment.
1} Display the Segment Comment Screen.

2} Enter the segment title and press the Enter Key.

Tools Quit

in Edit
hg—ﬂi—l’!l—!"l—s-ﬁnt Gu—uw-“—m

3) The cursor wili move 1o the segment‘comment field. Enter the segment comment.

Main . Edit Too, Quit
[ ———f2—F3 P4—=Sagmant C t F7-TIG-F8 -IHEE—FY

SEGMENT H HLzb-:pud togment
Selved during the hish—spesd scan.
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10.4 Editing Segment Titles and Comments

4) Press the Esc Key to exit the Segment Comment Screen.

To edit other Segment comments, move to another Segment Comment Screen referring sec-
tion 70.4.3 for details on the Goto operation,

10.4.2 Edit
| 1. COpy

The Copy operation stores the segment comments specified with the cursor. The stored data
can be copied to another position or another segment comment by using the Paste operation.

2. Delete

The Delete operation deletes the segment comments specified by the cursor, and simulta-
neously stores these comments. Therefore, the stored data can be moved to another position -
or another segment comment by using the Paste operation.

3. Paste

The Paste operation inserts the comment data stored by the Copy or Delete operation at the
cursor position. There is only one buffer, however, where data stored using the Copy or De-
lete operations is held. Therefore, when the Paste operation is used, the most recent data
which has been copied or deleted will be inserted at the specified position.

The three operations described above follow the same procedure as for the Network Com-
ment operation, so see section 10.3.2 Edit for details.

10.4.3 Moving Control

1) The Moving Control operation moves to the adjacent segments. The following keys can
be used when the cursor is positioned on the Segment Comment Screen.

Moves to the previous segment.

(GTRL)
T -+

Moves to the next segment.

2) ltis only possible to move to adjoining segments.
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Manipulating Reference Data

This chapter describes how to display and edit reference data.

11.1 Reference Data Screen ................... 11-2
11.L1.1  Screen Configuration .................c.0ooun... 11-2
11.1.2 BasicOperations ...................covuurvnnn.. 11-4

112 Edit .....0vvveviniiinninisennenseenass 11-8

11.2.1  Switching the Reference Data Display Format ....... 11-8
1122 SeHtings ........ccviiiniiiiii i, 11-16
11.2.3  SwitchingWindows ............................ 11-20
11.24 FileTransfer ...........coiiiinniiinnnnnn 11-20
1,25 Disable ... .. ... ... . . i, 11-28
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Manipulating Reference Data
11.1.1 Screen Configuration

11.1 Reference Data Screen

This section describes an overview of reference data edit operations including the
reference data screen Configuration and basic operations.

11.1.1 Screen Configuration ................... TR 11-2
11.1.2 BasicOperations ... ... i et 114

11.1.1 Screen Configuration

Reference data can be displayed in the following two ways.

1. Displaying Both Reference Data and Ladder Program

Reference data is automaticaliy displayed by selecting Ladder from the Edit Submenu under
the Segment Status Display Menu. Move the cursor to the reference data field using the Cur-
sor Keys. Then, edit the reference data.

in Format Settings Window Transfer Dizable Tools Quit
—_—F2 4———— 5 ————F6 ~————F 7 I FO I —F?
|Seg.ii 82 / 2 Timar 1
— l—'-;'l’l 1?-'
4 B.
|oBBeiE 4900a1

- 0.1_sec_register Timedunit= B.1s> is stored (Max=1@)

Refercnce Data
|omrn 8.1 sec_-> 0 Dec
B2 1_sec_re—> @ Dec
488803 1_minute-) @ Dac
488824 1_hour_r-> @ bec

Format :Decimal File Data Range : 1

2. Displaying Reference Data Only

Reference data is displayed by selecting Ref Data from the Main Menu. It can also be dis-
played by switching the windows as described in section 71.2.3.

b:in Format Settings oWindow Trancfer Dicable Tools Quit
———F2————Pp3}————P4—TReferonce batab———F7-ETW-FE-TG—F?

8.1 _sec_-> 2 Dec

1_sec_1e—) 2 Dec

492283 1_minute-)> 8 Dec
489004 1_hour_r—> 2 Dec

“ Format :Decimal File Data Range : 1
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1.1 Reference Data Screen

» Screen Configuration

The screen for displaying reference data alone consists of two pages as illustrated below. A
total of 88 references can be displayed. When reference data is displayed together with the
ladder program, however, only 10 references can be displayed.

Reference data

Page1
22 references 22 references
Reference data
Page2
22 references 22 references

» Reference Data Display

Reference data will be displayed as shown below.

XUAXKK XXXXXHXXXX  XAXXX XXX X

(1) (2) 3) 4y (5

(1) Reference number

(2) Symbol

(3) Reference data (déta length varies accord.ing to the format)
(4) Format (decimal, hexadecimal, etc.)

(5) E:Enabled, D: Disabled
(Displayed only for coils and relays)

The reference symbol field can contain up to 10 characters. Therefore, if the symbol length
exceeds 10 characters, only the first 10 characters will be displayed. In this case, the symbols
are displayed as shown below.

400001 ABCDEFGH-»> 1000 Dec
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Manipulating Reference Data
L

N
11.1.2 Basic Operations

11.1.2 Basic Operations

This section describes basic key operations in the reference data field.

|

(4]
£3

EL

[ BEEEH

[

Move the cursor up, down, to the left, and to the right.

1

Moves the cursor from page 1 to page 2. This key is invalid
when the cursor is positioned on page 2.

Moves the cursor from page 2 to page 1. This key is invalid
when the cursor is positioned on page 1.

Moves the cursor to the top left of page 1.
Moves the cursor to the bottom right of page 2.

Deletes the line on which the cursor is positioned.

Displays the most recently entered or displayed reference
number. This is useful when you want to display the same
reference data in different formats.

o Displays the next reference number, symbol, and
reference data when the cursor is positioned in a
reference number field,

# Displays the reference number, symbol, and reference
data just after the most recently entered or displayed
reference number when the cursor is positioned on a
blank line.

# Displays the previous reference number, symbol, and
reference data when the cursor is positioned in a
reference number field.

# Displays the reference number, symbol, and reference
data just before the most recently entered or displayed
reference number when the cursor is positioned on a
blank line.
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I.1 Reference Data Screen

The following example shows how to display and change register data.

1) Enter 400001 as a reference number and press the Enter Key.

in Format Settings Window Transfer Disable Tools Quit
P2 3 Pa— O oo PE F7-(C0R; FB-gY-—
Scg.B %2 / 2 Timer 1 N
|—;m 1?— aoie >
, - —
codele dooom! 1 88019
s—uern y—
BOORLY 8 eese2a
1 2F—UCTR |- —
- |—|ucm?— t
I
1 100084
Reference Data
PG
“ Format :Decimal File Data Range = 1

2) The symbol and register data will be displayed, and the cursor will automaticaliy move to
the register data field. Enter the new data and press the Enter Key.

Format Settings Window Tranzsfer Disahle Touols Quit
4 FS F6 Fo- BTGP -0i—FY

3

in
k!?———-—m 3
Seg.H 82 ~ 2 Timer 1

/l—;Ta EN
actols 480081

I
8.1_sec_rcgister TimoCunit= ©.13) is stored (Max~1@)
fersnce Data

—Ral
480881 9.1_sec_-> 1 NN

- Format zDecimal File Data Range * 1

The following example shows how to forcibly turn the input relay ON or OFF.

1) Enter 100001 and press the Enter Key to display the input relay data.

——F2
15-5.II U2 # 2 Timer 1

ey
adots dbaon

Format Settings Window Transfer Dizable Tools Quit
——P——F§ ———F———F7- T P8 -1 —FY

s

'Ho Symbo LDescripter availabl

Refearvence Data

400881 0.1 _sec_-> 15 Dec
186081 IR E
“ Pormat 'Dacimal File Data Range = 1

2) Move the cursor to the enabled/disabled status field using the Cursor Keys.
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Manipulating Reference Data

11.1.2 Basic Operations cont.

3) Enter D and press the Enter Key to switch to disabled status.

L!ain Foreat Settings Window Treanzfer Disable Tools Quit
[P ——p2——F3——P4——P§ —— P T 7O - I —F9
|Seg-H %2 / 2 Timer 1

)
/181
|eaBois 4pess1

'‘No Symbol/Dezcriptor availabl
400081 8.1 _zec_-3 15 Pac
108881 ]

ference Data

o

- Format :Decimal Fils Dbata Range : 1

4} The cursor will automatically move to the data field. The current setting is 0 (= OFF), so
enter 1 (= ON) and press the Enter Key. ‘

Main Pormat Settings Window Transfer Dizable Tools Quit
i F2——F3 F4 5 3 F7- G- Fe-SE—FY
eg.H 82 # 2 Timer 1 <
T L =
18881 08818
—/—{T8.1 - >
PB8818 488081 E 808919 N
/ =-{UCIR |~ —
9 409802 HOGHE! 000820
/] UCTR |- d—
B208Z8 4106893 RO0BZ4 BOSO21
/H—UCTR |-
1 498804

‘Ho Symbol/Descriptor availabl
4000881 0.1 _zec_-> 15 Dec
180881 1

Reforence Data
D

-

- Format :Decimal File Data Range @ 1

Note If an input relay or coil is set to disabled status in Online or Debug Mode, always return it to
enabled status. If the program is run while the input relay or coil is in disabled status, the pro-
gram will not monitor properly.

The following example shows how to display consecutive reference data starting with the
specified reference number. In this example, move the cursor to reference number 400100
and press the + Key to specify the consecutive reference data to be displayed. If the most
recently displayed reference number is 400100, pressing the + Key with the cursor positioned
in a blank line has the same effect as the above operation. Pressing the — Key displays the
previous reference data.

if the number of consecutive references to be displayed is already known, the Range Menu
described in section 171.2 Edif is useful.

1) Move the cursor to the beginning of the consecutive reference numbers to be displayed
(400100 in this example).
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11.1 Reference Data Screen

2) Press the + Key by the number of consecutive reference numbers to be displayed. In this
example, press the + Key three times.

Format  Settings Wlindow Transfer Disable Tools Quit
——F2 P4——Rsference Datat———F7—{EXIN-F8-T5—FY
hm&m B.1_sec_-> S Dec
488882 1_sec re—> 12 Dec
4108883 1_minute-) 15 Dec
4168804 1_hour_r—> 8 Pec

T Work_1_c-> 17 Dec

- Format :Decimal File Data Range : 1

The consecutive references starting with reference number 400100 will be displayed.

in Format Settings oMindow Transfer Dizable Tools Quit
[Fl——F2 4—HReference Datab————F7-ENNN-FO-TH—FY
400001 @.1 _sec_-) S Dec

408902 1 sec_re- 12 Dec

490003 1_minute-)> 1S Dec

480084 1_hour_r— % Dac

400108 Vork_1_c-> 1?7 Doc
408181 Work 2 _c~> 25 Dec

408182 Vork_3_c->
[EE Sork_4_c-> & Dec

Format :Dacimal File Data Range - 1
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Manripulating Reference Data

11.2.1 Switching the Reference Data Display Format

11.2 " Edit

This section describes how to edit reference data such as switching the reference data
display format and using the Disable operation.

11.2.1 Switching the Reference Data Display Format ....................... 11-8
11.2.2 Setlings ..o or it e e e 11-16
11.2.3 SwitchingWindows ..................... JR 11-20
11.2.4 File Transfer .. ... e ettt ettt et 11-20
1125 Disable ... ... it i e, 1-28

11.2.1 Switching the Reference Data Display Format

MEMOSOFT can display reference data in different formats as shown below.

1.

3.

Decimal Format

Register data is displayed in decimal between 0 and 65535. Signed data may not be dis-
played properly. Use this display format for calculation data for instructions like ADD or
SUB.

Signed Decimal Format

» Two’s Complement Format

Signed data stored in two's complement format is displayed in decimal between —32768
and 32767. Unsigned data or signed data in conventional format may not be displayed
properly. Use this display format for calculation data for instructions like AD16 or SU16.

» Conventional Format

Signed data stored in conventional format is displayed in decimal between —9999 and
9999. Unsigned data or signed data in two’s complement format may not be displayed
properly. Use this display format for data for instructions like SADD or SSUB.

Double-length Decimal Format

+ Consecutive Register Format

Data from two consecutive registers is displayed as double-length decimal data. The dis-
play range is between 0 and 4294967295. Data that is not used as double-length data
may not be displayed properly. Use this display format for unsigned calculation data for
instructions like AD32 or SU32.
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11.2 Edit

m

¢ Conventional Format

Data stored in two consecutive registers in conventional format is displayed as double-
length decimal data. The display range is between 0 and 99999999. Data that is not
stored as double-length data in conventiona! format may not be displayed properly. Use
this display format for calculation data for instructions like DADD or DSUB.

Signed Doubie-length Decimal Format

» Two's Complemenf Format

Data stored in two consecutive register is displayed as signed double-length decimali
data in two's complement format. The display range is between —2147483648 and
2147483647. Data that is not used as signed double-length data may not be displayed
properly. Use this display format for signed calculation data for instructions like AD32 or
SuU32.

+ Conventional Format

Data stored in two consecutive registers in conventional format is displayed as signed
double-length decimal data. The display range is between ~99999999 and 99999999,
Data that is not stored as signed double-length data in conventional format may not be
displayed properly. Use this display format for calculation data for instructions like SMUL.

. Hexadecimal Format

Register data is displayed in hexadecimal between 0 and FFFF.

Binary Format

Register data is displayed in binary between 0 and 1111111111111111.

ASCIl Format

Register data is displayed as ASCH characters.

Matrix Format

The ON/OFF status of coils orinput relays is displayed in consecutive 1 6-point units. This
format is for display only and does not allow editing.

Floating-point Format

* Two consecutive register data is displayed as floating-point data. For precision, the
number of significant digits is seven, and the exponent is between -38 and 38. For ex-
ample, 0.000123 is displayed as 1.23E-04. Floating-point data uses two registers.
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Manipulating Reference Data
11.2.1 Switching the Reference Data Display Format cont.

« Floating-point data will not be properly displayed if other formats are used. Use this dis-
play format for the EMTH instruction only.

+ Floating-point data display is displayed when the lower-order register of the reference
numbers is specified.

"« Rounding errors wili occur in the display.
» Switching the Display Format

The following example shows how to switch a decimal dispiay format to a binary display for-
mat.

1) Move the cursor to the reference number or reference data for which the display format is
to be changed using the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Binary from the Format Menu using the Cursor Keys and press the Enter Key.

S.tti.ngs Window Transfer Dizable Tools Quit
=S ——F—F - G-Fe -I—F9

Referonce Data
Pmaa Work.1c-> 17 Dec
dork2o-3 2§ Dec

Work 3 c—> 13 Dec
100163 bork 4 8 Dee

Format :Decimal File Data Range = 1

The reference data at the cursor position will be switched to binary display format.

hain Format Settingzs Window Transfer Disable Tocls Quit
—F2——F3 4————F§————F6 —F7- - Fe-Ti—FY
Seg.H 82 / 2 Timer 1 <>
L} ¥ L -
Re2918 agenLs
/ Ta.1}~ >—
3 4998081 #0906 pagary
rs UCTR —
* 2 2230220
g 2
2 £88824 983221
s —UCIR -

- Work._2

482188 Work. 1l c-> 17 Dec
Work 2_c—> DOOIODOPO0E11OOL

82 Work 3 _c—> 13 Dec

498103 Vork_4_c¢—> 8 Dec

- Format :Binary File Data Range = 1

+ Matrix Display

The following example shows how to display a coil in matrix format.
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I1.2 Edit

m

1) Move the cursor to the reference number of the coil for which the display format is to be
changed using the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Matrix from the Format Menu using the Cursor Keys and press the Enter Key.

Hain TTGXIEN Settings Window Transfor Disable Tools Quit

Ly N Format T F5———FE I DTG TO- A%

Seg.N 82 / 2 Time] Decimal

Yoy Pecied
ng Dec

——/1—{18.1 |pLong Signed

630018 4988a1 Hexadecinal

| Binar
12 ASCIT

Ploating Pt. md_?w“ 1
' 1 422884

1_sec_Timer_sutput On once & :gcgnd at "!::'.:er 1

RELEFENCE

408188 Vork 1 c-> 17 Dec " OO 1_sec_Ti-> 9OG0EAS0AREN0280
408181 Mork 2 c-> 25 Dec
488182 Work. 3 c-> 13 Dec
488183 VYork £ c-> * Dec
ge : 1

Format Matrix Pile Data

The ON/OFF status of 16 coils will be displayed.

ex.H 82 / 2 Timap 1

in Format Settings Window Transfer Disable Tool: Quit
ﬁg F3 P4 ¥5 6 7N Fi- O — Py

#9001
gy 1L

- 1_zec_Timer_output On once a second at “Timar 1"

ce Data:
400188 VYork. 1l rc-> 17 Dec 1_sec Yi-> BOAEINSEERAAR30D
ge 3 1

482181 WYork 2 c-)> 25 Dec
488182 Work_ 3 c-)> 13 Dec
488183 Vork_4._c-> B Dec

Format :Matrix File Data

Displayed data is shown as follows:

0000071 X X % X X X X X X X X X X X X X

Status of 000016
Status of 000001 (0 = OFF, 1 = ON)

Inthis matrix display, data is displayed in 16 points at a time, so the starting numberis 16n + 1
(n=0,1,2,..).If, forexample, coil 000020 is switched to matrix display format, the reference

number is automatically changed to 000017, and the displayed data is from 000017 to
000032,

» Entering Floating-point Data

The following example shows how to enter floating-point data. Floating-point data is
stored in the 754 standard format stipulated by the Institute of Electrical and Electronics
Engineers (IEEE). There are two input methods available for this format.
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Manipulating Reference Data
11.2.1 Switching the Reference Data Display Formal cont.

» Direct Data Input

Numerical values are entered directly. However,’only 16 digits can be entered.
Example: 0.0000123

« Data Input in Display Format

Numerical values are entered in floating-point format.
Example; 1.23E-5

i

1) Switch to the menu cursor using the Tab Key.

.

2) Select Floating Pt. from the Format Menu usind the Cursor Keys and press the Enter

. Key. .
1
in w Settings Window Tranzfer Dizable Tools Quit
P2 Format -F5 P6- F7-EIR;-Fo -1 —F?
Seg.H %2 / 2 Time | Decimal
T rSigned Inte
nesal FLong hl:i.lg
mﬁ——n‘a-u— blong Signed 3—
8 48981 Hexadsc 1 2eeaty
Binary =
[ee| ascrr E8006 ease2e
Matrix —fUCTR y—
Floating P't. IB 100824 BOBE21

{7 UCIR
1

- Refersnce Data
400180 Work 1_c-> 17 Dec 800991 1_sec_Ti-> @ E
488181 VYork _2_e-> 25 Dec L

488182 WYork_3_c-> 13 Dec

480183 WYork 4 _c-> § Pec

Fermat :Dscima) File Data Bange : 1

3) Enter 400200 as the reference number and press the Enter Key.

ain Pormat Settings Window Transfer Disable Tools Quit
L F2 P3 P4 P5 6 - -Fe -3y —F?
Seg.M #2 ~ 2 Timer 1

L)

=/ —q{T10.1 |
898918 486081

Th T

———————————————Roference Data

400188 Werk 1 _c-> 17 Dec B0Rd1l 1 _sec T1-> @ E
488181 Werk 2_c~> 25 Dec

408182 Work_ 3 _c—> 13 Dec

488183 Work_ 4 _c-> 8 Dec

Format :Floating Pt. Fils Data Rangs : 1
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4) Enter 0.000123 as the numerical value and press the Enter Key.

in Format Settings Window Yransfer Disable Tools Quit
k H %2 7/ 2 Yimer 1 = -
34 :

{ D=

{29
Besals 1009

!lllo Symbol/Dezcriptor availabl

426180 Vork 5 c—3 12 Dec “""""'aa"ii;;a taec Tid @ E
4081 rk_2_c~ 4902 INTTIVE
400187 Vork 3_c-> 13 Dec

499163 Work_4.c-> 8 Dec

- Pormat :Floating Pt. . Pile Data Range : 1

The numerical value will be displayed in floating-point format.

[Main Format Settings Mindow Transfer Disable Tools Quit
i F2 3 Pe P 6 F7 -8NP —FY
eg.H 842 # 2 Timer 1

Re £ co Data

488100 Vork_1_c-> 1? Dec 288eR1 1_sec _Ti-> @ E
488101 Work 2_c-> 25 Dec 466200
490102 Work.3_c-> 13 Dec

498183 Work 4. c—> 8 Dec

“ Format iPloating Pt. File Data Range : 1

+» Entering Signed Decimal Data
The following example shows how to enter signed decimal data in two’s complement format.
1) Switch to the menu cursor using the Tab Key.

2) Select Signed Integ from the Format Menu using the Cursor Keys and press the Enter
Key.

Main w Settings Window Iransfer Dizable Tools Quit
Iy F2 format -5 —F6————TF7- M- F-a—F9
Sag.H #2 / 2 Time | Decimal
T
#0081 rlong Dacimal
s/ b—{T8.1 Lo s od F—
oodots tvoos | hedaSigned 209019
Binary —
|w ASCII #B00G! 280620
B Macrix «{UCTR Y
Floating Pt. |0 4 |, Sooez4 aocaz:
eo00s1

4881@9 Work.l.c-> 17 De Reference Basar 1 _Ti-> 8 E
) T —S0C =

08181 Work 2.c-> %5 Dec =

4P81€2 Vork 3.c-> 13 Dec

400183 Uork 4.c~> 8 Dec

- Format :Decimal File Data Range = 1
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Manipulating Reference Data
11.2.1 Switching the Reference Data Display Format cont.

1

3) A submenu will be displayed. Select Signed frofn the submenu using the Down Cursor

Key and press the Enter Key.

k‘iﬂ Settings Window Iransfer Disable Tocls Quit
R A nrRat —P5————P6————— 75,
13.9.“ %2 7 2 Time | Decimal g-d Int.i
m‘ EEng EcmE ormat
m 18.1 tong Signed
] Hexadecimal 28019
Binary —
]n ASCII #8996 eedaza
- Matrix UCIR >
: Floating Pt. |@ 4 088a21
4 UCIR
1
Refeorence Data:
429188 York_ 1 _c—> 17 Dec 1_sec_Ti-> @ E
488181 Work 2 _c—> 25 Dec
488182 Work_3_c-> 13 Dec .
498183 Work 4 c—> 8 Bec
" Farmat ‘Decimal File Data Range : 1

4) Enter 400200 as the reference number and press the Enter Key.

in Format  Settingt Window Transfer Dicable Taols Quit
————F2 4————F 5 ———F———— T -} T8,

Seg.H #2 7 2 Timer 1

Rafsrence Data
B8 Work 1_c-> 17 Dec BR8] E

490191 Work 2 _c-> 25 Dec

489102 Work_3_c-> 13 Dec

488183 York_4_c-> 8 Dec
- Format :Signed File Data ge = 1

5) Enter —1 as the numerical value and press the Enter Key.

in Fermat Settings Window Transfer Diszable 1Iocol:s Quit
—F2 4s———F5 P =

Seg.H 82 / 2 Timer 1

T8 1.é
/ .
volals doooit
‘o Symbol/Descriptor availahl
-Refarence Data

498188 Work_1_rc-> 17 Dac 888Ba1 1_xec Ti-> @ E i
499181 York_2_c-> 25 Dec 488208 .
488182 Work 3 _c—> 13 Dec

488183 Vork_4_c-> 8 Pec

Format :$igned File Data Range : 1

If the entered data is switched to hexadecimal format, “FFFF” will be displayed.

» Entering Double-length Decimal Data

The following example shows how to enter double-length decimal data in consecutive regis-

ters.
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I1.2 Edit

1) Switch to the menu cursor using the Tab Key.

2) Select Long Decimal from the Format Menu using the Cursor Keys and press the Enter
Key.

[Ilain Settings Window Transfer Dizable Tools Quit
Fl ————P2—— ormat —FS——F6 ——F7- I F8 -GN} —F9
Seg.H 82 ~ 2 Time| Decimal
+Eisned Ints:
4 T8.1 | [ d >
. Long Eﬁ. —_
pos At Tl g e 00017
Binary Jmme
IBB ASCIL @08826
Matrfx —UCTR >—
Floating Pt. |0 . Hmucm?— 888821
s L
200321 108804
Raference Data
400188 Vork_1.c-> 17 Dec 080081 1_sec_Ti-> @ E 4
400101 York_ 2 _c-> 25 Dac [ ]
420102 Work_3_c-> 13 Dec
490103 York_4_c-> 8 Dec
- Format :Signed File Data Fange = 1

3} A submenu will be displayed. Select Long Dec from the submenu using the Down Cursor
Key and press the Enter Key.

|

in Settin Ilindnu Transf Disable Tacls: Quit
e S stor pssble Teole o
Seg.H 82 / 2 Time| Decimal
———— = |#Simmed lnte Decinl
St iy [ |
’ . on (]
Al ERE X
IE Ty aeguze
trix y—
Ploati.ng Pt. |0 490083 899821
400180 Vork 1 c—> 17 Do [ eodehy 1sec Ti> B E
P _C=. ] ~sec_li-
490181 Work 2 _c-) 25 Deg [ ]
490182 Work_ 3 _c- 13 Dec
480103 Work_4_c-> £ Dec
Format :Signed File Data

4) Enter 400200 as the reference number and press the Enter Key.

’ﬂnin Format Settings Window Tranzfer Dizable Tools Quit
Fa FS F6 F7- (R - JRR—9

T

FPi——P2 3
|Seg.H 22 / 2 Timer 1

T { )—

—iI8 1-
4 -
8 m'_

Reference Data

#9188 Work 1_c— 17 Dec 980981 1_sec_Ti~> @ E
100101 Workd oy 3% bes

488182 Work 3_c-> 13 Dec
480103 dork_4_c-> & Dec

Format :Long Dec File Data Rangs : 1 |
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Manipulating Reference Data
L _____________________________________ -________________________________________-______________________]

11.2.2 Settings
5) Enter 1234567 as the numerical value and press the Enter Key.
in Format Ssttings Window Trancf-r;bj.snhle Tools Quit
—2 e P P Pf ———— P 7~ F 8 ]
Seg.H #2 # 2 Timer 1
o
preApgti Sy
4 9
‘Ho Symbol- Descriptor availabl — o -
400180 Nork_ic-> 17 bec | 908081 1_sec_Ti-> © - E
e ke B s
488183 York_4_c-> 4 Dec
Format :Lonyg Dec Filse Data Rangs 1 1
If the entered data is split into reference numbers 400200 and 400201, and each refer-
ence is displayed in both hexadecimal and decimal formats, the data will be displayed as
shown below.
in - !’gmt a,ttinp g._indw ',Ivmtfor Ditabls 'l'oglz Quit
Seg.H lz‘; 2 '[:Ln-;-al . o i - *
Teve1y wova1d
—/F—{718.1} >
238818 408881 a [k
/+—{UCIR y—
9 20896 BOR2E ||
7 —UCTR —
a 4 SO0A24 ONRE21
s YCTR |
1 400004
'No Symbol/Descriptor availabl
Forent oGl 1 sec 11> & E
488208 1234567 LD
%&a D6E7 Hex 480288 54919 Dec n
- Format :Hexadeciniwu “"Pilc Data Wg@ : 1 h |
The entered data (1234567} is represented as 120687 in hexadecimal format. The last
four-digit part, D687, is entered in reference number 400200, and 0012 is entered in ref-
erence number 400201. In decimal format, D687 and 0012 are represented as 54919
and 18, respectively. '
0]1:11'-]» 1) The current format is displayed at the bottom of the screen. Switching the format stores

the new format in the memory. The next time the reference data is displayed by entering
the reference number, it will be displayed in the new format.

2} If the format is switched before entering a reference number to display reference data,
the same result will occur as above.

11.2.2 Settings

1. Range

The Range operation specifies the number of consecutive reference data to be displayed
when a reference number is entered. If, for example, 10 is specified as the number of consec-

—11-16 —



11.2 Edi

m

utive data to be displayed and 400001 is entered as a reference number, reference data
400001 to 400010 will be displayed.

1) Switch to the menu cursor using the Tab Key.

2) Select Range from the Settings Menu using the Cursor Keys and press the Enter Key.

Format JHINTYY tiindow Transfer Disable Tools Quit
tab——F -G - —FY

=P ttin

400001 B.1 sec.—> 5 De|HEEN

480882 1 _zec_re~) 12 De sar Scresn

489823 1_minute—) 15 De| Simple ASCII
1_hour_r—> % De

4881080 YWork_1_c-> 17 Dec

L

- Format :Decimal File Pata Range :

-

3) The range setting window will be displayed. Enter the range (5 in this example) and press
the Enter Key.

fMain Format  Settings olindow Transfer Dizable Tools Quit
[Pl ————F2 =e———F4—Refarence Datat F7- - -—F9
400001 8.1_sec_-> S Dec

480198 Work 1 c-> 17 Dec
I

- Format :Decimal File Data Ranye :

™

The range displayed at the bottom of the screen will switch to 5. From now on, eachtime a
reference number is entered, consecutive five references starting with the reference
number will be simultaneously displayed.

Format Settings OWindow Transfer Ditable Tools Quit
————F4—Reference Datat————F7—RVME-F3-Nd5—F9

N = c
4109082 1_sec_re~> 12 Dec
400083 1_minute-> 15 Dsc
4100084 1 _hour_r-> B Dec

408100 Vork_i_c-> 17 Dec
| |

Format :Decimxl File Data Range :

n
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11.2.2 Settings cont.

2. Clear Screen

The Clear Screen operation clears the Reference Data Screen.
1) Switch to the menu cursor using the Tab Key.

2) Select Clear Screen from the Settings Menu using the Cursor Keys and press the Enter

Key.
k:i.n Farmat wWindow Trancfer Disabls Tools Quit
—p2 13 ot t ingg-—rr ta———F7—EIG-F8 -—F?
480081 0.1 _sec_—)> S5 De| Rangs .
480682 1_szec_reo—)> 12 Da
488883 1_minute-> 15 Da .
488884 1_hour_r-> 8 De .

488108 Work t_c-> 17 Dec
|

- Format :Decimal Fils Data Range = 1

The Reference Data Screen will be cleared.

3. ASCl

The ASCI| operation stores up to 62 ASCII characters in the specified references. The total
number of ASCII characters is stored in the starting reference, and the actual ASClI charac-
ters are stored in the references following the specified (starting) reference number.

1) Switch to the menu cursor using the Tab Key.

2) Select Simple ASCII from the Settings Menu using the Cursor Keys and press the Enter

Key.
in Format olindow Tranzfer Disable Tools GQuit
h: sttings tab————F7-XI-F-TEG—F9

496883 1 _minute-> 15 De
480894 I_hour_»—> 2 De

I-ant zDecinal File Data Range = 1
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3) The window for setting the'starting reference number will be displayed. Enter 400200 as
the starting reference number and press the Enter Key.

in Format Settings oMindow Tranzfer Disable Tools Quit
F2——e—Py—————P4—Reforence Datab P? -
400881 9.1_sec_-)> 5 Dec | ]
490802 1_sgec_re-} 12 Dec

480803 1_minute-> 15 Dec
488084 1_hour_r—> 8 Dac

Start address: 1408201 7]

Format :Decimal Fils Data Rangs : 1

4) The window for entering ASCII character strings will be displayed. Enter up to 62 charac-
ters and press the Enter Key.

Format

Spttings oUindow Transfer Disable Tools Quit
———P4—Reference Datal———FP-NTNE-F8-
4888981 8.1 _scc_—-> 5 DPec | - ]

1 _hour > 8 Dec

Igl

- Pormat :Decimal Pile Data Range = 1

The contents of the consecutive registers starting with 400200 will be shown below.

Format Settings oMlindow Iransfer Disable Tools Quit

—F2 4—Reference Datab——rF7-00IN]-P8-
488901 0.1 _sec_-> 5 Dec B 7 Dec
408832 1 _sec_re=> 12 Dec 488281 Ex fisc
400083 i_minute—> 15 Dec 4188292 an Rzc
400084 1_hour_r—> $ Dec 4808283 prl Azc

© fse

- Format zASCII Fils Data Range : 1

1) If an odd number of ASCIi characters are entered, a space (code; 20h) will be inserted in
the lower digit of the last register.

2) The Enter Key is used to confirm data entry, so a return code (CR or LF) cannot be en-

tered in a reference. If a retum code is to be entered, change the format to hexadecimal
format and enter ODh or QAR
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e
11.2.3 Switching Windows

11.2.3 Switching Windows

The Window operation switches the screen between Slngle Display Mode and Simultaneous
Display Mode. In Single Display Mode, only reference data is displayed. In Simultaneous
Display Mode, reference data is displayed together W|th the ladder program.

The following example shows how to switch Simultaneous Display Mode to Singie Display
Mode.

1) Switch to the menu cursor using the Tab Key.

2) Select Window using the Cursor Keys and press the Enter Key.

m Format SW Iransfer Disable Tools Quit
————F3———F —F———F7-ER-Fe-TI—F9
ISegHﬂ/Zl’mrI
T { y—
/=78 1|— 3 >
AR 00 Boual’
7 —{UCIR y—
9 Ty Be8820 N
i —
108824 BOAG21
U4 UCIR |-
4190884

- 8.1 _sec_register Timedunit= @. 1:) is stored (m-m.

I B e % Boc —Refersnce Data
i_sec_re-2 12 Dec

The screen will switch to display reference data only.

Pormat Settings Window Transfer Disable Tools Quit
e 4Rt Dataé PP Fe - —F9

——— 1 srence —] =0
JEEEEE 8.1 _sec_-> 5 Dec
488982 1_sec_re—> 12 Dec
488883 1_minute-> 15 Dec
480984 1_hour r—> 8 Dec

Forsat :Decimal File Data Range : 1

11.2.4 File Transfer

1. Reference Data

The Reference Data operation stores reference numbers and reference data as text files and
reads text files as reference data. The text file format is as follows:
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100001 0 E
400001 3
400101 2597686
XXXXXX XXXXX
!_ —I— Enabled/disabled status display
Reference data (decimal)

Reference number

Reference data is stored in columns starting with column 8, and the data format is decimal. If
the reference is a coil or relay, enabled/disabled status is stored in coiumn 14.

» Exporting
1) Switch to the menu cursor using the Tab Key.

2) Select Reference Data from the Transfer Menu using the Cursor Keys and press the En-
ter Key.

Iﬂlin Format Settingz Window Disable ‘Iools Quit
[Pl ———p2————p3 - p4——— P ila Transfe - J—ry
Seg.H 82 / 2 Timer 1 <> ?Pﬂﬁ:m
{ >— enplate

P 1?—
0B0E1g 4600

- 8.1 _sec_register Time(unit= @, 13) iz stored (Hax=18)

Reference Data

AGHE1 ? .1_sec_- —g 12 g:c
09882 1 _sec_re-—. ]
468883 1_minute-)> 15 Dec
408984 1_hour_r-> 8 Dec

Format :zDecimal File Data Range : 1

3) A submenu will be displayed. Select Export from the submenu using the Bown Cursor
Key and press the Enter Key.

Main Format Sett:l.ng: Uindw Disable Tools

F} ————F2 3. raneFar feranco Nta

[Seq.H 82 + 2 Timer 1 i cerence b 1
< onp

d
7 —T18.1
[sedafe 1oaasi™ soscd
/H
9 apoea; ey
+—{UCTR —
8 fooezq edeazl
/ UCTR |-
1 406804

B._1_sec_register Time(unit= 8. !.t) is stered (Max=1d)

I mmm B.1_sec_: _> S Doc rence Data *
2 Dec
15 Dee
8 Dec
Pile Data Range : 1
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11.2.4 File Transfer cont.

4) The window for entering a file name will be displayed. Specify a file name and press the
Enter Key.

L‘Ili.n Format Sattings Window Transfer:Dizable Toaols Quit
1 ——f 22— T ————F 5 ———F o —F?- - -1 —FY
Seg.H W2 7 2 Timer 1 '

¥ T

— - —18 1?—
88818 4PBRGB1

' 8.1 _soc_register Time{unit=> 8.12) iz storsd (lh.x'lﬁi
Reforence Data

The reference data will be exported to the specified file.
¢ Importing
1) Switch to the menu cursor using the Tab Key.

2) Select Reference Data from the Transfer Menu using the Cursor Keys and press the En-
ter Key.

hlin Format Setting: Window Imlem Dizable Taols Quit
[P1——F2 _lM_"FS 1 Transfe -g—¥9
eg.H 7 2 Tiner 1 5 a I
{ )— saplate
: eesal

—i/—18.1
808818 1206

8.1_sec_register Timedunit= B.!._a‘)_ is :to;:d <Max=10>

Terenc ta
CIEEA B.1_sec_—> @ Dec = .
400082 1_soc_re-> @ Dec
400083 1_minute—)> @ Dec
400084 i_hour_r-> 2 Dec
“ Format :Decimal Filse Data Range : 1

3) A submenu will be displayed. Select Import from the submenu and press the Enter Key.

Fiain Format Settings Window {@P Dizable Tools Quit
i P2 F3 4 5 ¥ila Transfer Reference Data
Seg.H 82 7 2 Timer 1
{ >— *Tenplate T
200a18

/ Hmi—
Arg

8.1 _sec_register TimeCunit= B.1x) iz stored (Max+18>

Reference Date
CLLCH 8.1 _sec_—> 8 Dec
BOOE2 | sec_re—> 8 Dec

hour_r—> 8 Dec
Ll’m-ﬂﬂ: Decimal File Data Range = 1
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4) The window for entering a file name will be displayed. Specify a file name and press the
Enter Key.

ha:’.n Format $ettings Window Transfer Disable Tools Quit
4——F5 P —————F - IR PE - U —FY

P ~——F2:
Seg.N 82 / 2 Timer 1

%88010
——-VIB—ITB.II-

9.1 _tec_register Time{unit= B.1¢> ix st-;:d (Max=18>

;L Reference Data Import Filenane:
PR B

The imported data will overwrite the reference data.

in Format Settings Window Transfer Disable Tools Quit
—F2 —F3 P4 5 Pé F7- - Fe-J45—Fe
{Seg.H 82 / 2 Timer 1
90016

;&ﬂ;"m"' =

8.1 _sec_register TimeCunit= B.1z) iz storsd (Max=18)

Reference Data
% B.1_sec_-> 5 Dec
1_zsec_re=> 12 Dac

482222 1_minute-) 15 Dec
428894 1_hour_r-> & Dec

Format :Decimal File Data Range = 1

OI]IEE]) 1) The Import operation only reads file data and does not display the reference numbers
and reference data contained in the file. Therefore, fo view the data, be sure to display the
references. Alternatively, the references can be stored and displayed in the template.

2) Unless the drive and directory names are specified, file data is imported to or exported
from directory \FMSGL.

2. Template

The Template operation stores reference numbers and their display formats as a template in
a specified file. It cannot store reference data. This operation allows the desired reference
datatobeinstantly displayed simply by importing the stored template during online operation.

« Exporting

1) Switch to the menu cursor using the Tab Key.
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11.2.4 File Transfer cont.

2) Select Template from the Transfer Menu using the Cursor Keys and press the Enter Key.

Settings Window

Pain Format EETEER Disable Teals Quit
P1——f2—— F3—— F4————F% ile Transter— 8-MH—F9
cg.H 82 7 2 Timer 1 5 bfunca Data
Ly { >—

k]
—/—18.1+
00918 4000881

- 9.1 _sec_resizter Time<unit= 8. 1:) is :tnud (Ilax-lﬂ.

| 8.1_sec_-> 5 Dac
1_sec_re-> 12 Dec

m 1_minute-)> 15 Dec
488884 1_hour_»-> 8 Dac

- Format :Decimal File Data Range

"
-

3) A submenu will be displayed. Select Export from the submenu using the Cursor Keys
and press the Enter Key.

in Format
eg-H 82 / 2 Timer 1

Sctl:.ins’: H:uu!ou ‘Dizable Tools
rm:fer—ﬂ-
rReference Data 'lelp te
T { Y Im— \ |.<t.-
18 1?—
Id -
A

‘- 8.1_sec_register Time(unit= B. ls) is :toﬂd CMax=198>

muum 8.1 _gcc_~> S Dac Bata
32 1 _sec_re-) 12 Dec
15 Dec

ot -3 1 Dec
- Format :Docimal Fils Data

4) The window for entering a file name will be displayed. Specify a file name and press the
Enter Key.

Format Irancfer Disable Taols Quit
eu 7R uOF F s 3

———P2.
Seg.H #2 # 2 Timer 1

Settings Window
4—F5

‘ B.1l_sec_register TimeC(unit= B. 1:) is stored (Max=18>
Reference Data

DL 8.1_sec_-> S Dec
b2 1 _sec_re-> 12 Dec
m 1 minute-)> 15 Dec

498604 1_hour_r-> 8 Dec
File Data Range : 1

Format :Decimal

The template information will be writien to the specified file.

« Importing

1) Switch to the menu cursor using the Tab Key.
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2) Select Template from the Transfer Menu using the Cursor Keys and press the Enter Key.

in Format Ssttings Window Dicable Toole Quit
[Fl -~} ———— P 3~ P —————— P ————— Tranzfe 8-1g—F9
Seg.H #2 ~ 2 Timer 1 5 rRefarence Data
{ 3— plecpiote —— |
10905
9

“ Format :Decimal File Data Range : 1

3) A submenu will be displayed. Select Import from the submenu and press the Enter Key.

hln Format Settings Window Disable Tool:s GQuit
———fP 3 Pg- o s Trancfer—s-{i—i
eg.H 82 / 2 Timer 1 5 P-f-nce Data rTe te
< > Ié_hm
et =
[eosals dbaosy
¥4
>_
1
/i—iucm
1
hl
Reference Data
-
Format :Decimal File Data Range : 1

4) The window for entering a file name wilt be displayed. Specify a file name and press the
Enter Key.

Il‘la:‘m Format Settings Window TIransfer Dizable Tools Quit
7l 74 75 # ~IPN-F - UaE—FY

[F1 F2 I
|Seg.H 82 / 2 Timer 1

Reforence Data:
|

- Format :Decimal Pile Data Range = 1
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11.2.4 File Transfer cont.
The template will be imported, and the current reference data will be displayed in the
stored format.
in o Format Settings Window Iransfer Dizable Tools Quit
—2 —F ——— PP - — Y
S'ag.I! %2 7 2 Timer 1 < —
0.1_scc_register Timedunit= 8.132 is c_tond <Max=18>
-musdm 8.1 _aec_—> S Dec bbb ®
BROBZ 1_szec_rc—> 12 Dec
408083 1 minute-> 15 Dec
406804 1_hour_r-> 8 Dec
Format :Decimal Fils Data Rangs : 1
OIIIEIP 1) If 2 is entered inthe window for entering a file name, a list of currently stored template files
witl be displayed. A file can be selected by moving the cursor to the file and pressing the
Enter Key.

2) WFMSGL\PROGRAMS is the default directory when template files are imported or ex-
ported. If a directory other than \FMSGL\PROGRAMS is to be specified as the default,
select Location of Program Name from the File Menu and change the directory.

3. Debug Mode

In Debug Mode, it is possible to choose between displaying data from the PLC or data which
has been stored in a file. Reference data which is displayed can also be transferred to the
personal computer and filed, or filed reference data can be transferred to the PLC.

» Switching Display Data

Foliowing is an example showing the procedure used to switch the reference data displayed
on the screen from PLC data to data saved in a file.

1) Switch to the menu cursor using the Tab Key.

2) Select File Data from the Transfer Menu using the Cursor Keys and press the Enter Key.

in PLC Format Settings Window -Disable_ Tools Quit
4 sl 1 P R O e Yranst er— f-Fi I —37
Seg.H %2 2 Timer 1 N Taplat
L a
fe8e10 206019 L Eole Dot
$
s

- B.1_sec_xegister Timodunitw= G-}_sl)_ is :tn;:d Max=18>

l' 8.1 _sec_-> 52 Dec
m 1_sec_re~> 3 Dec
4880883 1_minute—> 49 Dec
488884 1_hour_r—> 8 Dec

L!'ln-lu.l.t sDecinal FLGC Data nge : 1




11.2 Edit

The display data will switch to file data.

in PLC Ope Format Settings Window Transfer Dizable Tools Quit
Fl 2. 44— ———F————F -} F-IT—FY
Seg.H %2 /2 Timer 1

/ 1@.1
8

8.1_sec_register Timedunit« 8. 1) is stored (Max=10)

Reforence Data
[ 8.1 _swc_-> 5 Dec
3682 1_soc_re-> 15 Dec
m 1_minute-> 2 Dec
488884 1_hour_r-> & Dec

Format :Decimal File Data Range = 1

To switch the display data to PL.C data, follow the same procedure described above, but se-
lect PL.C Data from the Transfer Menu.

The type of reference data currently being displayed will be indicated on the last line at the
bottom of the screen as either PLC data or file data.

« Transferring Files

Following is an example showing the procedure used to transfer the reference data displayed
on the screen to the personal computer and save it in a file.

1) Switch to the menu cursor using the Tab Key.

2) Select PLC to File from the Transfer Menu using the Cursor Keys and press the Enter
Key.

Main Ll.c Ope r;gﬂlt §Ettins‘s Window

[P1 F2: F3:
Sog.H ¥#2 /2 Timer 1 <3
Y - ¢ y—

Dizable_ Tools GQuit
B-F8-N—¥y

ranzfe
blnuplnte
PLC Data
Pile Datu
Egg to EE

[k ]
F—10.1 - 3—
s Ly >
”
pealapg izt ey 290820
+—{UCTR -
) 40as24 veB0z1
UCTRE-

- B.1_sec_register Time{unit= 8. 1) is storad (Max=18>
. Referance Data

PLC Data ge * 1

The reference data displayed on the screen will be transferred to the personal computer
and saved in a file.

To transfer reference data saved in a file to the PLC, follow the same procedure as above, but
select File to PLC from the Transfer Menu.
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11.2.5 Disable

11.2.5 Disable

1. Enable All

The Enable All operation enables all disabled coils and input relays.
1} Switch to the menu cursor using the Tab Key.

2) SelectEnable All fromthe Disable Menu using the Cursor Keys and press the Enter Key.

Fhin Format Settings Window Transfer TEEETITM Tools Quit
[Fl —F2—————PF3—sm—en P e ————— P ————— isable Fg
|Seg-H 82 # 2 Timer 1 .
et
= Arghtl 2006
IH9 UCTR
Reference Data
188881 ] E 28a2e1 1 D
108882 1 D eauze2 1 D
188883 ] b 889283 1 D
BBe108 a £ 00204 Q E
I.mel 1 )] .
Format :Decimal File Data Range : 1

3) A confirmation message will be displayed. Enter Y and press the Enter Key.

in Format Sottings Window Transfer Dizable Tools Quit
P S pi U po wOmFe-si—FY

Seqg.H 82 7 2 Timer 1
1

—1/—I8.1}
000018 488681

a

Moy

ooelal o |
Format :Dacimal File Data Range : 1

The currently disabled coils and input relays will all be switched to enabled status.

in Format  Settingt Window Transfer Diszable Tgols Quit
= 2 P4 e —pr——— - F-IT—F9
Seg.H #2 / 2 Timer 1
Al
s N
AP tAY, #0005
/H—UCTR -
898017 480002 20006
8 488883
280021
Refwrence Data
188881 1} E ssezet 1 E
180002 1 E POB202 1 E
128003 '} E B0E203 1 E
8891868 ] E 808204 ] E
easied 1 E
Format :zDecimal File Data Range = 1L
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2. List Disabled

The List Disabled operation lists the reference numbers of currently disabied coils and input
relays.

1) Switch to the menu cursor using the Tab Key.

2) Select List Disabled from the Disable Menu using the Cursor Keys and press the Enter
Key.

Format Settings Window Twanzfar Tools Quit
—raa———2: 4———P5——F6 1table

iog.H 82 / 2 Timer 1 Enable Al1

{ -

188081 e TUUE | eeazel 1 D
198e82 1 ] 828282 1 B
188083 8 D aeg2a3 1 3
mg g E 808284 8 E
Format :Decimal File bata Rangn = 1

Format  Settings Vindow  Transfor Dizable Tool: Quit
e — ] 4P Dizabled U5 and 1X references
Seg.H 82 / 2 Timer 1

[ZL515B N~ 886211
Blu2p2 BANZA3
186802 108083

<LSCY to quit

] 8882 1 D
1889082 1 ] 200282 1 D
180083 -] D 888203 i D
290188 ] E Baa2a4 ] E
a8a18, 1 | ]
" Porsat :Decimal File Data Range : 1

3) If all of the disabled coils and input relays cannot be shown on one screen, display by
using the Page Up and Page Down Keys to switch between screens
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Editing Motion Programs:
Offline

This chapter describes the MC Program Edit Screen and basic editing

procedures.

12.1 Overview ..........c.c...... ceveseasass 1222
12.1.1 MCProgram Edit Screen ........................ 12-2
12.1.2  Displaying the MC Program Edit Screen ............ 12-3
12.1.3 BasicInputProcedures ......................... 12-4
1214 Using Commercially Available Editors ............. 12-8

12-2 Fileselection PE P PP R TASIILOTISISIIEESIOETTINSOEAETS 12'10
1221 ONumberSelection . .........o.oooonur v, 12-10
1222 SelectingaModule ............................ 12-13

123 Editing .oovvvvnnnnnnnervinnereennnnnnns 12:15

1231 COPY « oo ettt 12-15
1232 Delete .. ... 12-16
1233 PaSIe ..ottt 12-17
12.3.4 N Number Substitution ......................... 12-17
12.4 Search and Substitute . ...... ceeseean cees. 12-20
1241 Search. ...t e, 12-20
1242 Substitute ., . ... ..ottt e 12-21

12.5 Moving Control .....covvvinvnvnnnnnnen., 12-24
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Editing the Motion Program: Offline
L

12.1.1 MC Program Edit Screen

12.1 Overview

This section describes the structure of the MC Program Edit Screen and basic program
input procedures. ‘

12.1.1 MC Program Edit Screen
12.1.2 Displaying the MC Program Edit Screen

12.1.3 Basic Input Procedures

12.1.4 Using Commercially Available Editors

12.1.1 MC Program Edit Screen

Select Motion Program from the Motion Submenu of the Main Menu. The MC Program Edit
Screen will be displayed.

............................

...........................................

...............................

fain Select Edic Srch-Sub Goto oDispla ‘Ioo

1) -8 CO MO, : @i NG PROGRAM EDIT i - 4)

2) - = 5}
LineNO| N NO 208 1.1 Mk LINE = 24

¢ [ $PROG.1 STORE V0! T STRTION_1 8)

ege2 [mwe1s |aBS; ABSOLUTE MODE
833 |Ng2B  |#1=H1; POINT_MD.{=PALLET NO.>
8884 |NB38 [#18-VEE4PB GET STATION’S Y-AXIE POS.
9905 |NB48  |#11-ZSE488 GET SIATION’S Z-AXIS POS.
B80C |NBSB  |#12=XEF400 CET STATION’S %-QXIS POS_
BBE? {NB68 3-AEERL; GET PALLET’S XIS POS .

3) < 208% |NB7R |14-ZRER1: GET PALLET’S XIS POS.
BERY |NPER |#1S-REES1; GET PALLET’S X-QXIS POS.
ame |Ne¥e {10M $il==1 CHECK RRM’S MEWTRAL POS.
8811 [N1B8 |816-811-10080; CALC. Z-AXIS POS. DATIA
8212 [N118 |MOU YE18 ZR16; MOUE TO STATION_2
aeil ni2e X812: E 10 WORKPI
PE14 |N13@ |INC MOU Zie.; UP Z-AXIS 1@MM

\ e85 [H148 [ABS POV E T0 ¥ _MEWIRAL
8816 [MI5& |ToW #[1==1 RM™S NEWTRAL POS
J

1) MC Number

Shows the number of the currently selected Motion Module.

2) O Number

Shows the O number of the currently displayed program.

3) Editing Area

Displays up to 16 lines of program.

4) Language
Shows the language (motion language or G) of the currently displayed program.

5) Edit Mode

Shows whether Inseri or Overwrite Edit Mode is being used.
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12,1 Overview

6) File Name

Shows the file name of the program currently being displayed. The configuration of file
names is as follows:

—I—— O Number

Module Number
1: Module 1; 2: Module 2

File name selected by Select Program

12.1.2 Displaying thé MC Program Edit Screen

The MC Program Edit Screenis displayed by selecting Motion Program from the Motion Sub-

menu of the Main Menu. The following example shows the procedure used to display the Lad-
der Editor Screen.

1) Switch to the menu cursor using the Tab Key.

2) Select Motion from the Main Menu using the Cursor Keys and press the Enter Key.

Elements Edit Gosfrch MNatwork Ref Tools Quic
v Honu——F———Pd—pE__pg -Odi—F9
Conf iguration
Dladder
PEdit Comment
Ref Data
)_
080921
Reforence Data

Format :Decimal File Data Rangs : 1

3) A submenu will be displayed. Select Motion Program using the Cursor Keys and press

the Enter Key.
Elements Edit GosSrch Hetwork Ref Tools Quit
in Menu F3: P4 5 F6 F7- P8 -1033—FY

oot sguration  |'———< >

ng i n —_
#ladder I-—Hut:lun N

1t Comment aramcter Peae1?
Ref Data Point Table —

Program Monitor oeeaza
UCTR >—
20e228 08e21
/ UCTR
1
Reference Data

Format :Decimal File Data Rangs : 1
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Editing the Motion Program: Offline’
12.1.3 Basic Input Procedures

4) The MC Program Edit Screen will be displayed. If no programs have been created pre-
viously, a window will appear asking for an O number. Enter an O number (1 in this exam-
ple) and press the Enter Key. )

Main Select Edic Srch7Sub Goto :#Display Tools Quit
[F————F2————F3 P4 P5 P6 F? =
MWODULE : 0 NO. > nC PROGRAN EDIT I LANGUAGE=
UNIT : »m
LineNO| N NO : MAX LINE =
. | -

The MC Program Edit Screen for O number 1 will be displayed.

h:in Select Edic SrchsSub Goto ‘wpisplay Tanls Quit

—n—ﬂ—?&———*ﬁm—ﬂ_ﬂ-ﬁ-ﬂ-ﬂn—l’?

[MODULE = MC1 O NO. = Bl MC PROGRAM EDIT I IiNe 1] M!ﬁliillgi:m
: N

LineNO| N WO GL128_1.181 ' MAX LINE = 1
2281

OIEEID if there are programs that have been previously created, a list will be displayed showing the O
numbers they have been saved against. See section 12.2 File Selection Proceduresfor more
details on the operation procedure.

12.1.3 Basic Input Procedures

Program lines consist of the following four elements.

NXXX MOV........ . Absolute Coordinate Position . .......
T Comment

End of Block
Program
N Number

In MEMOSOFT, the Program, End of Block, and Comment combined can be a maximum of
128 characters. The following example shows how to input program.
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12.1 Overview
M

Enter the N Number, Program, and Comment. Then, press the Enter Key.

Flain Selact Edit Srch/Bub Goto #isplay Toola Quit

] ————F2 3 4 Fh 6 F
MODULE : MC1 O NO. @ #&1 HC PROGRAM EDIT [ INS LAMGURGE: MG
UNIT : mm
LineNo] N WO l GL128_1.1081 MAX LINE « 2
BEE1 Hi HOU Xi88. Y288. ZZ50.:MOUE TO STRTION_1_

The N number will be placed automatically in the N number column. When the input has been
confirmed, the cursor will move to the next iine.

in Select Ec‘lit s__reIVSub gto wDizplay Teols Quit

WODULE = RCL O 1B, ¢ BT TG Frocmn EDIT [‘lﬁ m@uuﬁz: ne

HE ]

Linnuol N NO I CL120_1.181 MaX LINE = 2
2881 |NBBL WOV X109, ¥200. Z258:HOUE IO STATION_1

It there is no End of Block (%) in a line, an error occurs, and the input will be cancelled.

» Inserting Characters

1) Check that the Edit Mode is set to Insert Mode. Move the cursor to the point of insertion
using the Cursor Keys.

in . fghct Egu chhlSub E'uto gis la ;;nh Quit

MODULE : MCI O NO. * BL  MC PROGRAN EDIT [N LANGUAGE: NG

UNIT : »m

LineNO] N NO GL128_1.181 MAX LIRE = 2
8901 [H8e1 MOV X1PB. Y288. 7258, ROUE Y0 STATION_1
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Editing the Motion Program: Offline
-

12.1.3 Basic Input Procedures cont.

2) Enter the characters to be inserted (S100 in thi§ exampie) and press the Enter Key.

kin Select  Edit Srch/Sub Goto ‘Ditplay Tools Quit
F2 3 P4 ?5-———*{’6-—-—!’7;@-1’8 ﬁ?—l”
[WODULE : HMC1I O NO. : B1 MC PROGRAM ERIT [ ¢ 1A (i AGE: MC

1T = s

LincNO| N NO GL120_1.181 MAX LINE = 2
8881 [NBB1 |MOU XiSd. Y280. Z258. $10@.;HOUE TO STRTION_1
Baeaz H f

Olmiﬂb 1) If the Edit Mode is not set to Insert Mode, switch it using the Insert Key to toggle between
Insert and Overwrite.

2) If performing an editing operation such as insei'tirig characters in succession, use the Up
and Down Cursor Keys instead of the Enter Key to confirm inputs.

¢ Inserting a Line

1) Move the cursor to the position where a line is to be inserted using the Cursor Keys.

h;m . Selact [Edit  Srch/Sub Goto ‘wisshg Tools  Quit
[

L3 24 L2 g
MOBULE MC1 ONO. : @™ MC PROGMAN EPIT LARGUAGE: MC
UNIT : mm

LinsNO| N NO 20_1.1 . MAX LINE = 24

B88a1 sFROG.1 STORE WRIPIEGE “'I STATION_1

gaa? |N318 QB. ABSOLUTE WODE

8883 |N@20 [Ni-H1i; POINI_NO.<=PALLET NO.)-

BB84 |NEIR | K1G-YRESOR; GET STATION'S Y-AXIS POS.

8005 |KB49 |811-ZRE488; GET STIATION'S Z-AX1S POS.

8886 KBS | ¥12-XARE4DP; GET STATION’S X-AXIS POS.

0887 [NOGR |%13=-YEEEL; GE{ PALLEI’S Y-AXIE POS.

[rad $14=ZBEM ; GET PALLET'S Z-AXIS POS.

2887 {NE80 |HS-KEEE1; PALLET'S X-AXIS

GET -
2818 [Nase 10U Bit==1; CHECK ARM’S NEVIRAL POS.
9011 |N1O8 |¥16=N11-19000; CRLC. Z-AXIS POS. DATA
6812 (N118 10U ¢YE10 ZBi6; MOUE TO STATION 1
mi NL120 [MOU XE12; MOVE TO WORKPIECE POE

8015 {N148 |ABS MOU X0; MOUE TO X_NEWTRAL POB
8816 |N1Se |10W BIl==1; CHECK RRMS NEWIRAL POS.

g
g
8
3
2
B
-}
s
3
=

2) Press the Alt + Insert Keys. A line will be inserted at the cursor position.

k:in Select Edit Srch7Sub Goto #Display Tools Quit

——ﬂ——-—-——-*ﬁ-——-———l’i—*—-—ﬁ-—-ﬁ—ﬂ#ﬂ—ﬁ—f’

MODULE : MCT O NO. : &1 MC PROGRAM EDIT I MUH?'[GEM
-~

LineNO| B NO GL120_1.181 MAX LINE = 25
;FROG.1 STORE WORKPIECE AT STRTION_1
aAls; RBSOLUTE MORE

f1=411; NO. <=PALLET NO.) .
Ne38 un-“mm: GET STIATION’S Y-AXIS POS.
NB48 (811 -ZEF408; GET STATION’S Z-AXIS POS.
212=%2E400 ; GE.T STATION’S H-—M{IS POS .

PALLET’S Y-QARIS

NBGa IIS-YIEC:I..
NE78  [814=-78ES1 GE‘I’ PALLET'S Z-AXIS POS
NB%E 315-“33:‘!1. GET PALLET’S ¥-ARIS POS.

wosn  [Tow #I1-w1;  CHECK ARM’S NEWIRRL POS.

&

HiBA [#16=-811-10888; CALC. Z-AXIS POS. DAIR
N118 [MOU ¥E1@ Z816; MOUE TO STATION 1
o214 N120 x®12; MOVE TO WORKPIECE POS.
8815 |W138 [INC MOV Zi@.; UPF Z-RXIS 18MM

2
z
3
ﬁ
2
L

MOVE TO X_NEWTRAL POS.
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12.1 Overview

: OI]I]EID If a line is to be deleted, move the cursor to the line to be deleted, and press the Alt + Delete
Keys. If deleting several lines in succession, perform the operation from the Edit Menu. See
section 72.2 File Selection Procedures for more details.

« Editing the N Number

The N number can be entered from the program edit area. Editing procedures such as modi-
fying the N number, however, must be executed by moving the cursor to the position of the N
number,

1) Press the Alt + Left Cursor Key.

in o Select  Edit Srch/Sub Goto #Dizplay Tools Quit
MODULE : NCL O NO. : @1 NC PROGRAM EDIT L I% ! M%ﬂct: nc
UNIT : mm

LineNO} N NO GL120_1.1681 MAX LINE = 24

a1 sPROG.1 STORE WORKPIECE AT STATION_1

8082 |NBI® [ABS; ASSOLUTE MODE

29843 |Na28 =H1; POl =PALLET .

2984 |NE38 |810-YBE488; GET EIRTION'S Y-RXIS POS.

aes B11 =T i GET SIATION’'S Z-AXIS POS.

B006 [NGSH  |212=XH¥E400; GET STATION’S X-AXIC POS.

BEB7 NGO I i GEI PALLET’S ¥Y-ARIS POS,

2088 {N878 H GEY PALLET’S Z-AXIS POS

8809 |Nese H GET PALLEI’S X-ARIS FOS

8818 INBYB |IONW $li=w1; CHECK ARM’S NEWIRRL POS

8811 1IN0 |#16-811-10089; CALC. Z-AXIS POS. DATA

8812 |Ni1B Y818 Z8ié; MOUE TO SIATION 1

BB13 |N128 %B12; MOUE TO WORKPIECE POS.

2814 |38 INC MOV Z18.; UP Z-AXIS 1

8915 |N14@ |ABS MOV X@; E TO K_HEUTRAL POS.

8916 [N150 |[JON BIimwi; CHECK ARM'S NEWIRAL POS.

2) The cursorwill move to the N number area. Enterthe N number (N105 in this exampl) and
press the Enter Key.

b;in $elect Edit Srch’8ub Goto oDisplay Tools Quit
S - | 4 #5 ¥6 w#—n ~Un—p
JHODULE : mC1L O NO. : @1 MC PROGMAM EDIT LI RGE: MC

UNIT = mm
LineNO| N NO GL12@_1.1 MAX LINE = 24
Bea1 sPROG.1 STORE WORKPIECE li'l' STII'I'ION_I
8082 |Na16 ans. ABSOLUTE
a9a3 |Ha2e |E1-H1; POINT HO.(-MLI.E‘I‘
8884 |NE38 |§10=YSE400; GET STRATION’S v-mus POS.
8885 |Ne48 |811-Z3F408; GEI STATION'S Z-AXIS POS.
8896 I1NGSH |N12=XIF4P0; GET STATION'S X-AXIS POS.
BBB7 |NBEO |S13-YRERL: GET PALLET’S Y-AXIS POS
8888 H PALLE]’S Z-AXIS POS
B8P7? |NORD H PALLET'S X-AXI$ POS.
2018 |Neve 108 BIi==1; CHECK ARM'S -
211 [N1DO He=R11-10000; Ca XIS POS. DATA
8812 % HOU YRi® ZE16; MOVE TO STATION_ 1
8813 |NL2 HOU XE12; WORKPIECE POS.
B82t4 [N130 INC MOV Z10.; UP Z-aXI$ 10MN
8815 |Ni148 |ABS MOU XB; TO X_MNEWTRAL POS
8816 |N158 |IOW RI1=»1; CHECK ARM’S NEWIRAL POS
O INFO | D After the cursor has been moved to the N number area, it can be moved around within the

area itself. To move the cursor back to the program area, press the Alt + Right Cursor Keys.
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Editing the Motion Program: Offline
12.1.4 Using Commercially Available Editors

» Summary

Foilowing is a summary of the main keys used in program editing.

=)

Move the cursor, eicept when entering characters. If
pressed after characters have been entered, the action
confirms the input and the cursor moves to the next line.

(4]
(¥]

Confirms an input and moves the cursor to the next line. If
at this point the line does not contain an End of Block mark,
an error will occur.

Toggles between Insert and Overwrite in Edit Mode. The
initial setting is Insert.

m

Deletes one character at the cursor position.

:
d

ALT inserts a blank line at the cursor position.

ALT DEL Deletes a single Iiné at the cursor position.

+

A Moves the cursor from the program edit area to the N
number area.
Moves the cursor from the N number area to the program

A edit area.

a H
+ +
¥ @

Moves the cursor to the first line of the program.

Moves the cursor to the last line of the program.

Scrolls 16 lines towards the start of the program.

Scrolls 16 lines towards the end of the program.

12.1.4 Using Commercially Available Editors

MEMOSOFT motion programs are saved in files as text data. As a result, they canbe created
and edited using commercially available editing programs.
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12.1 Overview

» File Names for Newly Created Files
Make sure to use the following structure, as explained in section 72.1.1, when naming files.
_I_— QO Number
Module Number

* 1: Module 1; 2: Module 2
File name selected by Select Program

Be sure to save the file in the same directory as the other programs. The initial setting forthe
directory is \FMSGL\PROGRAMS.

* Program Format

Programs are saved in the format shown below. Make sure to use this format when creating
programs on a commercially available editor.

File Name: GL120_1.102 (Module: 1, O number: 2).

;PROG.2 STORE WORKPIECE AT STATION_2

NO10 ABS; ABSOLUTE MODE

NG20 #1=H2; POINT NO. (=PALLET NO.)
NO30 #20=Y#E401; GET STATION'S Y-AXIS POS.
N0O40Q #21=Z#E401; GET STATION'S Z-AXIS POS.
NOS0 #22=X#E401; GET STATION’S X-AXIS POS.
NO60 #13=Y#E#1; GET PALLET'S Y-AXIS POS.
NO70 #14=Z#E#1; GET PALLET'S Z-AXIS POS.
NOB0 #15=X#E#1; GET PALLET'S X-AXTIS POS.
NOSO IOw #Il==1; CHECK ARM’S NEUTRAL POS.
N10O #16=#11-10000; . CALC. Z-AXIS POS. DATA
N110 MOV Y#10 Z#16; MOVE TO STATION_2

N120 MOV X#12; MOVE TO WORKPIECE POS.
N130 INC MOV Z10; UP Z-AXIS 10MM

N140 ABS MOV XO0; MOVE TO X_NEUTRAL POS.
N150 IOW #Il==1; CHECK ARM’S NEUTRAL POS.
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Editing the Motion Program: Offline
12.2.1 O Number Selection

12.2 File Selection

This section describes the selection procedures for motion programs. These procedures
enable two files to be edited simultaneously.

12.2.1 ONUMDEr SEIRCHON ..\ e ettt e et e eiaeeenns eeren.. 1210
12.2.2 SelectingaModule ......c.iiiiiiiiiii et e e 12-13

12.2.1 O Number Selection

To edit a program other than the one already selected from the MC Program Edit Screen, the
display can be switched using the Select operation.

1) Switch to the menu cursor using the Tab Key.

2) Select O Number from the Select Menu using the Cursor Keys and press the Enter Key.

hin Edit Srch/Sub Goto ‘eDizplay Tools  Quit
————p2————Ffelect —rs——-—-——rs—n#—n-@—n
|HODULE : mC1I © [MModule MC PROGRAM EDIT [ LANGUAGE: MC

UNIT : mm

LineWO| H NG GL120_1.181 MY LINE = 24
[ “|sPROG.1 STORE WORXPIECE AT STATION .1
NE1B  ABRS: ABSOLUTE MODE
2883 |Ne28 jHi-i1; POINT NO.{=PALLEI MO.>
0884 |NG3I0 [ H10-YSE400; GET STATION’S ¥-AX1§ POS.
2005 NE40 [811=ZRE400; GET STATION'S Z-AX1S POS.
0006 NS0 |R12=X3E488; GET STATION'S X-AXIS POS.
BP07 |NG6D [R13I-YRERL: GET PALLET'S Y-AXIS POS.
2288 ; GET PALLET’S Z-AXIS POS.
0B |N28A [BiS=XEESL; GET PALLET'S X-AXIS POS.
2810 [N29e |IOW ¥[i=-1; CHECK ARM'S NEWTRAL POS.
el |NMe [Ri6=311-19808; CALC. Z-HXIS POS. DATA
BA12 IN11@ [MOU Y10 Z#16; MOVE TO STRTION 1
2813 [N128 [HOU X%12: MOVE TO WORKPIECE POS.

8814 [N132 [INC MOV Z18.; UP Z-AX]IS toMM
S X0 MOUE TO
8816 |H1Se [IOW Bli==1; CHECK ARM’'S HEVIRAL POS.

g
:
:
2
g
:
:

3) A list of the O numbers previously created will be displayed. Move the cursor to the posi-
tion of the O number to be edited using the Cursor Keys, and then press the Enter Key.

hin Select Edit Srch/Sub Goto wDisplay Tools Quit

———FZ—B—PQ—FS—-FG——”#—“-E—W

RODULE : M1 O NO. @ & nC PROGRAN EBIT [ 4 I.nuullili_:l!:nc
I mm

Lineh0 GL129_1.101 HRX LINE = 24
20a1 ;PROG.1 STORE WORKPIECE AT STATION_1
ape2 RES ; ABSOLYTE MODE
2803 INT_NO.(=PR HO.D>
] GET STRTION'S Y-AXIS POS,
2985 GET STRYION'S Z-AXIS POS.
2086 SIRTION"S RIS _POS.
2007? GET PRLLET’S Y-AXIS POS.
2208 PALLET'S Z-AXIS POS.
o PALLET*S X-ARIS POS,
aaia CHECX RRH’S HEWIRAL POS.
8|1l CALC. Z-AK1S POS. DATA
iz - MOUE TO STATION 1
2213 M2 E TO0 @0 POS.
2814 ur Z-AXIS 1
eas M MOUE TO ¥_MEWIRAL POS.
eaLe CHECK ARM'S NEVIRAL POS.
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12.2 File Selection

The program that was previously being displayed and the newly selected program will be
displayed simultaneously.

in Seloct  Edit Srch’Sub Goto #bizplay Tools Quit
JMODULE = MC1L O NO. = 81 MC PROGRAM EDIT 1 LANGUAGE: MC
MODULE = MC1 O NO. : B2 . UNIT : mm

LinsHO| N NO GL129_1.181 MAX LINE - 24

8881 ;PROG.L STORE WORKPIECE AT STATION_1

882 |N218 |8BS; ARSOLUTE MODE

8003 |WN828 |E1-H1; POINT NO.<{=-PALLET -2

0094 ING38 |B10=YRE400; GET STRTION'S Y-ANIS POS.

8985 1HO40 [811-ZRE408; GET STATION'S Z-AXIS POS.

806 [NESB |812=XERE400: GET STATION'S R-aX1S POS.

LineHO| N NO GL12@ _1.182 MAX LINE = 32

2081 ;PROG.2 STORE WORKPIECE A¥ STATION_2
1| €882 [NmA [ABS; RBSOLUTE MODE

8993 {N229 =H2 ; POINT WO.<=PALLET NO.>

8BB4 (NE3Q |820-YRE4R:; GET SIATION’S ¥-ANIS POS.

BODS |NGMP  [821=ZEE4R1; GEY SIATION’S Z-AXIS POS.

BBDG |NISE  [822=KRE4R1; GET STATION’S X-AXIS POS

1. Selecting the Edit Screen

The following example shows the procedure used to select one of two programs being
displayed simultaneously,

With the cursor in the O number 2 program, press the Alt + J Keys.

The cursor will move to the O number 1 program.

Select Edit Srch/Sub Coto oDisplay Tools Quit

——— ——— P4 — T —]
MODULE : MCL O NO. : @& HC PROGRAN EDIT (r LaNGUAGE: MG
MODULE : MCL O NO. @ B2 UNIT : »m
LineN0o] N MO GL12@_1.181 HAX LINE = 24

061 iPROG.1 STORE WORKPIECE AT STATION_t

o0z weie [Ams: ABSOLUTE MODE

0oe) |naze 13 POINT HO_(=PALLET MO.

0084 INZID |E10-YRE480;  CET STATION'S Y-RXIS POS.

8825 [N848 |#11-73E480;  GET STATION'S Z-AXIS POS.

P36 |NBS® |¥12-XEE409;  GET STATION’S X-RXIS POS.

LinshO| N NO GL129_1.182 Max LINE - 32

801 ;PROG.2 STORE WORKPIECE AT STATION_?

naie |aBs; ABSOLUTE MWODE

ega3 |Haze ez ; POINT NO.<-PALLET NO.)

0004 (MAIA |R20=YBE4@1;  GET SIATION'S Y-RXIS POS.

008 [NG4@ |R21-Z8E481;  GET STATION'S Z-AXIS POS.

P90 |NDSY  {22-4BE4B1;  GET STRTION'S X-AXIS POS.

2. Reading Multiple Programs

MEMOSOFT can edit a maximum of two programs at the same time. Therefore, if two pro-
grams are already being edited, one of these two programs must be exited first, before a third
program can be edited.

The foliowing example shows the procedure used to switch from editing O numbers 1 and 2,
to editing O numbers 1 and 3.
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Editing the Motion Program: Offline
12.2.1 O Number Selection cont.

1) Move the cursor to the O number 2 screen by p}essing the Alt + J Keys.

in - a:hl':t Eit .S__rch/Su.b Goto BDisplay Tools Quit
MODULE : MC1I © MO. : B NC PROGRAN EDIT [ LaR3HGE: mc
MODULE : MG1 O MO, : @& o UNIT : ma
LineNO| H NO GL129_1.181 . X LIKE = 24

9881 sPROG.1 STORE WORKPIECE AT STATIOW_1

8982 (NB1@  [ABS; ABSOLUTE MODE

983 |NB28 BE=H1; POINT WO.<=PALLEI NO.)>

Ba4 |NA3R X1 0=-YEE408; GET STATION'S Y-ARIS POS.

299C |KA4a |811-7EE4BR;  GET STATION’S T-AXIS POS.

@06C |NBSE |(S12-XRE4BB:  GET STATION’S X-AXIS POS.

LinsHO|] N NO GL129_1.182 i MAX LINE « 32

9881 sPROG.2 STORE WORNPIECE AT STATION_Z

ana? [wa1e  [ABS; RESOLUTE noDE

8883 |Na28 Ri=H2 ; POINT NO.<{~PALLET NO.)

2084 |NBE3IR £20-YEE4H ; GET STATION'S Y-AXIS POS.

G885 |N84P %21 ~ZHE4R1 ; GET STATION'S Z-aXIS POS.

000G |NBSP [822-XWE4B1:  GET SIATION’S K-AXIS POS.

,!_

2) Switch to the menu cursor using the Tab Key.

3) Select the Quit Menu using the Cursor Keys. If the program has been changed, a mes-
sage will appear asking whether to save the changes. To save the changes, enter Y and
press the Enter Key.

h;in . Select Edit Sroh/Sub goto obisplay Tools
MODULE : MC1 © NO. : 81  NC PROGRAM EDIT [.l# LA
MODULE i NCi o No..: e
LineN0| N NO G120 _1.181 WX LINE = 24
‘001 :

sPROGC.1 STORE WORKPIECE AT STATION 1
ABS QHOIJI'IE mma

"2

8293 R1-13 POLNT {=PALLET NO

2884 ING38 |E10=YSE489; GEI SII!I[OH'S ¥-ax18 POS-
800S |HB48 [811-Z8E4RD; GET SIATION'S Z-AKIS POS.
8896 |NE58 |[#12=X8E400; STATION’S X-AXIS POS.

LincMO] N NO GL120_1.182 MX LINE ~ 32
2ea1 iPROG.2 STORE WORKPIECE AT STATION 2

2862 |Ne18 |aBS; ABSOLUTE MODE

8883 N228 |¥i-li2 ; POINT MO.<{=PALLET MO.)

8884 [NA3D |220=YREABRL; GET STRTION’S Y—AXIE POS.

BRFS NS48 18321 -ZRE4R1; GET STRTION'S Z-AXIS POS.

8886 [N8SA (1E22=X8E4d; GET SIRTION'S X-AX]1S POS

Editing of the O number 2 program is complete.
4) Switch to the menu cursor using the Tab Key.

5) Select O Number from the Select Menu using the Cursor Keys and press the Enter Key.

kiﬁ Edit Srch/Sub Goto ohisplay Iools Quit
—F2. elect —F5————P————F 7 —E—H‘
|MODULE : MCt O [Miodule MC FROGRAM EDIT 1 LANGIAGE: MC
UHIT : mm

LineNO| H NO GL129_1.191 MAX LINE = 24

01 moc 1 STORE WORKPIECE AT STATION_1

28882 [Ne18 ABSOLUTE #MOD

2883 [NO2@ Ri-lii: POl <=PAA ND.>

228084 [N830 |$18-YEF400; GET STATION’S Y-AXIS Po3.

3805 1=ZRE4808; GET STATION’S Z-AXIS POS.

Q206 [NOSD |R12-XRE498; GET STRTION’S X—RXIS POS.

9887 |[NB6B {U13-YREN1; GET PALLET'S ¥-AXIS POS.

6Da8 (N878 {N14-ZREEL; GEI PALLEI'S Z-AXIS POS.

9889 |NBBR [81S=XEER1; GET PALLET’S K-AXIS POS

2810 [N999 110N $Ii=--1; CHECK RRM’S NEVWIRA .
2911 {N19@ |R16-F11-19899; CALC. Z-@XIS POS. PATA
8812 |N118 [MOU YE18 ZTH16;

8813 |N128 MOV XE312; HOUE TO WOl

8814 |NLIB |INC WOU Z1@.; UP Z-AXIS 1emn

2915 |N148 |ABS MOU X@; HOUE TO X_MEVIRAL POS.
2916 |H158 1OW §ili==1; CHECK RRW’S HEWTRAL POS.
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12.2 File Selection

M

6) A list will be displayed of the O numbers previously created. Move the cursor to the posi-
tion of 03 using the Cursor Keys and press the Enter Key.

DULE : MCI O NO. : @1 = MC PROGRAM EDIT LN LANGUAGE: mC
URIT : mm

MAX LINE ~ 24

Fiﬂ Eghcc Edit Erch-Bub Goto DDi: 1a l'rmh Guit
MO]

GL128 1.181
;PROG.1 STORE UORI(PIECE ﬁT SIR'I'ION_I
ARS; RAESOLU

POINT M.(-PRLLEI' NO.
GET SIATION’S Y-AXIS POS.
GET STATION’S Z-R

The edit screens for O numbers 1 and 3 will be displayed.

W[inFo > Use the Esc Key to exit an Edit Screen. Move the cursor to the screen to be exited and press
the Esc Key.

12.2.2 Selecting a Module

Use the following procedure to switch between Modules.
1) Switch to the menu cursor using the Tab Key.

2} Select Module from the Select Menu using the Cursor Keys and press the Enter Key.

Edic Srch7fub Goto Misplay Tools Quit
ct ——F5 ————Ff— PP -ag—m
nonuuz mo%mmnmn [r LANGUAGE: MG
UNIT : »m
LineNO| N NO GL1298_1.1681 Mi¥ LINE - 24
[ ;PROG.1 STORE WORKPIECE AT SIATION.1
NB18  |eBS; ABSOLUTE MODE
8083 |NB28  [si-H1 NI NO. (=
BB84 |NBG8 |S18<YNEson; GEI SIATION’S Y-#XIS POS
[ i H GET SIATION’S Z-AXIS POS
BO86 |MESP |N1Z-XEE400: GEI SIATION’S X-fX1S POS
0897 |NBC8 |13~y H GET Ph *S Y-AXIS POS
esns $14=Z858 ; GET PALLET*S Z-AXIS POS.
888 Iwpes |wiS-XBEM1; GET PALLET’S ¥-6XIS POS.
2210 [Nevo |Tow siie-1i; CHECK ARN'S NEWT .
8011 |N188 [S16=811-1008D; CaLC. Z-AXIS POS. DATA
9612 |M11@ |NOU Y10 ZEi6; MOVE TO STATS
9813 |n1ze XH12; MOUE TO WORKPIECE POS
Bt14 |Mi38 JINC MOY Zi@.; UP Z-AXIS 16/
BE15 |Mi48 |ABS U X@; E T0 X_MNEWIRAL POS.
M58 |TOW $l1e=sd; CHECK ARM’S MEWTRAL POS.
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12.2,2 Selecting a Module cont.

3) A submenu will be displayed. Select MC2 using the Down Cursor Key and press the En-
ter Key.

t Srch/Sub Goto H)is 'l'oe .'l:

I:C-
lmww mi 0 OGRAM ED]I' [ [NS MHGIHGE‘
T S

LineNO 28_1.1| MaX LINE = 24
pesL sFROG.1 STORE mlECE ﬁl‘ SIRI!OHJ-
2882 |He18 IIB. .

NB28 |Ei=Hi; POIHT HO [.I.!:‘I

NB38 |N10-YRF408; GET SIHIIW'S Y~-AXIS I’OS.

NS48 |#11-ZEF400; GET STATION'S Z-HXI1S POS.

H GI'.T SIAI]M‘S R-MC!S POS.
NB6E |813-YEER1; GET PALLET’S KIS POS.
K878 |[814=Z8ENL; GET PALLET’S z-mus POS.
NESR [E1S=KEENL; GET PRLLEI’S K-AXIS POS.
@910 1ME98 IOV #lie=i; CHECK GRM’S WEWTRAL POS.
8811 |N188 [B16=811-10000; CALC. Z-RX1S POS. DATAR:
G912 (N110 N0V Y818 Z¥16; MOUE TO STATION_1 ¢
8813 |M12R [MOU X312; MOUE 10 WORKPIECE
6914 |N138 |[INC MOU Zi8.; UP z-n:us 101
8815 [N148 |ABS MOV X9; HOUE X_NEWIRAL POS.
BR1S {158 [IOW BIiwsi; mm lM‘S NEVIRAL POS-

L
i
-]
i
B

4) A confirmation message will be displayed. Enter Y and press the Enter Key.

k Solect Edit Srch/Sub Gote  '®Display Teols Quit
—m—n—n—ﬁ——rs—ﬂ#ﬂ-—w—n
[MODULE : mMC1 O HO. : @1 NC PROGRAM EDIT 1 m“:lutm.
LineNo| W 80 GL129_1.101 : M LINE =
2981 sPROG.1 STORE WORMPIECE AT STATION_1
ANs: ABSOLUTE MODE
£1-41; NG, N

3

5) The MC Program Edit Screen for Module 2 will be displayed. If no programs have been
previously created, a window will appear asking foran O number. Enter an O number (1in
this example) and press the Enter Key.

in Select  Edit Srch”Sub Goto oDisplay Tools Quit

—_— —rer—F6 -

MODULE : mCi 0 NO. : @1 MC PROGRAM EDIT 1 LA UN?¥5= nc
s

MAX LINE = 24

GL128_1._181
;PROG.1 STORE WORKPIECE AT STATIOM_1
RES;: BOLUTE llDD

The MC Program Edit Screen for O number 1 of Module 2 will be displayed.
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M
12.3 Editing

This section describes the operations useful for editing, such as copying, and
substituting N numbers, in the MC Program Edit Screen.

12.3.1 Copy ...... e e, e e i, 12-15
1232 Delete .............. et ae s e e vev.. 12416
1233 Paste.......... et eeer e, e, Ceeeeaienen Ceereeenes 12-17
12.3.4 N Number Substitution . ......................... e freees 12-17

12.3.1 Copy

The Copy operation records the program data specified by the cursor in line units, The N
number, the program, and comments are all recorded. Data recorded by the Copy operation
can be copied to another position using the Paste operation.

1) Move the cursor to the first or last line of the area o be copied using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Copy from the Edit Menu using the Cursor Keys and bress the Enter Key.

k;;n. Select DUYNNNN Srch/fub Goto  eDigplay Tools  Quit
in gy Eglect | i _“_p#“_
MODULE : MCL O NO. : 21 N AM EDIT i1 Lﬁuu?gﬁ=m
RO 3 :
Paste
r

* R
Linsio| N N0 8L MAX LINE = 24
;PROG.1 $TO AT STATION_L
B982 |Mmu |aks; ABSOLUTE MODE
2983 [NG20 =y ; POINT NO. (=
8884 [WiIB |m1@-YSE48B;  CET STATION'S Y-axIs Pog
@295 |NB4B |811-7RE4BB;  GET STATION'S Z-ARIS POS
8886 |MESH |S12-KBE4B3:  GET SIATION’S X-ANIS POS.
8007 |NBEE |s13-vsER1: GET PALLET’S Y-AXIS POS.
aagi A-ZEERLD GET PALLET'S Z-AXIS POS.
] @ |#15-XBE#1; PALLET’S K-AXI§ POS.
2810 |NB98 |10 Bliwel:  CHECK ARW’S NEWT :
B2 (W10 |816-Wi1-10089; CRLC. Z-AXIS POS. DATR
@212 |miie ¥E19 ZH16; MOUE TO STATI
8413 |M128 [mov xmi2: 10 WORKPIECE PUS.
8214 [N130 |ING MOU Zi@.; UP Z-AXIS 1BMN
85 INi48 |QBS HOU X@; = MOUE TO X_MEWTRAL POS.
BO16 MIS@ |IOW &I1--1;  CHECK ARM'S NEWIRAL POS.

4) The cursor will change to a line unit cursor. Move the cursor to set the area to be copied
using the Cursor Keys,

5} Once the area to be copied has been specified, press the Enter Key. The specified data
will be recorded.

Select  Edit Srch/Sub Goto #Display Tools Quic
_m -

MODULE : MCL O NO. : @& NC PROGRAM EDIT [1 LANGIAGE: MC
UNIT : am
N NO GL128_1.181 MAX LINE =~ 24

;PROG.1 STORE WORKPIECE AT STATION 1

Na18 BS; WBSOLUIE MODE
NE28 i 13 POINI NO.(-PALLET NO.)

LineNO

Beel

Bhuz

2883

B804 |NA30 pt18) - H GEI STATION'S Y-AXIS POS.
BEOC INe40 | IR H GET SIATION'S Z-AXIS POS.
0806 |Wesa |Vl H 'S X-AXIS P
bea7 wsce |SIERETS 4 ax

8898 |NB70

2827 |Heea

8910 |NA%8

8811 |Miea

8812 N118 MOUE 10 STATION_1

8813 {N128 (hOU & E

8814 IM130

B8a15 |M148 MOUE TO ¥_NEWIRAL POS.
8816 |N159 CHECK ARM'S NEMIRRL POS.
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.
12.3.2 Delete

12.3.2 Delete

The Delete operation deletes the program data specified by the cursor in line units and re-
cordsit. The N number, the program, and comments can all be deleted. Data recorded by the
Delete operation can be moved to another position using the Paste operation. Therefore, the

Delete operation is useful both for deleting programs and for moving

them to other positions.

To delete only one line, move the cursorto the target line and, press the Alt + Delete Keys. The

line will be both deleted and recorded.

1) Move the cursor to the first or last line of the area to be deleted using the Cursor Keys.

2) Switch to the menu cursor using the Tab Key.

3) Select Delete from the Edit Menu using the Cursor Keys and press the Enter Key.

Quit

AGE: MC
T

in Select Srch/Sub Goto oDisplay Tools
i - _“—pw_pg_ﬁ_”
MODULE : MCL O NO. : @1 Gﬂﬁi Al EDIT [ 1Al T H

aste

[Lineno] N Mo N a1 . MaX LINE

9991 ;PROG.1 STO AT STATION_1

8082 |weie |ABS; ABSOLUTE MODE

2883 N828 -H1; POINT NO.{=PALLET NO.)

BE84 |HE30 H1@~7BE490; GET STATION'S ¥-AX1S POS.

8085 |Ha48 211 =Z8FE498; GET STRATION’S Z-AXIS POS.

9896 1NESH B12=ABRE4PD; GET STATION’S XK-AX1S POS,

U7 (NB6R BS13~4RER1; GET PALLET'S Y-AXIS POS.

PB8E {RE70 4=ZRER1 ; GET PRALLET’S Z-AXIS POS.

|Bay 1N9E0 B1S=XEER]; GEY PALLET’S X-ANIS POS.

8B1e |NBYe I0M BI1==1; CHECK ARM'S NEWIRAL POS.

BeLl |M18B #16=811-10808; CRLC. Z-AKIS POS. DATA

BB12 [N11P |MOU VN1 Z¥1G; MOUE TO STATION. 1

9813 W28 |hOU dAE12; MOUE TO WORKPIECE POS.

9814 |N130 INC MOU Z18.; UPF Z-AXIS 18HH .

ee1s M ABS MOU XO; 10 K_NEVTIRAL PFOS.

8016 |N158 |IoW BI1-=1;  CHECK ARM'S NEWIRAL POS.

- 24

4) The cursor will change to a line unit cursor. Move the cursor to set the area to be deleted

using the Cursor Keys.

5) Oncethe areato be deleted is set, press the Enter Key. The specified data will be deleted.

Main Select Edit Srch/Sub Goteo obisplay Tools Quit

[F1~———F2 3 F4 PS Pb F =

MODULE : MCL O NO. : @i NC PROGRAM EBIT 1 LA UN‘I"I.G'E: ne
:

Max LINE

PGINT NO.<=PALLET NO.>
G['T STATTON’ 2 v-Ax 05

AR -
H Z-RXIS POS. HIR
3 MOVE TO STATION_I
MOUE TO UORKPIECE POS.
: UP Z-AXIS 18MM
POVE TO X_NEWIRAL POS.
CHECK ARM'S NWEWTRAL POS.

CH
CRLC.

IOV $ii==1;

= 24

The programs below the deleted area will shift up to the line where the deletion started

from.
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12.3.3 Paste

The Paste operation takes program data that has been stored either by the Copy operation or
by the Delete operation and inserts it at the cursor position. The following example shows the
procedure used to insert data that has been stored by the Copy operation described in sec-
tion 72.3.1 Copy into ancther O number program,

1) Move the cursor to the line to be inserted using the Cursor Keys,
2) Switch to the menu cursor using the Tab Key.
3) Select Paste from the Edit Menu using the Cursor Keys and press the Enter Key.

in Selsct SrehrSub Goto oDisplay Tools Quit
————P3———P3 b ——Ff——F7 ROT L i
MODULE : MCL O NO. : &1 co{y AM EDIT [ 1 LANGIAGE: MC
MWODULE : MC1I O NO. : 18| Delets UNET = wm
E Er

LinsHO| N NO [ HAX LIME = 24
2387 |Noss T°8 X-A%IS POS.

2218 |88 |10 8l1--‘!..: CHECK ARM’'S NEVIRAL POS,
8e1i |w1ea ﬂ-cu-—im; CALC. Z-AXIS POS. DATA

8813 AR12;
BU14 INI3D |INC MOV Z18.; UF Z-ARIS 18MM

GL120 1.118 MAX LINE = 2
sPROG.10 STORE WORKPIECE AT STATION_18
H

The stored data will be inserted from the cursor position onwards.

in $clect Edit Srch/Sub Goto Wisplay Tools Quit
—p2 '3 P4 PG F- P8

MODULE : MCL O NO. @ @i MG PROGRAM ED1ITY { INS LANGUAGE: MC

MODULE : MC1 O MNO. : 18 UNIT 2 w0
LineNO| N NO GL12P_1.181 MAX LINE = 24
2909

¥15-XSERL; GET PALLEI’S X-AXIS POS.
$l1==i; CHECK RRM’S NEWIRAL POS.

] OO0 ; - .
8812 [H118 [MOU YE1P ZS163 MOUE TO STATION 1
Ba13 |[N128 [MOD XE312: MOUE TO WORNPIECE POS.
8814 |N138 |INC WOV 710.; UP Z-AX1S 18Mn

GL12@_1.118 "WAX LINE = 18
sFROG.18 STORE WORKPIECE AT STATION_1@
NB18  14BS; ABSOLUTE MODE
naz2 B1=H1; POINT_NO.(=PRLLFT NO.)
BBB4 N3 | E18-YEE408; GET STATION’S ¥-AXIS POS.
BOOS |NG4@ |811-TEE499; GET STATION’S Z-AXIS POS.
D006 (NG5S |12 ~XIE488; GET STATION’S X-AXIS POS.

12.3.4 N Number Substitution

The N Number Substitution operation substitutes the N numbers of a specified program by a
set number of steps. According to the settings for the start number and the number of steps,
only lines which have an N number attached to them can be changed. The N numbers in
GOTO statements will also be modified. This procedure applies to the whole of a specified
program; a partial substitution of N numbers is not possible.
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12.3.4 N Number Substitution cont.

Before Substitution

NO1lC ARS;

N0O20 WHILE #10 < 100 DO1;
N0O25 PMV Pl C#10;

N0O30 GSB P33;

N040 IF #150 == 1 GOTC 100;
N035 MOV X10. Y10.;

NOSO #10=#10+1;

NCEQD DENDIL;

N100 MOV X0. YO. ZO;

After Substitution: Start Number is N100, and thber of Steps is Set to 10.

1
N100 ABS;
N110 WHILE #10 < 100 DOl;
N120 PMV Pl C#10;
N130 GSB P33;
N140 1IF #150 == 1 GOTO 180;
N150 MOV X10. Y10.;
N160 #10=#10+1;
N170 DENDl
N180 MOV X0. YO0. Z0;

1

Note If the N number specified by the GOTO statement does not exist, the N number cannot be
substituted. As a result, other substituted N numbers and the N number specified in the
GOTO statement may be duplicated. Take care to avoid this happening.

An example of the operation is described below.
1) Switch to the menu cursor using the Tab Key.

2) Select N Number from the Edit Menu using the Cursor Keys and press the Enter Key.

h;in Select 8rch/Sub Gete oDisplay Tools Quit

P2 3 —f—————— P77 —
MODULE : MC1I O NO. : 87| Copy AM EDIT [z Lal uuﬂ]lGE: "
: .,

MAX LINE = 1t

=
g
-]
z
x
-

-4
sPROG.7? STO AT STATION_?

N@z@ |WILE %10 < 108 De1;
HE2t  (PMU PL CH10;

GSB P33;
No4@ {IF #1568 == 1 GOTO 188;
NE3I5  |MOU XKie. via.;
NBS8 |N18=¥1B+1;

DEND1 5
HOU Xe. vYe. Zo.;

1
&
g
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m

3) A window will be displayed asking for the starting N number. Enter the first N number
(N100 in this example) and press the Enter Key.

g

UNIT : mm

Select Edit Srch/Sub Goto ~  Wdisplay Tools Quit
. P ¥4 Ly e WM—H-&E}—-—H
{MWLE : ML O NO. @ B HC PROGRAM EDIT €1 LANGUAGE: nC

LineNO| N NO CL129_1.187 MmaX LINE = 11
8281 ;PROG.? STORE WORKPIECE AT STATION_?
2882 |Ne18 |ABS;:

8083 |NA20 |(WILE #19 < 188 DO1;
8884 [NI25 |PW P1 CH10@;

B@9S N33 |GSEB PF33:

BB0G |NB48 |IF 315@ == 1 GOTO 188;
BOE7 |NA3S IMOU Xi@. ViB.;

BBEA NESE | B1A=R19+1;

8207 |N@G8 |DENDL;

%? Hied [MOU XO. Ya. ZB.;

4} Awindow will be displayed asking for the step number, Enter the number of steps forthe
interval between N numbers (10 in this example) and press the Enter Key.

in Selsct  Edic SrchrSub Goto #Dizplay Toolx Quit

———p2——F) F4 5 o ""'{M‘“‘@_”
Eﬂww : HMC1L O NG, : 87 MG PROGRAM EPIT 1 Lai uu:?ﬂ: .+
: mm

MAX LINE = 1%

GL128_1.187

3EROG.7 STORE WORKPIECE AT STATION?
WILLE $10 < 190 Do1;

PN P CH1E;

GSB P33;
IF $158 == 1 GOTO 188;
MOU X18. vi8.;

O=810+1;

IESERRRERRE

The N numbers will be substituted.

Om» 1) The program only operates for lines with N numbers. New N numbers are not placed on
lines which had no N numbers before.

2} Iftwo or more identical N numbers have been used, an error will occur, A message will be
displayed and the substitution will not be performed.

3) When entering the starting N number, the substitution will proceed normally evenifan “N”
is not put in front of the number.
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12.4.1 Search

12.4 Search and Substitute

This section describes the procedures used to’ search for and substitute character
strings within programs.

1241 SRAICH .. ittt s et iae et e e s 12-20
12.4.2 SUDSHIUIE . ..ottt iiiie e ieterareeneanannerarenrnssrrsarannn 12-21

12.4.1 Search

The Search operation searches for the character string entered inthe currently displayed mo-
tion program. There are three kinds of search dependmg on the starting point for the search
and the search direction.

1) Search All

The specified character string is searched for from the beginning of the program through to
the end. When the target character string is found, the cursor will move to the position of the
character string. Press the Enter Key to continue searching for the next occurrence. To end
the search, press the Esc Key.

2) Search Forward

The specified character string is searched for from the line where the cursor is currently posi-
tioned through to the end of the program. When the target character string is found, the cursor
will move to the position of the character string. Press the Enter Key to continue searching for
the next occurrence. To end the search, press the Esc Key.

3) Search Backward

The specified character string is searched for from the line where the cursor is currently posi-
tioned back towards the beginning of the program. When the target character string is found,
the cursor will move to the position of the character string. Press the Enter Key to continue
searching for the next occurrence. To end the search, press the Esc Key.

Following is an example showing the Search All operation.
1) Switch to the menu cursor using the Tab Key.

2) Select Search from the Search/Substitute Menu using the Cursor Keys and press the
Enter Key.

Main Select Edit oDisplav Tools Quit
e —2——F ) Pp— en-ch/Suhstitua——| @—lﬂ
MODULE : HMC1 ¢ NO. = &1 nc e LANGUAGE: MC
sarch Fo UNIT = mm
Search Backwawd
LineNO| N NO GL12@81 Substitute 811 MAX LINE = 24
eaa1 ;PROG.1 STORE WORKP] | Substitute Forward
Neie |ABS; APSOL| Substituts Backward

B8eg2

|aea3 R1=H1; POINT

2084 [N83B |N10-YRE400; GE] STIATION'S ¥Y-AXIS POS,
2085 |[Ne4e I81i-Z8E408; GE? SIATION'S Z-AXIS POS.
8085 [NOSe |812-XSE408; GE] STATION’S X-AXIS POS.
mw H ¥-AXIS POS.

GEI PALLET’S
F14=28ERL GET PALLET'S Z-AXIS POS.
NBgR {#15=XNENL GEI PALLEI’S X-AX1S POS.
0018 |NE?R 110VW BIi==1 CHECK ARM’S NEWTRRL POS.
b811 |M180 |(#16=811-18888; CRLC. Z-AKIS POS. DATR
B812 |N118 |MOU YE1Q ZE16: MOVE TO STATIOM_1
BBL2 [W120 [MOU XE12; HOUE TO WORKPIECE POS.
8814 (W13@ [INC MOU Zi8 UP Z-AXIS 1
[t ABS MOV X8; MOUE TO X_NEWTRAL POS.
BB16 |M150 TOW BI1w=-1i; CHECK ARM’S NEWTRAL POS.
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“

3) A window will be displayed asking for the character string to be searched for. Enter the
search string (ABS in this example) and press the Enter Key.

E

a:loct Edit Srch/Sub Coto lbusha Tools Quit

0 LANGURGE: HC

p 3 F4 E: 6 2]
MODULE : MCL 0 MO. : @1 WC PROGRAN EDIT [i

UNIT : mm

MAX LINE = 24

GL120_1.181
;PROG.1 STORE WORKPIECE AT STATION_L
BS RESOLUTE MODE
POINT_MO.<=PALLET NO.)
GET STATION’S Y-AXIS POS

GET STATIONS Z-RXIS
GET SIATION’S H-ANIS -
GET PALLEI’S ¥-AXI

The search will begin from the top of the program. If the character string that matches the
search string entered is found, the cursor will move to the beginning of that character

string.
Main Select Edit  Swch/Sub Goto  Display Taole Quit
m—rz-—rs——m———rs—-—n—n#—w—ﬁ—m
MODULE : HMCLI O NO. : 81 WG PROGRAM EDIT [} LANGUAGE: MmC
Searching UNIT : mm
LineNO| N NO GL12@ 1.181 RAX LINE = 24
;PROG.1 STORE WORKPIECE RT STRTION_f
8982 (K819 BS ; ABSOLUTE MODE
2983 |Ne28 =H1; POINT MO, <=PALLET NO.>
D884 1NE30 {E18-YRE408; GET STATION’S Y-AXIS POS.
] 811 ~ZRE4PA ; GET STATION'S Z-AXIS POS._
2886 |N9SA  I®12-KBE4QD; GET STATION‘S X-AKIS POS.
B8B7 |NBER H GET PR . RIS POS,
[y ¥14=Z8Ew]1 3 GEI PALLET’S I-AKIS -
NESB |E1S5=XBES1; GET PALLET'S ¥-AXIS POS.
0818 |Ma%8 IOW 8I1==y; CHECX ARM'S NEWT -
el B16=811-10808; CALC. Z-AXIS POS. DRTA
Ba1? IN118 |[HOU Y&1@ Z316; MOUE 10 STATI
2813 |N28 23 E T0 WORKPIECE POS
2814 |39 INC MOV Z18.; UP Z-AKIS 18MM
8215 N1 ABS BOV XB; MOUE TO X_MEWIRAL POS.
8216 |MLSe [ION Sli=wi; CHECK RRIM’S NEUTRAL POS.
OIIEEID 1) To continue the search, press the Enter Key. The search will begin again from the current
cursor position. To execute another operation, press the Esc Key once to exit the Search

operation.

2) The Search operation is case sensitive. When searching for N numbers or instructions,
make sure they are entered in uppercase letters. For example, if searching for N number
10, make sure it is entered correctly as “NO10",

3) The Search operation can be used for motion programs as well as for comments.

4) A string of up to 8 characters can be searched for,

12.4.2 Substitute

The Substitute operation searches for a specified character string and replaces it with anoth-
er character string. There are three kinds of substitution, depending on the starting point for
the substitution and the direction.
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12.4.2 Substitute cont.

1) Substitute All

The character string is searched for from the beginning of the program through to the end.
When the target character string is found, the string will be substituted by the specified char-
acter string.

2) Substitute Forward
The character string is searched for from the line where the cursor is currently located,
through to the end of the program. When the target character string is found, the string will be
substituted by the specified character string. :

H

3) Substitute Backward
The character string is searched for from the line where the cursor is curtently located, back
towards the beginning of the program. When the target character string is found, the string will
be substituted by the specified character string.
An example for the Substitute All operation is described below.

1) Switch to the menu cursor using the Tab Key.

2) Select Substitute All from the Search/Substitute Menu using the Cursor Keys and press

the Enter Key.
in Select Edic Goto witpla Toak Quit
T X PR . —— i e earc uhtltue
MODULE : MC1I O MNO. : ™ NC P| Search Lﬁ AGE: MC
Search FPorward - UNIT = mm
Search Backeward ety
LineNO| N NO GL120 MAX LINE =~ 24
[ sPROG.1 STORE WORKPI tuts Fol
8882 |N218 |RBS; RESOL Sub:t;tuta Backward
2003 |NG28  R1-M1; POINT
0834 ING38 [¥18-YRE400; GEI' STATION'S ¥-AX1S POS.
BBOS K848 |#11-ZRE480; CET STAIION’S Z-AXIS POS.
000G INBSE  [H12=XEE480; m SI“TIOH'S K-AXIS POS.
BOO7 |NB6E |#13=YREML; GET PALLET’S Y-ARIS POS.
[ ] 4=ZRES81; GET PALLET’S z—axls POS
BBAY INBES [R1S-XSEN1: GET PALLET’S R-ARIS POS
BE18 |Na9E IO B11w=-; CHECX nnﬂ's HEWTRAL POS
8811 |M188 [M16+~811-18880; CALC. Z-AXIS POS. DATA
Ba12 IN118 MOV YHIB ZE16; WE 'l’o STRIION_1
2813 |Ni28 MO X®12; MOUE TO WORKPIECE POS.
aa14 |N38 INC MOU ZiR.; [P Z-AX]IS 1@mMM
BB1S |Ni48 |RBS MOU X@; MOUE TO X_NEWIRAL POS.
8816 (M158 10W $lia=y; CHECK ARM’S NEWTRAL POS.

3) A window will be displayed asking for the character string to be substituted. Enter the
string to be substituted (#E400 in this example) and press the Enter Key.

Select  Edit Srch/Sub Goto SDisplay Tools Quit
PG, =

——TF2 ———e g

MODULE : MCI ONO, : @ HC PROGRAM EDIT i LaR&lacE: mc
UNIT ¢ wa

LineNO GL128_1.161 HAX LINE = 24

cea1 :PROG.1 STORE WORKPIECE AT STARTION_1

8882 ABS; ABSOLUTE MODE

€063 POINT_HO.<=PALLET NO.)

8084 GET STATION'S Y-#XIS Pos.

8095

2886

8087

6808

B08Y

8818

w11

8a12

0813

8814

8815S

@815
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12.4 Search and Substitute

M

4) Next, a window will be displayed asking for the replacement character string. Enter the
new string to be inserted (#£500 in this example) and press the Enter Key.

l}:;in Select Esi: Srch/Sub Gato whshﬁ Tools Quit
MODULE : MCL O NO. : @1 NC PROGRAM EDIT [ ) MN%?]QE- nc
:

FAX LINE = 24

GL12P.1.181
;PROG.1 STORE WORKPIECE RT STATION_1
ABS; RIS LUTE MODE

POINT _MO.(=PALLET NG.)
CET 8T ATION'S Y-AX
GET SIAYION’S Z-f

Any character string that matches the character string set to be replaced will be substi-
tuted with the new character string.

OIHIEID 1) I the character string to be inserted exceeds a maximum of 128 characters, an error will
OCCur.

2) The Substitute operation can be used for motion programs as well as for comments.
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Editing the Motion Program: Offline

12.5 Moving Control

This section describes the procedure used to move to the first line or to the last line of

a program.

There are three kinds of operations that move control.

1) Goto Top Line

The cursor moves to the first line of the program curréntly being edited. This operation is exe-
cuted by pressing the Home Key.

2) Goto Bottom Line

The cursor moves to the last line of the program c:urrentlyr being edited. This operation is exe-
cuted by pressing the End Key. 1

3) Goto Input Line

A window is displayed for entering the number of the target line. The cursor will move to the
position of the target line.

An example for going to a specified line is described below.

1) Switch to the menu cursor using the Tab Key.

2) Select Input Line from the Goto Menu using the Cursor Keys and press the Enter Key.

= MCL

Select
0o ND, :

Edit
a

Srch/Sub wDispla
to

NC PROGRAM ED{ Top Line
Bottom Line

Terput Line
G120 1.181 e
iFBOG.1 STORE VORKPIEGE AT STATIONA

3
8i=41; POIHT uo {=FALLET NO.>
RLB=YEE400; GET STRIION'S Y-AXIS POS.
811 =ZRE490; GET STRTION'E Z-AXIS POS,
K12 -XPE400 GE‘I' STATION’S X-AXIS POS.
$13-YSESL ; PALLET" B Y-RAIS
S14=ZBESL GEI' PALLET*S Z-AKIS POS.
815=KEES1 GET PALLET’S X-AXIS POS.
104 BI1==1 CHECK ARW'S NEUTRAL
£16=011-10000 Z-RX1S POS. DATA
HOU Y818 Z¥16; MOVE TO STATION_L

X812; E T0 WORKPIECE POS
ING HOU Z18.; UP Z-AXIE 1
ABS MOU XB; MOVE TO X_NEWTRAL POS.
100 BIt==13 CHECK ARM’S NEWIRAL POS.

MAX LINE =~ 24

'lnnls Quit

RGE: MC
UHI‘I : .
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12.5 Moving Control

M

3) A window will be displayed asking for the line number of the destination. Enter the num-
ber (14 in this example) and press the Enter Key.

hain Selsct  Edic 8rch/ub Gaoto MWisplay Toels Quit

[F1———p2 ——s—— P4 o

JNODULE : MC1 O NO., : Bt MC PROGRAM EDIT L INS mﬂﬁrllgh nc
:

HAX LINE = 24

GL129_1.181
sPROG.1 STORE WORKPIECE AT STATION.1
MBS ABSOLUTE MODE

0 _WORKPIECE POS.
UP Z-AXIS 19mMM

The cursor will move to the position of the specified line number.

hli.ll Select  Edie Srch/Sub Goto oisplay Tools Quit
[Fl———F2——3 F4 S 6 r'?ilw-ﬂ—aga—n
1II'JDI.ILE P MCL ONO.: B MC PROGRAM EDIT [ Lal u"?ﬁ: MG

T:wmm

LinsHO| N NO GL129_1 .181

BBG6 INBSE  [R12-XNE490; GET STATION’S X-AXIS POS,
BEB? |HOGO |E13-YHENL; GET P ‘g ¥

ane |we7e H

S14=ZHER1 :
NOE®  [w15=X3ERI; GET PALLET’S X—RXIS POS.

MAX LINE - 24

318 m 10V BI1==1; CHECK RRM’S NEVIRAL POS

28211 N16=311-10888; CALL. Z-AXIS POS. DATA
B212 {M118d (HOU ¥Y¥#18 Z816; MOUE TO STATION_1
8813 [NI28  [MOD Xe12; MOVE TO WORKPIECE POS.
814 X138 *B"g mol Zig.; UP Z-4XIE 19MM

BB1S |W148 [-H MOVE TO X_MEUTRAL
8816 W15 [IOW SIi=~1; CHECK RRM'S MEWIRAL POS
8817 IM168 |INC MOU X188.; MOUE T0 POINT-81(%>
oais W INC nov ¥58.; E TO POINI-B1(Y¥)
8819 |N188 |INC WOU Z75.; UP Z-AXi§ FoMM

b6 [Ri98 [INC WOU X188.; MOUE TO POINT-@2¢H)>
9821 N2 INC MOU ¥Y58.; MOVE TO POINT-82(Y¥>
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Editing Motion Programs:
Online

This chapter describes the procedures for using the MC Program Edit
Screen and the location display, as well as displaying I/O data in On-
line Mode. '

‘13.1 MCngrammitScmeﬂ.--oot----o-olooo 13-2
13.1.1  Edit Screen Configuration ....................... 13-2
13.1.2  Differences from OfflineMode ................... i3-3

13.2 Motion Module Operations .............,. 13-§

132.1 1BlockExecute ...........ccocinvineunnnnan... 13-5
1322 Hold ......... . i, 13-6
1323 AbOM ... i 13-6
1324 Default ... 13-7

13-3 TeaChingPOSitionso.-.....-.-.--..-...-.. 13'10
13.3.1 Teaching the Current Position .................... 13-10
13.3.2  Teaching Arc Focal Point Coordinates ............. 13-11

134 Changing the Display .............0.0.... 13-15

13.5 Displaying Variables ..................... 13-17

13.5.1 Displaying References ...............0ouvevnnnn.. 13-17
13.5.2 Continuous Display ..................c.con..... 13-18
1353 ChangingData ............c.ccoooiviinnnnnn. ..., 13-20
13.5.4 Switching Screens ..............c.cvivuiunin. L1321
1355 DeleteScreen ...t 13-22
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Editing the Motion Program: Online
13.1.1 Edit Screen Configuration

13.1 MC Progi'am Edit Screen

i
This section describes the configuration of the screen when editing a motion program

l in Debug or Online Mode.

13.1.1 Edit Screen Configuration
13.1.2 Differences from Offline Mode

13.1.1 Edit Screen Configuration

.........................................

.....................................

The MC Program Edit Screen in Debug or Online Mo@ie also displays other information such
as the current position. The following example shows the screen in Online Mode.

Masn NC Ope  Solect Edic Srch/Sub Coto Display_Tools  GQuit
MODULE : MGL O NO. : @ WC PROGRAM EDIT LINS LANGUAGE:
UNIT : wm
LineNG| N MO . GL120_1.181 M LINE = 25
8881 ;PROG.1 STORE WORKPIECE AT STATION_1
2842 |Neie AR ; ABSOLUTE MODE
0883 |NE2B  |Ei-Hi; POING NO.(=PALLET MO.) 1.
eens |wm3s |xio-vaE<so GET STATION’S Y-AXKIE PoS.
oons |NB4e [(¥11-73E GET EIATION'S Z—AKIE POS.
0a86 |Kese |®12-xwE4pe GET SIATION’S X-RXIS POS.
0887 INDeO #13=YRENL; GET M| ‘S Y-AXIS POS.
oaos |we7e [s14-zn GET PALLET’S Z-AXIS POS.
882 |KDE9 #15=XBE#1 GET PRLLET’S X-RXIS POS.
[Current Fositienl
W ) 21086 = ] x: +64.000 [wml
= @ s1097 - @ ¥:  +560.808  [mm)
%1083 = ] 21908 = a zZ: <105 . 6088 fmm]
BI04 = a 21887 = ] S: -313.608 Tom]
$1005 - ] sl = ]
W A v
A A
2. 3

1. MC Program Edit Area

The selected O number motion program is displayed. This area functions the same way as

when in Offline Mode.

2. Variable Display Area

Variable data such as the I/O of the set reference number is displayed. The variables that can

be displayed are as follows:

= Input variables

o Qutput variables

¢ Link input variables

 « Link output variables
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I13.1 MC Program Edit Screen

M‘

s Common variables
» System variables
* H variables

The variables which can have their values changed in this area are output variables, link out-
put variables, common variables, and H variables. For more detailed information on vari-
ables, refer to the Motion Module MC20 Software User’s Manual (SIEZ-C825-20.52).

3. Current Position Display Area

The current position of each axis and error pulse is displayed.

13.1.2 Differences from Offline Mode

The following menus are added in Onfine and Debug Mode.
* MC Ope (Operation) Menu

In Online or Debug Mode, the MC Ope Menu is displayed when the MC Program Edit Screen,
Edit Point Table Screen, or Edit Parameter Screen is displayed. The corresponding Function
Key is F2. The Motion Module operations are as follows:

+ 1 Block Execute: Executes designated single block programs when the Motion Module
is in Online Edit Mode.

¢ Hold: Holds the operation of 1 Block Execute. If Hold is selected again while
the operation is already on hold, 1 Block Execute will resume.,

» Abort: Aborts 1 Block Execute.

¢ Default; Retumns the programs, point tables, and parameter data of the se-
lected Module to their default seftings.

See section 13.2 MC Operations for more details on Motion Module Operations.
» Display Menu
Three operations can be performed from the Display Menﬁ.

» Teaching Positions

The values for each axis of the program can be taught for the current position. For more
details, see section 13.3 Teaching Positions.
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Editing the Motion Program: Online
13.1.2 Differences from Offtine Mode cont.

« Change Display

Either the current position or error pulse is displayed. For more details, see section 13.4
Changing the Display.

» Variables Display

/O or other variable data of the Motion Module is displayed. These variables can also be
changed. For more details, see section 13.5 Displaying Variables.

Other selecting or editing operations are performed using the same procedures as in Offline
Mode. In Offline Mode, however, switching Modules is performed by switching edit files,
whereas in Online Mode it is executed with the menus.

(I If two MC20 Motion Modules are being used in Online Mode and Edit Program, Edit Parame-
ter, or Edit Point Table is selected, the Module Selection Window will be displayed. Make sure
to select the Module to be edited before continuing the operation.
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13.2 Motion Module Operations

m
13.2 Motion Module Operations

This section describes Motion Module procedures that can be executed in the MC
Program Edit Screen.

13.21 1Block EXeCUte . ...\ i e 13-5
1322 HOI ..o 136
T1B2.3 ABOM L 13-6
1324 Default ... ..o 13-7

13.2.1 1 Block Execute

The 1 Block Execute operation can only be performed when the Motion Module specified by
the ladder program is in Online Edit Mode. The single block at the cursor position is executed
when 1 Block Execute is selected.

Following is an example of the operation.

1) Move the cursor to the position of the biock to be executed using the Down Cursor Key.

Main MC Ope Select Fdit $rchSub Gota Display Tools Quit
[Fl ————nP2 4. W—Pﬂ-
MODULE : MCT O NO. : @1 #C PROGRAM EDIT [ LA AGE:
UNIT : sm
LineNO| N NO GL128_1.161 MAX LINE = 25
2881 ;PROG.1 STORE WORKPIECE AT STATION_I
Ea2 |NB1D BS; ARSOLUTE MODE
8983 |NIZ8 =H1; POINT NO._<=sPALLET NO.>
8884 |NB38 #10-YEE400; GET STATION'S Y-AXIS POS.
8905 |ND4e 11 H GET STATION'S Z-AXIS POS.
2006 |NDS8 212 =X2F400 GET STATION’S X-aXIS POS.
2007 |NP68 |[#13-YSERL GET PALLET'S IS POS.
e 4 GET PALLEI’S Z-AKIS POS.
B2ua9 [NOSD #15=X3E81 GET PRLLEI’S X-AXIS POS.
{Current Pazitionl
2} RIBBE = -] ] +64 . 68D [om]
- a 21827 = ] ¥ +560.988 (o]
HIMR3 = a #1888 = a z +1085.689 [ Y]
11884 = a RIBDY = ] 1 -313.688 [mm ]
Lnaas - ] s1418 - a
2} Switch to the menu cursor using the Tab Key. 1 3

3) Select 1 Block Execute from the MC Operation Menu using the Cursor Keys and press
the Enter Key.

in M Selsct Edit Srch/Sub Coto Display Toelt  Quit
ratlen ——S —— =
|HODULE : P&mom | NC PROGRAN EDIT [ msﬁzﬁ m% ’:

AGE
UNIT : mm
ABORT
LineNO| [»Default GL128_1.181 MAX LINE = 25
8881 WORKPIECE AT STATION_t
0002 ING10  [4BS ABS
8083 |Haze =Hi; POINT _NO. (] NO.>
2004 [N830 |318-YSE408 GET STATION'S Y-RXIS POS.
B8RS 1 GET SIATION’'S Z-AXIS POS.
8006 |MBSA |B12=XRE400 GET STATION’S ¥-ARIS POS.
8087 |NOLO |E13=YRERL GET PALLET’S Y-AX[S POS.
v H14-Z2ER1 GET PALLEI’S Z-ARIS POS,
B39 |NS3e  RLS~XEENL GET PALLEI’S X—AKIS POS.
(Current Position)

#{E_ a 41806 = -] ] +64_089 Emm]
e = a 21087 = a b +560.889 [ Y]
#1803 = ] siBB8 = a8 z +185 .60 [m]
RIBP4 = ] s1089 = ] H =-313.680 [wm1
*Igps - -] s1me - [

The single block where the cursor is positioned will be executed.
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Editing the Motion Program: Online

13.2.2 Hold
OII!HEID 1 Block Execute executes single blocks of programs selected on the screen. Therefore, the
program to be executed must be selected and displayed before this operation can be per-
formed.

13.2.2 Hold

The Hold operation puts a single block that is being executed on hold. It only functions while a
single block is being executed. Use the Hold operation to put the execution of a program on
hold. If Hold is selected while the operation is on hold, the hold will be cancelled and the
execution of the program will continue to the end. :

An example for the Hold operation is described below.
1) Switch to the menu cursor using the Tab Key.

2) Select Hold from the MC Operation Menu using the Cursor Keys and press the Enter

Key.
in Select  Edit S$»ch/Sub Goto ‘Display Taols Quit
— Oparation = —4
|me.E :| 1 Bleck Executs nC PROGRAN EDIT et LA AGE =
oL UNIT : mm
LineN0 Ichfwlt GL129_1.181 MAX LINE = 25
a8l WORKPIECE AT STATION_L
as82 |Nei@ |ABS; RESCLUTE MODE
8983 |N229 RieH1; © POINT _NO.<(=PH HO. >
2884 |NB38 |%re-YEE400; GET SIATION'S Y-RXIS POS.
8085 |HB48 |Xii-ZEE400; GET SIATION’S Z-RXIS POS.
0806 |N2Se |#12=XEE40A; GET STATION’S X-RXIS POS.
8887 {MB68 |NL3-YRENL; GET PALLET*S ¥-aXIS POS.
0888 |NE72 |Ri4=ZRERL; GET PALLET’S Z-AXIS POS.
2887 |NESe |RIS-HEERL; GEI PALLET'S W-RXIS POS.
[Current Position]

W B8 RI086 = -] R +54 . BOA [ ]

- e RIB87 = a ¥ +560. 060 (7 Y]
#1983 = -] RIP0E = e Zz +185.608 {mm]
21804 = ] 2100 = 8 s -313.600@ Inn]
#1985 - ] 8180 - e

3) The operation will be put on hold. To cancel the hold state, select Hold a second time.

13.2.3 Abort

The Abort operation stops the running of a single biock while it is being executed. lt only func-
tions while a single block is being executed. Select Abort to cancel the execution of a pro-
gram.

An example for the Abort operation is described below.

1) Switch to the menu cursor using the Tab Key.
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13.2 Motion Module Operations

2) Select Abort from the MC Operation Menu using the Cursor Keys and press the Enter
Key.

b;i.n Select  Edit SrchsSub gto Di:. La Toolx Quit

g gcnt.... 7S F6 77 Egj—n
1 Bleck Exocute HC PROGRAN EDIT [ ¢ LARGUAGE :
HOLD UNIT : »m
ﬁ;m!t GL12@_1.181 MAX LINE = 25
WORKPI ECE a‘g STATION_1

NB1@ JABS; RBSSIHIIE DE

888
333
RS

[Current Position)
54,088 [mnl}

e o sigss - 8 ®

- a H 1 8 ] +568.808 [mm)
RigEy = ] s1gss - 8 z «106.688  [mm)
#1004 = @ slgsy = 8 5 -313.688  [mw)

li 18G5 - 9 slai@ - 8

The single block execution will be cancelled.

13.2.4 Default

The Default operation returns all the data of a specified Motion Module to its default settings.
The Default Menu offers the following options.

¢ Clear All:  Deletes all the programs and sets the point tables and parameters of the se-
lected Motion Module to their default values. This operation can only be
executed when the Motion Module is in Edit Mode.

» Program:  Deletes all the programs of the selected Motion Module. This operation can
only be executed when the Motion Module is in Edit Mode.

» Point Table: Retumns all the point tables of the selected Motion Module to their default val-
ues. All point table data is returned to zero.

» Parameter: Returns all the parameters of the selected Motion Module to their default val-
ues.

OlmZﬂb A part of the parameter data cannot be replaced by other data unless the Module is reset or
unless the power is switched OFF and then switched ON again. The data is not immediately
affected by the execution of the Default operation. Refer to the Motion Module user’s manual
for more details.

An example for initializing parameters is described below.

1) Switch to the menu cursor using the Tab Key.
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Editing the Motion Program: Online

L
13.2.4 Defauit cont.

2) Select Default from the MC Operation Menu using the Cursor Keys and press the Enter
Key.

Ilki.n Select  Edit Srch/8ub Goto Display Iools Quit
[Fl——— rat ion —f = —
|MODULE :| 1 Block Execute nG PROGRAM EDIT 1 LANGUAGE =
WOLD UNIT = mm
ABORT
LineNO GL128._1 .1 MAX LINE = 25
81 UOMIECE Rf STATION 1
P82 [N218 ABS; ABSOLUTE MODE
8283 [RE29 |B1-H1; POINT MO.C=PALLET MNO. >
8084 [Na3e S19-YHE400; GET STATION’S ¥Y-AXIS POS.
9085 |HB48 1 GET SIATION’S Z-AX1S POS.
8886 NS - |H12-%RE408; GET STATION’S K-AXIS POS.
2227 |NBea H13=YSENL; GEJ] PALLET’S Y-AX1S POS.
2288 [NE78 4 H GET PALLET'S Z-AX1S POS.
eegy |Nesd ¥15-XEESL; GET MLLET’S X-AX1S POS.
[Current Position]
?II%_ [} 21086 = a M= +64.809 innl
- [} 41007 - -] ¥: +560.888 [wm}
21883 - -] 21808 = 8 4 +1085.608 (L))
21084 - L) 21887 = 8 $: -3131.688 [}
21085 =~ -] sime - 2

3) The Default Submenu will be displayed. Select MC2 using the Down Cursor Key and
press the Enter Key.

E;in Sal::t Edit Srchs/Sub Goto "Display lools liuic
(. rat =
JMODULE =} 1 llgg; Exscute MC FROGRAN EDIT E I LANGUAGE >
H LD N UNIT = am
I.I.I.Li.
LineNO ﬁ‘:% STATI MK LINE = 25
easi | Hl.‘ ON_1
weie  (aBS; UTE MODE
9293 |NB28 |#1-Hi; POINT WO, (=PA .Y
8804 |N830 S10=YRE488; GET STATIION'S Y-AXIS POS.
9005 [N848 {%11-ZRE408: SIATION'S Z-AXIS POS.
2006 |HE5A 212-XRE480; GET STATION'S X-AX1S POS,
2947 |RO6B [E13-¥ H GET PALLET’S ¥Y-qXIS POS.
2088 [NE78 [814=T7RER1; GET PALLET'S Z-AQKIS POS.
8889 |N889 |[#1S=XSER1;: GET PALLEI'S X-ARIS POS.
[Current Pns:cionl
W [} 21086 = B Xz +64 000
- ] 21087 = 8 $: +560._888 [-]
sigm - ) $I088 - ] 44 +185.688 [ Y]
RIGgR4 = -] X007 = 2 83 -313.688 [C* Y]
#1025 = a #ieig - ]

4) A submenu wili be displayed. Specify the type of data to be initialized. in this example,
select Parameter using the Down Cursor Key and press the Enter Key.

Main Select Edit Srch/8ub Goto ' Pisplay Toeols Quit
I ——— Operation —
MODULE 1 Block Exccute NG PROCRAM EDIT [ LANGUAGE=
HOLD UNIT =
ABORT fault—
LineN0 MICL  ———HC2 MAX LINE =~ 25
80al |\ —— | YTTe Clear A1l N_1
NE18  |RBS: Program
8083 |ME28. |#1-H1; PO Pn:i.nl: Table {NO.>
2004 (W83 |s1e-YRE<B0; GE 15 POS.
8ees |Ng4e [411~-ZeE4eA; GE 18 POS.
0086 |NB5S0 |E12-REE4009; GET STATION'S X—AXI§ POS.
BBA7 M0G0 |W13-YHERL; GET PALLET’S Y-AXIS POS.
PB8E |N878 [¥14-ZSERL; GET PALLET’S Z-AXI$ POS.
PeB7 |NB2Q |E1S-XBEEL; GET PALLET’S X-AXIS POS.
{Currant Pnaitinn]
W ] 1006 = [} H: +54.0098
) - ] 11007 = [} y: +560.088
2983 = B siees - a 2: +185 608
21984 = B 51097 = ] §: -313.608
Alges = @ 1016 = ]
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13.2 Motion Module Operations

5) A confirmation message will be displayed. Enter Y and press the Enter Key.

in MC Ope Selact Edic Srch/Sub Goto Display Tools Quit
Operation 5 ¥6 P74 = =]
1 Block Exmcute MC PROGRANM EDIT [ INS LA GE:
| HOLD URIT : wm
ABORT fault-
pCL PAX LIME = 25

The parameters will be set to their default values.
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13.3.1 Teaching the Current Position

13.3 Teaching Positions

This section describes the operations that can be used to teach coordinates using the
MC Program Edit Screen.

13.3.1 Teaching the Current Position
13.3.2 Teaching Arc Focal Point Coordinates

13.3.1 Teaching the Current Position

The operation for teaching coordinates is used to write to a program positions that have been
set with an operation such as Jog. This time-saving operation allows you to modify a program

..............................

while being able to see a teach while monitoring the ‘current position.

Following is an example showing how to teach a position for the 1 Axis.

1) Afiera position has been set move the cursorto the line to be displayed using the Cursor

Keys.
in MC Ops  Select Edic Srch/Sub Goto Dicplay Tools Quit
H—u—wﬁa—m’—m
[MODULE : MC1L O NO. : @S NG PROGRAM EDIT [ LaR&unGE:

UNIT : mn
LineNO| N NO GL128_1.185 max LINE = 24
[ ;PROG. S
oenz [weiw  |Aov Kide. Yzee. zz5e.
mon: |Heze | mos K1S0. +350.5 Fige i
8284 [Ne38 nus ¥228. Z788. Fid8.;
8285 [NB4B {MOW PXY X128, ¥188. i58. JS@. P199.:
986 |NESH  |MOU X1@. Z15R.;
8287 |NBGA |MUS X20@. YI9R. F208.;
9088 K878 |MUS K32@.Y188. usa.
80e% |[Nee8 (WIS ViSe. Zea. FiSe.:

[Current Position]

] 21006 - a ®= +54_BB8 [T
Rieez = 8 21097 = a ¥ +560.,808 [na]l
£1003 = 8 s1088 = a z: +105.688 [wm]
21884 = 8 21009 = a 8= -313.608 Tan]
108 - [} 21818 = 8

2) Switch to the menu cursor using the Tab Key.

3) Select Axis from the Display Menu using the Cursor Keys and press the Enter Key.

brain MC Ope  Select Edit Srch/tub Coto Tools Quit
¥ nphy——— —F9
MODULE : MC1 O NO. : B5 HC PROGRAM EDIT [|rCoordinate IIIIGE:
5 : -
rData
LineMO| N NO GL12@ 1 .185 ) ME - 24
8882 |NEi1@ ¥208. Z258.
8O3 |KkB20 IIJS 3158 1250 s P.lBB
P84 |RE3IB |MUE Y220. Z286. F10a
8885 |Ned@ |MCV PXY X128. uaa ISB J50. F1B8.;
oboE |KES8  |mOu R:I.O Z‘.l. 8
8887 |NBGE |MUS X290
2988 [NO7R |MUS xaza.um. naa.
B28Y [NDGE |MUS Y158, Z3BO. HSB.:
[Current Positionl
{II'P 2 (086 = B X +54.099 [T
3 - a 2106727 ~ [ ¥: +560.009 L[mm )
2983 = a 2[968 = 8 Z: +185.608 )]
21884 = [} 1009 = 8 [ -313.608 o}
RIBES = a 1018 - [}




13.3 Teaching Positions

4) A submenu will be displayed. Select 1 Axis using the Down Cursor Key and press the
Enter Key.

in MC Ope  Select Edit Srch/Sub Goto W Tools Quit
Pl e P ] ———— P~} meee Py e isplay———F9
MODULE : MCL O NO. : ®B5 NC PROGRAN EDIT [|rCoordinate —fixis

+hata Axiz
LineNO| N W . GL128._1.185 10 3 fAxis

;FROG.S 4 Axis
8882 INGIA ROV X180. Y280, 2259, ;

WS %200, Y399,
NE78 WS X326.Y108. F100.:
NO®9 |ws vi5e. zIee. Fi5e.;

[Curvent Positien)
% a 21086 = e X +64.888 (Y]
¥ = [} %1087 = -] ¥ +56@. 088 [ D]
#1083 = ] L1008 = ] Zz +1085.688 [mm]
21084 « [} 21009 = [} S -313.680 {mm]
slees ] ie18 = ]

The 1 Axis data (X in this example) for the program at the cursor position changes to the
data for the current position.

)

NG Ope Selsct Eit SrehSuk &tu l?_i’s_. lay Toogls Quit
JHODULE : MC1 O NG. : @ = NG PROGRAM EDII ['IM Lakduace:
UNIT : ma

LineM0| N NO GL12@_1.1685 MAX LINE - 24
2981 ; s

;PROG.
NE1® MOV X180. Y209, Z25d.;
NE28 WS X150, ¥250.5 Fi0@.;
Nalg  |mUS Y220. Z280. F194.;
NB4@ HCY HG; lggéﬂ Y108, 158. J59. F106.;

NBS9 1

HBGO |MUS X209, Y380, F204.;
NO78  [MUS X320.Y189. FiB8.:
NB8H [WUS Yi5e. Z388. F156.;

[Current Positionl
W ') BIS0E = ] ® +64.D00 [mm]
% » [’} 21087 = ] ¥ +560.800 L)
#1883 = ] %1008 = [} 4 +105 .88 [ )]
#1084 = ] %igg? = 4 s -313.608 [£* %]
#ees - [} R0 = -]

Use the same procedure to teach the positions for axes 2 to 4.

OIIEEIF If the specified axis data is not included in the program at the cursor position, an error will
oceur.

13.3.2 Teaching Arc Focal Point Coordinates

The coordinates for the focal point of an arc can be taught after the coordinate display has
been switched to the arc display. Following is an example showing the teaching operation of
the focal point coordinates for an arc for the 1 Axis.

1) Aiter setting the position of the arc’s focal (center) point, switch to the menu cursor using
the Tab Key.
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13.3.2 Teaching Arc Focal Point Coordinates cont.

2} Select Coo

rdinate from the Display Menu using the Cursor Keys and press the Enter

Key.
Main MC Ope Select Edit Srch/Sub Goto | Tools  Quit
i1 — 73 ——F———r—Dizpla £
MODULE : MCL O MNO. : €5 nC PROGRAM EDIT [ AGE:
. Hixic IT = mm
rData
LineMO| K NO PBoc GL120_1.185 10 WE = 24
P90z |wate [ou %iee. vzee. z25e.;
6883 [NE2@ [WUS Xi5@. Y258 S Fied.;
e904 |NE38 WS ¥220. 7280, :
eoes [Nasa [mcu PXY X120. $168. ifa. Jse. Fiee.;
880c [N9Sa [noU x10. ot
PeB7 |ND68 [MUS %209. Y300. F200.;
£868 [nB78 [mos x320_viee. Fide.:
£099 |NSS8 (WS Y159. Z30d. F150.;
[Current Position]
— 81006 - 8 e +64., B [
- 8 sieg7 - @ ¥:  +560.000  [mml
1883 = @ sioes - 1 Z:  +105.608  Imm)
1884 = @ S1897 = @ $:  -313.608  Iwm]
sip8s = e sieln - @
3) A submenu will be displayed. Select Circular usmg the Down Cursor Key and press the
Enter Key.
in MC Ope Select Edit Srch/Sub Goto Tools
TRODULE = MC1 O Mo : @5 ¢ NG PRGRAN EDIT [ h P:ﬁé"i::'
) ST “xu (,nculn l
LineMo| N NO GL120_1.105 '7}'6' - 24
aaL 1PROG.S
90a> |we1e |mou niee. y2ee. z25e.;
ee3 |wza Mg Xical yoed's Eed:
emb4 |KB38 (WIS Y220, 228,
Goos |wasn |ncw rae Hige. w1 ita. Jse. P10M.;
0806 |Nesa |mou x18. Zi5@
oee? |NBsR |mus x2@a. vIea. Foee.; l
oBpe |Ne?8  |mus X320.viea, P08, ;
oee? |wese |mis viSa. med. Fi56.:

o p— a X [Cumnt Pu::étiﬂn]
uzlim_mz - 8 s1ee? - a i  eanme  teal
21893 = @ yiook - a ‘Z: +105.6P8  [wal
sipes - a 81007 - 8 §: -313.6828  [mml
sle8s - [ sie0 ~ ]

The current position display will switch to a display of the coordinates for the focal point of
the arc.
giain HC Ops  Select Edit Srch/Sub %to Pispla 'l'unas Quit
[MODULE : MCL O NG. = BS  ™C PROGRAM EDIT 1 LandiacE:
UNIT : »m
Lineho| N MO GL2129_1.165 MAX LINE = 24
001 sPROG.S
NE1B  [MOU XiG®. ¥280. Z258.;
Boa3 |Ne2e [mug X3Sal y25als Fioh.;
e84 |neae |ms v220. z2s0. Fide.
eoes |Me48 [mow PxV 4120. V108, ise, Jsa. F186.;
800% |nese 9. 7150, ;
0087 |NBGE |MUS X2PB. ¥IR0. F208.;
oees |ne7e  |wus X320.vi00. Fiea.:
0007 |NBSB |Ws Y158. Z309. F158.;

2 #1086 “ PR+ k-
s%- 8 t1087 - a J: 60888 Lmal
2983 = 8 sioos = a K:  +185.6880  [mal
ti084 = 8 giee = Q L:  -313.¢68  (wm)
gIess « C] HC

4) Move the cursor at the line of the program for which the coordinates are to be taught, and

then switch

10 the menu cursor using the Tab Key.
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13.3 Teaching Positions

5) Select Axis from the Display Menu using the Cursor Keys and press the Enter Key.

Srch/Bub Gotn Iouls Mit
MG PROGRAM EDIT hcoord:mnt II‘IGE
"hl”

ru-l.n

h;in MC Ope  Select Edit
————F2——— P} F4
MODULE : MCL O NO. : @S

H

24

GL128_1.195

;PROG. 5
esa2 [weie [Wov Xied. vee. z25a,
NE28  IMUS X158, ¥259.5 FIBO-.
HEG8 IMUS Y229, Z288. F188_;
NB48  IMCV H(g !gga $108. 150. J50. F183.5

NGB S X200. VIed. p2es._;

NE78 J'IJS %320.¢198. Fied.;

NB38 S Y158. Z388, F150.;

[Current Positionl

W ] 21606 = 2 I: +54 008 Enml

- [} 21007 - ] Jz +560. 800 (L))
81083 - ] RIBDE = '] X: +105.688 2 Y]
21004 « 8 RIBBY = ] Lz -313,608 (5]
RIRES - 2 21010 - ]

6) A submenu will be displayed. Select 1 Axis using the Down Cursor Key and press the
Enter Key.

,H-i.n NG Opeo Gelset  Edit Srch/Sub Coto Tosls Quit
4 16— play— —P,
1MWLE T MCL O ND, : 85 MG PROGRAM EDIT 4 bcoox-d:.natn is
FData Axiz
JLineNO| N NO GL120_1.185 170 3 fixis
80 H .5 4 fixis
G982 IN3I8 MO0 X188, Y288 Z350.;
B8B83 INO28 (WIS X150, ¥258.5 Flﬂ.:
0984 |NB38 |MUS ¥220.
005 NS48 ﬂc\l HI\' %X128. suaa. ISB. J58. F109.;
8005 [Nesh
D87 |NB58 !'IIS ! H !3“ HN..
8988 |Ne78 |MUS X32@.v1i88. F168.;
BEEY |NDED |[MUS Yi5Q, Z3IRA. F150.;
I[Current Poxitienl
gﬁ'“ ) 81886 = e Iz +64 098 [nm)
= 2 21887 = '] J3 +560.908 [nn)
21883 = a 31888 = [} - X3 +1085.680 ()]
#1804 = 2 21009 = 8 L: —313.400 (]
3185 = 2 1010 = e

7) The 1 Axis data at the cursor position (I in this example) will change to the data for the
current position.

k;i.n 2"0 Ope S-lnr:t .E'git §__r|:h/8ub gto R;: la ;;nls Quit
[MODULE = MCL 0 1B, + &5 & 1 PROGRAN Fore L1 LANGUAGE:
UNIT = mm
|LineMNO{ N NO GL128_1.185 MAX LINE = 24
8262 (We1e [moU Xime. vzes. z2se.,;
8025 |NB20 |mwS Xice: Yeve s sigs’ i
8204 |Ne3e |wus v22e. Z28R, P189,:
Bacs |waee Incy piy k128, ¥188. 164.808 J50. F189.;
2906 |NDSB Zz158
067 (MO8 [s £200. 4388 P208.:
8883 |We7e [mUs X320.viee. F18e.:
8069 |MBED [MmUS Y152, Z388. P159.:

[Cuarrent Poszitionl
+54 908 [}

Elilm_ a 11086 = [ 1

aleas = ] #1087 = 8 J +560.000  [wn]
21093 = e 81883 ~ B X +185.688  [mm)
BIGB4 =« ] 11089 - a L -313.688  [mm]
£1085 « 2 41810 = e

The data for “J” and “K” axes can be set using the same procedure.

1) Ifthe specified axis data is notincluded in the program at the cursorposmon an error will
occur,
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L _ -
13.3.2 Teaching Arc Focal Peint Coordinates cont.

2) Todisplay the position forthe X and Y axes, change the current position display by select-
ing the Position menu option. Conversely, to display the position of the focal point coordi-
nates of an arc, change the current position display by selecting the Circular menu option.
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‘

13.4 Changing the Display

This section describes the procedures for switching the display of the current position
in the MC Program Edit Screen.

When the MC Program Edit Screen is displayed, the current position is displayed at the cur-
rent position display. Foltowing is an example showing how to change this display to an error
(deviation) pulse display.

1) Switch to the menu cursor using the Tab Key.

2) Select Data from the Dispiay Menu using the Cursor Keys and press the Enter Key.

rln MC Ope  Select Edit SpchsSub Goto Toole Quit

P P P gronoul 20T0 | Loy —FI
HODULE : MGL O NO. : BS = NG PROGRAM EDIT »Coordinats |AGE:
ixis IT : an
Line0| W WO CL120.1.195 e
‘001 s PROG_5

0802 |NG1® MOV X188. Y288. Z25Q.;
NO28 IWUS X158. ¥250.5 Pipd.;
8884 |NA3IA WS ¥228. Z268. FiEM.;

BB25 [NG48 [nCW PXY X12d. Y109. I159. J50. F168.;
8006 |NES0 |MOV %10, Z159.;

aes?
[ et
200y

NBEB IMUS X209, YI08. F200.;
W78 NS X320.vi90. F19_;
NOSB WS YiSe. Z30e. Fi58.;

[Current Position]
| W 2 21096 = 9 % %4.880 o)
- a8 21087 = '] ¥ +560.980 Lom}
21993 = 9 si1o8s = Q z +185.680 L)
21884 = "] 8128% = a 4 -313.608 (L "Y]
sl0es - ] aeid - 8

3) A submenu will be displayed. Select Error Pulse using the Down Cursor Key and press

the Enter Key.
I[Fl;:ln g Opa g_;hct ggit ?_'_'uIvSub %tn llouh Quit
T‘owm : HCL O NO. : 85 MC PROGRAM EDTT [ H:oordgnat- RGE: ﬂ I

Potition

tet] .
LineNO| N NO 5 CL120_1.185 ?% '

PROG,
pesz |npta [Pou ¥ide. voue. z2c0._;
a8es |Neze |mUs X158, Y258.5 Fied.;

8884 |NEI8 |MUS Y220. Z280. FLOO,;

8285 |NG48  |MCW PXY X120. vi9@. 158. JSB., F180.;
8006 [NBSB MOV X18. Z150.;

aea?
]
aeg9

[Current Poxition])
W a #1885 = "] X +64 . PBA nal
- a %1887 = a ¥ +560.988 el
%1003 - a RI1G8E = a Zz +195.688 mal
21004 = ] 21897 = a8 $ =-313.688 (om}
|1085 = 8 s1618 - "]
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:

The current position display will switch to the error pulse display.

llla:l.n MC Ope  Select  Edic $rch/Sub Goto Dis Taols Quit
[F1 e - = =i
JHODULE : MCXI O NO. = B5 MC PROGRAM EBIT [1 LA AGE =
. UNIT = s

LineNO| N NO GL128_1.185 MAX LINE = 24

8881 PROG.S

BEE2 |WAt® |MOU X189. Y208. I250.;

6983 |NE28 |WUS X158, ¥250.5 Fled.;

8984 |NE30 (WS v229. Z280. F104.;

8905 |Na4e PRY ¥128. ¥100. 150. J50. F1.;

B8RS |NESe X19. Z158.;

2887 |NB6E |MS X208. Y308, F208.; !

6382 |HE7@ |MUS X320.Y198. F190.;

9987 |NBSR |[MS Y150. 21382, F150_;

21006 - 2 L
21097 = a ¥:
aIees - ] z=
21007 = 2 s
3N:®s - e

[Error i?ulsl Jtien)
+1
-1
-1
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M

13.5 Displaying Variables

This section describes the procedures used to dlsplay and change the data for the
Motion Module /O and other variables.

13.5.1 Displaying References .........c.ovvtinieireeie e 1317
13.5.2 Continuous Display .. .....ovvuininiii e 1318
1353 ChangingData...........oooouiiiiiiiinii i 13-20
13.5.4 SwWitching Screens ...........ovviiiiiie e 13-21
13.5.5 Delete Screen ...ttt e 13-22

13.5.1 Displaying References

Use the following procedures to display Motion Module I/0 and other variables.
1) Switch to the menu cursor using the Tab Key.

2) Select /O from the Display Menu using the Cursor Keys and press the Enter Key.

Pain NG Ope  Select  Edit Srch/Sub Coto Tools  Quit
P2 ¥3 F4 5 £6 —Displa —F9
|MODULE = #Ct O MD, : ©5 HC PROGRAM EDIT t Coordinace qma:
rixis IT 2
rData
LineNO| N HO s GL12@_1.185 . NE = 24

;PROG.
NO18 MOV X100. Z250.;
NO2O WS X154, !25. 5 FMee:
NB38 |MUS ¥228. Z£28@. F1B8.:
NB48  INCY PXY 8128 Ylﬂ iSe. Jse. F188.;
NBS8 Iﬂ.l X18. Z150.
NBGB S %208, Y390, P268. ;
NB78 FIJS X320.Y108. FiBE.;
NE3@ (S YIS, Z3ed. F150.;

[Cu.rrcm: Pogition]
4.8068 Y]

*558 808 (L) ]
+105.688 [ )]
~313.608 [l

WNHER
e

3) Move the cursor to the variable display area. Move the cursor to the data to be displayed
-using the Cursor Keys.

k{:ncn Dol fill REF OFP Con Disp - Toels Quit
T3 P4 F2- ! =
MODULE : MCL o NO. 5 ©5 MC PROGRAM EDIT I LANGIAGE :
UNIT : mn
LineNO| N NO GL120_1.1085 MAX LINE = 24
(e :PROG 5
0882 N1l (moU X ¥289. Z250@.;:

€0 [NR2E8  |MUS 3158 ¥250.5 naa
8884 |Ha30 !‘IIS Y220. 7288,

B985 {NO4D [NCW PXY X120. 'llﬂ ISB J58. Fiea.;
9886 |WaSe  [fhou X198, Zi58

eco? |Noce [mus ¥2ed. Yied. Fzee. H

BOBE |NG7H |MUS X32@.YviBO. F100.:

eoe? |Neee |ms vise. Zied. Fi5@.;

[Current Pezitianl
+64. 008 [mm]
+560.888 L2 ]
+1@5 . 688 Iom]
=313.680 [C*Y]

NS
MR
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13.5.2 Continuous Display

4) Switch to the menu cursor using the Tab Key.

5) Select REF using the Right Cursor Key and press the Enter Key.

cresn Dol All oN OFF Con b:l.sp Tacls Quit
— 3P4 P57 :@—n
MODULE = MC1I O NO. : @5 MC PROGRAM EDIT [ INS Mﬁ??.
. :
LineNO| N NO GL128_1.185 MAaxX LINE - 24
2081 H

;PROG.S
NB1@ [BOU X199. Y208, 7258.:

Ni7% Ge
Hese |msS viSe z3e8. Pi56.;

2083
2004
0806 {NISE MOl X1@. Z150.; i
2087 21
I DOBS
[

{Current Positian]
808 ()]
+560.608 (mn]

[om]
=313. saa Cmm]

N rC 3

IR
-
E &
8

6) Enter the reference number (#1010 in this example) and press the Enter Key.

ceeen Dl All REF ﬂl Can Disp Tools Quit
IMMLE P ONC1 O ND. @ BS nc mn EDIT ﬂ ! %ﬂ;lllgnz i
: .
LineNO| K MO GL128_1.185 MAX LINE = 24
Beal ;PROG.S
B8R2 |NBi8 |MOU X19@. Y208. 7258
8843 |Wa28 |WS 3150 !258 s P:I.B‘B..
.88a4 K838 [MUS ¥ 2. ;
PERS N84  |mCU m 8128. !1aa. ite. Jse. F1e@.; .
B0eE INBSA MOV X19. Z158.;
9007 |MBCH s . P3 F208.;
2008 |N978 |[MUS X320.71900. F100.:
" BOE7 |NSSA WS Y158. Z398. Fi50.;
Il ! {Current Ppaitionl
£ *64.000 [mm]
¥ +560.000 [mn}
z +105 .600 [}
8 -313.600 [l

The reference number and data for the variable #1010 will be displayed.

creen Dol All REF ON OFF Con Disp Tools Quit
——f—p3———P4———F5——F6 -]

JHODULE : NCi ¢ NO. @ B5 WC PROGRAM EDIT I INS LANGUAGE: NG

UNIT = mm

LineNO] N NO GL126_1.105 HAX LINE = 24

.Pm.s
oAz |18 ¥188. Y2@8. I250.;
RB28 I‘IJS X158, ¥250.5 F189.:
RE3D [MUS ¥229. Z288. PFlea.
NE4B  [MCW PRY 3128. Y1608. i59. Jsa. p10a.;

Ka28
NBS® [MUS Y159, Z36@. FiS6.;

[Current Pou.tnnl
+54 . 008

+560.980 [ﬂl
+105 688 L]

-313.688 [mm]

#1918 = L]
|

Lol L3
ARt

13.5.2 Continuous Display

The Continuous Display operation is used to display the reference numbers before and after
the one currently being displayed. The following example shows how to display the reference
number after the one currently being displayed.
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1) Move the cursor to the position of the reference number for continuous display using the
Cursor Keys.

lScreen Del All REFP ON OFF Con Disp Iools Quit
[———— P2} P4, -
MODULE : MCL O NO. : B85 MG PROCRAM EDIT E1 LANGURGE :
UNIT : mm
LineRO| N NO GL128_1.185 MIX LINE = 24
oee] i FROG.S
80a2 |Na1e |MoU X189, Y290, Z25@.;
8883 IN223 |mus X158. ¥258.5 F108.;
0004 (N30 [MUS Y228, Z2
8085 |HA48 |MCU PRY X124, !1@. iSe. Jse. Ple@.;
BPRE 1NOSH Xt@, Zi
0087 [HO68 (WS ¥20d. Y388, P2uG.;
BBES |NE78  |WUS X3209.Y188. F199.;
8889 |NB3O |WS YiSe. Z34a. Fi5P.;

I(:urnnl: Position)
+64 {mm]

-]
ArCde
Mttt
[ 2
[
3588
)
=]

-313.608 (L}

2) Switch to the menu cursor using the Tab Key.

3) Select Forward from the Continuous Display Menu using the Cursor Keys and press the
Enter Key.

MODULE : MCL O MNO. : @S nC FROGRAN ED| Baclwars

E:hun Del ALl REF on oFP W Tools  Quit
F2 I P4 PS5 Cont y—lp—ﬁmwm

Frproqred
.L%lo N N0 5 GL120_1.18% PAX LINE = 24
ootz (w1l |mou X180, Y208, Z250.;
8883 |He28 [MWE X158, Y25R.5 Fln i
Boa4 |NGQB |G Y229, Z200. FiB9.;
8885 [No48 IK:H m 29 91“ ise. Jsa. F100.;
296 |NO58 MOV %18,
BBE7 NGBS [MS X208. !3“ F2p@. ;
BOB3 NG (WIS X320.Y1R8. HU..
8889 |Wga [MUS Y158. Z398. F158,

ONeX
"

o

~313.688 Cam]

[Corrent Positionl
& [} +64.088 [
CHAUI. Sio os s

+185 680 [CEY]

The reference number at the cursor position will be increased by 1, and the original refer-
ence and the new reference will be displayed in succession.

kcnen Del A1l REF s ] OFF cen Disp Tools Quit
133 ¥ 3 ¥4 F M—Pﬂ-—
MODULE : MCI O NO. : BS [+ FROGMH ED]T II La AGE:
UNIT = mm
LinaeNO] N NO GL128_1.185 MAX LINE = 24

; PROG. 5
nou X10@. ¥288. Z258.;
WS X15@. ¥25@8.5 F1 m..
WS ¥22@8. Z288. Fl1e8
MCW P!? X128. viee. iSe. Jsa. Fi88.;
Moy 2158
e Y389, HBB-:
mws

8

S X
X320 Y188, F19d.:
¥158. Z368. F158,;

L
g

tCumnt Poszition)
2IM1E - 4. 889 [mm]

X:
¥: ’SSB [ [om)

+185 600 [L "%
-313.688 (L %]

The same procedure can be repeated to display reference numbers in succession.
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13.5.3 Changing Data

13.5.3 Changing Data

i
it is possible to change the values of Motion Module 1/O output and other variables. The fol-
lowing example shows how to change the data for reference number #0005 from OFF to ON.

1) Move the cursor to the position of the reference number to be changed using the Cursor

Keys.
creen Del 411 REP ON OFF Can Diszp Tools Quit
—2 ) F4———F% = !
JMOBULE : MCL O NO. : 85 #C PROGRAM EDIT I LANGUAGE:
+ UNIY : me
LineNO| N NO GL128_1.18% : MAX LIME = 24
8881 ;PROG.S ,
2882 |NB18 [HMOU X188. ¥200. Z258.:
2283 |Naze [MUS Xi15@. !259 5 nw..
2004 |Ng38 [MUS v22@. Fee.:
2005 |N240 [MCW PXY 8128 !!.ﬂ ie. J59, Pipe.;
9006 |NRSe MOV Xi1B. Z158.;
B8a? |NP6R MS X208. Ym. F208. ;
BHRs  |NG78 MUS X328.Y18@. Flea.:
BaRY |NOal IWS Yi59. Z388. Fi50.;
[Current Positunl
e - a #0005 = _ x: ] =]
a5a11 - 2 ROGRE = ¥: +560.890 [—]
20087 = ] s «105 480 [oam)
1] -312.600 fan]

2) Switch to the menu cursor using the Tab Key.

3) Select ON using the Right Cursor Key and press the Enter Key.

E:m Del @11 REF | BiE OFF Con Disp Tools Quit
g l @]ﬂﬁb‘ ﬂ

{MODULE : MC1 O NO. : B85 HC PROGRAM EDIT 1

LineNO| B NO GL128_1.185 . MAX LINE = 24

PFROG_S
NB16 [MOU X188. Y2@@. Z259.;
NE26 IIIS !150 ?Zig .5 F&a.;

F108. ;
IIGJ H! !!.28a ¥108. i50. J59. F199.;

®
»

[Current Pas{.t:inn ]

£Iain - a 0985 = P X: +64.888 ]
#ig11 = 8 30086 - ¥: +560.080 [mm]}
20887 ~ ] Z: +105._688 [om]

Sz -313.608 inm]

The data for reference number #0005 is turned ON and the display will change to 1.

’Scmcn Dal R11 ON OFF Con Dizp Tools Quit
Py ————P3———F4————F5 =
JWODULE : WCL O WO, = @5 nC PROGRAM EDIT [ ¢ LANGUAGE =
UNIT : om
LineW0d| N NO GEL120_1.1085 MAX LINE = 24

PROG.5
NPi@ NOU X108. Y208,
N@28 |MUS X1508. ¥250.5 P133 H
NO30 |MUS Y228, I280.
NO40 |HCU PRY Xi12@. !1m ISB J5@. F189.;
HOU X1@. Zi150.;
NOGB |mus x280. v3eh. Free.;
NA78 |MUS X328.viee. naa..
H8g8a |MUS Y158. Zjee. .3

[Gumnt Pn:%t:mln]

"568 [ [om]
+185_688 [mm]
—313.688 L]

[.-]. ]
A ||

1

-]
O NMC X
IRt
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O[EEEID The variables that can be changed in this area are the output variables, the link output vari-
ables, the common variabies, and the H variables. Modifying the value of variables other than
the output variables is done by entering the new value directly. For more detailed information
on variables, refer to the Motion Module MC20 Software User's Manual (SIEZ-C825-20.52).

13.5.4 Switching Screens

To display a large number of MC variables, the display area can be enlarged. The differences
between the two display modes are as follows:

s Normal Mode: Displays motion programs, variables, and current position.
-« Zoom Mode: Displays variables and current position.
The foliowing example shows how to switch to Zoom Mode.
1) Switch to the menu cursor using the Tab Key.

2) Select Zoom from the Screen Menu using the Cursor Keys and press the Enter Key.

Del All REFP ON OFF Con Dixp Taals Quit
creen 3 P4 F5 ¥6 Wﬂﬂ-ﬁ—”
Hormal [MCL O NO. : @5 MC PROGRAN EDIT T LANGUAGE :
UNIT : wm
LinchNQd] N NO . GL129_1.18% MAY LINE - 24

NGl [MUS ¥220. Z28B. F109.:

MB48  [MCW PRY ¥120. Y189. 158. JSO. F109.;
noU ¥1@. ZiS@.;

HBGA WIS X200. ¥Y3PO. F200.;

NB78

MS X320.Y108. F100.;
NOER |MUS Y15€. Z3ee. Fi5Q.;

[Current Positionl
+64.000 o]

LG BAE  [mnd
+185.688 (an]
-313.688  [me]

] 089S =
@ 20806 =
#0887 «

L -1 L

apyre 3
Mt

The screen will switch to Zoom Mode.

creen  Del All  REP O OFF Con Disp Tools Quit
'?'1-—-——!‘2———!’3——-—?*—-—?5——!6*—?7-“—?8-@—?9
20885 =
20896 =
20087 =

[-[.-1.2

ICurrent Positionl
X +64.000[nm]) ¥: +5609.0000[mn] Z: +1P5.688[nam) §3 -313.6800mm1
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13.5.5 Delete Screen

13.5.5 Delete Screen

All the currently displayed reference numbers and data can be deleted. Use this operation to

refresh the Variables Display Screen.

1) Switch to the menu cursor using the Tab Key.

2) Select Del All using the Cursor Keys and press the Enter Key.

creen ';EF ﬂ OI'F Con Disp - Tools Qli?
MODULE : MCL O HO. : 85  MC.PROGRAN EDIT t':ﬂ LANGURGE:
UNIT : mn
LinsM0O| N NO GL128_1.1P85 MAX LINE = 24
Nel@ |MOU Xi@8. Y200, Z25B.;
NBZB |MWUS ¥158. ¥250.5 F1B9.;

K838 |muS ¥228. Z288. F104.:
HCW PRY X120. ¥108. 158. J58. Fie8.;

NESE  [Mou ¥18. Z158.;

NEGB  [MUS ¥208. YI0G. F200.;
NE78  [WS X320.vi08. Fide.;
Wese |MUS Vice. Z3@a. PiSe.:

F ; [Current Poctitienl
IR @ To085 = 1 x: +64.008  Imml
flga= A 6% - @ ¥:  +5¢0.888  [mm]

£0087 « Z:  +105.688  [me)
§: 313680  Leal

3) A confirmation message will be displayed. Enter Y and press the Enter Key.

%nun Del All REF O IJPP Con D.isp Tooh Qu:.t
{HODULE : MCL O NO. : @S MC PROGRAN EDIT unIlIGE.
LineMO| N NO GL128_1.185 mAaX LINE = 24
[ ;PROG.S
2882 [N218 MU X190. ¥Y200. Z250.;
883 |[N228 |msS Xi50. 'lZSB.S nea..
a8a4 [N@3e  |mus 9228. zz F189.:
8885 |N@48 [MCW PXY X suaa. ite. J50. F104.;
Q986 19,
2ea?
ey
[Cl.u-rent: Pusiti.onl
4.800
~568 Bﬁa [nn]
+185.6 [nm]
-313. sm Tmn]

The Variables Display Screen will be refreshed.

croen Dtl_ﬁl.l_gu“_‘_ggl' cnu:ls_p_w_‘ Tools Quit
|MCDULE = MCT O NO. = @5 NC PROGRAM EDIT L IHE ! m%ﬂuﬁz:
: an
LineNG| N NO 5 GL120_1.185 MAX LINE = 24
o297 [Mgio  |MOu xiee. Yzed. Z25B.:
o883 [NBz@ |mus x:lSU. \'250 5 Pi8d.;
o884 [NE30 |WUS ¥220. Z780. F160.;
2805 |H8d40 |MCY m X120, Y100. 153 J50. F100.;
2886 |H85e |MoU X zi50.;
2087 |No68 2“. 3@. F200.;
2368 |N8?@ |MUS X320.Y108. F100.:
8887 |NEE8 WS Yi5e. Z389. PISB.-
i
[Current Position
[ s +64._BED
¥s: +568.888 [ml
z: +105_688 (€]
8: =313.689 (om]
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Editing Motion Parameters

This chapter describes procedures for editing motion parameters, and
other motion parameter operations such as writing data to a text file.

141 OVerview ....covverrnnrrenvocenennnnne. 1422

14.1.1  Motion Module Parameter Edit Screen ............. 14-2
14.1.2  Displaying the Motion Module Parameter Edit Screen . 14-3
14.1.3  Basic Input Procedures ......................... 14-4
14.1.4  Copying Parameter Data ...........0uvennnnn.. 14-6

14.2 Changing the Display ..........0000vuo... 14-8

1421 ChangingtheModule ........................... 14-8
1422 Switchingthe Axes ...........c.c0ovuinnnvnn.... 14-9
1423 Switching Functions .. .......................... 14-11
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1442 Exporting ...........c.cvininiinnnn, 14-17
1443 Importing ........o i, 14-18

—14-1 —



- Editing Motion Parameters

14.1.1 Motion Module Parameter Edit Screen :

14.1 Overview

This section describes the configuration of the screen for editing motion parameters and
basic input operations.

14.1.1 Motion Module Parameter EditScreen ............. .ot 14-2
14.1.2 Displaying the Motion Module Parameter Edit Screen ............ e 14-3
14.1.3 BasicIlnput Procedures ................. e 14-4
14.1.4 Copying Parameter Data

................ 14-6

14.1.1 Motion Module Parameter Edit Screen

Seiect Parameter from the Motion Submenu of the Main Menu. The MC Parameter Edit
Screen will be displayed.

Lluin Select PFunction Axis Default Textfile Iools
[F1l ———F2——F3 ey e~ T8 ]
MC PARAMETER EDIT

| DESCRIPTEON
|

NOT USED
AXIS 1 DESIGNATION

NO

reBes

PoBE1

reeaz

PaBs3

PBEB4 |AXIS 4 DESIGNATION
Iraaas ECIMAL

by eeed

repe7?

Peses

Pesp? |ITR LIN ACC/DEC GW SP
rgaie |IIR EXP DEC CONST
Padil |IIR H]’ ACC/PEC G(“T
PeR12 |ITR EXP ACC/DEC B

Pea13 |IIR HW AUG TINE cousr

1. File/Module Name

When operating in Offline Mode, the file name of the currently displayed parameters is
shown. The configuration of the file name is as follows:

GL120

.1PM
’ Parameter File
Module Number
1: Module 1; 2: Module 2
Name of the File Selected using Select Program

While in Online or Debug Mode, the currently selected Motion Module is displayed as MC1 or
MCz2.

2. Parameter Type

Thetype of parameter currently being displayed is shown. The following five types of parame-
ters can be displayed.
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14.1 Overview

» Common: Parameters common to the Module.
o 1 Axis: Parameters for the first axis.

» 2 Axis: Parameters for the second axis.

» 3 Axis: Parameters for the third axis.

* 4 Axis: Parameters for the fourth axis.

3. Parameter Data
The parameter data that has been entered is displayed.

14.1.2 Displaying the Motion Module Parameter Edit Screen

The MC Parameter Edit Screen is displayed by selecting Parameter from the Motion Subme-
nu of the Main Menu. The following example shows the procedure used to display the screen
from the Ladder Editor Screen.

1} Switch to the menu cursor using the Tab Key.

2) Select Motion from the Main Menu using the Cursor Keys and press the Enter Key.

Elements Edit Go/Srch Network Ref Toels Quit
F3 P4 F5 Fe F7-{Ie-Fe - —FY

ney 1

in Menu

et sgureci
ni tian
Sladder

PEdit Comment
Ref Data

Rafsrence Data

![
Format :Decimal File Data Range = 1

3} Select Parameter from the Motion Submenu using the Down Cursor Key and press the
Enter Key.

Elemats Ed:l.t GosSrch Metwork BRef Tools Quit
:’% Menu TP - Fe - I —FY

Gonhsuutmn —-1—( )‘—

Ilution Prn >—
—-nt 2832019
lhf Data d—
Ihn:ttor 880828
llcl'lt >—

IIC'I'R

Reforences Data

- Pormat :Docimal Pile Data Range : 1

The MC Parameter Edit Screen will be displayed.
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Editing Motion Parameters .
14.1.3 Basic Input Procedures

14.1.3 Basic Input Procedures

Parameter data is input by moving the cursor to the position of the parameter to be changed
and entering the data.

1) Move the cursor to the position of the parameter to be modified using the Cursor Keys.

2) Enter the data (300 in this example) and press the Enter Key.

hin Selact Function Axis Default Textfile Tools Quit
—p2————F3———F g —————F7 - F - VP
NG PARAMETER EDIT
Pilenams: GLI28_1.1PH
[ Common 1
wo. | DEscriPTiON SET UALUE UNIT RANGE
PBOOB |NOT
PBBAL |A%]S 1 DESIGNATION * XYZSAPCDPQ
POGAZ |AXIS 2 DESIGNATION ¥ XYZSABCDPQ
PBAB3 |AX1S 3 DESIGHNATION z RYZSAECD!
8984 |A%X1S 4 DESIGNATION s RYZSRBCDPR
P985 |DECIMAL POINT 3 1-3
P8886 |1 FEED MAX SP SET 24008 |me/min i - 240898
PEBE7 |ITR LIN ACC/DEC T A ne 1 - 10988
Feds |1TR LIN ACC/DEC 186 |ns 1~ 18888
Peee? |ITR LIN ACC/-DEC 5W 5P 248808 | me/nin B - 249908
Peg18 |1TR HON-EXP DEC COMST 188 |ns 1 - 19888
Pe@1i {ITR EXP ACC/DEC COMST 108 |ne 2 - 1008
PE@12 {1TR EXP ACC/DEC RIAS @|masmin @ - 240808
PEE13 {ITR MOU AUG TIME CONST 198 |ms 2 - 1868

The input will be confirmed and the cursor will move to the next line down.

Main Select Function Axis Default Textfile Tools Quit
F{— p2—— F3——F ———Pg— b7 L PO - A
MC PARRMEIER EDIT
Filename: GL128_1.1PM
[ Common 1
w. | DESCRIFTION SET UALUE UNIT RANGE
reses |NoT USED
POORL |AXIS 1 DESIGMATION X YZSABCOPY
PORSZ |AXIS 2 DESIGNATION ] XYZEABCDPQ
PBB83 |AKIS 3 DESICHRTION z ABCDPG
Peass |AX1S 4 DESIGNATION 5 XYZEABCDPQ
PeBeSs |DECIMAL POINT 3 1-3
PGPS |INTRPL FEED WX SP SET 24083 |me/win 1 - 240008
- P8e6? |11R LIN ACC/DEC CRSTL 308 |ns 1 < 1eese
PEB0s |1TR LIN WCC/DEC CNST2 T | ns 1 - 10008
PEoRy |ITR LIN WCC/DEC EW SP 24868 | an/min 8 - 248399
P@AL@ |ITR NOM-EXP DEC CONST 108 |ms 1 - 18389
PaAii |ITR EXP RGC/DEC CONST 188 |ms 2 - 1983
peai2 (ITR EXP ACC/DEC BIAS 9 |mamin 8 - 24pan8
PEG12 |ITR HOU AUG TIME COMST 108 |ns 2 - 1960
|
O[E]E]P In addition to the Enter Key, the Up and Down Cursor Keys can also be used to confirm the

input. For example, after entering the parameter data for PO006 and pressing the Up Cursor
Key, the data for PO00S6 will be changed and the Up Cursor Key will move to the position of
PO000S.
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14.1 Overview

M

Bit parameters can be set using the bit setting screen.

1) Move the cursor to the position of the bit parameter using the Cursor Keys and press the

Enter Key.
in Select Punction fAxis Dafault Textfile Toels Quit
[F1 = ——P2: 3 o F5 F6 7 - -8 - Sd--—F9
MC PARAMETER EDIT
Filename: GL12@_1.1PH
[No 1 axiz)

NO, DESCRIPTION SET UALVE UNIT RANGE
P15@1 |ENCODER PULSE 2048 {MULSE 1 - 32%8
P1582 |ENCODER FLS $£1G SELECT 4 1 2 4 MLTPLY
P1563 |MACHINE FER UNIT 182908 [UNIT 1 - 1588098
P1584 |GEAR RATIO SETCMOTOR)> i 1 - 19002988
P1585 |GEAR RATIO SET CMACHINE 1 1 - 19906880
P158¢ |MODE SET FW/RU FNI/INF LN/RO{8-31(h—4>
P1587 |BACKLASH COMPENSATION PULSE a8 - 3277
P1588 |STORED STROKE LIMIT(+> 99922999 JUNIT 29999999
P150% [STORED STROXE LIMIT(-> -79999999 [UNIT 7999999%
P151@ |FUNCTION SELECT 2 8|@:NOT USED 1:USED |bd:L$ =K
PiS11 {MAX ROTATION SPEED 3088 | r/min 100 - 4588
P1512 |MAK DA OUTPUT 6iv 1 - 18
P1513 |MOTOR SPEED LIMIT 4008 | r/min 2 — 18680
P1514 [AUTO ZERO ADJUST CONST 1808 [ns 1088 - 979

2) The bit setting window will be displayed. Move the cursor to the position of the parameter
to be modified using the Cursor Keys. Enter 0 or 1 and press the Enter Key.

Main Select Function Axis Dafault Textfile Tools fuit
[F1——————f2 3 T4 5 i 7P -T—F9
MC PARAMEIER EDIT
Filsname: GL128_1.1PH
INo 1 axis)
NO. DESCRIPTION SET UALVE uNiT RRNGE

ENCODER PULSE H MILSE
I.Mi UNIT

]| FW~RY PNT/INF LH/RO
Bl POS.:Nane  ON/OFF  Renarks

W:inotor reu. 6] Husl 1:CU
L O TR GC (W sFinitesinfinite W :Finite 1:zanfinite
mx bR QUTPUT b2:linear/rev. linear 1ipev.

MOTOR SPEED LINIJGREFPET IR trervg 1iunlt. output
AUTO ZERD ADJUSTIEEHTIINTE iCI'F 0N

3) Now move the cursor to the last line. Press the Enter Key to confirm the input, and the bit
parameter editing will be complete.

in Selsct Functiom Axic Default Textfile Tools Quit
k—n—-——n P4 5 76 7~ F8-d3—F9
NC PARRMETER EDIT
Filename:= GL12& 1.1PH
[Ho 1 axis)
NO. DESCRIPTION SET UALVE " UNIT RANGE
P1581 |ENCODER PULSE 2048 |PULSE 1 = 32768
P1582 [ENGODER PLS SICG SELECT 12 4 MLTPLY
P1503 |MACHINE ROT PER UNIT 182898 |UNIT 1 -~ 15
Pi5@4 |GERR RATIO SET<MOTOR> 1 1 - 1
P15@5 |GERR RATIO SETCMACHINE 1 1 - 1PE8E2H0
Pi5S@86 |MODE SET BIFU/RY FNI/INF LM/RO|8-31(bd—4)>
P15087 |BACKLASH COMPENSATION PILSE 8 - 32767
P15688 |STORED STROKE LIMIT(+> UNIT 29999999
P15@9 |STORED STROME LIMIT<-)> -999999%9 |UNIT +39999999
P1518 [FUNCTION SELECT 2 B|@:NOT USED 1:USED |b8:LS bi:BK
P1511 [MAX ROTATION SPEED 3880 |»/ain 28 ~ 4508
P151 max DA OUTPUT 6]v 1 -18
P1513 |MOTOR SPEED LIMIT 4088 | r/win a - 188988
I P1514 |AUTO ZERO ADJUST GONST 1888 | ns 1088 - 9997y
OIJIIEID When naming axes, two axes cannot be specified by the same name. If, for example, the ini-

tial settings are X, Y, Z, and S, and if these are to be changed to S, Z, Y, and X, two S's will
occurwhen X is changedto S, resulting in an error. In such a case, it is betterto change allthe
axes’ names to “=" before setting them.
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Editing Motion Parameters
14.1.4 Copying Parameter Data

The following is a summary of the keys used to edit parameters.

Move the cursor around when no data has been entered. If
the Up and Down Cursor Keys are pressed when numerical
values have been entered, the input of the data is confirmed
and the cursor moves to the next line.

(4]
)
(]

1
Confirms the input of data and moves the cursor to the
location of the next parameter one line down. If it is pressed
when no data has been entered, the cursor simply moves
one line down.

Cancels input if pressed while data is in the process of
being entered. As a result, the previous data before the
input is displayed. If this key is pressed when no data has
been entered, the program exits parameter editing.

Displays the previous 14 lines of data before the currently
displayed parameter data.

Displays the next 14 lines of data after the currently
disptayed parametér data.

Moves the cursor to the top of the currently displayed
parameter types. As a result, the common parameters are
displayed, from P0O000 to PO013, with the cursor at the
location of PO0OQ. -

Moves the cursor to the end of the currently displayed
parameter types. As each parameter has a reserved area,
parameters that do not basically have to be set are
displayed. .

PR e

14.1.4 Copying Parameter Data

The parameter data for one axis can be copied to another axis. The following example shows
how to copy parameter data from the 1 axis to the 2 axis.

1) With the parameter data for the 1 axis displayed, switch to the menu cursor using the Tab
Key.

2) Select Copy from the Axis Menu using the Cursor Keys and press the Enter Key.

l'hin Select Function Default Textfile Tools Quit
[ e PR ———— P} ————Fp————— X1y — - - —FY
NC PAR} Common
wi Axis Pilename: GL120_1.1PM
[} 2 Axis
3 fAxis
NO. DESCRIPTION SET| 4 Axis UNIT RANGE
P11@1 |POSITION LOOF GAIN [ ] Efm!ﬂ 1 - 288
P1182 |PEED PORWARD GAIN —_— a ~ 200
P1183 (POSITIONING RANGE 18 |UNIT a - 19608
P1184 |POSITIONING CHECK TIME 198800 | nx @ - 108980
P1185 [POSN BEVIATION MRGIN 208 |« ? - 208
P1186 a —+79999999
Piig? a -+99999992
fe bl ] ] -+9999999%
Pi189 ] -+99992999
Pii11@ -] -+9999999¢
Pl111 a -+99999999
1112 a -+999999992
P1113 a — 499999999
Pii14 [} —+99999999
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4.1 Overview

3) A submenu will be displayed for selecting the copy destination. Select To axis #2 using
the Cursor Keys and press the Enter Key.

in Sslect Function m Pefault Textfile Tools Quit

k!:—-—rz—-q Fé: Axis 7P - —F9
NC PAR| Common
" Axis Filenamse: GL128_1.1PNM
| 2 Axis
[ wo DESCREPTION SET| 4 Auts ——Co —— RANGE
. X
oo lxgi £1

P18 JPOSITION LOOP CAIN li Default 1 - 200

P1182 |FEED PORUARD GAIN o axiz 8 - 288

P1183 |POSITIONING RANGE 10} To axis %4 . |8 - 10888
i P1i8d |POSITIONING CHECK TIME 100008 || To all axes a2 - 100000

P1185 |POSN DEVIATION MARGIW 208 | a - 208

P1106 a2 yye9

P11B? ] 9999

P118¢ -] 9999

F118% a + 9999

P111Q -] 399999

P1111 2 +999999

Pl112 a +999799

F1113 a + 9

Pli14 ] —+9999999%

4) A confirmation message will be displayed. Enter Y and press the Enter Key.

Llni.n Selsct Function Axis Default Textfile Taols Quit
I —— P2 ——p3 ¥4 5 6 F7- WP -TE—ry
MC PARAMETER EDIT
Filenams: GL120_1.1PM

i [Ho 1 axis)

no. DESCRIPTION SET UALE | uNIT RANCE

P1181 |POSITION LOOP CAIN 1/8 1 - 208

P11z |FEED PORWARD GRIN _ﬂ % 8 - 208

P1183 |POSITIONING RANGE 18 JUNLT 4 - 10088

P1184 |POSITIONING CHECX TINE 100688 [ms 8 - 188808

P1185 |POSN DEVIATION MARGIN 208 x a - 208

P110¢

Piie?

Piies

P11

Pi118

P1111

P1112

P1113

Pi114

The parameter data will be copied.

OIIIEEID 1) The Copy operation will not work if the common parameter data is displayed. Make sure
to switch to the display of the axis set with the data to be copied before performing the
Copy operation.

2) See section 14.2 Changing the Display for details on how to switch to display the axis. 14
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Editing Motion Parameters

m

14.2.1 Changing the Module

14.2 Changing the Display

This section describes changing the parameters being displayed, such as switching the
Module or the axis.

14.2.1 Changing tﬁe Module
14.2.2 Switchingthe Axes ..................... ettt iaetaae s
14.2.3 Switching Functions '

14.2.1 Changing the Module

..............................................

..............................................

This operation changes the Motion Module. The foilowing example shows the procedure
used to switch from Module 1 to Module 2.

1) Switch to the menu cursor using the Tab Key.

2) Select Module from the Select Menu using the Cursor Keys and press the Enter Key.

Pain Function fixis  Default Textfils Tools  GQuit
i aloct———F5 ———F7-- P8 -NiE—FY
nC PARMMETER EDIT
Filename: GL128_1.iPH
[ Common 11

wo. |  DEscRrrTION SET VALUE | UNIT RANGE
Poese [wot -ql
Pee8L |AXIS 1 DESIGNATION XYZSABCDPQ
Posez |AXIS 2 DESIGNATION ¥ X¥ZSABCDPY
POBa3 I DESTCNATION z XYZSABCDPG
POBB4 |AXIS 4 DESIGNATION $ X¥ZSADCDPY
Pepes |DECTHAL POINT 3 i-3
PO@eS |INIRFL FEED MAX SP SET 24008 [am/min 1 - 240608
Paga? |ITR LIN QCC/DEC CMST1 389 |ws 1 - 16889
Paoes |1TR LIN GCCDEC CHST2 160 |ne 1 - 16888
P8y |IIR LIN ACC/DEC SW SP 2 na/nin 8 - 248080
PBa1® |ITR NOW-EXF DEC COMST 109 |ns 1 - 16008
PBE11 [ITR EXP RCC/DEC CONST 109 2 - 1982
Peaiz |ITR EXP #CC/DEC SIS 2| wmrmin 8 - 248008
Peai3 |ITR HOU AUG TIME COWET 108{ne 2 - 1608

3) Asubmenu will be displayed. Select MC2 using the Cursor Keys and press the Enter Key.

k Punctian md.: h%ok Quic
RRH:EIEI EDIT
m.' Filsname: GL120_1.1PH
[ Common 11
[ I DESCRIFTION SET UVALVE UNIT RANGE
PE98A [NOT —
PE8B1 [AX]IS 1 DESIGNATION RYZSABCDPQ
POAB2 |AX1IS 2 DESIGNATI ¥ XY ZSABCDPQ
PABA3 [AXIS 3 DESICHATION 4 ¥YZSABCDPQ
PREE4 |AA1S 4 DESIGNATI 8 X¥YZSABCDPQ
PB@8s |DECI POINT 3 1 -3
PUSes |INT FEED X SP SET 24600 |mm/min 1 - 249088
FEP87 |1IR LIN ACC/DEC CNST1 300 |nz 1 - 18888
PEOBE |ITR LIN ACC/DEC CNSI2 100 |ms 1 - igees
PBRBY 1ITR LIR ACC/DEC SW SP 2 -n 2 — 249898
Feaie {I1TR EXP DEC COMST 108 |ns 1 - 10028
P11 |ITR EXP ACC/D CONST 188 |ns 2 - 1088
PABL2 |ITR EXP ACC/DEC BIAS 3| ann 8 - 240008
PBRLI |ITR MOV AUG TIME CONST 198 [az 2 - 1688
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m_

4) A confirmation message will be displayed. Enter Y and press the Enter Key.

£n Selsct Punction Axis Default Textfile Tools Quic
P2 Fa P4 5 b7 - T8 -1l —F%
F NC PARAMETER EDIT
Piloname: GL129_1.1PM
[ Common 1] -
WO, DESCRIPTION SET UALUE UNIT RANGE
PBB38 INQT USED [ ]
PB8aL |AXIS 1 DESIGHATION X XYZEABCDPG
POBE2 |AXIS 2 DESIGMATION ¥ XYZSABCDPQ
POBAZ |AXIE 3 DESIGNATION 4 XYZSRBCDPG
FOBB4 IAXIS 4 DESIGNATI [ XYZSABCDPQ
PBBAS |DECIMAL POINT 3 -3
PBBB6 RP1, FEED MAX SP SET 24898 |nn/nin 1 - 240988
PBB8? |ITR LIN ACC/DEC 308 |ms 1 - 18889
Pooes |ITR LIN ACC/DEC 100 s 1 - 16680
PO8@% [I1TR LIN ACC/DEC £V SP
PRO1® {ITR NON-EXP DEC CONST

PBBtL |ITR

The parameter data for Moduie 2 will be displayed.

in Select Function fAxis Default Textfils Tools Quit

—_— 3 P4 5 F6- F7— T Pe-JET—
h NC PARAMETER EDIT
Pilename: CL120_1.2MM
[ Common ]}

HO. I DESCRIFTION SET VALUE UNIT RANGE
PEBBR |NOT USED q
POGUL |AXIS 1 BESIGMATION |X¥ZSABCDPY
POBO2 |AXIS 2 DESIGNATION b4 [XYZSABCDPG
POBA3 1AXIS 3 DESIGNATION z XYISABCDPQ
PBB84 |AXIS 4 DESIGNATION £ XYZSABCDPQ
PR2G5 |DECIMAL POI 3 -3

PRBBE [INIRFL FEED WaX £F SET 24008 |mn/nin 1 - 248868
PFaBR? [1TR LIN ACC/DEC CNSI1 180 |ns 1 - 18889
P83 [ITR LIN ACC/DEC CNST2 189 |ns 1 - 189888
B8Ry |ITR LIN ACC/DEC SV SP 24888 [nm/min 0 — 248888
POEL8 [ITR NON-EXP DEC CONST 189 | ms 1 - 18888
Pedit |ITR EXF ACC/DEC CONST 100 | ms 2 - 18088
PB@12 |ITR EXP ACC/BEC BIAS B |marnin 8 - 2488889
PBE13 [ITR MOV AVG TINE CONST 106 | ns 2 - 188Q

OITHEID When the changes to the currently displayed parameters have been made, a message will be
displayed asking whether to save the edited data. To save the data, enter ¥ and press the

Enter Key.

14.2.2 Switching the Axes

Parameters can be classified into the following groups: Parameters common to all axes and
parameters for each of axes 1 to 4. The following example shows how to switch common pa-
rameters to parameters for the 1 axis.

1) Switch to the menu cursor using the Tab Key.
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Editing Motion Parameters
14.2.2 Switching the Axes cont.

2) Select 1 Axis from the Axis Menu using the Cursor Keys and press the Enter Key.

in Select Punction TPWENEE Defaule Textfile Tools Quic
h?——m 3 F4 fAxis 7R 8=
MC PFAR{mCommon
Filename: GL120_1.1PN
- 4 Ax
3 Axit
w. | DESCRIPTION SET| 4 Axie UNIT RANGE
Py

PBBBE |NOT USED 8| Defauie
PEBAL |RXIS 1 DESIGMATION ABCD!
PROAZ |AXIS 2 DESIGNATION ¥ |x¥ZsnBcoPa
POEO3 |AXIS 3 DESIGNRTION z XYZSABCDPQ
POBB4 |AXIS 4 DESIGNATION £ XYZSABCDPQ
POBIS |DECIMAL POINT 3 ‘ =3 li
PBOO6 |INTRPL FEED Max SP SEX 24908 |ma/min 1 - 249008
Feed? |IIR LIN ACC/DEC CHST1 308 |ns 1 - 19888
PEOBBS |ITR LIN ACC/DEC 108 | . 1 - 10000
PGO? (ITR LIN ACC/DEC SV 5P 24800 |mmmin I8 - 240000
PEE18 |ITR NON-EXP DEC CONST 188 |ns i 1 — 18080
PeRi1 |ITR EXP W 108 {ms : 2 - 1980
P@@12 |ITR EXP WCC/DEC BInS 8| nemin @ - 2490089
PEB13 {ITR MOV AUG TIME CONST 100 |ns 2 - 1008

]
The parameter data for the 1 axis will be displayed.
ki.n Sslect Punction Rxis Dafaulr Textfile Tools Quit
—_—p———73 PO} TR
MC PARAMETER EDIT ,
Filename: GL129_1.1PM
[No 1 axis]

No. DESCRIPTION SET VALUE | UNIT RANGE
Pii@1 |POSITION LOOP GAIN |1z 1 - 208
Pi182 |FEED PORUARD cAIM % ? - 208
P1183 |POSITIONING RANGE 1@ |UNIT 2 - 192888
Pi184 |POSITIONING CHECX TIME 192960 |ns @ - 1
P110S |POSN DEVIATION MARGIN 208« )
P1186 1 +99999999
F1197 [ 99999999
Pi1se 8 39999999

1 . +999999%9
F1118 MR +9999799%
Pilit 8 499999999
P1112 ] +99999999
P11i3 s —+99999999
P1114 . 9999999

If, for example, 2 Axis is chosen from the Axis Menu, while displaying the 1 axis parameters,

the same parameters as for 1 axis will be displayed. For example, if the parameters for #1201
{velocity, acceleration) on the 1 axis are being displayed, the parameters from P2201 will be
displayed for the 2 axis.
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14.2 Changing the Display

14.2.3 Switching Functions

The parameter data for each axis is broken down by function, as shown below.

PA101 Positioning parameters
PA201 Not used
Speed/Acceleration parameters
PA301 Not used
Home Position Retum parameters

"7 777 Notused

PA401 Absolute Detecting System parameters
"""" Notused |

PASO1

Machine System parameters

© 77 Notused
PAGO1

Servo parameters
"""""""""""""""" A = Axis number
Not used {from 1to 4)

Move the cursor around. When the cursor is on the last line,
the screen scrolls to the next parameter.

i

Displays the previous 14 parameters before the parameters
currently shown.

Displays the next 14 parameters after the parameters
currently shown, )

Displays the next function after the currently displayed

CTRL + function from the first line. For example, if the Homing

parameters are currently being displayed, using these keys 1 4
will change the display to the Absolute Detecting System
parameters.

Displays the previous function before the currently displayed
CTRL + function from the first line. :

Displays from the first parameter (PA101) onwards. It can
also be used to display the Positioning parameters,

Displays the last parameter. Therefore it can also be used to
display the Servo paramsters.

The following example shows how to use the Ctrl + Page Down Key.
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Editing Motion Parameters
14.2.3 Switching Functions cont,

Display the Position parameters for the 1 axis. Pres$ the Ctrl + Page Down Key.

kh Select Punction Rxix Default Textfile Tools Quit
— P ———F ———F6————F 7 P - A —F9
NG PARRMETER EDIT
Filename: GL128_1.2PH
[No 1 axis]

NO. PESCRIPTION SET VaLUE | UNIT RANGE
P11@1 |POSITION LOOP GRIN 1/% 1 ~ 2808
P1182 |FEED FORWRD GAIN H 2 - 298
P1183 |POSITIONING RANGE 18 |UNIT @ - 18808
P1184 |POSITIONING CHECK TIME 106088 |ns : 8 - 108008
P118S |POSN DEUIATION MARGIN 208 |2 o - 208
PLig% . ] -9
P1187 -] )

Pi1068 ] —+¥
Fi11089 [ ]

PF1118 a

Piiil a

P1112 ] -
F1113 ) =
Fi114 9 -

The Speed/Acceleration parameter will be displayed.
in Select PFunction fxis Default ;Textfils Tools Guit
—F2—F3 ———— P iG-Fa - —F?
MC PARAMETER EDIT
Filenane: GL120_1.2P1
[No 1 axisl} .

w. | rescrirrion SET VALWE | UNIT RANGE
P1281 |MRX FEED SPEED I—/hi.n 1 - 249898
P1202 |PEED SPEED -W m/min 1 - 248888
P1283 USED 8 . - 499999999
P1284 |LIN RCC/DEC CONST<1) 100 |mz 1 - 1808828
P1285 |LIN ACC/DEC b 188 |ns 1 . 1 —~ 19888
P12@6 |LIN ACC/DEC CWST SV SP 24908 |an/min 9 - 248808
P12@87 |NON-EXP DEC TIME CONST 109 |nx 1 - 18388
P1288 |NOT USED L] —+9999999Y
Pi28Y |EXP RCC/DEC TIME CONST 108 |ns 2 - 1008
P1z18 |EXP ACC/DEC BIRS SP 8| an/min 8 - 249808
F1211 |MOVE 8UG TIME COMST<1)> 100 w3 2 - 1800
P1212 |WOT USED —+9999999%
P1213 E RCCEL-/DECEL S$ET 1 a-13

214 |JOG/STP RCC-/DEC SEI i |B -3

in addition to switching the function using keyboard commands, the function can be switched
fromthe menus. The following example shows how to switch from the Positioning parameters
to the Servo parameters.

1) Switch to the menu cursor using the Tab Key.

2) Select Servo from the Function Menu using the Cursor Keys and press the Enter Key.

Main Selnct w Axis Default Textfile Tools Quic
M ———f————p— P unction g—mm-m——ps
IO
wPoszition Filename: GL120_1.2PH
UelocitysAccel
Homing
NO. DESCRIPTION Ahsoluts UNIT RANGE
Machine
Pi1181 |POSITION LOOP GAIN P 1 — 288
F1182 |FEED FORWARD GRIN ault 9 - 289
P1183 |POSITIONING RRNGE NIT 8 - 10028
P1194 |POSITIONING CHECK TIME 100858 jmz 2 - 180880
[F1165 {POSN DEUIRTION MARGIN 200 x e — 289
P1186 [} —+9999999%
1167 ] 99999999
P1168 [} +99999999
P1169 ] +9999999%
Piii@ a +9999999%
Pi111 a +99
1112 8 —+99
P1113 ] ~+99
Pi1114 8 *99
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142 Changing the Display

M

The Servo parameters will be displayed.

h;ln Selsct Function Axis Dofault Textfile Tools fuic
— 23— P4 %, 6 —————F7- G- FE -5
MC PARAMETER EDIT
Filename: GL120_1.2MM
[No 1 axis]

w. | pEscarrrion SET VALVE | UNIT RANGE
P18t |PUNCTION SELECT 3 _Ha:uor USED 1:USED |b8:0T bi:BRX
Pice? |BRAKE TIME ne 8 - 1988
P1683 |BRAKE-ON MOTOR SPEED 1 fesmin 1 - 19880
P16 ] $999
P1605 8 9999
P160OG e +399399
PleE? 0 9993
P1683 [ +999999

& a +39999999
P1618 8 +99299999
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Editing Motion Parameters
14.3.1 Initializing All Parameters

14.3 Setting Default Parameters

This section describes the procedure for retummg parameters to their default settings
while in Offline Mode.

14.3.1 Initializing All Parameters ............... e 14-14
14.3.2 Initializing Selected Parameters .......... e eaeaas 14-15

14.3.1 Initializing All Parameters

While in Offline Mode, use the following procedure to retum the parameters for all the current-
ly selected Modules to their default settings.

1) Switch to the menu cursor using the Tab Key.

2) Select All from the Default Menu using the Cursor Keys and press the Enter Key.

in Select Punction Axis Textfile Toaols Quit
— P viin P e il e Py ault— —EIF-FE -]
NG PRRRNETER ED &[F
elect [Filaname: GL120_1.2PH
[ Common ]
[w. ] vescrirrion SET VALUE UNIT RANGE
Peooa |WOT USED ]
PPOEL [AXIS 1 DESIGMATION X XYZSABCDPQ
POOEZ [AXIS 2 DESICNATION ¥ RYZSABCDPQ
POOB3 |AXIS 3 DESIGNATION z ZSABCDPQ
PoBB4 |AX1IS 4 DESIGNATION 1 RYZSABCDPQ
P8ees |DECIMAL POINT 3 -3
POOO6 MK P 24888 [manin 1 - 240000
PeaE? |ITR LIW ACC/DEC CNSTL 380 [ms 1 - 16008
PEBBE |ITR LIN ACC/DEC CNS' 188 Ins 1 - 19988
PRe89 |1TIR LIN ACC/DEC SW SP 24008 | min 8 - 248000
PEALA |1TR NON-EXP DEC CONS 100 |nx 1 - 18608
Peail |ITR EXP ACC/DEC CONST 198 |ns 2 - 1888
Peas? |1TR EXP ACC/DEC BIaS 8 {me/min 8 - 246808
PE813 |1TR MOU AUG TINE CONST 109 |me 2 - 1689

3) A confirmation message will be displayed. Enter Y and press the Enter Key.

b:in Select Punction Axis Default Textfile Tools Quit
MC PARANETER EDIT
Filename: GL128_1.2PH
[ Common 11
HO. l DESCRIPTION SET VALVE UNIT RANGE
PRERA |NOT USED | ]
PABB1 |AXIS 1 DESIGMATION ] REYZSABCDPQ
PRBB2 |AXIS 2 DESIGMATION ¥ YZSABCDPQ
PRBE3 |AXIS 3 DESIGHATION z KYZSABCDPQ
PORa4 GNA H XY ZSADCDPQ
PROES
POBRE
PORA7
bt
b easd
Peaie
POBLL
PaaL2
POBL3
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14.3 Seiting Default Parameters

fmro I

4) Module 2 is used in this example, so all the parameter data in Module 2 will be returned to
the default settings.

in Select Punction Axis Default Textfile Tools Quit
—_———p3 P4 5 76 F7- (RO Fe - a—F9
MC PARAMETER EDIT
Filenane: GL128_1.2PN
I Common 1

HO. DESCRIPTION SET VALVE | UNIT RANGE
PO9EA |NOT USED |
PPOEL |AXIS 1 DESIGNATION — XYZSABCDPG
P@BEZ |AXIS 2 DECIGNATION ¥ XYZSABCDPQ
Poea3 qlﬂls 3 DESIGNATION z RPZERBCDPQ
P@984 [4XIS 4 DESIGMATION s XYZSABCDPQ
P20Es |DECIML POINT 3 -3
PPBeG6 {INTRPL FEED W% SP SET 24000 | nmmin 1 - 240808
PBPa7 |ITK LIN RCC/DEC CHST1 108 |ne 1 - 1p608
Peoet |ITR LIN ACC/DEC CNST2 198 [as 1 - 10008
Poee? |1IR LIN ACC/DEC SV $F 2408 [ men/min @ - 248800
PBRIA (ITR NON-EXP DEC CONST 108 s i - 18099
POB11 |ITR EXP ACC/DEC CONST 188 ms 2 - 1888
Pe@iz |ITR EXP ACCDEC BIAS &|namin 2 -~ 248089
POB13 [ITR MOU AUC TIME COMST 100 s 2 - 1908

Parameters can also be retumed to their default settings while in Offline or Debug Mode using
the MC Ope Menu. See section 13.2 Motion Module Operations for further details.

14.3.2 Initializing Selected Parameters

Each axis can be initialized separately to return the parameters for them to their default set-
tings while in Offline Mode. The example below shows the procedure used to initialize the
parameters of a single axis.

1) Switch to the menu cursor using the Tab Key.

2) Choose Select from the Default Menu using the Cursor Keys and press the Enter Key.

in Select Punction fixis Textfile Tools Quic
hj‘.—-——n———n——p e PANLCEITER Em:}lnu!e - - —FY
Filename: GL128_1.2PH
[ Common 1
M. | bEschirTion SET VALUE uNIT RANGE
] ED q
PBO81 anls 1 DESIGNATION XYZSABCDPQ
POOB2 [AX PESIGHATION ¥ XYZSABCDPQ
POOE3 [AXIS 3 DESIGNATION z XYZSABCDPQ
POBA4 {AXIS 4 DESIGNATION [ XYZSHBCDPQ
Pe8Es |DECIMAL POINT 3 -3
PBEB6 |INTRPL FEED MAX SP SET 24908 | me/min 1 - 240808
Paga? |ITR LIN ACC/DEC CHST1 188 1 - 19a08
PAOBE [ITR LIN RCC/DEC CNST2 188 1 — 18888
PeBe? {iTR LIN ACC/DEC SV SP 24088 [me/min 8 - 240009
PBALB |ITR NON-EXP DEC COMST 108 |ms 1 - 19828
PRBL1 |ITR EXP ACC/DEC CONST 168 ns 2 - 1888
PB812 [I1IR EXP ACC/DEC BIAS Blam/min @ -~ 248088
P8813 [ITR MOV AUG TIME COWST 198 |ms 2 - 1888
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Editing Motion Parameters
14.3.2 Initializing Selected Parameters cont,

3) A submenu will be displayed. Select 1 Axis usmg the Down Cursor Key and press the

Enter Key.

in $ocloct Function RAxis chtfile Tools Guit

%—n——n—r -7

HC PARRMETER ED nn e ct—
TTATTNI| Commen = GL12@_1.2PH
[ Common ] — x
x
w. | DESCRIPTION $ET UALUE 3 fxis RANGE
%
POBBA INOT USED -q
POBA: |RXIS 1 DESIGNATION XYZSABCDPQ
PREE2 {AXIS 2 DESIGMATION 4 YZSABCDPQ
POARI JAXIS 3 DESIGMATION F4 XYZSADCIPQ
Poae4 4 DESIGNATION s XY ZSABCIPQ
P85 |DECIRAL POINT 3 1 -3
PEBESL MAxX SP SET 24088 |an/nin 1 - 242888
PBEE7 IN EC T1 108 {ns 1 - 10008
POB8S |ITR LIN ACC/DEC CNSI2 1908 |ns i - 19080
PROOT !ﬂ! LIN HMEC S\l SP 24000 | me/min 8 - 240800
roais NON-EXP 106 |ns 1 - 10008
roall ITR EXP Hmﬁc mr 188 |ns 2 - 1008
Po@12 |ITR EXP ACC/DEC BIRS |4 in a - 240880
POE13 |ITR MOU RUG TIME CONST 106 |ns 2 - 1008
1

Module 2 was selected in this example, so only the Module 2 parameter data forthe 1 axis will
be initialized.

OIITEID 1) Initialization of parameters for a single Module and axis is not possible in Offline or Debug
Mode.

2) Parameters can also be initialized for a single Module and axis by displaying the parame-
ter data for the axis to be initialized, and selecting Default from the Axis Menu,
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H
14.4 Text File Operations

This section describes the procedures used to write parameter datato a textfile and read
a file created on a standard text editor.

14.4.1 TextFile Formats................ e iiaae e 14-17
1442 EXPOMING ...ttt i i e 14-17
1443 IMPorting . ... 14-18

14.4.1 Text File Formats

Parameter data created on MEMOSOFT can be saved to a text file. The text file can then be
edited on a standard text editor. Conversely, data created on a standard text editor can be
read to MEMOSOFT as parameter data. The format of a text file is shown below.

PXXXX, XXXXXXXXX,

Parameter Data (8 characters max. +sign)
Parameter Number

The actual file data is as follows:

P0O000, DEMO,
P0O001, X,
P0O002Z, Y,
PO00C3, Z,
P0O004, s,
P0O0OS, 3,

0.

PO00OS, 3000

P4610, 0,

14.4.2 Exporting

Use the following procedure to write to a text file.

1) Switch to the menu cursor using the Tab Key.
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Editing Motion Parameters
14.4.3 Importing

2} Select Export from the Textfile Menu using the Cursor Keys and press the Enter Key.

Lh:l.n Select Function fxis Dafault m ‘l’ools mit
L3 WG PAMHETER EDIT Tapore. | v
' lﬁh GL120_1.2PR
[ Common 11
NO. DESCRIPTION SET UALVE | UNIT RANCE
PEBER |MCT USED -q . .
PE@EL [AX1S 1 DESIGNATION r ABCD!
PBBRZ |AXIS 2 DECIGMATION ¥ XYZSABCDPQ
PABB3 1AX]IS 3 DESIGMATION z XYZSABCDPQ
PoR4 |a%1S 4 DESIGHATION $ YZSh
Paeas IMAL_POINT 3 1-3
POGRE FEED MAX SP SET 24900 |wa/nin 1 - 248909
Poea? |1TR LiN & 188 | s 1 - 10000
Poedt |1TR LIN ACC/DEC CNST2 189 1 - 16888
P89@? |ITR LIN ACC/DEC SV SP 24000 |mmin 8 - 249008
POB1@ |ITR HOW-EXP DEC T 100 {ns 1 - 10888
Powi1 |ITR EXP ACCr/DEC oous'r 188 |ms 2 - 1089
Pe@1z |ITR EXP aCC/DEC B B|wnsmin 9 - 240000
PEE13 |1TR MU RUC TIME mr 108 |m= 2 - 1088

3) A window asking for the file name to be exponed will be displayed. Enter the file name
{PARAMTR1.TBL in this exampie) and press the Enter Key.

i

k;in Select PFunction Axit Dofault Textfile Toels  Quit
—_————F3———P 57— T8I — Y
: NG PARAMETER EDIT
Filenams: GL120_1.2PH
[ Common 11
w. | oescarrrion SET VALUE UNTT RANGE
PO2Es | |
PAo#L |AXIS 1 DESIGNATION % XYZSABCDPQ
PBBA2 |AXIE 2 DESIGWATL ¥ XYZSAECDPY
PAOBI ES LGNAT I z XUZSABCDPG
Poee4 |axis 4 DESICNAT $ XYZSABCDPQ
PPeS IMaL_POINT 3 1-3
POBRG
PE8e? 1
PoOSS
PB88Y

The parameter data wi}l be saved as a text file with the name “PARAMTR1.TBL".

[inFo D The text file will be saved automatically to the default directory \FMSGL. To save to a different
directory, make sure to include the desired directory path name when entering the file name.
For example, enter A\ADATA\PARA.TBL.

14.4.3 Importing

Use the following procedure to read parameter data from a text file.

1) Switch to the menu cursor using the Tab Key.
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4.4 Text File Operations

2) Select Import from the Textfile Menu using the Cursor Keys and press the Enter Key.

Select Function Axis Default mﬂq Toele Quit
¥3 Fd il PO Toxtfi -JF5—PFe

—WF |
5

MC PARAMETER EPIT I‘jﬁml
rt GL12@_1.2PH
{ Comman 11
NO. I DESCRIPTION SET VALUE ] UNET RANGE
FResh |NOT USED q
Pgeal |AXIS 1 DESIGNATION XYZSABCDPQ
POOS2 [AXIS 2 DESIGNATION ¥ ABCDPQ
PBB3A3 |AXIS 3 DESIGNATION z XYZSARCDPQ
PBOR4 |AXIS 4 DESIGHATION -] XYZSABCDPQ
PBBES |DECIMAL POINT 3 ~3
POOBE |INTRPL FEED MAX SP SET 24868 | min 1 - 240009
PBBA7 |ITR LIM ACC/DEC CNST1 109 ms 1 - 10008
PEABS 1ITR LIN ACC/DEC CNSIZ 108 |ns 1 — 19009
POPEY |ITR LIN ACC/DEC $W P 24800 lam/min @ - 240000
PR210 |ITR NON-EXP CONST 100 [»s 1 -~ 19008
P01t lITR EXP ACC/DEC CONST 100 |n: 2 ~ 1009
P8B12 |ITR EXP ACC/DEC BInS @{mnmin 8 ~ 249080
PBE13 |ITR MOV AUG TIME CONST 108 |ns 2 - 1088

3) A window asking for the file name to be imported will be displayed. Enter the file name
(PARAMTR1.TBL in this example) and press the Enter Key. '

k:in Salect Punction Mxis Default Textfile Tools Quit
—F2————1~3 T4 S e F7- NP -N—F9
NC PRRAMETER EDIY
Filename: GL120_1.2PN
[ Common 1
DESCRIPTION SET UVALUE UNIT RANGE

T1

ITR LIN ACC/DEC CNST2
ITR LIN RCC/DEC SW EP
ITR NON-EXP DEC COMST
ITR EXP ACC/DEC CONST

R

(8

The data from PARAMTR1.TBL will be read as parameter data.

OIIIHEID The directory from which the text file is imported is set to \FMSGL as the default. To import
from another directory, make sure to include the directory name when entering the file name.
For example, enter A:\DATA\PARA.TBL.

— 14-19 —



Editing Point Tables

This chapter describes point table procedures such as editing a point
table and writing data to a text file.

151 OVerview ...vvvvevnnennnreencenennnnne. 152

15.1.1 Point Table Data Edit Screer . .................... 15-2
15.1.2  Displaying the Point Table Data Edit Screen . ........ 15-3
15.1.3  Basic Input Procedures ......................... 15-3

15.2 Editing L R I T O 15'6

15.2.1 SelectingaModule ............................ 15-6
152.2 Editing Procedures ............................. 15-7
1523 MovingtheCursor .............oooovuionnnn. ... 15-10

153 Filing .....oovvviiivniinarinnennnnns... 1513

1531 TextFileFormals ..............covuunvennnn.... 15-13
1532 Exporting .........coovivuiininiinnnnnnnnnn. .. 15-13
1533 Importing ........coviniiiiiiinnin . 15-14
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Editing the Point Table
15.1.1 Point Table Data Edit Screen

15.1 Overview

This section describes the configuration of the Point Table Data Edit Screen and basic
point data input.

15.1.1 PointTable DataEdit Screen .........covieiiiieiiiiiiinniisanenas 15-2
15.1.2 Displaying the Point Table Data EditScreen ......................... 15-3
15.1.3 Basic Input Procedures ................. b e 15-3

15.1.1 Point Table Data Edit Screen

Select Point Table from the Motion Submenu of the Main Menu to display the Point Table
Data Edit Screen shown below.

eloct t to extfi.
in Select Edi o Textfile .
— P Ft———F—F5
POINT TABLE DATA EDIT
iloname 61120 1 .1FT
Wo. | Laard_x 3y | zmxadg_ v 3) | 3exifl z ) | qaxi s n
{ X N

1 — e ) 9

2 A 9 a\ v
3 e I\ 2 g N\ e 3

5 ] H 8 @

H 2 ] 8 ]

? ] 9 8 @

1.4 s e 8 8 €

’ o ] 9 1

19 s 9 ] .

11 a 8 a ]

12 8 ] ] 8

13 ] ] ] e

11 8 9 ] .

\ is a 9 L] e

1. Editing Area

A total of 15 consecutive lines of point table data can be displayed at the same time. The
cursor is used to display previous data or following data. A point data table of a maximum
of 500 lines can be edited.

2. File Name

The file name is shown for the currently displayed point table. The file name configuration

is as follows:;
' —|—— Point Table
Modute Number

1: Module 1; 2; Module 2
File Name Selected using Select Program

3. Axis Name

The axis name set in the parameters is dlsplayed If no setting has been made for the
axis, the names will show “-"
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15.1 Overview

H

15.1.2 Displaying the Point Table Data Edit Screen

To disptay the Point Table Data Edit Screen, select Point Table from the Motion Submenu of

the Main Menu. The example below shows how to start the point table from a Ladder Editor
Screen.

1) Switch to the menu cursor using the Tab Key.

2) Select Motion from the Main Menu using the Cursor Keys and press the Enter Key.

Elomsnts Edit Go/Brch Netwark Ref Iools Quit
F3——P4————F5 15— W PO

Raf "
Rafurence Data

“ Format Decimal File Data Range : 1

3) Select Point Table from the submenu using the Down Cursor Key and press the Enter

Key. :
Elements Edit Go/Sech Metwork Ref Tools Quit
m Manu- ﬂr—l’!—-—!’s——?ﬁ—-—-ﬂ?—im-—m—h
FHode r
Conf tion r—

W Hotion Progran J—_
Plcfth meent | Parameter oeem e N

ta —
e t 208020

gran nitor sy y—
200029 200024 00OR21
4 UCIR
1
Refarence Data

- Forsat :Decimal File Data Range = 1

The Point Table Data Edit Screen will be displayed.

15.1.3 Basic Input Procedures

To enter point table data, move the cursorto the input position and enterthe numerical values,

1} Move the cursor to the input position using the Cursor Keys.
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Editing the Point Table

15.1.3 Basic Input Procedures cont.

2) Enter the numerical value (1000 in this example) and press the Enter Key.

Main Sclect Edit Gato Textfile Tacls Quit
n— P4 ———— P ———P——— PO FS- T —FY
POINT TRBELE DaTa EDIT
! Pilename:GL12@_1.1PT
NG, 1 AXISC X > 2 RXISC ¥ > 3 AXISC Z > 4 AXIsC § >
i ] 2 : -] ]
3 0 H H 5
3 — 8 .8 e
s "] ] [} a
3 -] 8 8 ]
? " [] [} -]
8 ] [:] 2 a
9 ] ] ] ]
18 -] '] 4 a
11 a a ] a
12 a a 8 a
13 a a ] e
i4 a a -] a
15 ] ] ] a
The input will be confirmed and the cursor will move to the right.
dn o, Select  Hn cug__;gxtfihj Too m_g-,.it
—P——F% —— 7 Fe
POINT TABLE DRTK EDIT .
* Pilename:GL120_1.1PT
wo, 1 ARISC X > 2 RXISC Y ) 3 AXISC. Z ) 4 AXISC 5 >
1 a a a B
3 1008 -ﬁ 8 e
4 a ] ]
1 ] ] ] ]
[ ] ] ] ]
? n a8 a [}
] a -] a ]
b4 a ') a a
18 8 2 2 a
11 ] 8 8 q
12 a [} a ]
13 -] 8 a ]
14 a L ) 8 a8
15 -] 9 "] 8
Olmi’ﬂb In addition to using the Enter Key to confirm the input, the Up and Down Cursor Keys can also

be used. This option is useful when entering point data for the 1 axis, for example. The follow-
ing example shows how to enter 1 axis data continuously.

1) Move the cursor to the input position using the Cursor Keys.

2) Enter the numerical value (2000 in this example) and press the Down Cursor Key.

Main Select Edit Goto _“l:xtfile Toa Quit

[Pt ————TF2———F3 P PS5 FE 779 -,
POINT TABLE DATA EDIT

Filename :GL120_1-1PT

NO. 1 AXIs< X 2 AXISC ¥ 2 3 RRISC Z 2 4 RRISC 8 »
1 -} ] a e

3 ) 2 8 °
41 8 a [}

5 [} e ] a
[] e a 8 -]
7 2 ] -} a

] ] ] ] a

? 2 ] 8 -]
18 a a a -]
11 2 -] ? a
12 -] Q -} [
13 [} a a -]
14 a a a ]
15 ] [ 4 e

|
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m

3} The cursor wili move down one line. Enter the next numerical value and press the Down
Cursor Key.

Paain

Select  Edit Goto Textfile Tools Quit
3 F4 F5 B TGP - M —Fe

POINI TABLE DRTA EDIT
Filsname:GL120_1.1PT
NO. 1 RXISC X > 2 AXISC ¥ O 3 AISC Z > 4 RXISC 8 >
1 [} 8 [} [}
3 200 ' 2 2
4 _IE -] [ a
5 2 @ a
1) [ 2 [} a
? e a [ @
] 2 -] ] [}
4 '} a -] []
18 [} -] 2 a
i1 [} ] [} -]
12 a e [} a
13 a [ a e
14 [} [] [-) ]
15 [} -] 8 ]

In this way the numerical values for the same column can be entered continuously.

The following is a summary of the keys used to edit point tables.

Move the cursor around when no numerical values have been
entered. if the Up and Down Cursor Keys are pressed when
numerical values have been entered, the input of the numericai
values will be confirmed and the cursor will move to the next line up

or down.

If the Right Cursor Key is pressed at the location of the 4 axis, the
cursor moves to the 1 axis on the next line.

If the Left Cursor Key is pressed at the location of the 1 axis, the
cursor moves 1o the 4 axis on the previous line.

Confirms the input of numerical data and moves the cursor to the
column on the right. If it is pressed when no data has been entered,
the cursor merely moves one column to the right. If it is pressed
when the cursor is located at the 4 axis, the cursor moves to the 1
axis on the next line.

Cancels input if pressed while numerical values are in the process of
being entered. The previous numerical values are then displayed. If
this key is pressed when no numerical values have been entered, the
program exits point table editing.

(4)

Displays the previous 15 lines of point data before the data currently
being displayed.

Moves the cursor to the beginning of the point table (1 axis, number
1.}

(PgUp ]

Displtays the next 15 lines of point data after the data currently being
displayed.

((HOME ]

(END ]

Moves the cursor to the end of the point table {4 axis, number 500.)
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Editing the Point Table , ;
15.2.1 Selecting a Module ’

15.2 Editing

l This section describes editing operations useful for editing point tables.

15.2.1 SelectingaModule ... ...t e 15-6
15.2.2 EditingProcedures ..............ccovven e anerarsrerea s 157
15.2.3 Movingthe Cursor...............ccautn et e 15-10

15.2.1 Selecting a Module

When the Point Table Data Edit Screen is displayed, the pointtable for MC1 is displayed. The
following operation switches the Motion Module to be edited from MC1 to MC2 and back
again to MC1.

1) Switch to the menu cursor using the Tab Key.

2) Select Module from the Select Menu using the Cursor Keys and press the Enter Key.

Finin Edit Goto Textfile Toels Quit
T OINT TRELE DATA EDIT T
Hn

= : Filsname:GL128_1.1PT
1 RdIsc A 2 aXISC ¥ > 3 RXIS< Z > 4 pRISC £ >

GR-ARNLWNHE |-

i@

3) A submenu will be displayed. Select MC2 using the Down Cursor Key and press the En-
ter Key.

pe

to Textfile Tools Quit
t 6 ————— P 7P -1y
Produiy] » m.s DATA EDIT
Filename:GL128_1.1PT

1 AXISC X > 2 ax1s< ¥ 3 ARISC Z) 4 AXISC 5

P i
PAWNHDIEARN RN | -
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M

4) A confirmation message will be displayed. Enter Y and press the Enter Kay.

hi.n Select Edit Gato Taxtfile Tools Quit

——p2: 3 P4 ¥5 6——F o
POINT TRILE DAIR EDIT

Filoname:GL128 1 _1PT

NO. 1 AXISC X ) 2 AXISC ¥ > 3 AKISC Z) 4 RRISC 8 >

1 ...Illl% a ] 8

I 2 a -] a

3 ] 2 "] -]

4 e a ] a

5 a a8 ] a

6 9 [} [} [}

? ) -] 8 [

s ] [} -] a

9 a a a ]

18 9 [ 8 ]

11 e 2 [} [}

12 ] ] 2] a

13 [

14 a a

15 [}

The point table data for MC2 will be displayed.

Edie Gato Textfile
"POINT TRBLE Bala EDIT

Quit

Tools

Fain Select
[Pl —————F2 3

3

Filename:CL120_1_2PT
3 ARISC - > 4 ARISC -

BRI RUTLRWN |

1 AXISC - 2 ARIEC - >

18

When the changes to the currently displayed point table have been made, a confirmation -
message will be displayed asking whether to save the point table data. To save the data, enter
Y and press the Enter Key.

15.2.2 Editing Procedures

1. Copy

The Copy operation records 4-axis point table data specified as a group. The recorded data
can be inserted at another position using the Paste operation.

1) Move the cursor either to the end or to the beginning of the area to be copied using the
Cursor Keys. It does not matter which column the cursor is in,

2} Switch to the menu cursor using the Tab Key.
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15.2.2 Editing Procedures cont.

3) Select Copy from the Edit Menu using the Cursor Keys and press the Enter Key.

km Selsct . Goto Textfile' Tools Quit
—FZ———F3 ) -— -ll:i——-—w
£ DATA EDIT ‘
lb'chto Filsname:CL12@_1.1PT
azto
NO. 1 A%ISC X > fb———ly > 3 AXISC Z D 4 AXISC § O
1 [-] ] ] 8
2 28 8 ]
3 19 s ]
4 108 150 . 1208 188
g - 558 259 . 688 200
6 1999 2008 1] 188
? 850 78 999 638
8 308 208 t 2009 15088
? [] Q : []
18 ] ] '] 8
11 ] ] ] ]
12 9 ] ] ]
13 ] ] ] ]
14 ] ] ] ]
15 ] ] ] ]

4) Specify the area to be copied using the Up or Down Cursor Key and press the Enter Key.

hm Salect Edit  Goto  Textfils Too Quit
_— e —— P4 — P ————F ——F7- - P - U9
POINT TAELE DaTa EDIT
. Filoname:GL128 1.1PT
NO. 1 AKISC X O 2 ARISC ¥ O 3 ARISC ZO 4 AXISC §
i 8 (-] -]
2 1 2u
3 LM
4 | 154
2 25
? 788 . 990 [x13
] 2060 2008 1508
9 B B 8
18 ] B a
11 8 B 8
12 a a 8
13 "] -] a
14 9 8 ]
15 e Q [
2. Delete

The Delete operation sets the 4-axis point table data specified as a group to 0 and save the
data in a buffer. The deleted data can be inserted at another position using the Paste opera-
tion.

1) Move the cursor either to the end or to the beginning of the area to be deleted using the
Cursor Keys. It does not matter which column the cursor is in.

2) Switch to the menu cursor using the Tab Key.
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15.2 Editing

3) Select Delete from the Edit Menu using the Cursor Keys and press the Enter Key.

Main Select | Goto Textfile Tools Quit
[PL F2 3 1t = ——— T ———— PR P -7
Co E DATR EDIT
w Filenane :6L128_1.1FT
'azte
NO. 1 AXISC X > 'R 3 ARISC Z 4 AKISC §
1 9 8 [}
2 10 28 ] [
3 18 5 [
4 198 150 120 180
5 250 6 200
. 1 2008 1588 1]
? 858 754 990 638
] 308 208 2 1500
’ [ ] 8 [
10 2 @ 2 ]
11 '] ] ] .
12 8 ] a ]
13 [ @ @ 8
14 8 [ ] 8
15 8 ] [ [

4) Specify the area to be deleted using the Up or Down Cursor Key and press the Enter Key.

in Salect Edit Goto Textfile Tools Quit
h; F2: F3 P4 -3 —FY

"POINT TAELE DATR EBIT
Pilenane :GL120_1 .1PT

1 AXISC ¥ > 2 ARIBC ¥ > 3 aXIS¢ Z > 4 AXISC $

]
i@ 28
18
188 158

T b ok 5
(R AT L] - EAT N7 CRT VRN By
o
FEE:
g
g
uoousuéumna
oonuuug

ha

The data within the specified area will be set to 0.

Main Select Edig Goto Textfile Iools Quit

[P1- P2 3 Fé- —E—F9
POINT TRBLE DaTa EDIT

Filename:GL120_1.1PT

NO. 1 AXISC X 2 RRISC ¥ > 3 ARISC Z > 4 AXISC 8§ )

1 a a ] ]

2 18 28 8 8

3 5 18 S 8

4 189 158 1208 1890

5 ] 8 [} [}

1 -} -] -] a

Pl — £ g g

9 e [} -]

18 B ] e ]

11 ] ] ] L]

12 a a ] a

13 ‘8 8 a a

14 e 8 [} [}

15 °] ] [}

The data recorded during the Delete operation can be inserted at another position using the
Paste operation in the same way as the data recorded using the Copy operation.

3. Paste

The Paste operation inserts data that has been recorded using the Copy or Delete operation
into a specified area. In the following example, the data recorded during the Delete operation
in 2. is inserted at another position.
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Editing the Point Table
15.2.3 Moving the Cursor

1) Move the cursor to the beginning of the inserted fine using the Cursor Keys.
2) Switch to the menu cursor using the Tab Key.

3) Select Paste from the Edit Menu using the Cursor Keys and press the Enter Key.

. _
in Select Goto Textfile- Tools Quit
—F 2T it 6 -l — P9 —

] Gu{z E DATA EDIT .
te + Pilename:GL128_1.1PT
d".[t‘
NO. i AXISC X > Y > 3 akIsC Z > 4 AXISC S >
1 ] 2 8 a
2 i8 28 [} ]
3 5 1 - -]
4 p1: ] 159 120 198
5 [ ] '] [} a
[ -] -] ] a
? -] a [} ]
P — : : g
1@ I3 ] a
11 a ] ] a
12 -] 2 ] a
13 ] 8 e a
14 2 -4 ] a
15 8 -] -] ]
The recorded data will be inserted at the current cursor position.
kin Salect Edit Goto Textfila, Tools Quit
— P F——— P ———— PP 7P - I —FY
POINT TABLE PATR EDIT s
Pilsname:=GL128_1.1FT
NO. 1 AXISC X > 2 ARESC ¥ 2 3 aXIsC Z > 4 aRIS< 5 >
1 8 9 B a
2 18 20 8 -]
3 5 i9 5 -]
4 1080 158 128 190
s a 9 e ]
6 "} 2 ] -4
? ] ] -] ]
$ a ] -] L]
? 558 258 [ -] 208
18 1908 2 1598 208
i1 250 788 90 6308
g 398 2% 2 2 1588
14 E a -] -]
15 -] ] ] a

OITIIEIP ~ There is only the one buffer for storing the data recorded during the Copy or Delete opera-
tions. As a result, the Paste operation inserts the data recorded during the most recent Copy
or Delete operation.

15.2.3 Moving the Cursor

The cursor can be moved to the first line (position number 1,) the last line (position number
500,) or a specified line in between. Special keys have been allocated to move the cursor to
the first and last lines.

1. Moving the Cursor to the First or Last Line

The following example shows how to move the cursor to the first line.
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m

1) Switch to the menu cursor using the Tab Key.

2} Select Top Line from the Goto Menu using the Cursor Keys and press the Enter Key.

in Select Edit Textfile lTools Quit

T T
tton Line Filenane:GL120.1.1PT

Input Line

NO. 1 WKISC ¥ > 2 AXISC————— 1 7 4 AXISC 8 >
1 e 8 a
2 18 20 [ 8
3 10 5 ]
] 198 158 128 108
I3 [ ] ] ]
€ 8 M a e
7 0 ] 8 8
2 ] M ] ]
9 s58 256 608 208
18 1888 2068 1588 o0
i g2 e k] £
13 8 8
14 — 8 a ]
is ® e ] 1

The cursor will move to the first line.

in Select Edic Goto Textfile Tools Quit
h——ﬂ—ﬂ———?i—*—ﬁ—-—?ﬁ———r)m‘-m—-ﬂ
POINT TABLE DATA EDII

Pilename:GL128_1.1PT

NO. 1 ARISC ¥ > 2z AXISC ¥ D 3 AXIS¢ Z > 4 AXISC 8 >
i q a -4 ]
2 1 20 ] [}
3 5 ie 5 a
4 108 159 120 108
5 e ) 9 B
6 ] e '] -4
? ] a ] 4
[] 9 [} a ]
? 550 258 600 208

19 1088 2000 1508 (1]
11 850 e %0 &30
12 ] 268 26800 1588
13 ] -4 a
14 a [ a [
15 e 8 [} -]

Use the same procedure to move the cursor to the last line.

Two keys have been allocated for moving' the cursor to the beginning and to the end of the
point table. Only the one key is needed in both cases. In addition, two other page movement
keys are shown below.

Moves the cursor to the beginning of the point table (1 axis, number
1.)

Moves the cursor to the end of the point table (4 axis, number 500.)

Displays the 15 sets of point data immediately preceding the
currently displayed data.

Displays the 15 sets of point data immediately following the currently
displayed data.

2. Moving to a Specified Line

The foliowing example shows how to move to line 300.
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Editing the Point Table
15.2.3 Moving the Cursor cont.

1) Switch to the menu cursor using the Tab Key.

2) Select Input Line from the Goto Menu using the Cursor Keys and press the Enter Key.

Hain Select Edit Texefile Tools Quit

fr—*2 to — 7N+
POINT TR| Top Linc

Bottonld.ne ' Pilename:GL120_1.1FT

NO. 1 A%ISC X > 2 RXISC . Z) 4 AXISC S 2

1 q ] : e -]

2 1 29 e [}

3 5 18 H] 8

4 108 150 120 188

S ] ] "] a

é ] 9 '] ]

? e ] -} a

| (] [} U] a

b4 558 250 600 288

18 1068 28689 15908 08

11 350 288 990 638

12 3808 289 2009 1508

13 a 2 a a

14 a ] 2 ]

15 a 9 ] ]

3) A window will be displayed for entering the specified line. Enter the line number (300 in
this example) and press the Enter Key.

in Select Edic Gato Taxtfile’ Teols Quit
[f] ——sm—F2. - -
POINT TABLE DATA EDIT

: . Filename:GL126_1.1PT

NO. 1 ARISE X > 2 axI1s¢ ¥ > 3 ANISCG Z D 4 QXIS S >

1 qa 9 -] [}

2 20 ] ]

3 5 18 5 9

4 108 158 120 188

s e '] a ']

] -] [} 2 ]

? 2 [} 2 a

] a L] ) 8

9 2
18 200 ]
11 958

12
13
14
15

The cursor will move to line 300.

E;in Select
—_—F 23

Edit Goto Textfils
—F
POINT TABLE DATA EDIT

Tools

Quic

Pilename=GL120_1.1PT

1 ARISC X >

2 ARISC ¥ 2 3 ARISC

zZy 4 ARISC S
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.3 Filing
15.3 Filing

This section describes the procedure used to write point table data to a text file and read
a file created with a standard text editor.

15.3.1 TextFile Formats.........ooouiiie e 15-13
15.3.2 EXporting .......oovvniini e e et taaa e, 15-13
15.3.3 IMPORING . ... 15-14

15.3.1 Text File Formats

Data in point tables created on MEMOSOFT can be saved to other files as text files. The
saved text files can be edited on a standard text editor. Conversely, data created on a stan-
dard text editor can be imported to MEMOSOFT as pointtable data. The format of the text file
is as follows:

XXX: XXXX, XXXX,XXXX, XXXX

I— 4 axis data {8 characters max.)
3 axis data (8 characters max.)
2 axis data (8 characters max.)
1 axis data (8 characters max.)

Line number
The actual file data is as follows:
l1: 0, ¢, 0, O
2: 10: 20: 01 0
3: 5, 10, 5, 0
4: 100, 150, 120, 100
5: 550, 250, 600, 200
6: 1000, 2000, 1500, 800
7: 850, 780, 990, 630
8: 300, 200, 2000, 1500
9: 760, 2030, 1051, 200
10: 1024, 320, 511, 1300
500: O.r O.r OJ 0
Olmiilb When no drive or directory is specified, the data is read from or written 1o the defauit directory

\FMSGL.

15.3.2 Exporting

Use the following procedure to write to a text file.

1) Switch to the menu cursor using the Tab Key.
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Editing the Point Table . ]
e i
15.3.3 Importing '

2) Select Export from the Textfile Menu using the Cursor Keys and press the Enter Key.

Inl:in Select Edit Goto . Tools Quit

[P ———F 22— I =Pl “Exﬂi ~{Ee-Fo-3—FY
POINT TABLE DATA | Import

EATHRO | s Lenane sGL126_1 . 1FT

NO, 1 AKISC X > 2 ARISC ¥ O 3 ARISCH 2D 4 ARISC 5>

1 : a [] [} ]

2 28 2 [}

3 ie 5 8

4 188 158 128 100

[ -] [] [} [}

6 8 ] a 8

? 8 [} ] ]

8 U] 9 @ 8

9 558 250 608 200

1@ 10990 2880 1508 (]

11 258 780 998 38

12 390 209 1508

13 [ ] 8 [}

iq 8 ] 8 [

15 ] ] 8 8

3) A window will be displayed for entering the file name. Enter POINT1.TBL and press the

Enter Key.

in Select Edit Goto Textfile Tools. Quit

— 22—} PP ————Fh —F - PO - —FY

POINT TABLE DATA EDIT

. Pilename:GL126.1.1PT

NO. 1 axis{ % > 2 AXISC ¥ O 3 AXISC T 4 AXISC S >
i a a a -]
2 28 [} ]
3 S 2
4 198 ] 188
5 [} 8 a
1] -] a8 a
? -] a a
] a a L)
9 558 288
ie 1888 ea
11 359 638
12 308 1588
13 ) [}
14 : 8
15 Sunbol Tahle Expart Filenanc: ]

The point table data will be saved under the file name “POINT1.TBL" as a text file.

15.3.3 importing

Use the following procedure to read point table data from a text file.
1) Switch to the menu cursor using the Tab Key.

2) Select Import from the Textfile Menu using the Cursor Keys and press the Enter Key.

POINT TaBLE DATA
port flenane=CL120_1_1PT
NO . 1 AXIsSC X > 2 RXISC ¥ > 3 ARISC T > 4 ARISC $ >
1 _Ia] "] -] [}
1 z ] ] ]
3 ] a -] a
4 ] a B -]
5 -] ] B []
6 ] ) -] "]
7 -] a -] a
.3 a a -] [ ]
9 2 a -] -]
18 a -] a a
i1l 2 ] -] 2]
12 2 "] %] a
13 a ¢ [°) "]
14 a -] -] a
1% -] [ ] a a
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15.3 Filing

3) A window will be displayed asking for the file name. Enter POINT1.TBL and press the

Enter Key.
{
'guin Seloct  Edit Goto Textfile Toals  Quit
] —————F2——————F3 P4 F5 F6 P T-Fe--NE—9
POINT TRELE DATR EDIT
Pilenams :GL128_1.1PT
HO. 1 ARISC X > 2 ARISC ¥ > 3 ARISC Z > 4 MISC § >
i ] [} 8
2 _E a2 ] [
3 B 8 @ ]
4 a 8 [} ]
5 a ] 8 B
% ] 8 ] B
? [ ] B ] ]
8 B [} 2
9 [ B [} 8
10 ] 9 [ ]
11 g ] ] ]
12 a ] a e
13 @ [ @ 8
14 8
15 g_-ml'u)l 1d]})1t‘ Inpurt Filenane: a

The data from POINT1.TBL will be read as point table data.
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Monitor Operations

This chapter describes monitor operations such as displaying PLC and
Motion Module status.

16.1

16.2

16.3

16.4

16.5

Displaying PLC Status ................... 16-2
1611 PLCSIANS .. .ouvvennenen e, 16-2

Motion Module Current Position Monitor
Screen ..ot 16-8

16.2.1  Displaying the Current Position Monitor Screen . . . ... 16-8
1622  Switching Modules ............................ 16-10
162.3  SwitchingModes .............................. 16-11
16.2.4 Displaying All Coordinate Valves ................. 16-12

Motion Module I/O Status Monitor Screen .. 16-13
16.3.1  Displaying the /O Status Monitor Screen ........... 16-13
16.3.2  SwitchingModules ......................... ... 16-15

Motion Module Status Information Monitor

Screen ... .iiiiiiiiiiiiie i, 16-16
16.4.1 Displaying the Status Information Monitor Sereen ....  16-16
164.2 SwitchingModules ............................ 16-18

Motion Module Program Monitor Screen ... 16-19

16.5.1  Displaying the Program Monitor Screen ............ 16-19
16.5.2 SwitchingModules ............................ 16-20
1653 ErorPulseDisplay ...................oovo. ... 16-21
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Monitor Operations
W
16.1.1 PLC Status '

16.1 Displaying PLC Status

This section describes how to display the PLC status, such as the PLC ladder program
update and the error log.

16.1.1 PLO Status ...t i ittt i i it rete sttt aa s s 16-2
16.1.2 DisplayingPLC Status .........oiiiiiiiiiiiii et 16-3

16.1.1 PLC Status

MEMOSOFT allows the following PLC status items to be displayed.
« Controller Status

Appears when PLC Status is selected from the Information Submenu of the Tools Menu. Itis
the same screen as that displayed when Start is selected from the PLC Options Submenu of
the Tools Menu.

¢ Machine Status

Displays the PLC status such as the current Sweep Mode setting or memory protect status.
» Error Code

Displays up to three types of error codes.

+ CPU Error Log

Displays a log of the last 20 CPU Module errors. The stopped status, error code, and time of
error occurrence are displayed for each error.

+ Power Failure Log

Displays the times of the last five power failures.

» /O Status Table

Displays the IO Module status of each rack.

« /O Error Counter

Displays the number of IO Module errors for each station.
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16.1 Displaying PLC Status

* Local Module Error History

Displays the last 20 errors that occurred to the Module instalied on the local channel.
* Remote Station Status

Displays the status of each remote station.‘

» Option Installation Information

Displays information about installed optional Modules, such as MEMOBUS and PC Link
Modules.

» Optional Module Status

Displays the status of optional Modules, such as MEMOBUS and PC Link Moduies.

» Optional Module Revision

Displays the ROM revision history stored in optional Modules, such as MEMOBUS and PC
Link Modules.

* MC20 Motion Module Error History
" Displays the last 20 errors that occurred to the MC20 Motion Module.
* PC Link Status

Displays the status of PC Link Modules.

16.1.2 Displaying PLC Status

1. Displaying the Controller Status Information Screen

This section describes how to display the Controller Status Information Screen.

1) Select Info from the Tools Menu using the Cursor Keys and press the Enter Key.

] Conf Ladds: Mot i, Comment Ref Dat IE’]” it
Ed——rzﬁ—m a A Fo e ‘n—mm— uoequl

e

[ r—— t
Pro Name: GL128
m’?’m“: MB: IJ
PLC Type:

Iab  moves betwesn the Manu Bar and the Editing Screen.
ALT H provides halp on the menu itsm zelected by the cursor.
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16.1.2 Displaying PLC Status cont. .

2) A submenu will be displayed. Select PLC Status from the Info Submenu using the Down
Cursor Key and press the Enter Key.

IlP‘I."le Confu l.lddtr Hotion Cnl-nnt Hef hta

Frograw Mamo: GL1ZO1 :
m.c Address: MB: 1
PLC Type:

Tab moves batween the Menu Bar and the Editing Screen.
ALT ¥ provides help on the menu item selocted lly the cursor.

.

3) In Offline Mode, the Communications Parameters Setting Screen will be displayed. Enter
the communications parameters and press the Enter Key.

L]hlh Config L-Mer ﬂuti.on Gounnt !I'-E lktl Iunh . ?uit
6 n
L ft
Progrem Name: GL120.1 |
FIC Rddresa: MB: 1
COMMUNICATIONS PARANMETERS
adg!--sa Pntocol llnds hta Bits Pu-:u:, Stnp Bits Bam'l Deuisc

q Dip Switches 38N 48X | | SBX/ MK I |
2345678 23 675 23455

The Controller Status Information Screen will be displayed.

CONTROLLER STATUS INPORMATION

PC_: SYSTEM REGISTER : INFO
PC RADDRESES ] BIRY COIL 888122 EXEC ID B8F2 REV Ri8ad
PC IYPE cLi2e SIATUS Stoppad
CONST SWEEP 409998 - LOGIN NOHE
USABLE MEMORY 16193 482297 S10P CODE [
NO_OF SEGMENT 1 HS SCANTIME 409937 MEMORY PROTECT N
MOTION 2 MODULE TIMER REC 40999 CONST SWEEP N
LINK 2 MODULE STEP RELRY %835 BATTERY OX ¥
REF RAMGE = CALENDER 489988 -
288192 489995

1A =
INPUT W0 OF I-0 MODULE 34
HOLDING REG 489399 H

COMST REG 704096 NO OF 1 REM SIAT 15
L COIL -1 D110824 WO OF 2 REM STRT 15
L colL -2 Dz1624

L REG -1 Riie24

L REG -2 R21824

Press <PGDN> for I[,0 Statue; CEnter> or <ESC> to exit

4) To switch to a detailed status display, press the Page Down Key.
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-II-lllllIlIIiIIIIIIIIIllIII-IIIlIIIl---I-------.l.I-------.IIllIIII-lllI-.---II.II--.I-.III-II---.

5) The PLC Status Menu will be displayed. Move the cursorto the desired item on the menu
using the Down Cursor Key (Option Install Info in this example), and then press the En-

ter Key.
ox Decimal BRinary Move Quit
hl ¥2 3 Fd P5 Vit n—m—n—@a—n
MACHINE STATUS 1 GE 1,37
PC STAIUS
MACHINE S§TAIUS
ERRCR CODE M
1= CPU failure history BIT15 =

l

Pouer failure history

170 module status table BITiG = @

170 error countep BITE? = B

Lucal rwdule Failure histowy BITES = B

Reiwte Stat ivn Statuy BIT@? = 1
| Opt 10 BITBG6 =
;I Optivn Mudule Statue BITRS = 1

Option Mudule Reuision BIT4 = B

HC29 failure hi.

C

[ 11328 -1 o)
s vapnr

The Option Instali Information Screen will be displayed.

*x Decimal Binary Maouse Quit
P2 ¥3 P4 5 P w—m—rs-qﬁ-—n
F‘ OPTION INSTALL INFORMATION CE 2937
provss ek |
~— BIT 15 - 14 WOT USED -
1 = REMOTE - 2 RIT13 - B
1 = REMOTE - 1 BIT12 = B
1 = HEMOBUS - 2 BIT11 = @
1 = HEMOBUS - 1 BIT1O = 8
=— BIT 89 - 86 NOT USED ——
1 = PCLINK - 2 BITRS = 8
1 = PCLIMNK - 1 BITB4 = @
— BIT 83 - @2 NOT USED —
1 =M28 -2 BITBL = B
1 =nc28 -1 BITO8 = B

6) To return to the Controller Status Information Screen, select Quit from the menu baror
press the Esc Key. '
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16.1.2 Displaying PLC Status con.

2. Switching the Data Display Format

Use the following procedure to switch the status data célisplay format from hexadecimal to dec-

imal.

1) Move the cursor to the position of the data for which the display format is to be switched

using the Cursor Keys.

b;x Decimal Binary HMove
—_—F——>"

TCOP ERROR COPE
SYSTEM ERROR CODE

DEAD ERROR CODECPREVIQUS)

Quit

TS ———— 7 PO T
GE 5737

A HEL2

[ HEX

DFFF - HEX

2) Switch to the menu cursor using the Tab Key.

3) Select Decimal using the Cursor Keys and press the Enter Key.

hgx—w Binary  Move Quit
—F3 P4 PG PG —————F 7[RI F9-
ERROR CODE GE = 5,37
TCOP ERROR CODE SRR HEX
SYSTEM ERROR CODE es8e HEX
DEAD ERROR CODECPREVIOUS)> DFFF #EX

The data at the cursor position will be switched to decimal display format.

ox Decimal Binary Move
—_—r—p3———F

TCOP ERROR GODE
SYSTEM ERROR CODE

DEAD ERROR CODECFREVIOUS>

Quit
GE 5737
2] DFC
-] REX
DFFF HEX
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m

3. Switching Screens

Basically, the screen can be switched by selecting the desired item from the PLC Status
Menu. To display the PLC Status, select Quit from the menu bar or press the Esc Key. To
switch the screens within the selected item, press the Page Down or Page Up Key. To switch,
for example, rack 1 to rack 2 within the 1/0 Status Table, press the Page Down Key.

Switches to the screen with the screen number one greater
than the current screen number,

Switches to the screen with the screen number one smaller
than the current screen number.

If the screen number of the screen to be displayed is known, the Move Menu ¢an be used to
switch to another screen just by specifying the screen number. Use the following procedure to
switch to ancther screen.

1) Switch to the menu cursor using the Tab Key.

2) Select Move using the Cursor Keys and press the Enter Key.

Mox  Decimal Binary ZETEN Quit
Fi—— P2 F3 £ s P #7-IE-PS -
ERROR CODE B e

L TCOP ERROR CODE b DiC ]
1 SYSTEM ERROR CODE 2800 HEX
DEAD ERROR CGODECPREVIOUSY DEFF KEX

L

3) The window for entering a page number will be displayed. Entera page number (28 in this
example) and press the Enter Key.

ex Decimal Binary Move Quit
F2 F3 P4 i) P& mm-q;?—n
Fl ERROR CODE GE $37
TCOP ERROR CODE b i |

H SYSTEM ERROR CODE 8age HEX

DE.’ u.‘.. »m ‘ Hn
:

Page number 28 will be displayed.
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16.2.1 Displaying the Current Position Monitor Screen

16.2 Motion Module Current Position Monitor Screen

This section describes the procedure used to monitor current values or errors when the
Motion Module is installed. This operation cannot be executed for the MC10 Motion

Module.
16.2.1 Displaying the Current Position Monitor Screen ...................... 16-8
16.2.2 SwitchingModules ........ ..ottt e, 16-10
16.2.3 SwitchingModes ...... ... 16-11
16.2.4 Displaying All Coordinate Values .........cocieninriiniirarians 16-12

'16.2.1 Displaying the Current Position Monitor Screen

if the Motion Modulé is installed and allocations have been executed, the current position for
each axis connected to the Motion Module can be displayed. Use the following procedure to
display the Current Position Monitor Screen.

1) Select Info from the Tools Menu using the Curspr Keys and press the Enter Key.

k‘id' Config Ladder Motion Comeent Ref Data
B A e e e T RTEE-

FLC Type:

noves betuwaen the Menu Bar and the Editing Screen.
au H provides help on the menu item selected by the cursor.

2) A submenu will be displayed. Select MC Status using the Down Cursor Key and press
the Enter Key.

kdc Cvnfig Lnrl.dur lloti.on Cn-mnt Rll‘ Data Guit

MEMOSOF;

Praogran Name: GLIZB_!
PLC fddress: MB:
PLC Type:

le
S‘EE
x5
et O by
[ =0
oo
=

.;.l

Tab  wove:r between the Menu Bar and the Editing Screen.
ALT K provides help en the menu item selected by the cursor.
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16.2 Motion Module Current Position Monitor Sereen

3) The MC Status Submenu will be displayed. Select Position Monitor using the Down
Cursor Key and press the Enter Key.

do Config l.ad.dar Hﬂtion Comment Rl!‘ Dlta oo] ] ?ui
FS n n
Koy Holp
stltus
H E H 5 u St“u’ Mni:nr
(R>
Progran Name G"lei_l-t
PLC Address: NB: 1
PLC Type:
Tab  moves betwesn the Menu Bar and the Editing Screen.
ALT H provides help en the menu item selected by the curser.

4) In Offfine Mode, the Communications Parameters Screen will be displayed. Enter the
communications parameters and press the Enter Key.

('anfi’ hdd.-r Ihtion Cul-lnt hf Data l'ool,s l?uit
nfo
Koy lhlp

|"'| EMOSO"

| (T e

ulmnons PARAMET.

ERS
Rddress Protocel !lodo Dau Bits Parity B:un Bits Bmd Deui.cc
108 MEMORIS

E Dip Switches 3I8K-48X Ji—l cox 7 | I
45678 2345678 12315

The Current Position Monitor Screen will be displayed.

in ncL ll:‘& ??mcz .%’ositin gror P ?%_l‘ Too_ls Quit
Current Position Monitor
Rodale Mol IR SN il
[ Display Unit z 1 &2 ]
n | 2
ModesEQLt Stac:Ready |mode -Eass Stat:Ready
Axis Name Current Pozition Axiz Hame Curpent Positien
1 ] +134.394 [mm] 1 X -53.869 (L}
2 ¥ +*166.396 [ )] 2 ¥ ’ +169.587 [mnl
3 z —879.356 £ %] 3 z +604.7%2 Lm 1
4 s 575,206 Imm] 4 -
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16.2.2 Switching Modules

16.2.2 Switching Modules

Toincrease the speed by which display data is refreshed, it is possible to switch to displaying
a single Module. Use the following procedure to switch from displaying both MC1 and MC2 to
displaying MC1 only.

1) Switch to the menu cursor using the Tab Key.

2) Select MC1 using the Cursor Keys and press the Enter Key.

NC1 ne2
— e Y e ow ey e
Currant Position Monitor '
fodule Mo. = MCI gm. : B8 :

in HCL+MC2 oPositio Error P All Tools Quit
f———F —————F6———F 7 OF Faugst 3 ]

fodule MNe. :
[ Dizplay Unit : 1 = 2 ]

| = [ v
[#ode:Edic Stat:Ready |Mode: . Stat:z

Axiz Hame Current Position Axiz Name

1 X +134.3%4 [on] 1

2 4 +166.3% [an] 2

3 z —£70.356 [nn} 3

4 5 +675 . 206 (am} 4

The screen will switch to displaying the Current Position Monitor for the MC1 only.

hiﬁ nc1 "-2 ﬁm gnlitio W‘ﬂll l'oo_l.s Qtlit_-
Current Poszitisn Monitor
Hodule Mol i RGO Mo. : U8
{ Pisplay Unit : 1 » 2 ]
nci ne2
Mode Edit Stat:Ready Mode :Edit Stat:Ready
Axiz HNawe Current Position Axiz Name Current Position
1 ] +134.394 Lom] 1 X -53.86% (L) ]
2 4 +166.3% [ 2 ¥ +169.587 Inn]
3 z —.78.356 [om] 3 z +£04.792 (LY ]
4 g +£75.2806 [mn] 4 -
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16.2 Motion Module Current Position Monitor Screen

m

16.2.3 Switching Modes

The Current Position Monitor displays in either the Current Position Mode or the Error Pulse
Mode for current position commands, When the Current Position Monitor is first displayed,

the current position will be displayed. Use the following procedure to switch to the Error Pulse
Mode.

1) Switch to the menu cursor using the Tab Key.

2} Select Error P using the Cursor Keys and press the Enter Key.

tain nct ncz MC1+MC2 wFositio iymﬂ all Tool:s Quit
[FL F2 ¥3 F4 5 ———F7- - — Y
Current Position Monitor
Moduls Mo. : MCL O Mo. -]
Module No. : HCZ O No. ]

- e

Display Unit : 1 = 2 ]

| el ne2

|noae :Eaie Stat:Neady Mode :Edit Stat:Ready
RAxis Hawe Current Porxition Axis Name Current Pesition
K +134.394 ml| 1 % ~53.86% [
2 ¥ +166.39¢ {mm) 2 ¥ +169.587 o)
3z -478.356 [am] 3z +604.792 [n?
4 s +675.206 el | 4 -

The current position display will switch to the error pulse display.

Ll-i.n nc1 nc2 MC1+MC2Z Position wEwror P A1l Tosls Quit
[Pl ——F2——F3 P4 PS5 6 Pr-ET-Fo—I—F9
Module Me. : MCI  © Mo. (:u.aent Pozition Monitor
Module Ne. : MC2 O No. : B8
[ Display Upit = 1 = 2 1
nCL nC2
Mode :Manual Stat:Ready Mode :Manual StatzReady
Axiz Name Error Pulse Axis Name Error Pulse
1 4 -1 i 4 -2
2 ¥ -2 2 ¥ -2
2 4 -1 3 z -1
4 & -4 4 -
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16.2.4 Displaying All Coordinate Values

16.2.4 Displaying All Coordinate Values
In the Current Position Monitor Screen, there is a choice of displaying the workpiece coordi-
nate system values, or all of the coordinate system values. When the Current Position Moni-

tor is first displayed, the workpiece coordinate system values will be displayed. Use the fol-
lowing procedure to switch to displaying all the coordinate system values.

1)} Switch to the menu cursor using the Tab Key.

2) Select All using the Cursor Keys and press the Enter Key.

Piain M1 no2 MCL+IC2 wPositio WO'&: Quit
[Pl e 22— ———— P 4———F~—Fb — —33—F9
Currsnt Position Monitor .

Hodule Wo. = NGt O Mo. : @9
Rodule Ho. = MC2 O Mo. : @8

[ Display Unjt 2 1 =2 ] '

Mods :Manual Stat:Ready Hode :Manual Stat:Ready
Axis Mame Current Pozition Axizs Name Current Position
1 % +128.000 [nm] 1 X -57.206 fom}
2 ¥ +179.200 [ )] 2 ¥ +153.580 {nm)
3 z -485.37% Tan] 3 z +£07.862 Lom3
4 s +*75.200 L] 4 -

The display will change to show the current position for mechanical, work, work offset,
and work feedback position coordinates.

in MCt ncz MC1+MC2 WPozitio wErvor P General Tools Quit
—_—— ) —— 4 P& P 7P - —FY
Current Pozition Moniter

Hodule Ho. : HC1 O Ne. : B9

Module No. = MC2 O No. : D@
[ | . [~ |

Mechanical X +128.000 [mal Mechanical ® -57.296
¥ +17%.200 [nnl ¥ +153.580
z —885.376 [mm] z +687.862
s +675.200 [nn] -

Work X +128. 538 Inm} Work x —57.286
¥ +179_208 [aml ¥ +153.588
z ~-285.376 Imm] z +*£B87.862
] +£75.208 [mm] -

Work Offzet % +0.008 [mm] Work Offact % +0. 908
¥ +9.008 [nn) ¥ + 000
z +8.008 [mn] z +9.000
$ +2.008 [mn] -

Work FE Pos % +120.008 [mn) VWork FB Poz H] -57.972
¥ +179.200 [mm] ¥ +153.577
z -885.375 [mal H +£87.861
H +£75.281 [mm] -

OIEIEID For more details on the the coordinate systems that are display, refer to MEMOCON GL 120,
GL 130 Motion Module MC20 Software User’s Manual (SIEZ-C825-20.52).
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16.3 Motion Module I/0 Status Monitor Screen

M

16.3 Motion Module I/O Status Monitor Screen

the Motion Module when the Motion Module is installed. This operation cannot be

This section describes the procedure used to monitor the status of the /O connected to
executed for the MC10 Motion Module,

16.3.1 Displaying the I/0 Status Monitor Screen
16.3.2 Swiiching Modules

16.3.1 Displaying the I/O Status Monitor Screen

If the Motion Module is installed and allocations have been executed, the I/Q data for each
axis connected to the Motion Module can be displayed. Use the following procedure to dis-
play the l/O Status Monitor Screen.

1) Select Info from the Tools Menu using the Cursor Keys and press the Enter Key.

b.lm Config Ladder Motion Comment Ref Data
— e T e fmment Be

Tabh = mouss between the Menu Bar and the Editing Screen.
ALT H provides help on the menu item selected by the cursor.

2) A submenu will be displayed. Select MC Status from the submenu using the Down Cur-
sor Key and press the Enter Key.

ds Conf Ladder Motion Comment Raf Data Quit
kz‘i——m—i—!—n 74 5 76 e

Yoy Hel I
P’Ug S:a:us
PHC ccazuc |

MEMOSOF

ft

¥ Yhid

<R>

H

i Program Name: GL120

1 PLGC Addross:  MB: 1-1
PLC Type:

Tab  moves between the Menu Bar and the Editing Screen.
ALT H provides help on the menu item yolected by the cursor.

I — A
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Monitor Operations
16.3.1 Displaying the I/O Status Monitor Screen conl.

3) The MC Status Submenu will be displayed. Select VO Monitor using the Down Cursor
Key and press the Enter Key.

Fde C-nfig l.-ld.-r Ilnt:.on comnt Ref Data’ Quit

l'l_ylﬁi'i_l

R>

Program Nams: mza_.l
PLC ﬂrlllru sz MB:
PLC Type

moves botween the Menu Bar and the Editing Screen.
UL‘I H provides Jwlp on the smenu item zelected by the cursor.

4) In Offline Mode, the Communications Parameters Setting Screen will be displayed. Enter
the communications parameters and press the Enter Key.

Edc Gnnfi. I.uldnr I‘bthn couunt Rof Datn Tools Quit
—— - Info
E y I|cl
Pn::.tion ﬂonitnr
tatus Honltor
{R>
| Prol'm Nuc %123_1 |
S OFNICATIONS PARANETERS—
Address Protecol Hlule Dl.:l Bits Pu-:.ty Step Bits Baud Device
b | MEMOBUS 1 9680 com
H Dip Switches IBX/48X | I 68X-78% I_ |
345678 12345678 2345678

The I/O Status Monitor Screen will be displayed.

k;;u nc1 ncz moinez o Tools Quit
- T SThiUs MONITOR F7- ST -Fe- 2

38 f

i T CMCUNIT : L k21

:
B
2%
Az

2

B

[ ]

E-3

1z

1]
BN S ORISR0 OO ® -
ﬂ:nmmmﬂ:munsna

| T O I B B BN RO I )

DEISYRTD0 DEEEE R

DULLOPLEREPRIROONW
CLASNPLETOEE RN W K-
AL P DS SIS O 0 & N W

(-~ =[] -1 -[=1-1 11 LTI L.

POS. SET SIGNAL
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16.3 Motion Module I/0 Status Monitor Screen

M

16.3.2 Switching Modules

Toincrease the speed by which display data is refreshed, itis possible to switch to displaying
a single Module. Use the following procedure to switch from displaying bothMC1 and MC2 to
displaying MC1 only.

1) Switch to the menu cursor using the Tab Key.

2) Select MC1 using the Right Cursor Key and press the Enter Key.

in__g_ nez2 NC1+1C2 Tools Quic
—————F3 P4 P F6 Fr-Y-Pe-IE—FY
) l‘O STATUS MONITOR

[MCUNIT : 1 &2 1

-
%

3
g

)

»

w

=]
ORI OLIDISOeD®KH
PO ERPDOERIFEE A

LI T T T O B O B I O I I Y

CERITOLEOLIDOe DEW
CERIT SN ORI 00RM
SRS RE © OEIDe DO
RS 5 DL SO OEIDI © A W

L= =1 --T-T-[-1.1 1T LIt}

SERVO ON SIGNAL
POS. SET SIGNAL

The I/O status will be displayed for MC1 only.

[Main neL nez ;K__:lm o - 'logls Quit
170 STATUS MOMITOR

N, 9

No. :

§
5
58
:
[-1-]

CMCUNIT = 1 &2 )
NC1

g

]

t-J

F3

"

1
SRS OSSO @D @K =
]S PRI DE O Dm-E N

FlLrrititdinnnnim
ttrtrrtrdtrrniaw

BRSO 0 SITISII® 0o 0.8

tdirrtrreirv
LI I T OO I I B Y

SRl B0 RO DO O W

SIGMAL
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16.4.1 Displaying the Status Information Monitor Screen

16.4 Motion Module Status Informatiori Monitor Screen

This section describes the procedure used to monitor the Motion Module status when
the Motion Module is installed. This operation cannot be executed for the MC10 Motion

Module.
16.4.1 Displaying the Status Information Monitor Screen .................... 16-16
16.4.2 SwitchingModules ..................... e ara e, 16-18

16.4.1 Displaying the Status Information Monitor Screen

If the Motion Module is installed and allocations have Been executed, the Motion Module sta-

tus can be displayed. Use the following procedure to display the Status Information Monitor
Screen.

1) Select Info from the Tools Menu using the Cursor Keys and press the Enter Key.

kd. Conf ig Ladder HMotion GComment Ref Data
———F3——F4—F—Fh

Tab moves betwsen the Menu Bar and the Editing Screen.
ALY H provides help on the menu item selecttd by the cursor.

2) A submenu will be displayed. Select MC Status from the submenu using the Down Cur-
sor Key and press the Enter Key.

hd- Conﬂ.s Luirhr rm:m CDlncnl: n-f Bata mm:-—[gm
nko
Hel;
E Plz Stalt’us
4
FSetting
DOS
n CR>
gram Name: cmza_; I
PLC Gddress: MB: 1
FLC Type:

Tah moves between the Henu Bar and the Editing Screen.
ALY H provides help on the mehu item selected by the cursor.
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16.4 Motion Module Status Information Monitor Screen

3) The MC Status Submenu will be displayed. Select Status Monitor using the Cursor Keys
and press the Enter Key.

io L‘onfig Inl“el' Ilnt:l.nn Commcnt lef hta

5 el T

E 5 n P‘“it“n Mnitor
Monitor
IHI IHI Statun Hunnm

<R>
!

Program Name: GL128 1 -
FLC Rddress: MB: 1
FLC Type:

Tab = woves betwesn the Henu Bar and the Editing Screen.
ALT W provides belp on the manu item swlectesd by the cursor.

4} In Offline Mode, the Communications Parameters Setting Screen will be displayed. Enter 1¢
the communications parameters and press the Enter Key.

]Hod. Gonfiy l-lrld.nr mtion Golunt Hef Data o Tanls Quit

Fl hy:ai‘l’ﬁ

Pocition Honitor
l/D Honitar
i —

<R

| Frogran Nameo: (‘-’LIZD_I |

FLC Address: NB: 1

-COMMUNICAT IONS PARAMETERS

Rddress Protocol Mode Data Bits Parity Stop Bitz Baud Device
1 HEMOBUS RIu EVEN 1 608 com

q Pip Switches 38K/ 48% |! I CBX/ 78X I I
2345679 12345678 2345678

The Status Information Monitor Screen will be displayed.

in e nez NCL1+C2  hlarm ROM Menor Tools Quit
e ] 4 F5 F6 ¥ m—ﬂiﬁ—m
ModulesMCL O Ho 0@ $tatus Information Monitor
Hodule:MC2Z O No =98 [Display Unic: 1 = 2)
MC1 nc2
Axis No 2 3 4 1 2 4
fxiz Name X ¥ Z ] ] ¥ z -
Hoving a ] -] -] ] -] ] -]
Mode Nanual Manual
Homing
Running
be $inele Block
v - c
Finished

gran
¥Waiting H code Pinich
Hachine Lock Active
nc Unit Readsy
Alarm

zﬂnoowan

-1 %QQMOU

Mo .
Bain Program [l 299 ) 8en
Suk 1:Progran QO No. 892 B No 820 ¢ No. 888 B No ]
Sub 2:Progran 0 No. @89 B Mo @88 0 No. 880 B No ]
ub 3:Progran 0 No. B30 B No 802 0 No. 08 B No ]
Sub 4:Progran 0 Ne. B33 B No 888 0 No. No L]

—16-17 —



Monitor Operations .
M
16.4.2 Switching Modules '

16.4.2 Switching Modules

To increase the speed by which display data is refreshed, itis possible to switch to displaying
a single Module. Use the following procedure to switch from displaying both MC1 and MC2 to
displaying MC1 only.

1) Switch to the menu cursor using the Tab Key.

2) Select MC1 using the Cursor Keys and press the Enter Key.

Llaln nc2 MC1+MC2  Alarm ROM Memor Tools Quit
[F1. —————F §———F5 P —-IN—F7
Podule:AC1 O No -0 Statuz Information Wonitor
Nodule:MC2 O No :08 . I[pisplay Unit:s 1 = 21
ncy nc2
fAixis Wo 3 4 1 2 4
Axiz Nems X ¥ z s X ¥ z -
Hoving a ] a ] e a a2
Node Manual Hanual
Homing ] a
Running ] ]
Progran Hold
Iolrby Sin!,h Block
Program Finished ;
Vaiting ¥ code Finish -4 8
bl gk e : :
nit 1] 1 L
Rlarm No. ] i &
Main Frosram [ - -] 98 /08
Sub 1:Proyran 0 No. 888 3 Mo 808 0 No 823 B No. [
$ub 2:Program 0 Mo. a9 3 Mo 288 0 Mo 288 B No. 898
$ud 3:Program 0 No. 808 B Ne 288 0 No 908 B MNa. [
$ub 4:Progran 0 MNo. 089 B Mo 288 0 Ho 208 B No. 288

The Status Information Monitor Screen will be displayed for MC1 only.

blli.ll =] [ NCL+HCZ Alarm RON Homor Tools Quit
[F1 3 e F5 i F7- -
Illnduhzlm 0 No 00 S$tatus Information Monitor
le:— O Mo - {Display Unit: 1 = 21
neL HC2
Axic Mo 1 3 4 1 2 3 4
Axiz Name H v z 8 - - - -
Houing ] ] 9 a - - - -
Mode Manual
Homing '] -
g-nn lhmning | ] -
lhlg by Si.nglc Bleck i -
Program Finished -
Vaiting N code Finish [ ] -
Machine Lock Active ) -
NG Unit Readey 38 -
Alarm No. -
Main Pregram L) [ - -
Sub 1:Program 0 No. 9280 B Mo P88 O MNo. ~ B Ne. -
Sub 2:Pregram 0 Na. 2888 B Ho B&3 O No. - B No. -
Sub 3:Program 0 Ka. 838 B No 828 O No. - B MNo. -
Sub 4:Program 0 Mo. 208 B Mo B398 0 No. - B No. -
OIREEP Apart from the status information displayed in the Status Information Monitor Screen, the fol-

lowing information can also be monitored.

« Alarm Log

By selecting Alarm from the menu bar, a list of the alarm logs will be displayed.
* ROM Version

By selecting ROM from the menu bar, the ROM version will be displayed.

+ Program Memory Space

By selecting Memory from the menu bar, the total amount of memory, used memory, and free
memory will be displayed in bytes. ‘
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16.5 Motion Module Program Monitor Screen

M

16.5 Motion Module Program Monitor Screen

when the Motion Module is installed. This operation cannot be executed for the MC10

This section describes the procedure used to monitor the motion program running status
Motion Module.

16.5.1 Displaying the Program Monitor Screen ...........ooooeeeennon. ... 16-19
16.5.2 SwitchingModules .........couiuiineine e 16-20
186.5.3 ErorPulse Display . ...... ... iiiiiiiiii e 16-21

16.5.1 Displaying the Program Monitor Screen

if the Motion Module is instalied and the motion program is running, the block currently being
executed, the I/O data, and the current position can be displayed. Use the following proce-
dure to display the Program Monitor from the initial screen.

1) Select Program Menitor from the Motion Menu using the Cursor Keys and press the
Enter Key.

de Conf Ladder Comment Raf Data
Buee  goness g o

Tab  moves hetwsen the Menu Bar and the Editing Screen.
ALT H provides help an the menu item selected by the cursor.

Yools  Quit
-7

2) In Offline Mode, the Communications Parameters Setting Screen will be displayed. Enter
the communications parameters and press the Enter Key.

]’:';d. Cenfig L:d.d..r }In{tinn gmnc ?‘:f Data . l'oo_ls Quit I
I IEI IDEDI I cR)h
Program Name: cuze_x.'t

I PIC Address:  MB: 1 1

COMMINICATIONS PRRAMETERS
Address Protocol Mode Data Bitz Parity Stop Bits Baud Device
1 MEMOBUS RIU [:] EVEN 1 7609 Com

|H I Dip Switches 38%/4BK |- | £8X.78% l-l
2345678 2345678 2345679 _||
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Monitor Operations

16.5.2 Switching Modules
The MC Program Monitor Screen will be displayed, with the block currently being
executed displayed in reverse video.

in Module  Display ‘lool: Ouit

Eowu : MCL QO ND. : BS HC PROGRAM MOMITOR : IAMUI'I'?%E nc
LineNO| N NO s mi¥ LINE = 26
[ 3 -5 .
g882 |NBi@ |MOU X108. Y200. 225
2283 |Ne2e S X158 Y2hH. ,mm 1
2esd | N938 0, 2280. Piga.;
2885 |Ka4e I'KJJ XY 2128 Y198, ISB J58. F190.; -
8es6 |NaSe MOV X18. Z158.; : !
2087 |Nece 8a. F208. ;
2068 WS X320.Y180. F100
0887 |Nese 1598. Z38@. Fi5

o o ;K' [&’.L;'l'lllt Fozitionl
T . o $00e3 - @ HE T -+~ S el
21812 - a8 Z: +i4 388 {mn]
slei3 = e . 8¢ +451.200 {mm]
z0881 = -]
Olm'ﬁlb 1f two MC20 Motion Modules are being used, the Module Selection Window will be displayed

before the Program Monitor Screen is displayed. Select the Module to be monitored, and then
continue the operation.

16.5.2 Switching Modules

The target for program monitoring can be switched from MC1 to MC2. Use the following pro-
cedure to switch from displaying MC1 to MC2.

Select MC2 from the Module Menu using the Cursor Keys and press the Enter Key.

Im% Display Tools Quair
——F{—-——-—-—-—-FS—PS—-—W—W—N- 3
JHODULE : NC PROGRAM MOMITOR LANGUAGE: MC -
W UNIT = s

MAYX LIME = 2¢

3 PROG.S
89n2 [N818 MOV X190. Y208. Z258.;

NE3R WS ¥228.

NB48 |NCY PRY 3{120 ¢108. ISB JSB. F1ed.;
NE50 |MOU X10. .3

N26Q |MUS X208. !3“ 8. ;

N270 |MUS X328.Y108. Pim

NOR® [MUS Yi58. I399. P:I.SB

[Current Position]
v W a 0082 - a L H -112.008 [mm]
- 2 20883 = ] ¥: +153.608 [mm]
#IB12 =~ 2 Z: 008 [m)
81813 = [] $: +451._200 [mml
goael = ]
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16.5 Motion Moduie Program Monitor Screen

The display will switch to show MC2,

bpl:i.n mdule 'D_i:phy o __ " Tools Quit
JHODULE = MCZ O MO. : @7 = WG PROGRAM MOMITOR LaNGliacE:

UNIT = w»

LineNO| N NO MAX LINE = 11

Ni11@ [WHILE %18 < 188 boi;
28 P P1 CRiG;
GSB _P33;
40 |IF #1598 == 1 GOTD 188;
NLSH MOV X18. (1@.;
*¥10=810+1

L L
-3
B

[Current Pogition]
m_ a 0002 - a Xz +70.488 [am1]
] = a 80083 = a ¥: +734.488 (O}
A2 = a Z3 -11%.488 [om]
#1813 = e 53 -176.888 [mm]
#oee1 - ]

16.5.3 Error Pulse Display

Either the values for the current position or the error puise can be displayed. When the MC
Program Monitor Screen is first displayed, the current position wili be displayed. Use the fol-
lowing procedure to switch from the current position dispiay to the error pulse display.

Select Error Pulse from the Display Menu using the Cursor Keys and press the Enter Key.

Pain Hodule !mp Tools Quit
IF1 F2 Data ] 76 F7-RE PR
[MODULE : MEL © | Positien PROGRAN MOHITOR LANGUACGE :
URIT : mm
LineNO| N NO MAX LIME = 26
[ ;PROG.5
0682 [NB18 |HOD ¥iPd. Y288, Z250.:
8223 |mwaze |
ep84 |NB3B |MUS ¥220. 7280, Fiea.;
880G 1N348 |MCU PXY %120, Y108, i59. J58, F199.;
8806 |RBSA [MOU ¥Xi@. Z150.;
8887 |N260 [mUS X288. Y394. F200.;
6883 W87 |MUS X320.Yie9. Fi80.;
0807 |NG3P |MUS YiSe. Z300. F15d.;
(Current Poxition)
[} 20002 = ) Xz +188. 968 [ )
= B 20093 = ] ¥z +1321.668 {mn)
RIB12 = ] z: 4355 [mn]
%1913 - 8 8:  +1369.6E9 [mn]
P01 - 2

The current position display will switch to show the error puilses.

Pain _ Moduls Display o B . Tools  Guit
T MCL OMO. 1 @ = NC PROGRAM MONIIOR - LaRCTnaE:

UNIT : mm
N N0 MAX LINE = 26

;PROG.5
HE10 MOV X188. Y2PR. Z25@.;
HUS W10l ¥250.5 FlUb s

- B, a.;
MOV PRY X128. ¥189. 150, J58. F189.; 1
HOU X19. Z158.;

88. ¥300
NE72  |MUS %32@.Y198. PiBd.:
NSBE WS v150. Z388. F158_;

— &
el ¢
g
-]

{Error Pulseltion]
ﬁﬂm_ a 20802 - [} #: ~4
a1 - [} #0083 - B ¥ +
81912 = [} Z: 1
Ne13 - a 83 +*
20881 = -]
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File Operations

This chapter describes operations used to manage program files such
as creating new programs and reading programs.

17.1 Overview creeeseststanesanarreeneasneas 172

17.2 File Operation Details ................... 174

17.2.1  Selecting Program ..................ccc.oeiun... 17-4
17.2.2  Creating New Program ......................... 17-5
1723 SavingChanges ............ccooivuruuinno. 17-7
1724 Saving AllFiles ................ ivvinii . 17-8
17.2.5 Saving As Specified File Names ... ............... 17-9
1726 Changing PLC Addresses ....................... 17-10
17.27  Location of Program Name ...................... 17-14

17.3 FileOperations ..........vvevvnunnnn.... 17-16

17.3.1 File Operation Screen ..............c0vooooon.. 17-16
173.2 Copying Programs .................covuvueuo... 17-17
17.3.3 Deleting Programs ............................. 17-18
17.34  Renaming Programs .....................co... ... 17-20
17.3.5 Formarting Floppy Disks ........................ 17-21
17.3.6  Changing Program Paths ........................ 17-23
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File Operation
e

17.1 Overview

l This section briefly describes file operations, such as reading or saving programs.

File management refers to operations such as readmg or saving programs. A list of opera-
tions is provided below:

» Select Program: Selects a program for editing.

+ New Program: Creates a new program.

« Save Changes: Saves only files that have been changed.
+ Save AllFiles: Saves all files under edit.

* Save As: - Saves the file under edit with a new name.

s Change PLC Address: Sets up communication parameters when a created program
is sent to PLC using the loader operation. Setting up these pa-
rameters is required unless the default settings are to be used.

i
» Location of Program Name: Changes the list of programs in the default directory,
which is accessed by choosing Select Program.
« File Operation: Executes management operations, such as copying programs that
have been created to a floppy disk, deleting programs, and formatting
fioppy disks.

W[inFo > The default directory path for programs when using the Location of Program Name operation
is \FMSGLWPROG F{AMS.

Use the following procedure to start the File Menu.
1) Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

hdo Config Laddsr Motion Comment Ref Data
—_—F———— 55— P6

~—tamosoft
Progran Name: GLIZBJ
PLC mh‘lre:s NB:
FIC Typo

Tab moves betwesn the Menu Bar and the Editing Scrsen.
ALT H provides help on the wenu item sclected by the cursor.
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The Files Submenu will be displayed.

Mode Confu Ladder Hnti.on Cnlllnnt Rcf Data m Quit
[P1: ""E.. o0 lg——p——my
o3

Hew E

Save chim

Save A1 ;

Save as...

Change PLC Address
Location of Program Hame
Pile Operation

Progran llu- mza_z
PLC .ddu HR: 1
F1C Type

Tab  moves betwesn the Manu Bar and the Editing Screen.
RLT H provides help en the menu itsm selscted by the cursar.
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17.2.1 Selecting Program

17.2 File Operation Details

' This section describes the various operations associated with the File Menu.

17.2.1 Selecting Program ...ttt i e 17-4
17.2.2 CreatingNew Program ... iiiiiiiiierriiiiiicnaianneans 17-5
17.2.3 Saving Changes . cveriieiiieiiiiiiaiiisieeeiairieetrasnraennanns 17-7
1724 SavingAlFiles ...t enaan e 17-8
17.2.5 Saving As Specified File Names ......... et 179
17.2.6 Changing PLC Addresses ............... ettt 17-10
17.2.7 Locationof ProgramName ...ttt 17-14

17.2.1 Selecting Program

The Select Program operation is used to read an already created program. The programto be
read is stored in the directory \FMSGL\PROGRAMS.

To read a program stored in another directory, use Location of Program Name (see section
17.2.7 Location of Program Name) to change the drive or directory, and then perform the
selection operation.

1) Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

hi- Confiy Ladder Motion Cosmpnt Ref Data
£2 F3 P 5 —F6—F?—- T

Program Nane: m":zn_;t
PLC Address: MB:
PIC Type:

Tab wmoves botween the Menu Bar and the Editing Screen.
ALT H provides help on the menu item selected by the cursor.

3) Choose Select Program from the submenu and press the Enter Key.

Mode (‘.nnfig hirl.-r Hotion Cn-nnt Ref Data Quit
FL ———F7- M- Teo ls— ——

Iluu ?mgm

Save changes

Save A1l File

Save as.

Thangs PLC Address
Locatinn of Program Hamo
File Operation

Proyran Name: Gl.izﬂ.,.l.
P‘LC Address:  MB: 1
FLC Type:

Tab moves between the Menu Bar and the Editing Screen.
ALT H provides help on the menu item selected by the cursor.
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4) The program selection window will be displayed. Move the cursor using the Cursor Keys
to select the program to be read, and press the Enter Key.

blalln Config Ladder Motion co-enl: Re!‘ Pata Tools Quit
M ——p———Pp3— P ——P P r—Ioels————

Tiles

Select % gw
OELTSB_L Save chan o:
GL128_2 Save All
SLizu 3 gl.‘:; u...
‘ Q_z l.ocatlnn of Prngn.n Name
- le Operatien

Program Name Gll".ﬁ:;r‘-
PLC fddress: MB: 1
TIC Type:

moves between the Menu Bar and the Editing Screen.
aLT H provides help on the menu item zelacted by the curzor.

The selected program will be then read to memory.

17.2.2 Creating New Program

The New Program operation is used for creating a new program.

1) Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

]Hndn Conf:l.g' l-uidur Hnt:inn cnlncnt ltf Dlta

MEMOSOF;

gran Nawe: GIJ.ZG_.I.
PLC ad.d.r-n ne: 1

Tah = moves batwsen the Menu Bar and the Editing Screen.
ALT H provides help on the menu item zelected by the curzor.

3) Select New Program from the submenu and press the Enter Key.

d. c-n!i’ Ladder 'bt:l.ol'l CO“nt Ref Data Quit
"m'l—gnlc—l""-l

Files

Select Program 1

Ew' cm

Save A1l ﬂh

Save as...

Change PLC Addres:z
Lecation of Pngru Nane
Fils Operation

I
. I

gran Name : GLI.ZB_J.
PLC Rddress:  HB:
PLC Type:

Tab  woves between the Nenu Bar and the Editing Screen.
ALT W provides help on the menu item zelected by the cursor.
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17.2.2 Creating New Program cont.

4) The Filename window will be displayed. Enter the desired filename (GL120_4 in this ex-
ample) and press the Enter Key.

!

Iunls

o F1.

Tab  moves betwesn the Menu Bar and the Editing Screen.
ALY N provides help en the menu item zslsctsd by ths cursor.

Config Ladder Motion Quit

Pode  Contis Laddor Mo
Filenane: GL120 4 Bd.ll] |

Comment Rof Data
G- — 78

GL128 1
MB: 1

Pro Hane :
m’:..ﬂulc :
FIC Typs:

5) The communications parameters setting window will be displayed. For details on the set-
tings of communications parameters, see 17.2.6 Change PLC Address. If the PLC ad-
dress does not need to be changed, leave the settings as they are and press the Enter
Key.

Pode o

MEMOSOFT|

T

Gunfis Ladder Hotf..ll CO—IH: Rcf Data: I'oolt

Program Name: cuza_; I
PIC Address:  MB: il
COMMUNI mnous PARAMEIERS
Addrecs Pmt.col llnd- htl Bits Parity Stn) Bits Bnml Dcvi,cn
158 MEMORL: EVEN

m Dip Switches 38K-48% m sa%7E% Hl
2%

6) The PLC System Configuration Screen will be displayed. For details on changingthe sys-
temn configuration, see chapter 7 Setting System Configuration. If the system configura-
tion does not need to be changed, choose Quit.

in - Ma Settings Tools Quit
TL eI W TR X e
Wﬂ_ nfiguration
ges
PIC = Systen Registers Special Re
PIC type G !‘/sn-n z Y18256 t coil muvz
ExecPack 2 208256
User Logic 1 Ihtinn 11 Q1816 C swesp 489998 -
Stats RAM 3| PC Lin 12 Q@168 499999
Segment No 1| Reset Dofmlt 1 X18256 Hepeed zcan 489997
Motion 2 2 X2d256 Timer Reg 489796
Link 2 Module nC cntrly-1 P18256 Step Relay 482081 -
WG catrly-2 P28256 432832
I = Mcode rly-1 M1B896 Calendar 4879988 -
170 moduls 34 Mcade rly-2 M2BO76 429995
CH1 Station 15
CHZ Btation 1% Link Coil 1 Dii824 MG linkRegl 499042 -
Link Coil 2 D21824 489914
Refurence Link Reg 1 RiiP24 BC linkReg2 489915 -
Coil paa1Y2 Link Reg 2 R21P824 499987
Input Relay 181824
[nrdlt Reg 300512
Hold Regy 48999%
Const Reg 78487

The Segment Status Display Screen wilt be displayed.
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IMPORTANT 1) Communications parameters set here are used by Select Program or for executing Load
whenin Online Mode. Make sure to setthese parameters correctly to correspond with the
parameter settings of the PLC. See 17.2.6 Change PLC Address. After having once en-
tered the settings, they can be changed again using Change PLC Address Menu.

2) Confirmation of system configuration is required before creating a new program. If some
settings, such as PLC type, are different, the program cannot be loaded to the PLC. Also,
some operations cannot be used when editing the program.

17.2.3 Saving Changes

Programs in MEMOSOFT are saved in several files, such as system configuration, ladder
program, and motion program. Save changes operation saves and renews only files that
have been changed among those program files. if the program size is large, the processing
time can be reduced dramatically by performing this operation rather than the Save All Files
operation described in section 17.2.4 Save All Files.

1} Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

hiﬂ Elemsnts Edit GosSrch MNetwork BRef
———— —p— P P PP
Seg.H 82 / 2 Timer 1

Reforence Data

Format :Decimal Pile Data Range = 1

3) Select Save changes from the submenu and press the Enter Key.

Main Elaments Edit  GosSrch Metwork Ref it
FL P2 - mnsindall 7 o e "?-m—m—oo  Quie
Seg H 82 / 2 Timer 1 il

Files

$elect Pro

New Pro gran
Save as...

Change PLC Address

Location of Program Name
Pils Operation

h
BBOAZ1 432804

Reference Data

~ Format :Decimal File Daca Range = 1

Only the files that have been changed will be affected.
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17.2.4 Saving All Files
OIRED 1 MEMOSOFT is exited without saving a program that has been changed, a message will ask

whether to save the changed program. Be sure to regularly save the program being worked
on, especially if the computer is to be left unattended.

17.2.4 Saving All Files

Save All Files operation saves all the files of a program currently being edited. This is conve-
nient when making the creation date uniform for all the files included in one program (for ex-
ample, when finishing the program). When the program size is large, it is better to perform
Save Changes described in section 17.2.3 Save Changes to reduce the processing time.

1} Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

h Elements Edit  Go/Srch Metwork 'Eaf Quic
= F4 3 el =) R

References Data

- Format :Decimal Pils Data Range = 1

3) Select Save All File from the submenu and press the Enter Key.

Ein Elements Edit
—2————P3———P
|Seg.H 82 / 2 Timer 1

GorsSrch  MNetwork Ref Quit
G e D et

Select Pro.yﬂn
New Pro

| Save clunﬁs
Save asz...

Changse PILC Addrezs
Lacation of Program Name
File Operation

Reference Data

Ll’wﬂa‘.‘ iDecimal Fils Data Range : 1

All files associated with those being edited will be saved and renewed.
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%

17.2.5 Saving As Specified File Names

The Save As (saving as specified file names) operation saves the program which is currently

being edited under a different program name. It is convenient when creating two similar pro-
grams,

1} Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

Main Elementz Edit GosSrch HNetwork Ref Quit
P PGP P7-RATR

- Format :Decimal File Data Range = 1

3) Select Save as... from the submenu and press the Enter Key.

7
i

ge ¥
Location vf Program Hame
File Operation

m@ﬁz_m

Re £ ce Data:

 Format :Decimal Pile Data Range : 1

4) The Filename setting window will be displayed. Enter the new file name and press the
Enter Key.

hd- Conf iy Ladder Motion Commant Ref Data

e Ta T o ¥

To: 1= Quit
<R>

Tab = movet betwesn the Menu Bar and the Editing Screen.
ALT H provides help on the menu item selected by the cursor.

Filenane: ARF[EY . ENU I

Program Name: GLIZB 1
PLC Rddesss: MB: 1
PLC Type:
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17.2.6 Changing PLC Addresses

5) The comrﬁunications parameters setting window:will be displayed. For details on setting
communications parameters, see 17.2.6 Change PLC Address. If the PLC address does
not need to be changed, leave the settings as they are and press the Enter Key.

h;de Config Ladder Motion Comment Ref Data Tools Quit

MEMOSOFET

¥

P ft
Progran Namo: GL120_1 ¢ ' Il
PLC Address: ME: 1
COMUNICRTIONE PARAMETERS

fiddress
1

| -]

Protocol Mode Data Bits Parity Stop Bitz Baud BPevice
HEMOBUS RIU [ ] EUEN 1 9608 coMt

Dip Switches 2JISX/48% [- | 68X 78X |- l
12345678 12345679

The file will be saved with the specified name.

01mm> After the Save As operation is finished, the name of the program being edited will change to
the name of the program which has been newly saved. To edit the original program which was
being edited before the Save As operation took place, import the original program by using
the Select Program procedure again.

17.2.6 Changing PLC Addresses

The Change PLC Address operation sets up the personal computer for communications with
the PLC. The setting parameters are shown below. Parameters for the PLC are set by the
system configuration port. See chapter 7 Setting System Configuration for details.

¢ PLC address:

» Protocol:

» Mode:

+ Data Bits:

o Parity:
« Stop Bits:

« Baud Rate:

+ Port:

Specify a unique number for each PLC so as to easily identify the PLC
required.

Select MEMOBUS, REMOTE MEMOBUS, or MEMOBUS PLUS proto-
col.

Select either RTU or ASCII Mode. For the connection between the per-
sonal computer and the PLC, however, only RTU Mode can be used.

Automatically determines the number of data bits according to the
mode.

Select odd, even, or none.
Select 1 or 2.

Select the baud rate within the range of 150 bps minimum to 19,200 bps
maximum,

Select the communications port.
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1) Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

kiﬂ Elemonts Edit CosSrch Metwork Ref
———F2——F3 P4 PS5 e
Seg. H 82 / 2 Timer 1

Format :Decimal File Data Range = 1

3) Select Change PLC Address from the submenu and press the Enter Key.

in Elements Edit GorSrch Metwork Ref m Quit
—— Pl '3 P4 5 6 F?{E-r—Toolea——-——y
Sow.H 02 » 2 Timer 1 tiles
$clect Program
w
Save chsnr.:
Save A1l File

cation of gran Name
ile Operation

| |

- Format :Decimal File Data Range : 1 !

4) The Communications Parameters Setting Screen will be displayed. The cursor will be
located at the PLC address, so enter the PLC address (3 in this example) and press the

Enter Key.
I;l?;in - Elements Eéit E/Srl:h ktwrk %EW_Tnn%s e Quit
Sea.H 82 7 2 Timar 1 o o b - Files— Lo—
’S':hct Progran
W
Save :ms
Save A1l gih

Save am...

71— UCIR |- cation o yran
8 450083 o File Operation
" 9900Z1 100884 l
—COMRUNICATIONS PARAMETERS:
[ Address Protocel Hode Data Bitz Parity Stop Bitz Baud Device
] MEMOBUS RTY B EVEN 1 608 ComL

|- I Dip Switches 38X/48X I- | 63X78% [-I
12345678 12345678 2345678
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17.2.6 Changing PLC Addresses cont.

5) The cursor will move to the protocol position. If the current setting as MEMOBUS does
not need to be changed, press the Enter Key.

fain Elements Fdit  GosSrch Network Ref Tools _ Quit

—F2——— 33— PP ———F6 Tools————|

Seg.H 82 / 2 Timer 1 —-—1;81 tProﬂ“

— elec
IRO081 e HWew Program gran
[— Save =hln$u
T 1OD0G Save All File
rplatie Ws‘" o TLC
/I—I I cation of gran
qm:!_ .;I le Operation

”

- H[m'ﬂm PARANETERS
Address Protocel llod. Du:a Bits Pu;ty Stop Bits Bami Deuicc
3 HEMOBUS s6e8

- Dip Switches 3IB8X/48X | | SSKMH | |
2345678 2345678 23155?3

6) The cursor will then move to the mode position. As the personal computer can only com-
municate with the PLC in RTU Mode, press the Enter Key.

b;zn - Elements Edit  Go/Srch Mecwork Ref __ Toals _ Quit
—H—FS"—PG—Wmmtoukﬁ—ﬁ

Swlact Pro;;::.

New Program

Save changss

Save All Fils

Save as.

Charnye PL(. f lll! €Ly

pcation o 0

Filo Operation &

R

0rINICATIONS PARAMETERS
r| Address Pretocol Mode Data Bits Parity Stop Bitz Baud Device
3 MEMOBUS RTU | ] EVEN 1 2688 cont

q Dip Switches 38%/48% - GR¥ /78X I |
2345678 2345678 123456

7) The cursor will move to the parity position. Select odd, even, or none by moving the cur-
sor with the Up and Down Cursor Keys, and then press the Enter Key. in this example,
even is selected.

Illai.n Elements Edit Go/Srch  MNetwork Ref Toals Quit
4 s f 2 e P} e Fe————— 1§ ———— 6 —————F 7T T 00 1s————
Sey.% ¥2 / 2 Timer 1 Files
Select Program
New Pro

Save changes
Save All File
Save as. ..

Location o gran Name
File Operation

|

RARET ERG
Addrezs Protocol Mode Data Bits Parity Stop Bit: Baud Device
3 MEMOBUS KTV [} EVEN 1 9688 COoML

|q I Dip Switches IBUL 48K |! I [3:+ g H] I_I
12345678 12345678 2345678
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8) The cursor will move to the stop bits position. Select either 1 or 2 by moving the cursor
with the Up and Down Cursor Keys, and then press the Enter Key. In this example, 1 is

selected.
in Elements Edit GosSrch MNetwork Ref Tools Quit
Pl ————F2— P} fo——F—— 6 —To0la—y——
Seg. H %2 / 2 Timer 1 il

Tiles
Select Pregram
Wev Program
Save changes
Save A1l File
Save as...

cation of gran Name
Fila Operation

&l_m

COMMUNI CRTIONS PARANET J

ERS
r ld.g.nu Protocol Mode Dna.Bi.l:c Parity Stnpinit: Baud Device

MEMOBUS RTU EUEN soe  Comi
|- I Dip Suitches 38K/48X i_l 68X.78% |- [
2345578 2345671 2345678

9} The cursor will move to the baud rate'position. Select the baud rate by moving the cursor

with the Up and Down Cursor Keys. In this example, the rate is left at 9,600. Then press
the Enter Key.

Main Elemsnts Edit GosSrch Metwork Rsf Tools Quit
[P ———e—F2———F3 t—r—F5———P&
eg_H #2 / 2 Timer 1

Select F
Haw Pro

COMMUNI CATIONS PARAMETERS |
Addross Protocol Mode Data Bits Parity Stop Bits Baud Device
|' 3 MEMOBUS RTU [ EVEN 1 9688

m Dip Suitches 3X48X m 68%./78% m
78 678

10) The cursor will move to the device position. Select either COM1 or COM2 to specify the
communications port by moving the cursor with the Up or Down Cursor Keys. In this ex-
ample, COM1 is selected. Then, press the Enter Key.

k:i.n Elements Edit GosSrch Metwork Ref Too%l Le Quit
———p—— gy R ok  m ———
Seg H #2 / 2 Timer 1 G":D

E
Select Pre
Naw Program
Save changes
Save ALl iih

CONMUNICATIONS PARAMEIERS
r| Rddress Protocel Hode Data Bits Parity Step Bit: Baud Device
3 MEMOBUS RIU -] EUEN

1 7608 ComML
H Dip Switches 3X/48X% I- | 68K/ 788 Iqﬁl
2345678 12345678 12345

The communications parameters settings are now complete.
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17.2.7 Location of Program Name

+

IMPORTANT |  If the communications parameters of the personal éojmputer (as set by the Change PLC Ad-
dress operation) do not correspond with the communication parameters of the PLC (as set by
the System Configuration Port operation,) communications will not be possible. Basically, do
not change parameters, except for the PLC address, after they have been set for the first
time. '

17.2.7 Location of Program Name

The program path must be changed if a program is to lbe read from a directory which is differ-
ent to the initial setting, or from a fioppy disk.

1) Switch to the menu cursor using the Tab Key.

2) Select Files from the Tools Menu using the Cursor Keys and press the Enter Key.

&u Config Ladder fMotion Comment Ref Data:
—_—p PP G 6

Tah wsoves betueen the Menu Bar and the Editing Screen.
ALT H provides help en the menu item steloctsd by the cursor.

3) Select Location of Program Name from the submenu and press the Enter Key.

Iﬁd‘ Cnnfig mnu.- nm.nn couent Ref Data m.'n-mn
rl'unls—r-—:

Files

Select Program

Now Program

Save changes

Save All File
Save as.

Change PLC Address
FiE Eutun

ft

Program Name: cuza_;
ru: m'ldrlss #MB:
PLC Typas

moves between the Menu Bar and the Editing Screen.
au H provides help on the menu item sslected by the cursor.
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4) A directory setting window will be displayed. The default setting is \FMSGL\PRO-
GRAMS. Enter the new directory name and press the Enter Key.

de Config Ladder Motion Comment Ref Data Tools Quit
~——F2———T3 P4 P6 7 r—Tools————y
Seloct Pro‘s;;;.

75

Hew Program
Sa:e changes
Save All File
Save as...
Change PLC Address
HE EErat!m'l

[t

Pro Nams: GL129_1 N
ms:“ddnn: MB: 1
PLC Type:

Location of Kanes Driuve B direrntonry:
~. g 1\pros x

Tab
ALT H p

From now on, when Select Program is selected, programs in the new directory will be
displayed.
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17.3.1 File Operation Screen

17.3 File Operations

This
and

17.341
17.3.2
17.3.3
17.3.4
17.3.5
17.3.6

17.3.1 File Operation Screen

section describes the various operations associated with the File Operation Menu,

the necessary operating procedures.

File Operation Screen ................ve e eaaaa et 17-16
CopyiNg Programs . ...veuuneiinnirieiiceir e iataernrisainrarnnes 17-17
Deleting Programs ........oveieueunenns R R PP PR R TR 17-18
Renaming Programs .......c.viiiiiiiiiiiiiieiiai i aaeanrananas 17-20
Formatting Floppy DiskS ......coovinnion e 17-21
Changing ProgramPaths ......... ... .ot 17-23

By selecting File Opefation from the Files Submenu of the Tools Menu, the File Operation
Screen shown below will be displayed.

in Copy Dalets Rename Format Path Set Too Quit 2
1\ —_— Py 5 ——— P —————F7- T P —FY -
N Cinfmsgly N — —— A3 —
SETUP_1
SETUR 2
GL128_3 SETUP.3
CL139_1 TEST 1 3.
L1392 TEST 2
TEST_1 TESI 3
TEST_2
1EST 3

——— FREE SPRCE  1662,656KE — ——— FREE SPRCE 694XB —

1. Left Program Display Window

Displays the programs to be operated on. The programs in the directory specified as the de-
fault in Location of Program Name will be displayed.

2. Right Program Display Window

Displays the programs to be operated on. The programs in the route directory of the floppy
disk drive specified as the default will be displayed. If a floppy disk has not beeninserted when
File Operation is selected, a confirmation message will appear asking to check whether a

floppy di

sk is inserted.

3. Window Title

Displays the drive and directory name for each window being used for the operation.
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%

4. Free Space

Displays the amount of free memory space available on each disk.

17.3.2 Copying Programs

The File Operation operation can be used to Copy programs between the left and right win-
dows in either direction.

The following example shows the procedure used to copy a program from the left window to
the right window,

1) Select the window containing the program to be copied. Then, select the program to be
copied (GL120_2 in this example} using the Cursor Keys.

in Copy Deleta Rename Format Path Set Tools Quit
E;-—rz—-r T4 F5 Pé- F7-TP e

3 ~ag-—F9
— C:\g 1N N\ —_ —— AN —_—
CL128 1 o Tosrans SETUP.1
SETUP_2
GL13871 i
302 IEST 2
TEST 1 TSI
TEST 2
TESTS
{
L FmEE sPacE  1662.656m L PReE sPacE 694KH —

2} Switch to the menu cursor using the Tab Key.

3) Select Copy using the Cursor Keys and press the Enter Key.

Main Delete Rename Format  Path Sst Tools Quit
Piin g Do P4 4 55 7N PY - E—
C:nEmegly, N — Az —
Glazg g U ProgTans SETUP_1
W SETUP S
iy i
GL138_2 IEST 2
TEST 1 IESTS
TEST 2
TESTS
L vmeE sPacE  1662.55600 — L—  PReE space 694x8 —
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- L
17.3.3 Deleting Programs

m

4) A confirmation message will be displayed. Enter Y and press the Enter Key.

g;in Copy Dalete Renams Format Path Set! Tools Quit
e pp————— 3 ————P4—msm——F5 ————Fo————F 7- TG P8-S —FY
— C:\fregl\programs\ ——— e
GL129
GL138_1
GL138_2
TEST. 1
TEST 2
TEST_3
——— FREE SPACE  1662,656KB — ——— FR‘EE SPACE 694KB -

The program will be copied. When the copy operation is complete, a message indicating
compietion will be displayed.

5) Press the Enter Key. The message will disappeér, and the list of programs will be dis-
played once again.

17.3.3 Deleting Programs

The File Operation operation can be used to delete programs as shown in the following exam-
ple.

1) Select the window containing the program to be deleted. Then, select the program to be
deleted (GL120_3 in this example) using the Cursor Keys.

Ilhin Copy Delete Rename Format Path Set Tao Quit
P ————F2————P3}————F4~—Fs———F6 —— P2 -F8 -TH—F?
— C:\fmsgliprograms™ -_— AN —
GL128_1 SETUP.1
GL120_2 SETUP 2
SETUP_3
TEST 1
cLi3e_2 EST_2
TEST_1 IEST. 3
TEST 2
TEST 3
L——— PREE SPRCE  1662,816KB — '——— FREE SPACE 634KE —

2) Switch to the menu cursor using the Tab Key.
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%

3) Select Delete using the Cursor Keys and press the Enter Key.

in Copy lm Rename Format  Path Set Tools Quit
’I'% P2 F3 F4 FS P& F7— G F8-i—Fe

—— CI\F 1INDrogTram™ —_— — A\ ——
aaze g e SETUP_1
GL128 SETUP2
Eﬁ— SETUP_3
e g
TEST_{ 1813
TEST 2
IEST_3
L PREE SPACE  1662.e16kB | L —— ¥RrEE sPacE 694KB J

4 A confirmaﬁon message will be displayed. Enter Y and press the Enter Key.

¥ T e T

in Copy - Delete Ranane Format Path Set Tools Quit
F:-—Pz P4 5 6 Fro- {0l -Hg—FY

—— C:\Fuzgl\pro AN ——
GL126_1 grans
GL128
CL13e_2
TEST 2
TESI_2 Cinfnsylsproyrans \GL126_3 vill he deleted
TEST 3 Iz 1t OK? CYrnd v
——— FREE SPACE  1662.816XB ——— FREE SPACE £94KE J

The program will be deleted. When the deletion is complete, a message indicating
completion will be displayed.

5) Press the Enter Key. The message will disappear, and the list of programs will be dis-
played once again.
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17.3.4 Renaming Programs

17.3.4 Renaming Programs

The File Operation operation can be used to rename programs as shown in the following ex-
ample.

1) Selectthe window containing the program to be renamed. Then, selectthe programto be
renamed (GL130_1 in this example) using the (;ursor Keys.

]

Hain Copy Delste Rename Format Path Set " Toels Quit
[P ——r—p2 P —————F4————F5 - ———Pe——F 7 - PR M — 79—
— CiNF 1N AN — —— A=\ —_—
PR ik SETUP_L
cLi2e 2 - SETUP_2
GL128@. SETUP3
}ES
TEST L TEST_3
IEST. 2
TEST 2
i
L—— FREE SPACE 1661.723XB — t—— FFEE SPACE £94XB -~

2) Switch to the menu cursor using the Tab Key.

3) Select Rename using the Cursor Keys and press the Enter Key.

in Copy Dolete M Format Path Set Tools Quit
k?—rz—n — 7P
= C:\fasyl\prograns\ —y — A\ —_—
GL12B8 1 SETUP_1
cL128_2 SETUP_2
GL128 SEIUP_3
TEST
() TEET 2
TEST 1 TEST 3
JEST 2
TEST 3
L——— FREE SPACE 1661,728KB — —— FREE SPACE 694KB —

4) A program renaming window will be displayed. Enter the new program name and press

the Enter Key.
kiﬂ Copy Delete Rename Format  Path Set Tools Quit
—f— —  pe——po-REIE-FE - —FY

—_ C:\Fusg L\proyrane
GL128_1 shhwre

Selected progran iz
GLi3a_1 !
Enter progran nane
(AAX # characters?

———— FREE SPACE  1664.768KB FREE SPACE 694NB —
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5) A confirmation window wil be displayed. Enter Y and press the Enter Key.

in Copy Delete Rename Format Path Set Tools Quit
b;———n—-—r- F4 P 3 F7-I- P8 —3lE—F9

CrnFrsgl\prograns\
GL126_1 it

LB
SETUP_1
EETUP.

Proyram vane uwill be chanyed to TESTA0O1
T it OK? CYoN) y

——— FREE SPRCE  1665,448XB FREE SPACE 694KB —

The program will be renamed. When the renaming is complete, a message indicating
completion will be displayed.

6) Press the Enter Key. The message will disappear, and the list of programs will be dis-
played once again.

17.3.5 Formatting Floppy Disks

The File Operation operation can be used to format floppy disks as shown in the following
example. :

1) Select the window for the floppy disks using the Cursor Keys.

Illain Copy Dalete Rename Format Path Set Tools Quit
iwt 72 73 P4 FS 76 F7-EG-Fe-Ti— ¥y

CinFmegliprograns™ _— — —

czs ——
mzaj

'——— FREE SPACE  1664,648Kp —J L FREE sPRcE ¥B J

2) Switch to the menu cursor using the Tab Key.

3) Select Format using the Cursor Keys and press the Enter Key.
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e e —

17.3.5 Formatting Floppy Disks cont.

A confirmation message will be displayed askirig whether a floppy disk has been in-
serted.

I;I.?;in Ceopy Delete Rename Format  Path Set Tools Quit
—— C:nFmsgliprograms™. — — ! —
GL128_1 .
Fornat iny ef 7« floppy disk will be denc.
Set o floppy disk to the floppy deave.
1f 1t’z OK then press .<Enu:v> kcy to continuc.
L——— FREE $PRCE  1664.648XB - ‘——— FREE SPACE X8 —

4} Press the Enter Key and a window for entering the title comment cf the floppy disk will be
displayed.

5} Enter the title name (DISK001 in this example) and press the Enter Key.

h;in Copy Dalste Rename Format Path Set Tools Guit
—_—f—Pp}— 7. e
—— C:zfmsgl\programs’ ——
GL128_1
GL128_2
GL128_3
GL138_1
GL13|
TEST_1 v
TEST 2 Enter « title connent of the Floppy disk.
TEST.3 2 11 characters.?
|
———— FREE SPACE 1664.672KB FREE $PACE KB —
|

6) A window confirming the format operation will be displayed. Enter Y and press the Enter
Key.

Format Path Set Quic

b
uin Copy

Dolete Tools

—— C:nfmegly N
S gl \prograns

a title connent

CHaxinun iz 11
DISKB3a1

ALl the files will be

Do yun wvant tu fornat

Enter

‘——— FREE SPACE  1664,672KB

of the floppy dick.
charagters. )

deleted by fornating.

o Fluppy disk?<Y /N3y

PREE SPACE

The floppy disk will be formatted. When the formattmg is complete, a message indicating

completion will be displayed.
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7) Press the Enter Key. The message will disappear, and the list of programs will be dis-
played once again.

OlmEIb Only floppy disks formatted for 1.44 Mbytes can be used. Reading/writing can be performed
for floppy disks formatted for either 1.2 Mbytes or 1.44 Mbytes if 3 modes are supported.

17.3.6 Changing Program Paths

The drive and directory for file operations can be changed. The following example shows how
to change a floppy disk file window to a hard disk file window.

1) Select the window for the floppy disk using the Cursor Keys.

I!Iai.n Copy Delete Rename Format Path Set Toels Quit
[Fl--—— 20— 3 Pa ¥S F6 —F?- R F8 i —F9
pr—r c;\f” l\m’.‘.’\ —— el  E 0 ——
GL128_31 ¥
GL128_2
6L128_3 SETUP_3
Gl.iggj gmr_z
TEST. 1 TESI A
TEST 2
TEST 3
—— FREE SMACE  1663.36000 J ———— FREE $PACE 34XB -

2) Switch to the menu cursor using the Tab Key.

3) Select Path Set using the Cursor Keys and press the Enter Key.

in Copy Polete Renane Format | Tools Quit
h P2 F3 F4 S —W 77~ A}-F8 - —F9

—— Civfrrgliprograms, — — — A\ —
aLize g oo

h——— FREE SPACE  1663,369XB —I —— FREE SPACE 694xp -
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w
17.3.6 Changing Program Paths cont. :
4) A window for entering the new path name will be displayed. Enter the path name
(C:ATMP\ in this example) and press the Enter Key.

h;in Copy Delete Rename Format  Path Set Tools Quit
—_—p——— F3———F 4P ————— P~ ——F7- RO PR- T —F9

— C:nfargl\prograns™
GL12@ 1

path changed
b3 @ | Current path
TEST 3 CEAN

Enter the path
<Max 58 characterad

C:NTrr

e FREE SPACE  1663,360)B FREE SPRCE 694K8 ~-

OIIEEID When changing a path name, always place a backsla'sh'(\) at the end of the path name, e.g.,
CATMPA.

5) A confirmation window will be displayed. Enter Y and press the Enter Key.

1

in Copy Delste Renane Format Path Set Tools Quic
— s B2 e [} e P ——— 5 5 ————F 7 AT - O — P9
——— G:infmzgliprograne™ — — N ——

GL126_1

GL128_2 UP,

GL128 2 SEIUP.3

GL138_1 JEST A

GL138_2

TEST_1

L——— FHEE SPRCE  1663,360MH — ‘——— FREE SPACE 694KB —

The program path will be changed and the list of programs will be displayed.
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This chapter describes operations such as loading programs created in
Offline Mode to the PLC or a Motion Module, and saving programs
from the PLC to the personal computer,

18.1

18.2

18.3

18.4

18.5

PLC Load/Save Operations ...............
18.1.1  Loading from Personal Computer to PLC ...........
18.1.2  Saving from PLC to Personal Computer ............
18.1.3  Verifying PLC Data with Personal Computer Data . . . .

Motion Module Load/Save Operations . . .. ..
18.2.1 Loading from Personal Computer to Motion Module . .
18.2.2  Saving from Motion Module to Personal Computer ...

18.2.3  Verifying Motion Module Data with Personal Computer
Data ... ..o

Motion Module Options ..................
18.4.1 Motion Module Option Operations . ,..............

184.2  Split Loading to Motion Module ..................

MC10 Motion Module Load/Save Operations
18.5.1 LoadingtoMCI10..............................

-~ 18-1 —

18-2
18-2
184
18-5

18-7
18-7
18-9

18-11

18-13
18-13
18-13
18-15
18-16

18-17
18-17
18-17
18-20
18-21

18-23
18-23




Loader Operation

w

18.1.1 Loading from Personal Computer to PLC

18.1 PLC Load/Save Operations

computer to the PLC, saving programs from the PLG to the personal computer, and

This section describes operations procedures fo} loading programs from the personal
verifying the data between the personal computer and the PLC.

18.1.1 Loading from Personal ComputertoPLC ...t 18-2
18.1.2 Saving from PLC to PersonalComputer .............ccoviieninnn 18-4
18.1.3 Verifying PLC Data with Personal ComputerData .................... 18-5

18.1.1 Loading from Personal Computer to PLC

This operation loads a program created in Offline Mode to the PLC CPU Module. The opera-
tion can be performed only in Offline Mode. If the PLC is in RUN State, stop the PLC after a

confirmation message is displayed by MEMOSOFT. When the PLC is in RUN State, the pro-
cedure is as follows:

1) Select the Loader Menu.

2) Stop the PLC after a confirmation message is displayed.

3) Load the program to the PLC.

4) Start the PLC after a confirmation message is displayed.
Use the following procedure to perform the load operation.

1) Switch to the menu cursor using the Tab Key.

2) Select Loader from the Tools Menu using the Cursor Keys and press the Enter Key.

kdl Config Ladder Motion Comment Ref Data
—_— P4 —Fs Fe TP

ft

14a
i PR e

Tak #oues betwssn the Henu Bar and the Editiny Scresn.
ALT H provides help on the menu item selected by the curser.
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3) Select File to PLC from the Loader Submenu using the Down Cursor Key and press the
Enter Key.

ode  Config  Ladder Motion Comment Nef Data
Pl ————F2—— P ———F4———pr ¢

=
M
=
-
LI
=

—temozoft
GL120

Progran Name:
| FLG Address: NB: 1
FIGC Type:

Iab = moves betwesn the Menu Bar and the Editing Screen.
ALT H provides help on the menu item selected by the cursor.
&I; .

4) A window for selecting the file to be loaded to the PLC will be displayed. Select the file
name to be loaded using the Down Cursor Key and press the Enter Key.

de Conf Ladder Motio Co t Ref Data Tool; Quit
——-rz———r”s 3 P4 ul ﬁnn 6 .“'n‘m-ﬂ—ﬂ‘n-—ﬁ
<R>
flenosoft
GL128_1
MB: 1

®oves: betwesn the Menu Bar and the Editing Screen.

Tah
* ALT W prevides help on the menu item selected by ths curzer.
1

5) The program will be loaded to the PLC. When the load operation is completed, a mes-
sage will be displayed asking whether to start the PLC. Enter Y to start the PLC.

Olmiﬂb 1} The communications parameters used for the load operation are those which were set
when the new program was created by the New Program operation. If the communica-
tions parameters need to be changed, select the file name to be loaded using the Select
Program operation, and then change these parameters using the Change PLC Address
operation.

2) Ifthe same coil is used more than once, an error will occur during load execution., in this
case, execute File Check on the Segment List Display Screen to correct the duplicated
coil.
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18.1.2 Saving from PLC to Personal Computer

18.1.2 Saving from PLC to Personal Computer

Saving a program stored in the PLC CPU Module to the personal computer can be performed
only in Offline Mode. This operation can be performed even if the PLC is in RUN State. The

following example shows this operation.

1) Select PLC to File from the Loader Submenu of the Tools Menu. Then press the Enter
Key.

c.nfig Ladder der B l‘l-tmn Go-nnt lhl‘ Bata

HEHDEDFW

Nemosof t
Program Name: 'I‘Kl'_.l
PFLC Address:
PFLC Type:

Tab moves betwnen the Menu Bar and the Editing Screen.
ALT W provides halp on the menu item sclectsd by the cursor.

2) A submenu will be displayed. In this example, select New Program using the Cursor
Keys. To overwrite the new file to a file that aiready exists, choose Select Program.

}bdt con!‘i’ Luldn- I‘lotiu- coannt lof Data Qu.{e
ann

MEMOSOES

Program Ihua: IES'I'J Fe
PLC ddl'e MB: 1
PLC Type

Tabh moves betwsen the Menu Bar and the Editing Screem.
RLT W provides help on the menu item selscted by the cursor.

3) Enter the file name (GL.120_4 in this example) and press the Enter Key.

de Cnnl'ig Ladder Motion Comment FRef Data Yools Quit
——u—rs—rs—v?-m-rc I—F?

I'l.l'IF

Progran Hame:
PFLC Addrezs: MB: 1
PLC Type:

<R>

Tabh moves between the Menu Bar and the Editing Screen.
LT H provides help on the menu itsm selected by the cursor.
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4) Set the communications parameters.

de Config Ladder Motion Comment Ref Data Tools Quit
E-——n——n Pd 5 e F7-R-Fe - —F9
<R>
i
Progran Mame: T;T.‘l £
. I PLC Address: MB: 1 I
—COMMUNICATIONS PARRMETERS
Rddress Protocel Mode Data Bits Parity Step Bits Baud Device
f MEMOBUS RIU ] EVEN 1 2680 cont
Iq I Dip Switches 38X/ 48X I! | 111 ¥ H] |q I
23 ¥y 12345679 23 78

The file transfer from the PLC to the personal computer will start.
Olm. 1} To change the communications parameters, see 17.2.6 Change PLC Address.

2) When saving a program using the Select Program operation, the parameters which are
saved in the selected program are used for the communications parameters with the
PLC. To change the communications parameters, load the file and change the parame-
ters using the Change PLC Address operation.

18.1.3 Verifying PLC Data with Personal Computer Data

After executing the load operation from the personal computer to the PLC, or the save opera-
tionfrom the PLC to the personal computer, for confirmation, verify the PLC data with the per-
sonal computer data. An example is shown below.

1) Select Verify PLC from the Loader Submenu of the Tools Menu using the Cursor Keys.
Then press the Enter Key.

’!bdo Confi Ladde Mot io Conment Ref Dat iﬁq* Quit
[F1. o s F4 u 5 Fe ‘.

MEMOSOFR

File to PLC
Program Mame: TEST 1

rlerify MC
PLC Option:
MG Options

+PLC to File
T
PLC Pddress: NB: 1

MG to File
PLC Type:

Tab = moves between the Menu Bar and the Editing Screen.
ALT W provides help on the menu item solected by the cursor.
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18.1.3 Verifying PLC Data with Personal Computer Data cont.

2) Select the file name to be verified (GL120_1 in this example} using the Cursor Keys and
press the Enter Key.

Mode
[F1

Config Ladder Motisn Comment Rof Data . Tools Quit
_-.—..-—n -

MOSOFT

wovss betwesn the Menu Bar and the Editing Sereen.

2
23
1
2

<R>

T
ALT # provides olp on the menu itom sslscted by the cursaor.

If the contents of the selected file do not correspond with the PLC, the following message
will be displayed.

1

Confiy Ladder Motjom

oo oo

Comment Ref Data Tools Guit
PGP FY- T

Conparing networks ...
Panel - RNetuork
Identical netuorks

Uerify Result:

Panel progran daffercent than PC progran

Last differcnce at netvork: 2 Colunni 11

Nede Data:  Pancl - BxBec 88 61 PLC - @x8c 468 bd
Continue ‘Gt

Dis-cont inue *D*
File only ‘F’

c/o-F 2 A

3) Continue the procedure according to the messages displayed. The following file will be
created to save the verification results.

rx*.MAP

J — Program name
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18.2 Motion Module Load/Save Operations

to the Motion Module, to save a program from the Motion Module to a personal computer,

This section describes the procedure used to load a program from a personal computer
and to verify the data between the personal computer and the Motion Module.

18.2.1 Loading from Personal Computer to Motion Module .................. 18-7
18.2.2 Saving from Motion Module to Personal Computer ................... 18-9
18.2.3 Verifying Motion Module Data with Personal ComputerData ........... 18-11

18.2.1 Loading from Personal Computer to Motion Module

This operation loads the motion program, parameters, and pointtable created in Offline Mode
to the Motion Module. The operation can be performed only in Offline Mode. The Motion Mogd-
ule must be in Edit Mode. If the Motion Module has been switched to another mode, such as
Manual Mode, make sure to retum it to Edit Mode before loading.

This operation can also be